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COPYRIGHT NOTICE
 
Be advised that this ExcelCEO Excel 2016 complete self-study course, the ExcelCEO website, online 
student profile, Review Questions, chapter exam questions, the ExcelCEO Excel 2016 course manual, 
included contents, and practice files are protected under U.S. copyright laws. Do not give a copy of this 
course to anyone, regardless of monetary or other gain. 

Making copies of any of the material herein for anyone not registered for ExcelCEO Excel 2016 training 
to use is illegal and provides for severe penalties. 

In addition to being fraudulent, making illegal copies prevents sales that are necessary to fund future 
editions. Printing one copy of this course manual for your own use is permitted. 
 

Thank you for your integrity by not copying any portion of this ExcelCEO 
Excel 2016 complete self-study course, including the course manual and/
or practice files (in whole or in part) for others to use.  

Jim Cline 
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ExcelCEO believes the information contained in this manual is accurate. We have taken much care in its 
preparation. However, we do not accept any responsibility, financial or otherwise, for any consequences 
coming from the use of this material, including loss of profit and any other indirect, special, or 
consequential damages. No warranties extend beyond this course specification. If you do not agree to 
these terms, do not use this course. Use of this course for Excel training and reference is considered 
agreement to these terms.

You should exercise care to assure that the use of the concepts taught in this course is in full compliance 
with federal, state, and local laws, rules, and regulations, and meets your certification requirements. 

These materials are confidential works of ExcelCEO/ExcelCEO.com, and are produced by ClineSys. 
Contents of this publication are copyrighted and cannot be reproduced in any form without the 
expressed written permission of ExcelCEO. The information contained herein is subject to change. 
Revisions may be issued from time to time and ExcelCEO assumes no responsibility to advise customers 
of such changes.

Rev. 1.14
All right reserved
 © September 2024, ClineSys/ExcelCEO.com	
Printed in Bay Town, TX, United States of America 
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Introduction 

When I was a college student in the 1980s, I took a course called “Introduction to Computers.” The first 
part of the class was devoted to WordPerfect, a popular word processing program at the time. That part 
of the course was helpful, but it was the rest of the semester that changed my life forever. That is when I 
was introduced to a spreadsheet program called Lotus 1-2-3. As an Accounting major, I loved the ability 
to manipulate numbers any way I wanted on a spreadsheet. When we got to the macros section of the 
class, I fell in love all over again. I knew I had discovered my career. 
 
Over decades of working with spreadsheets, I decided to write this course. I have compiled in this course 
the material that took me years to learn, in easy-to-understand examples, lessons, projects and code. I 
will walk you through hundreds of formulas, functions and code examples that are designed to give you 
the experience necessary to masterfully work Excel on your own. I explain each task or concept just like 
I was at your desk, helping you each step of the way. However, I cannot teach you all of the logic that you 
will need in every situation you may encounter. I will show you how to use Excel and I will do my best 
to teach you logic for many different situations, but it is up to you to apply that logic to your particular 
circumstance. 
 
Let me explain how this course works. The projects, illustrations, tasks, and examples taught in this 
course could be considered as on-the-job training, as it would take you years to gain this experience on 
your own. In the course, there are more than 745 screenshots, screentips, and icon images total included 
helping to show you how to do the almost 1,500 tasks you will perform. The concepts herein are designed 
to teach you the basics of financial reporting and analysis using Excel. These are real-world examples 
that you would find in actual situations. In fact, many of the exercises are actual projects that I have done 
over the years in my experience as an auditor, tax accountant, real estate appraiser, financial analyst, web 
developer, programmer, and instructor. As you work these examples, I encourage you to think about the 
concepts being taught and make up examples of your own, using data and situations with which you are 
familiar. This will significantly reinforce the concepts taught herein for your own Excel mastery. 
 
This course is based on progressive learning. When I teach a new concept, I will explain in full detail 
how to do it. Thereafter, I will not explain it in detail, but I will assume that you have learned that 
concept. If you need to refresh your memory on how to accomplish the task, refer back to the pages where 
that concept was originally taught. I encourage you to try to do it on your own before referring back, 
unless you are completely lost. In my years of experience, I have discovered that is the best way to learn. 
The course is made up of 18 chapters, and it should take you between one and four hours to complete 
each chapter (see the CPE Credit Schedule table), including working the examples, completing the Review 
Questions and taking the online chapter exam at the end of each chapter. Some of the more advanced 
chapters may take more time, depending on your experience level with the concepts taught.

It is important to realize that the concepts taught in this course are very versatile and there are many 
ways to do essentially the same thing. If you have learned a concept in a way that is different from how it 
is presented in this course but it achieves the same objective, feel free to use it. This course is designed to 
give you exposure to a variety of ways of doing things. For example, most people are familiar with using 
the mouse to execute commands, but I prefer to use the keyboard whenever I can. I find that I can move 
around a spreadsheet much faster by using keystrokes on the keyboard than I can with a mouse. As much 
as is reasonable, I will teach how to use both the mouse and keystrokes on the keyboard to show you how 
to execute the commands.  
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In developing this course, I created a company whose accounting system is complex enough to simulate 
real world activity, but simple enough to be used in the examples and projects. I didn’t want the students 
to have to take a course just to learn the accounting system of this company, but I had to make it 
complex enough to teach the necessary concepts. As such, I created a fictitious company called Nitey-
Nite Mattresses. Nitey-Nite’s business is to operate 29 retail stores across the United States. Nitey-Nite 
purchases mattresses, pillows, and other merchandise from various manufacturers, and sells them in 
their retail stores. 
 

Please note: The financial data contained herein is purely fictitious and 
does not resemble the activity in any way of any similar retail store 
today. The accounting methods used in these examples and projects do 
not necessarily conform with GAAP (Generally Accepted Accounting 
Principles) requirements for the industry, although the financial statements 
and accounting practices herein reflect standard double-entry accounting 
methodology. 

 
This course is written specifically for Microsoft Office Excel 2016 using the Windows 10 operating 
system. While the skills and tips taught generally translate to other versions of Excel, this training 
program should be taken with a copy of Microsoft Excel 2016, which is not included in ExcelCEO 
training. Now, in Excel 2007, the Microsoft engineers introduced the concept of the Office Ribbon, which 
is located at the top of the program window. All of the toolbars and menus prior to Excel 2007 have been 
reorganized into the Office Ribbon tabs and galleries. If you are an experienced user for any version prior 
to 2007, you will initially find yourself very frustrated. Excel 2016 expands on the capabilities of Excel 
2007 — 2013, although there haven’t been many major changes since Excel 2010 for Excel. If you are 
new to Excel, you will find it very easy to unlock the powerful data analysis capabilities as compared to 
previous versions. 
 
I sincerely hope that you will enjoy this course. If you find any errors that should be corrected, or if you 
would like to send me any feedback, please email Customer.Service@ExcelCEO.com. Thank you. 
 
 

Jim Cline
Founder, Developer, and Author 

Derek Mecham
Editor, Designer, and Technical Support
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Getting Started  
Welcome to the ExcelCEO Excel 2016 training course! Whether or not you are taking this course for CPE 
credit, we are confident you will gain significant and useful skills as you follow the detailed, step-by-step 
instructions provided in this course manual and work through these 18 chapters of projects designed to 
teach you beginning to advanced Excel. This course will challenge you, but the gains will definitely be 
worth the effort!

ExcelCEO courses are classified as self-study, and are not considered to be online courses, so you will 
need access to a copy of the Microsoft Excel 2016 or similar program to follow along with the examples 
outlined in this course manual. All CPE credit chapters (1-17) have available tutorial videos through the 
Videos section of your ExcelCEO training account Main Menu at www.ExcelCEO.com. The tutorials are 
designed to show you skills you should be able to gain for yourself as you progress toward ExcelCEO 
Excel Master status by allowing you to see the instructions and work hands-on with the projects given. 
Completing the hands-on projects is essential for passing the chapter exams.

When you registered for this course, you received a Password. Your password is case-sensitive. You will 
input the email address that you registered with as your User ID, and then your Password to login at 
www.ExcelCEO.com to download the Practice Files, take Review Questions and Chapter Exams, and 
gain general access to your ExcelCEO profile. Keep your User ID and Password in a secure place, so you 
can refer back to them when needed. A [Forgot Your Password?] link is also available at ExcelCEO.com. 

To work the many examples illustrated in this course, you need to download the Practice Files from the 
Main Menu in your student profile. To download the Practice Files for your selected course, log in to 
www.ExcelCEO.com with your User ID and Password, and click on the Downloads link on the Main 
Menu. Step-by-step instructions are provided to show you what to expect as the files download to the 
computer you are using. If you choose to save the Practice Files somewhere besides the default location, 
remember where you saved them to ensure convenient access later. If you do forget the location, you can 
click on the Windows button (Windows 7), the Start Menu icon (Windows 8/8.1), or the Windows button 
(Windows 10), then type Excel2016 in the search box, and select the file folder from that menu.

Review Questions  
As you work through the course manual, you will periodically be instructed to sign on to www.
ExcelCEO.com and complete the Review Questions. Review Questions are formatted in the same way as 
the actual examination questions, but are provided for review purposes as well as for extended learning 
opportunities. Review Questions are not graded, though the program will indicate whether or not the 
chosen answer is correct. Have the Excel program open for hands-on learning when completing Review 
Questions. If you choose an incorrect answer, a message will pop up indicating why the chosen answer is 
incorrect, and the program will allow you to choose another answer. You must choose the correct answer 
before continuing to the next question. Login to your student profile at www.ExcelCEO.com to complete 
the Review Questions when you see a note paragraph like the following: 
 

Review Questions: It is now time to complete the hands-on Review Questions. 
Log on to www.ExcelCEO.com with your Email address and Password, click 
on the Excel 2016 Review Questions, Chapter 1, Section 1 of 3 option in 
your Main Menu, and complete the Review Questions. 
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The program will guide you to the correct Review Questions section or Chapter Exam based on the 
sections you have already completed. Each chapter (except Chapter 18) contains between two and four 
sections of Review Questions. Review Questions for each chapter must be completed in order to access 
the chapter exams. 

Chapter Examinations  
There are 18 chapters in the course, contained in four sections (Beginning, Intermediate, Advanced, 
and Master). At the end of each chapter, you will be instructed to go to www.ExcelCEO.com, log in, and 
take that chapter’s exam. After you login with your User ID and Password, and complete the Review 
Questions, you will click on the link for the test indicated which will navigate you to the appropriate 
test. All tests are administered sequentially after you successfully pass the previous exam. The exam uses 
questions from a database of thousands of possible questions, so it is unlikely that any two people will get 
the same exam. Some of the exam questions are based on the examples in the practice files, so you are 
encouraged to complete all of the exercises in the course. For example, if you complete an exercise that 
calculates net income by store, one exam question may ask, “What is the 2016 Net Income for Store 1002, 
if you change Other Revenue to $25,000?” Each question is in a multiple-choice format, and you will have 
four choices from which to choose.  
 
The only recorded score for each exam is the passing grade. Your ExcelCEO student profile contains 
a Certificates section where exams you complete are tracked by date and score. You must score a 70% 
or better on each exam to pass. After obtaining a passing grade, you will be able to complete a short 
survey of the chapter, then print out a Certificate of Completion as evidence that you’ve read the material, 
worked the hands-on project examples, completed the Review Questions, and passed the chapter exam. 

CPE (Continuing Professional Education) Credits  
To claim CPE credits under NASBA guidelines, the CPA must successfully complete any chapters in the 
course within one year from the date of purchase to claim credit for them. The CPE credits for each 
chapter in this manual are listed below. Upon completion of a chapter, sign on to www.ExcelCEO.com 
with your email address and password and click on the Certificates link to view and print a copy of the 
certificate of completion. As of December 31, 2010, the student can take up to two retests on final exams 
that were failed. After the second retest (or the third time to take the final exam), the student cannot 
receive CPE credits for that chapter).

National Association of State Boards of Accountancy (NASBA) 

ClineSys is registered with the National Association of State Boards of Accountancy 
(NASBA) as a sponsor of continuing professional education on the National 
Registry of CPE Sponsors. State boards of accountancy have final authority on the 
acceptance of individual courses for CPE credit. Complaints regarding registered 
sponsors may be submitted to the National Registry of CPE Sponsors through its 
website: www.nasbaregistry.org

http://wwwnasbaregistry.org
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CPE Credit Schedule
Chapter Title CPE Credits

1 Excel 2016 Basics 3.0
2 Formatting 2.0
3 Simple Graphs and Flowcharts 2.0
4 Sorting, Subtotaling and Filtering 2.0
5 Printing 1.5
6 Intro to Formulas and Functions 2.0
7 Text Functions 2.0
8 Financial and Math Functions 3.5
9 Date, Statistical and Lookup Functions 3.0

10 Advanced Lookup and Logical Functions 2.0
11 Intro to PivotTables 2.5
12 Advanced PivotTables 3.0
13 Charts, Graphs and Objects 2.0
14 Analysis Tools 2.5
15 Graphics, Protection and Sharing 2.0
16 Macros and the Developer tab 3.0
17 The Web and New 2016 Features 2.0
18 The Comprehensive Project 0.0

Total 40.0

Note: There is no CPE credit given for completing Chapter 18. Completion of 
Chapter 18 is required to earn an ExcelCEO Excel Master certificate.

Conventions Used In This Course  
 The basis behind this course is learning by example. As such, I have included hundreds of tasks, examples 
and projects. Step numbers to complete a task are numbered and shown in italicized, ﻿bolded text. Objects 
or buttons you can see are in Bold font, and object names or formulas you should type are bolded and 
italicized. Workbook tabs have vertical tab lines around them, and are bolded. Here are some examples: 
 

1. Click on Cell B12 on the  tab. 
2. Type =SUM(B2:B11), and press [Enter]. 

 
To assist you, I have included hundreds of screen shots and pictures of the icons used in the examples, 
including simple assists like this Save icon:   Screen shots are from Excel 2016 using Windows 10.
 
Action keys (keys that do something other than type a character on the screen) on the keyboard are 
referred to in brackets, such as the Enter key [Enter] and the F2 key [F2]. Sometimes it is required to hold 
down one or more keys on the keyboard to perform a certain action. For example, to make a cell bold, 
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you press and hold the Control key [Ctrl] and then type the “b” key. I will refer to this action as [Ctrl]+b. 
Action keys can also be sequential, by typing one key at a time. For example, to execute the process to set 
a column width using action keys would be to press and release the [Alt] key, then the o, c, and w keys, 
each separated by a comma. I will refer to this action as [Alt], o, c, w. These work in Excel 2016 just as 
they did in previous versions of Excel. If you are accustomed to using action keys in previous versions of 
Excel, you’ll feel at Home with Excel 2016.

Keyboard Shortcuts 

Keyboard shortcuts are keyboard strokes that execute functionalities without having to choose the 
options from the Office ribbon with the mouse. Keyboard shortcuts generally include the use of the 
[Ctrl], [Alt], and/or [Shift] keys. For those of you who liked to use keyboard shortcuts in Excel 2003, 
you’ll be happy to know that the same shortcuts exist in Excel 2016. To get a complete list of keyboard 
shortcuts available in Excel, go to the Excel Help menu, search for “keyboard shortcuts” and click on 
“Excel shortcut and function keys”.  

Prerequisites  
Prerequisites for taking the Excel series of this course include a basic knowledge of a Windows operating 
system, and knowing how to use the keyboard and mouse. This course is written specifically for people 
with accounting or financial training, so I will assume you know the basics of income statements and the 
transactions (the debits and credits) that make up the statements. Familiarity and prior experience with 
Excel is helpful, but not essential.

New for Excel 2016
As you work through the course, and I introduce a concept that is new to Excel 2016, I will indicate 
it. Microsoft has been following a pattern of introducing revisions over time. Excel 2007 brought major 
upgrades compared to Excel 2003. Excel 2010 and 2013 were not overly different from 2007, and now we 
have Excel 2016, which has some useful upgrades to improve functionality with expanded Sharing and 
cloud-based storage access, and to follow the productivity trend of making documents more portable/
mobile and easy to intrepret. Below are some specifications of Excel for you to compare:

Item Excel 2003 Excel 2007 — 2016
Columns in a worksheet 256 16,384
Rows in a worksheet 65,536 1,048,576
Number of conditional formats applied to a cell 3 Only limit is available memory
Sort levels in a table 3 64
Items displayed in a Filter list 1,024 32,768
Characters displayed in a cell 1,024 32,768
Unique cell styles in a workbook 4,000 65,536
Number of nested levels in a formula 7 64
Maximum arguments in a formula 30 255
Number of columns allowed in a PivotTable 255 16,384
Number of fields displayed in the PivotTable Field List 255 16,384
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The Microsoft Office suite continues to become more flexible with the 2016* (and 2013) version. New 
features since Excel 2013 include:

Share* - Simplified ability to collaborate on files by allowing you to grant access, permissions, and 
email files directly from Excel.

Query* - This provides standard access to Power Query, which was previously an Excel add-in. 
Connect to data sources and even write and edit SQL queries within Excel for returning selected data.

Tell me what you want to do (or Search)* - This search box above the Office Ribbon allows for you to 
search for functions based on a typed explanation of what you want to accomplish.

Flash Fill - Flash Fill is a predictive auto-fill feature that looks for patterns in the way data in a column 
is being entered. This feature tentatively populates the column with what it is seen as the pattern from 
the first and second cells in the column, and can do simple things like extract a domain name for an 
email address list, first or last names, etc. The tentative fill is optional, and defeatable for the column, 
or you can disable the feature using Excel Options to customize your experience.

Quick Analysis - When selecting a table or data for quick options, a preview mode is available to 
show you what the option would look like in finished form, which assists with making your data 
more illustrative. Quick Analysis provides access to chart controls, including Sparklines, which were 
introduced in Excel 2010.

Recommended Charts - This is a new option in the Insert tab available through the Quick Analysis 
box, or to the right of a chart you create. Editor buttons show to the right. Report Filtering is much 
easier. Click Apply after filtering. Keep working with Chart Elements or click outside the chart to 
finish.

OneDrive® (formerly SkyDrive) - Options like saving files to OneDrive, the hard drive on your 
computer, the web, or to other locations makes it quick and easy to retrieve files on mobile devices 
and computers for yourself, or for team members you choose to Share with wherever you have access 
to this cloud-based application (app). OneDrive works as a cloud backup, increasing file security, as 
well as providing an option to access and sync files offline from a variety of devices.

Representational State Transfer (REST)-compliant web services - Compatibility is made easier with 
online editing , and you can use the same file and version to collaborate. Excel online makes it possible 
to save part of your workbook to the web for access and editing.

Rich Data Labels - formatting that stays with the chart, even if you change  the chart style. Charts are 
much more user-friendly in Excel 2016, and provide previews as you make changes, so you can decide 
whether or not the change you’ve made accomplishes what you intended.

View animations in charts - watch changes in your chart when data changes. Charts are no longer 
static. PivotTable analysis comes with previews, and you create more tables using the same Fields, add 
timelines to compare rolling data, and more.



SECTION I: BEGINNING EXCEL 
 

The first section of this course is designed to teach you the basics of Excel 2016. I realize that you may 
already have some Excel experience and may even consider yourself to be an Excel expert. As such, you 
may think this material is insulting your intelligence by asking you to complete the examples. However, 
please understand that I have designed this course as one that builds on concepts taught in previous 
lessons. I expect for you to continue your education beyond Excel to other topics I teach, including Access 
and SQL. The ideas and concepts I teach in the Excel course serve as a foundation for concepts you will 
learn in later courses, and I must be assured that you have reviewed and understand the basics. I will 
therefore ask you to work all of the examples in these exercises. To keep you advanced people engaged, 
I’ve included a lot of tips and tricks in the beginning chapters that many of the Excel “experts” don’t 
know. Additionally, you will need to complete the exercises in their entirety in order to answer some of 
the questions in the exams. 
 
If you are a former Excel 2003 (or previous version) user, and tried to use Excel 2007, 2010, 2013, or 2016 
with no instruction, you have probably become very frustrated. The new Excel interface is vastly different 
from previous versions, and you have probably asked questions like, “How in the blazes do I open the Find 
dialog box?” Rest assured, you are not alone. I will point out those differences in many of the exercises 
herein, which gives you even more of a reason to work ALL of the exercises. 
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CHAPTER ONE — EXCEL 2016 BASICS

Chapter Objectives: 
 

•    Identify basic icons, groups, and menus within the Office Ribbon and File tab
•    Recognize how to enter and edit basic data directly into a cell as well as in the Formula Bar
•    Choose the Excel Options to customize your Excel program interface
•    Recognize and use Alt key sequences to execute Keyboard Shortcuts
•    Choose a custom Cell Style for application to selected cells
•    Identify Merge & Center functionality
•    Select the appropriate keystrokes to Copy and Paste cell contents
•    Determine the correct way to insert columns and rows to increase spreadsheet flexibility for use
•    Identify how dates are formatted and how calculations can be performed on them
•    Recognize Data Fill to copy data and formula patterns within a column
•    Choose the Freeze Panes and Split Windows functionalities to increase visibility to important 

rows and columns
•    Recognize how to insert and delete Comments to a spreadsheet cell 
•    Identify File Properties area and add identifiers to a workbook
•    Select an Excel workbook to insert into an email message

Projects You Will Complete During This Chapter:

•	 myIncomeStmt.xlsx (beginning from a Blank workbook)
•	 myMay_Sales.xlsx (using pre-configured May_Sales.xlsx)

CPE Credits possible for this chapter: 3
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Excel 2016 Basics  
Excel is an electronic spreadsheet. It allows you to organize data into lists, filter, sort, summarize, 
compare, rank, add, subtract, multiply, divide, and do just about anything you want to do with those 
numbers. In the information age of today, time is money, and Excel helps you collect, organize, and 
analyze information very quickly. With Excel, you can calculate the average days outstanding on your 
receivables, sum total sales figures for each region of your company, or calculate the average age of your 
customers, and present it all in graphs that allow upper management to see trends. And the more you 
know how to organize and manipulate those numbers, the more valuable you become to your company. 
Data is little more than a collection of numbers or words by itself. The goal of this course is to teach 
you through hands-on projects how to make sense of the data given, and to teach you many of the ways 
Excel can help you understand and present the data in ways that help you make informed decisions. The 
ExcelCEO Excel courses cannot teach every single thing Excel is capable of doing in one course, but by 
the time you finish your training, you should have a solid understanding of how Excel works, and then 
your limitation becomes only your imagination, or knowing what you want to accomplish.
 
In this chapter, you will learn the basics of Excel. Please note that it is not my goal to insult your 
intelligence by making you do some seemingly easy tasks, as you may have a great deal of experience 
with Excel. However, I have included in this chapter a few tricks that not many Excel users know about, 
so it will definitely be worth your while to work every example in the chapter, and in the whole course for 
that matter. Let’s first discuss some of the basics in Excel 2016.

The Backstage View  
When you first open Excel in the 2016 version, the default setting brings up the Backstage view. From 
the Backstage, you have the option to search through pre-configured Excel templates, open a Blank 
workbook, or use the Recent files section on the left to open any recent files you have been working with.  

Figure 1.1 

Figure 1.1

1. Open Excel 2016 (If you are using Windows 10, click on the Windows  icon, All Apps, 
scroll down to Microsoft Office 2016, Microsoft Excel 2016). For Windows 8/8.1, the 
Start Menu button is an icon that looks like a Home . Type Excel 2016, and select the 
Excel 2016 under the heading of Apps, which will open the Excel 2016 program for you.
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2. Excel 2016 does not open to a Blank workbook (by default), so click on Blank workbook  from 
the templates after opening the Excel 2016 program and a new workbook will be created.

Figure 1.2

The Office Ribbon
Click the Blank workbook option to open Excel and you will see the Office Ribbon at the top of the screen 
that looks something like the image below, based on a full, wide screen. Note that the Office Button in 
Excel 2007 was replaced with the File tab in Excel 2010 — Excel 2016. In the next few exercises, we’ll go 
through how to navigate within the Ribbon. 

Figure 1.3

In the upper-left corner of the Excel screen, just to the right of the Microsoft Excel button is the Quick 
Access Toolbar . We’ll discuss the Quick Access Toolbar a little later. Along the top and 
center of the spreadsheet is the Title Bar . It shows the name of the file. In the upper-right 
corner of the spreadsheet are the standard Microsoft Excel Help (F1), Ribbon Display Options, Minimize, 
Maximize, and Close buttons . Just below the Title Bar of the spreadsheet are ten 
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default tabs:  File, Home, Insert, Page Layout, Formulas, Data, Review and View. Your version may or 
many include Acrobat, Add-ins and/or Team. All of these tabs, with the exception of the File, Acrobat, 
and Team tabs, are the same as in Excel 2007. The File tab in Excel 2010 — 2016 replaced the Office 
Button in Excel 2007. When you click on any tab, the Office Ribbon will change to show the icons 
associated with that tab. If you hold your cursor over almost any icon or menu item, a ScreenTip will 
appear. The screen tip tells you what the icon or menu item does. Hold your cursor over the Format 
Painter icon to see a screen tip for applying its use in a new section on the lower-left of the screen in 
addition to the temporary window that appears near your cursor. 

Figure 1.4

If you click on the File tab, you will see the following expanded feature screen with vertical tabs to display 
document information in the following categories: Info, New, Open, Save, Save As, Print, Share, Export, 
Publish, Close, Account, Options, and Feedback. Several of these are common Office features you should 
be familiar with, and some are new. 
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Figure 1.5

We’ll go through the menu items on the left in future exercises. If you have experience with previous 
versions of Excel, you should already be familiar with some of the icons like Save, Save As, Open, Close, 
and New. You make each choice active by clicking on it. For example, if you click on the Info tab, it shows 
information about the spreadsheet that you currently have open. We’ll go through each of the various 
options as needed throughout the course. The section to the right gives more information and choices 
within the selected tab. The Options button allows you to create and customize certain options within 
Excel. The Close button will, of course, close the Excel program. 
 
When you open Excel 2016, the program opens to a templates page, the first of which is Blank workbook 
with one tab located along the bottom of the screen. The tab defaults to name Sheet1 and contains a 
worksheet, also called a spreadsheet. With the new Office interface, you can add more spreadsheets 
by clicking the circled plus symbol to the right of the existing sheet tab - called New Sheet. The main 
body of the worksheet is divided into columns (indicated by alphabetic characters across the top of the 
spreadsheet) and rows (indicated by numeric characters located along the left side of the spreadsheet). 
The box at the intersection of a column and row is called a cell. The location of a cell is referred to by its 
column letter and row number. Cell A1, for example, is the first cell on the spreadsheet. Cell A6 is located 
in Column A, Row 6, Cell F19 is located in Column F, Row 19, and so forth. The body of the spreadsheet 
looks like the image below: 
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Figure 1.6

When you open a new workbook, Excel 2016 gives you one worksheet by default within the workbook. 
Versions of Excel previous to Excel 2013 defaulted to three tabs. You can add more worksheets or delete 
worksheets, and I’ll show you how to do that in this and later chapters. Each spreadsheet, or tab, is named 
by default Sheet1, Sheet2, and so forth, and are shown in tabs at the bottom of the screen. The next figure 
shows the result of clicking the New Sheet icon .

Figure 1.7

You make a tab active by simply clicking on the tab. You can use the tab selectors to select the tabs at the 
beginning , one tab to the left , one tab to the right , or the last tab . Unless you have 
numerous tabs on the workbook, you can usually see all of them at the bottom of the screen. Typically, 
data in each tab should relate to other data in the workbook. For example, the first tab may contain a list 
of vendors and the second tab could contain invoices payable to each vendor. If you right-click on any of 
the tab selectors, a dialog box pops up that shows you all of the tabs in the workbook. If you have more 
spreadsheets in your workbook than are visible along the named tabs bar, you can scroll to see them, or 
right-click on the Last arrow to see all sheets listed. 
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Figure 1.8

Entering and Editing Data  
Let’s start by typing some data onto a blank spreadsheet. That is one of the beautiful things about Excel – 
anyone can open a spreadsheet and start typing data into cells and make Excel do something. There are 
basically two ways to type data into a spreadsheet: typing directly into the cell and entering data using 
the Formula Bar. Let’s first enter data directly into the spreadsheet. 
 

3. Click on the Home tab. 
4. With the  tab selected, click on Cell A1 and type Nitey-Nite Mattress, then press the 

[Enter] key.

Figure 1.9

Pressing the [Enter] key inputs the typed characters into spreadsheet cell A1. However, we find that 
we’ve made a mistake. The name of the company is Nitey-Nite Mattresses. We will now edit the name to 
include the extra “es”. 

5. With your mouse, click on Cell A1. 

The Formula Bar is the box located just above the column lettering above the spreadsheet with “ ” or 
Insert Function button to the left. We will discuss the use of the Insert Function button later. The Formula 
Bar should look like this: 
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6. Click inside the Formula Bar to the right of the Nitey- Nite Mattress text.

Once you click inside the Formula Bar, you will see an “X” and a check mark to the left activated, with fill 
color no longer grey.  If you click on the X, it will undo any changes you made to the cell before they were 
entered. The check mark accepts the changes. It is similar to the [Enter] key, except the mouse will not 
move down one cell. 
 

7. Edit the text to read Nitey-Nite Mattresses, and click the check mark in the Formula Bar. 

The Formula Bar and spreadsheet should now look as follows:

Figure 1.10

Moving a Cell  
Moving a cell is very easy. Let’s suppose that you wanted the Nitey-Nite Mattresses text in Cell C1 instead 
of Cell A1. All you have to do is drag the text over. Let’s try it. 
 

8. Place your cursor over the bottom, top, or side line of Cell A1. Your cursor will turn to a cross 
with arrows on the tips. 

9. Click, hold, and drag the cell over to Cell C1, then release.

Figure 1.11

The Nitey-Nite Mattresses text is now in Cell C1. Alternatively, you can Cut and Paste the cell. When 
you cut and paste the cell, you are cutting the cell contents into memory then pasting those contents to 
another cell location.  

When you open a workbook, Excel 2016 selects the Home tab by default. Let’s now cut and paste the 
contents of Cell C1 using the icons in the Home tab. 

10. With the Home tab selected, and with your cursor on Cell C1, click on the Cut icon  in the 

Clipboard  group.
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Note: Groups are sets of similarly-functioning icons within a tab that are 
divided by thinly outlined boxes. For example, the Clipboard group contains 
icons that store data into virtual memory for relocation, allowing you to 
modify your spreadsheet without having to erase, write, or memorize cell 
contents during the transition.

Cell C1 is now surrounded by a moving dotted line, indicating that the cell is either copied or cut. 
 

11. Click on Cell A1, then click the Paste  icon. 

Note: You can click on either the icon, or the drop-down arrow, then click on 
the Paste icon. This is a little different from Excel 2007.

 
The text is now back in Cell A1. 

Figure 1.12

Excel Options 
When you press the [Enter] key, your cursor may skip down one cell. Personally, that bugs me, because I 
usually want the cursor to stay where it is after I press [Enter]. The only exception is when I am entering 
in data, but I can make the cursor automatically jump to the next cell in other ways. For now, I want to 
turn off the automatic skipping down by one cell. You can do this using Excel Options. The next few steps 
show how to turn that off. If you don’t want to turn it off, just skip those steps. However, you should read 
through the instructions in case you need that functionality someday. 
 

12. Click on the File tab, then click on the Options button at the bottom of the left column of the 
dialog box.
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Figure 1.13

Figure 1.14

Jim.Cline@ExcelCEO.com
Jim.Cline@ExcelCEO.com

Jim.Cline@ExcelCEO.com
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The Excel Options dialog box opens. There are MANY options you can change in this dialog box. I 
encourage you to click on the menu items to the left to find out which options are contained in each. In 
this exercise, we’ll turn off the functionality that moves the cursor down when you press [Enter]. 

13. Click on the Advanced menu item on the left side of the dialog box. 
14. If necessary, uncheck the After pressing Enter, move selection box (the first box under 

Editing Options).

Figure 1.15

15. Click OK. 

The dialog box disappears and you return to the worksheet. Now you will input some more data on to the 
worksheet. 
 

16. Type the following data into the indicated cells (Plain text, no italics when you type the data): 
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Cell Cell Input Value
Cell A3 Three Year Sales Summary 
Cell A5 Sales 
Cell A6 Mattresses 
Cell A7 Pillows 
Cell A8 Total Sales 
Cell B5 2016 
Cell C5 2015 
Cell D5 2014 
Cell B6 33415892 
Cell B7 14682832 
Cell C6 31585275 
Cell C7 13892897 
Cell D6 29574225 
Cell D7 11546835 

Your spreadsheet should now look as follows:

Figure 1.16

Formatting Cells  
Not to be disrespectful, but your spreadsheet looks kind-of, uh, bland. Fortunately, we have some tools 
at our disposal to make the report look more attractive. Most of the formatting tools you need in this 
exercise to make the report look nicer are found in the Home tab. There are seven standard groups in the 
Home tab: Clipboard, Font, Alignment, Number, Styles, Cells, and Editing. The formatting tools you’ll 
need in this exercise are found in the Font, Alignment, and Number groups. Take a few moments to look 
at those icons. Hold your cursor over each icon and read the screen tip to see what that icon does. Let’s 
clean up the report a little by using some formatting. 
 

17. Click on Cell B5. 
18. Click the Underline icon  in the Font group.
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Now Cell B5 is underlined. You want to underline the other years in Cells C5 and D5 as well, but you 
don’t have to do it one cell at a time. 
 

19. Left-click on Cell C5 and hold. 
20. Drag the cursor over to Cell D5 (to select both cells). 
21. Release the left-click on  the mouse (this process is called selecting cells). 
22. Click the Underline icon. 

Figure 1.17

Now Cells B5, C5 and D5 are underlined.

Keyboard Shortcuts  
If you prefer to use the keyboard to select multiple cells, you can click on Cell C5, hold down the [Shift] 
key and press the right arrow key on your keyboard to select both cells. With those cells selected, you 
can press and hold the [Ctrl] key and type the letter “u” to underline the cells. The [Ctrl]+u trick is the 
same in all Microsoft Office and most Windows-based programs. These are called keyboard shortcuts. A 
keyboard shortcut is the keyboard version of executing commands (or choosing options) that could also 
be done with a mouse. There are many other keyboard shortcuts in Excel. One easy way to find out what 
they are is to hold your cursor over the icon and read the screen tip. If a keyboard shortcut is available, 
the screen tip will tell you what the keyboard shortcut is. For example, if you hold your cursor over the 
Copy icon in the Clipboard group of the Home tab, you will see the following screen tip:

Figure 1.18
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To the right of the Copy choice you see (Ctrl+C). This means that you can click Ctrl+C together, and then 
Excel will copy whatever you have selected. The Ctrl+C reference is the shortcut. It is a little deceiving 
in that the C in the reference is capitalized, and the shortcut works when [Caps Lock] is on or when 
you type Ctrl+c (lower-case c). If you type Ctrl+Shift+c (to put the c in upper-case), it will not work as 
intended. If you prefer to use the keyboard to do many commands (like I do), these keyboard shortcuts 
can save you a lot of time. When you use keyboard shortcut combos, note that the “+” is to show you the 
combination of keys to use together — the “+” is not a part of the combination.
 
Let’s now return to our spreadsheet. Our file is starting to look a little better, but those numbers need 
some formatting. The years look good, as year numbers are typically shown with no formatting, but the 
sales numbers need to have some formatting, so let’s do that now. 
 

23. Select Cells B6 through D7. 
24. In the Number group of the  Home tab, click on the Number Format drop-down arrow to 

the right of the word General.  

Figure 1.19
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This is a short list of commonly used number formats. We want to format our sales figures with commas 
with no decimal places, and such a format is not included in this list. In this and previous versions of 
Excel, you could use the Format Cells dialog box. To display the Format Cells dialog box in Excel 2016,
click on the Dialog Expander, located at the lower-right corner of the Number group. 

Figure 1.20

25. Click anywhere outside the Number Format list (to make the list disappear). 
26. Click on the Dialog Expander , located in the lower-right corner of the Number group of 

the Home tab.
 
The Format Cells dialog box opens. Another way to open the Format Cells dialog box is to right-click 
anywhere in the spreadsheet and choose Format Cells. 

Figure 1.21



Excel Tips, Tricks and Training for You to Become the Chief Excel Officer of Your Company

ExcelCEO 

            Chief Excel Officer 18

27. In the Format Cells dialog box, make sure the Number tab is selected. 
28. In the Category: field, click on Number. 
29. Check the Use 1000 Separator (,) box. 
30. Click on the down arrow in the Decimal places: box until it reaches 0. 

Figure 1.22

31. Click OK.  

Figure 1.23
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You should spend some time experimenting with the different cell formatting options in the Format Cells 
dialog box. You will most likely use many of the formats available. 

One more useful tip: You will be using Excel a lot during this course, so it would be a good idea to make 
the program easy to find. Microsoft makes it possible to Pin items to your Start Menu, or even to your 
Taskbar, so you don’t have to search for programs each time you want to open them, and this can be a 
real time-saver for accessing any program you use regularly.

32. With Excel still open, right-click on the Excel 2016 icon on your Windows Taskbar, and click 
Pin this program to taskbar.

Figure 1.24

Now the Excel 2016 program is Pinned to your taskbar, and even when the program is closed, you can 
see the icon, and click to open it without having to search through Program Files from the Start Menu, 
or even through Cortana. You can Pin most any program to your Taskbar. We’ll explore more of this Pin 
functionality later.

Review Questions: It is now time to complete the hands-on Review Questions. 
Log on to www.ExcelCEO.com with your Email address and Password, click 
on the Excel 2016 Review Questions, Chapter 1, Section 1 of 3 option in 
your Main Menu, and complete the Review Questions.  

Cell Style  
When creating reports, it’s nice to have a standard format for the numbers. I like to use a cell format of 
Number with the comma separator with zero decimal places. Sometimes it can be tedious to remember 
the different formats of all the possible styles. Excel provides a great tool for you to store the formatting 
style and use it again and again. This functionality is called a Cell Style. Let’s set up a style. 
 

1. With Cells B6 through D7 selected, click on the Cell Styles icon  in the Styles 
group of the Home tab. 
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Figure 1.25

You can use one of these styles provided by Excel 2016, or you can create one of your own. One great 
feature about Excel 2016 is that you can hover your cursor over a formatting style and see what it would 
look like on your spreadsheet without having to click on the style. Let’s try it. 
 

2. Place your cursor over the 60% - Accent1 box (located under Themed Cell Styles, first 
column, third row), but don’t click on it.

 
When you place your cursor over the style, watch how the formatting for Cells B6 through D7 change. 
Play around with it a bit. Place your cursor over different styles and see which one you like best. 

Let’s suppose that you don’t want any of the styles provided in the dialog box. You can create your own style.  

3. In the Cell Styles dialog box, click on the New Cell Style…  icon.
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Figure 1.26

The Style dialog box appears. Note that it is already pre-populated with the style for which the cell range 
is currently formatted. If you like, you can change the formatting by clicking the Format… button. 
Clicking the Format… button will make the Format Cells dialog box appear, and you can make any 
change you want. 
 

4. In the Style name: box, type ExcelCEO1 and click on the Format… button. 
5. In the Number tab of the Format Cells dialog box, make sure Number is chosen under the 

Category group, the Use 1000 Separator (,) box is checked, and 0 is in the Decimal places 
box. 

6. Click on the Font tab. 
7. Under Font Style, choose Bold, then click OK. 
8. Click OK in the Style box. 

Nothing happened to the formatting of Cells B6 – D7. Why? You created a new cell style but you haven’t 
applied it to the range yet. Let’s do that now. 

9. Click on the Cell Styles icon. 

You should now see the ExcelCEO1 style listed under the Custom group, as illustrated below. 
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Figure 1.27

10. With the range B6 – D7 selected, click on the ExcelCEO1 custom style. 

The range is now formatted with the custom style you created. 

Figure 1.28

Column Widths  
Do you see how the last “s” in the word Mattresses in Cell A6 appears to touch the outline in Cell B6? 
That is because Column A isn’t wide enough. A standard Excel column measures 8.43 characters, but can 
be increased to 255 characters or decreased down to zero (hidden). These sizes represent the number of 
characters that can be displayed in a cell that is formatted with the standard font. There are a number of 
ways you can resize a column. Let’s explore some of those ways.
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1. Place your cursor on the column margin (the line between Columns A and B) above Row 1 
and your cursor will become a vertical line with left and right arrows. 

2. Double-click on the column line.  

Column A is automatically resized to fit the cell containing the longest text string in the column, which 
would be Cell A3 (Three Year Sales Summary). We don’t need for the column to be that wide. All we 
want to do is to adjust it so it is just to the right of the word “Mattresses” in Cell A6. 
 

3. Place your cursor on the column line between Columns A and B where your cursor turns to a 
vertical line with left and right arrows. 

4. Click, hold, and drag the column line to the left. 
 
As you drag the line to the left, you will see a ScreenTip box. This box tells you the width of the column as 
you drag it. 
 

5. Drag the column line until the screen tip reads Width: 10.00 (75 pixels), and release. 
 

Trick: You can also set a column width by using the keyboard. With your 
cursor placed in the column(s) you want to adjust, type the [Alt] key and 
then type the letters “o”, “c” and “w”, then input the desired column width. 
(These are the commands to set column widths since Excel 2003, and also 
works in 2016.) Additionally, you can also right-click the Column letter and 
choose Column Width...

At this point, you should be able to see all of the word “Mattresses” in Cell A6 with space following.

Figure 1.29

Merge & Center  
It really would be nice if we could have the title centered over the report. What’s that you say? Can we do 
that? Sure we can. Just about every time I think of a question that begins with, “I wonder if Excel can …”, 
it usually can. It just takes a little investigation on how to get it done. In this case, you can use the Merge 
& Center icon. 



Excel Tips, Tricks and Training for You to Become the Chief Excel Officer of Your Company

ExcelCEO 

            Chief Excel Officer 24

6. Select Cells A1 through D1. 
7. Click the Merge & Center   icon in the Alignment group of the Home tab. 

This action combines the four cells as one and centers the text “Nitey-Nite Mattresses” over the report. 
You can use the Merge & Center icon to merge and center, merge across, merge cells or unmerge cells. To 
see these choices, simply click on the drop-down arrow located on the right side of the Merge & Center 
icon. Let’s do some more formatting. 
 

8. Click on the Font Size box in the Font group of the Home tab and choose 14.  
9. Click on the Italics button.  

 
This increases the size of the text to a size 14 font and italicizes the text.  

10. Select Cells A3 through D3 and use the Merge & Center icon to center that text over the 
report. 

11. Change the font size to 12.

Figure 1.30

Simple Formulas  
Now we will calculate the Total Sales. This is the meat of Excel – calculations and formulas. When typing 
formulas, you must always begin the formula with an equal sign “=”. Let’s begin with the most basic of 
Excel formulas: adding two cells together. 
 

12. Click on Cell B8, type =B6+B7 and press [Enter].
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Figure 1.31

Trick: To input this formula, you can also type “=” then click on Cell B6, type 
the “+” sign, and click on Cell B7. Alternatively, type “=” then scroll to Cell 
B6 with the arrow keys on your keyboard, type the “+” sign, then scroll to 
Cell B7.

The SUM() Function  
This is one of the easiest calculations in Excel - adding two cells together. But what if you want to sum 
up a bunch of numbers? Answer: use the SUM() function. Even though we don’t have a lot of numbers to 
sum, I’ll show you how it works. I will cover other helpful functions in later chapters. 
 

13. Click on Cell C8 and type the following partial formula: =SUM(  then click on Cell C6 and 
drag the cursor down to Cell C7, release the mouse, type the closing parenthesis ) and press 
[Enter].  

Trick: You can also type =SUM( then scroll to Cell C6 with the arrow key on 
your keyboard, press and hold the [Shift] key, then the down arrow key to 
select Cell C7, type the closing parenthesis, and press [Enter]. Alternatively, 
you can click on Cell C8 and click the AutoSum icon  in the 
Editing group of the Home tab. BUT BE CAREFUL! If you do that, the icon 
automatically inputs the formula adding up all contiguous cells above it, 
including the Year heading (2015). Because of that, I prefer not to use that 
icon much. 

The formula in Cell C8 should read “=SUM(C6:C7)”. Whenever you type a formula into a cell, the result 
appears in the cell. The formula itself appears in the Formula Bar, as shown as follows: 
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Figure 1.32

To the left of Cell C8, you should see a caution icon. This icon will appear when formulas that are next 
to each other are not consistent. The formula in Cell B8 reads “=B6+B7”, which is not consistent with 
the formula in Cell C8, even though they are basically the same. For now, click on the caution icon and 
choose Ignore error. We will explore those messages in more detail in later chapters.

Tip: The Caution  icon is setup to appear based on criteria in Excel 
Options in the Formula group. In this case, the checkbox Formulas which 
omit cells in a region is checked, and applies here. 

 
14. Click on the caution icon next to Cell C8 and choose Ignore error. 

Copy and Paste  
It appears that you will be using the same basic formula for the summation of sales in Column D, and 
Excel has provided the functionality where you can copy a formula and paste it in other cells. 

1. With your cursor on Cell C8, press the Copy icon   in the Clipboard group of the 
Home tab. 

 
You will see a moving dotted line around Cell C8. This is the indication that the cell is copied and is in 
memory. 
 

2. Click on Cell D8 and click the Paste icon in the Clipboard group of the Home tab. 
3. Press the [Esc] key to take the Copy command out of copy mode. 
4. Ignore the error on Cell D8. 

 
Trick: You can also type [Ctrl]+c to copy and [Ctrl]+v to paste. I like to use 

the keyboard commands much more than using the icons. 
 
When you use the Copy command (either from the icons or the keyboard), Excel assumes that the cell 
references will change in the direction of the Copy and Paste commands. For example, when you copied 
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the formula “=SUM(C6:C7)” over one column to Cell D8, Excel assumed you will use the cells above Cell 
D8 and accordingly changed the formula to “=SUM(D6:D7)”. Wasn’t that nice of Mr. Gates?  

Trick: To copy a formula over, down, or up without the cells changing, copy the 
formula in the Formula Bar, press [Esc] (to exit out of Edit mode), click on 
the cell you want to copy the formula to, and press [Ctrl]+v to paste it. 

Now all we have to do is to clean it up a little more and we will have a working report. 
 

5. Select Cells B7 through D7 and click the Underline icon in the Font group of the Home tab. 
6. Select Cells A5 through D5, then press and hold the [Ctrl] key, select Cells A8 through D8, 

release the [Ctrl] key and click the Bold icon. 
7. Select Cells B6 – D7 and click the Bold icon. 

 
Since the selection B6 – D7 was already bolded, by clicking the bold icon again removes the bold. By 
pressing and holding the [Ctrl] key, you can select a non-contiguous range of cells.

Trick: A keyboard shortcut to Bold, Italicize, or Underline is to select the cells 
you want to format, press and hold the [Ctrl] key, then press the “b” key (for 
Bold), the “i” key (for Italics), and the “u” key (for Underline). 

 
When we bolded some of the cells, it may have increased the size of the text a bit, so it may be a good idea 
to resize all the columns to give the numbers a little more breathing room. Excel 2016 usually does a good 
job of resizing columns as data is entered, but sometimes it’s a good idea to resize everything just for 
grins. Here’s a trick on how to resize all of the columns in the spreadsheet at once. 
 

8. Click in the blank gray box that is above Row 1 in the spreadsheet to the left of Column A. 

This highlights or selects the contents of the entire spreadsheet. 
 

9. Place your cursor over any column line above Row 1 where the cursor turns to a vertical line 
with right and left arrows, and double-click on the column line. 

10. Click on any cell in the spreadsheet to deselect the entire spreadsheet selection. 

When you double-click the column line, you should see the columns automatically adjust their widths. 
Note that this method of adjusting widths ignores the text that is merged and centered on Rows 1 and 3. 
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Figure 1.33

Aligning Text  
Notice that, by default, all of the numbers are right-justified and all of the text is left-justified. With Excel, 
you can change the alignment of any cell to be right, centered, or left justified by using the Align Text Left, 

Center ,  and Align Text Right icons. You can also align cells vertically, using the Top  Align 
, Middle Align , and Bottom Align icons. All of these icons are located in the Alignment group of 

the Home tab. Let’s center the Years. 
 

11. Select Cells B5 through D5. 
12. Click the Center icon. 

Figure 1.34

13. Click the Save icon   in the Quick Access Toolbar just above the File tab. 
 
By clicking the Save icon on a workbook that is not yet named will display the Save As screen. 
 

14. In the Save As screen, navigate to the Chapter1 folder under the C:\ExcelCEO\Excel 2016 
folder on your computer (it may be under Current Folder or Recent depending what you 
have been working on). 
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15. In the Save As dialog box File name box, type myIncomeStmt. 
16. Make sure the Save As type box is set to Excel workbook. (*xlsx)
17. Click the Save button. 
18. Close the myIncomeStmt.xlsx and Excel by clicking on the Close Window icon (in  the 

upper-right corner of the spreadsheet). 

Review Questions: It is now time to complete the hands-on Review Questions. 
Log on to www.ExcelCEO.com with your Email address and Password, click 
on the Excel 2016 Review Questions, Chapter 1, Section 2 of 3 option in 
your Main Menu, and complete the Review Questions. 

 
Let’s start another project. In this project, you will add to your Excel skills in formatting a spreadsheet by 
creating a multiple page report.
 
At Nitey-Nite Mattresses, there are ten store managers that are considered to be the best in the company. 
Upper-management wants you to develop a report that shows the daily sales of each of these people. It is 
known as the Top Ten Report. They want the report to show the daily sales for each person each month 
for the last three months. You have an unformatted text file that gives you all of the data you need to 
create the report. All you have to do is take that text file and format it to create the Top Ten Report. The 
text file is located on Sheet1 of the May_Sales.xlsx file. 
 

1. Open Excel to a Blank workbook, then click on the File tab, and then click on Open 
from the menu. (You can also use the Open Other Workbooks icon on the bottom-left of the 
templates page when you first open Excel. These options take you to the same place overall.)

2. Navigate to the May_Sales.xlsx file from the C:\ExcelCEO\Excel 2016\Chapter1 folder, and 
Open it. (Click Enable Editing (if the Protected View security message appears).

3. Click on the File tab again, click on the Save As  option.

This opens the Save As screen.  
 

4. Navigate to the C:\ExcelCEO\Excel 2016\Chapter1 folder (should be under Current Folder).
5. Click on the drop-down menu in the Save As type box and review the types of files you can 

save the file as (Excel Workbook (*.xlsx), Excel 97-2003 Workbook (*.xls), etc.) 
6. Make sure the Save As type Excel Workbook (*.xlsx) is selected. 
7. Change the name of the file to myMay_Sales.xlsx and click the Save button. 

Note: Whenever you use an ExcelCEO practice file in this course, you will 
open the file, then save it typing the word “my” at the beginning of the file 
name. Make sure you complete each project in each chapter, as chapter 
exams will refer to these projects, and further your understanding of the 
functions learned by having you change specific details, and answer based on 
the changes. These are additional opportunities for mastery of Excel, so make 
sure your work is correct.
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Figure 1.35

As you can see, the data is unformatted and needs a lot of work. Each row of data contains 
the sales for each day of the month, but it has no dates. As you scroll down in the file, 
you will see that the March data is followed by April data, which is followed by May data.  
  
 The first thing we need to do is to format the sale amounts and resize the columns, so we can more easily 
read the data. 

8. Select the entire sheet. 
9. Resize all columns. 
10. Format all cells in Columns A through J to be Currency, two decimal places with the dollar 

($) sign (Do this from the Format Cells dialog box) 
11. Place your cursor to the left of Row 1 and left of Column A and the cursor will turn into a 

right arrow. Click on Row 1 and the entire row will be selected. 
12. Underline all cells in Row 1.  

Insert a Column  
Next we will add a date field to be the first field in the spreadsheet. To do so, we need to Insert a column 
to the left of the data in which we can store the dates. 
 

1. Click on any cell in Column A. 
2. In the Cells group of the Home tab, click on the drop-down arrow below the Insert icon. 
3. Choose the Insert Sheet Columns option. 
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Trick: Alternatively, to Insert a column, you can right-click on any cell in 
Column A and choose Insert…, choose Entire Column from the Insert 
dialog box, and click OK. If you prefer to use the keyboard method, you can 
click the [Alt] key, then type the letters “i” and “c”. 

 
4. In Cell A1, type Date 
5. In Cell A3, type 3/1/2016   

Figure 1.36

Dates  

Hhhmmmm? The cell now reads 42,430. What’s that all about? Let’s talk a little about dates. In Excel, a 
date is simply a formatted number. The number 1 represents January 1, 1900. The number 2 represents 
January 2, 1900 and so forth, one day for each whole number. March 1, 2016 is 42,430. In other words, 
there are 42,430 days from January 1, 1900 to March 1, 2016. When you input a date in the Month/
Day/Year format, Excel will usually assume it is a date unless the cell had previously been formatted as 
another type of number. This makes performing calculations on dates very easy. 
 
To further illustrate, let’s suppose you have a birth date in one cell, say February 7, 1961, and another 
date, use June 13, 2017, in another cell. If you subtract February 7, 1961 from June 13, 2017 and format 
the result as a number, you get 20,580, or the number of days from February 7, 1961 to June 13, 2017. 
To get the age, simply divide 20,580 by 365.25 (the 0.25 is to account for the leap year day every four 
years) which results in 56.34 years. The time of the day is stored in numbers less than 1. For example, 
42,899.46 formatted as date and time is June 13, 2017 at 11:02 AM. We’ll do those and more complex date 
calculations in future exercises and projects, but for now, let’s just input the dates we need. 
 

6. Format Cell A3 as Date, in a m/d/yyyy format (choose *3/14/2012 in the Date category, 
Number tab in the Format Cells dialog box)



Excel Tips, Tricks and Training for You to Become the Chief Excel Officer of Your Company

ExcelCEO 

            Chief Excel Officer 32

Figure 1.37

Data Fill  
 Cell A3 should now read “3/1/2016”. If you were to type in the date for every line item, it would take 
quite awhile, as you have three months of data. Excel provides a way to make this much easier. 
This functionality is called Data Fill. Using Data Fill, you can fill in the data below (up or to the side) 
beginning with the cell that is currently selected. When you use Data Fill with dates, Excel assumes you 
want to increase each date by one day. Let’s try it. 

7. With Cell A3 selected, place your cursor over the small black box at the bottom-right corner of 
the cell. (Depending on your computer settings, cell outline and Data Fill may be red.)

Your cursor will turn to bold plus sign “+”. This activates the Data Fill button. 

8. Click and drag the Data Fill  button down to Cell A33, and release. 
 
As you drag the cell down, you will notice a screen tip appears on every cell the cursor is dragged to, 
increasing the date by one day. You can also double-click the Data Fill button and Excel will automatically 
fill in the dates for every cell beneath. Double-clicking on Data Fill works only when you want to fill in 
data BELOW the cell you are currently on. When you do this, all cells below must be contiguous (i.e.- no 
blank cells) and the data in the rows must reflect data that is one day apart.   

Deleting  
Our data is not quite in the right format, as three rows of data (currently Rows 2, 34 and 65) contain the 
name of the month but no daily sales data. Let’s delete those rows so we can use Data Fill properly. I will 
show you three ways of deleting rows in the steps below. 
 

1. Click on Cell A2 (or any cell in Row 2). 
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2. In the Cells group of the Home tab, click on the drop-down arrow below the Delete  icon, 
and choose Delete Sheet Rows. 

Figure 1.38

 Row 2 is deleted and all of the rows beneath Row 2 move up. BE CAREFUL! If you click the Delete icon 
itself (not the drop-down arrow), Excel will delete the cell and move the other cells in that column up one 
row. That can really make a mess of your spreadsheet, if you’re not careful. 
 

3. Click on Cell A33. 
4. On your keyboard, type [Alt], e, d, r, [Enter] 

This is the keyboard method of deleting rows. Watch the commands on the screen execute as you type 
the various keys. Now we’ll do the right-click method of deleting a row. 

5. Right-click anywhere on Row 63. 

A series of choices pops up in a short menu. 

6. Choose Delete… 
7. Click on the Entire row radio button, and click OK. 

Remember, right-click is your friend. If you want to do something and can’t remember where it is, try a 
right-click and see if the correct choice pops up. 
 
If you want to delete only the contents of the cells but not the rows themselves, you can select the range 
and press the [Delete] key on your keyboard or use the Cut icon . Using the [Delete] key or the Cut icon 
will delete only the contents of the cells, but it will not delete the formatting. One difference between the 
two is that the Cut icon will keep the deleted selection in memory, while using the Delete key will not. 
 
Now that your data is all contiguous (i.e.- no blank rows), you can add dates for every row of data in one 
easy step. 
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8. Click on Cell A32 (the last date we populated with a date). 
9. Double-click the Data Fill box. 

The dates are filled in through Row 93, which is exactly what we wanted to do.  

Figure 1.39

Freeze Panes and Split Windows  
Notice that the names in Row 1 are the same for the three months of data. As you scroll down the page to 
see April and May data, the names of the managers disappear. When you scroll down, you would like to 
fix or freeze the first row of names. Let’s do that. 

1. On your keyboard, press [Ctrl]+[Home] (this takes you to Cell A1). 
2. Click on the View tab. 
3. In the Window group, click on the Freeze Panes icon. 

Figure 1.40

4. Click on the Freeze Top Row item.
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The first row of names will now remain in place while you scroll down through the rest of the records. If 
you want to freeze column(s) on the left, simply position your cursor in the cell to the immediate right of 
the last column you want to freeze and choose Freeze Panes. Let’s do that. 
 

5. Click on the Freeze Panes  icon, and choose Unfreeze Panes. 
6. Click on Cell B2. 
7. Click on the Freeze Panes icon, and choose the Freeze Panes item. 

Now you can scroll up and down, to the right and to the left and the titles AND dates are frozen. You can 
also use the Split functionality under the Window group of the View tab. The split window differs from 
the freeze panes option in that a split window allows you to scroll independently in each window.  

Insert a Row  
In looking at this data, I think we need totals by person. That way, upper management can see monthly 
totals for each of the top ten people. Currently, there are no blank rows between the monthly data, so we 
need to Insert a couple of blank rows after every month end. This is similar to inserting columns like you 
previously learned. 
 

8. Click on Cell A33, and click on the Home tab. 
9. Click on the drop-down arrow under the Insert icon  on the Cells group, and choose 

Insert Sheet Rows. 
10. Repeat the previous step to insert a second row. 
11. In Cell A33, type Total  

Figure 1.41

Note: To set the height of a row, click on the bottom line of the row, and drag it 
down or up. You can also set the row height by clicking on the Format icon 
in the Cells group, choose Row Height… and type in the height you want 
the row to be. 

12. Insert two rows at the break between April and May. 
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13. Type the word Total at the end of the April and May data. 

Now you are ready to sum the sales numbers for each manager in each month. 
 

14. In Cell B33, type a formula that sums the contents of all cells above it. (Remember how to do 
this? If not, go back to the SUM() function you used previously.) 

15. Copy that formula to Cells C33 through K33. 
16. Bold Cells A33 through K33 
17. Underline Cells B32 through K32. 

Figure 1.42

18. Do the same for April and May totals. 

Comments  
In scrolling through the report, you notice that Lee Underwood had kind of a low month in April where 
he sold only $41,522.92. When you called him to see what happened, he explained that he had some 
sickness in his family and was unable to come to work for a number of days during the month. You 
decide you would like to communicate this information to upper management, and you want to put it 
somewhere in the file, but where? Excel provides a nifty little tool called Comments. In any cell, you can 
type any comment you want. Let’s try it here. 
 

1. Right-click on Cell I65, and choose Insert Comment. 



ExcelCEO 

            Chief Excel Officer

SECTION 1: Beginning Excel   —   Excel 2016 Basics

37

1Chapter

Your computer name should show up as the first part of the comment. 

Figure 1.43

2. In the Comment box, type Lee had some family sickness this month. 
3. Press the [Esc] key twice to exit Insert Comment mode.  

Figure 1.44

When you escape out of design mode for the comment, the comment will either remain visible or it will 
disappear, depending on if you have used the Comment functionality previously. If it remains visible, you 
can right-click on the cell and choose Hide Comment. The commented cell is tagged with a red triangle 
in the upper-right corner of the cell. It will remain displayed until you hide it. Let’s do that now. 
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4. Right-click on Cell I65 and choose Hide Comment (if necessary). 

The comment will now remain hidden until the user moves the cursor over the cell. You now decide you 
want it to remain visible so upper management can immediately see it when they open the report. 

 5. Right-click on Cell I65 and choose Show/Hide Comments. 

Again, this makes the comment visible whenever the user is looking at the spreadsheet. Note that the 
displayed comment will not print when you print the report.  
 

6. Insert a comment in Cell I69 that reads Lee returned to work today. 
 
You can also use the Comments group of the Review tab to manage all comments in the spreadsheet. 
I typically find that I don’t need that group much as I can use the right-click functionality to manage 
all the comments I have. To remove a comment, you can right-click on the commented cell and choose 
Delete Comment. You can remove all commented cell comments at once by using the Go To dialog box. 
 

7. Click on any cell that does not contain a Comment. 
8. Press the [F5] (or Fn+[F5]) key on your keyboard.  

Figure 1.45

The Go To dialog box appears. The Go To functionality helps you to find text, numbers, Formulas and 
formatting. 

9. In the Go To dialog box, click on the Special… button.  
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Figure 1.46

10. In the Go To Special dialog box, make sure the Comments radio button is selected, and click 
OK.

Excel will select the commented cells I65 and I69. 

11. To delete the Comments, right-click either Cell I65 or I69, and choose Delete Comment. 
 
Both comments are deleted. To edit a comment, right-click the cell where the comment is and choose 
Edit Comment.  

File Properties  
You will probably save this file on the hard drive of your computer, but many people save files on network 
drives. Sometimes, particularly if you create a lot of files, you may store them in places that you can’t 
remember. In Excel, you can search for files based on certain criteria, like name, size, author, and 
keywords. This type of information is stored in the file’s properties. It is good practice to put in keywords 
into a file to make it easier for you or your colleagues to find it later. Let’s use “Top Ten” as the keyword 
for this file. 

1. Click on the File tab and make sure the Info  icon to the left is selected. 
2. In the panel to the far-right, click on the Properties icon   (it’s not really apparent 

at first, so you may not see it right away). 
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3. Click on Advanced Properties. 
 
The Properties dialog box for this workbook (myMay_Sales.xlsx) appears. Here you can view properties 
associated with the open document, and add Keywords to make the file easier to find and categorize.

4. Click on the Summary tab.

Figure 1.47

5. In the Keywords: box, type Top Ten. 
6. Click OK to close the myMay_Sales Properties dialog box (Clicking the red X will not save the 

key words).
 
On the Info window, Top Ten now appears as a Tag. Review the other boxes in the Properties group to 
familiarize yourself with the types of file properties that are available. If you were to open the Save As 
dialog box, below the Save as type: box, you would see the Top Ten keyword visible in the Tags: box. 
From there, you can add more keywords, or edit existing keywords before saving

Enhanced File Sharing  
You know how sometimes you want to send the file you’re working on as an attachment? Most people 
save the file, then open Outlook (or some other email management program), create a new email and 
attach the file to the email. In Excel, all of this can be done in two clicks while you still have the file open 
thanks to a new feature for Office 2016 called Share. All you need is to have the file saved on a network 
drive or in cloud-based storage (OneDrive or similar - your favorite cloud storage should work).
 

1. Click the Back arrow  icon, then on the File tab and click Share  on the upper-
right of the Excel window.

Jim Cline
Owner
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Tip: Save the file to your cloud-based storage to do this exercise. Or, just read 
Steps 2-4 to learn how Share works without actually sharing this file. 

  
2. In the Share pane below the Invite People box, type your email address.
3. Leave the edit options drop-down box set to Can Edit.
4. Type ExcelCEO Excel 2016 Ch. 1 - myMay_Sales.xlsx in the Include a message (optional) 

box, then click the Share button.

Figure 1.48

You can even access a contact list using the icon to the right of the Invite people box. Once you click 
Share, the file instantly sends as an email attachment (as long as you are connected to the internet) 
using your Microsoft account-associated email address. Since Office 2013, and expanded in Office 2016, 
Microsoft has worked to make Office programs, including Excel 2016, more collaborative and user-
friendly. You should have seen your name as the file owner below the Include a message (optional) box, 
and you could have clicked the Email icon in that box. Once the file is shared, you can see the list of users 
attached to the file.

With your own projects, you could use the Address Book icon to the right of the Invite people box, and 
in the attached user list, expanded options for sharing can be had using features from Skype for Business, 
if the contact has that application available. There is even a link on the bottom-right of the Share pane 
where you could Get a sharing link to make available to team members as a web page URL, SharePoint 
link, etc. This is just one more option where you could add value to your team, and by the time you reach 
ExcelCEO Excel master status, there would be so much more you could do and share.

5. Save and close myMay_Sales.xlsx. 
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Review Questions: It is now time to complete the hands-on Review Questions. 
Log on to www.ExcelCEO.com with your Email address and Password, click 
on the Excel 2016 Review Questions, Chapter 1, Section 3 of 3 option in 
your Main Menu, and complete the Review Questions. 

Conclusion 
In this chapter, you learned the basics of Excel. You learned what a spreadsheet looks like, how to work 
the navigation, how to use the various tabs and the Office Ribbon, and how to enter basic data on a blank 
spreadsheet. You learned how to move the contents of a cell to another location and how to turn off the 
skipping down of the cursor when you press [Enter]. You cut and pasted data within cells, and formatted 
data and text by using the underline, bold, italicize icons (and keyboard functions), you aligned text to 
be centered, left-justified and right-justified, and formatted cells using the Format Cells dialog box. You 
learned how to use keyboard shortcuts, resize column widths and row heights, and used the Merge & 
Center icon to center text across multiple columns. You created your own Cell Style. You created simple 
Formulas and Inserted rows and columns. You wrote a formula using the SUM() function, worked with 
dates, used the Data Fill functionality, and learned how to delete cell contents. You can make a row and/
or column stay fixed by using Freeze Panes and/or the Split Window functionality. You deleted rows and 
text, and can now insert comments in any cell of a spreadsheet. Finally, you learned about file Properties 
and how to send a workbook as an email attachment using Share.  

Chapter Exam  
You can now go to www.ExcelCEO.com, type your email address you registered for training with along 
with your password on the top-right of the ExcelCEO.com page, log in and take the exam. Make sure 
that you take the exam on the same computer on which you completed the practice files, as some of the 
questions on the exam may refer to some of the completed projects. Chapter exams are intended to be 
hands-on to test how you completed the chapter projects, so make sure you completed them correctly.
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CHAPTER TWO — FORMATTING 
 
 

Chapter Objectives: 
 

•    Identify and use the Underscore character in column and naming data ranges
•    Recognize the Format Painter for quickly applying cell formats to multiple locations
•    Choose different types of cell formats to enhance cell appearance
•    Locate and Paste functions using menus and keyboard shortcuts
•    Find the Custom Formatting environment
•    Identify errors within Formulas and how to handle them
•    Identify Absolute, Mixed, and Relative references to enhance formula writing
•    Recognize the appropriate icons for increasing the Indent of text within a cell
•    Choose the Fill Color and Font Color formatting icons
•    Identify options within the Borders menu for drawing borders around and within a report
•    Select the Undo and Redo buttons
•    Identify how to create a template file
•    Organize files to the Taskbar icon for quick access with the Pin feature

Projects You Will Complete During This Chapter:

•	 myNet_Inc.xlsx
•	 myNet_Inc.xltx
•	 myNet_Inc_Tmpl.xltx
•	 mySls_Jrnl.xlsx

 
 
 
 

CPE Credits possible for this chapter: 2
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Introduction
In one of my previous jobs as a real estate appraiser, I was assigned numerous tasks using my computer 
skills to create complex discounted cash flow analyses. Sometimes, my manager would ask me to analyze 
a property and not give him a report, but simply “a number” along with the supporting calculations. 
He would tell me not to worry about formatting a report – just give him one sheet of paper with the 
supporting calculations and the value of the property. And that is exactly what I gave to him. Every time 
I did this, he would take that sheet of paper and begin to mark it up with his infamous red pen and 
write, “Center this title”, “Format this as a number with two decimal places”, “Make these numbers right-
justified”, etc, etc, etc. I got so upset when he did that, especially when he specifically told me not to 
format the report. He said that the report can’t be right on the first try, so he HAD to edit something. 
I then decided that I was going to take the time to format ALL of the reports and analyses I gave him, 
even if he said not to do it. That taught me a great lesson – whenever you create a report, format it so that 
the person you give it to can review it, understand it, make no corrections, and send it along to the next 
person who needs to see it. Data means little unless it is easily understood.  
 
In this chapter, we’ll be exploring more formatting options. 
 

1. Open Excel 2016, and navigate to the file located at C:\ExcelCEO\Excel 2016\Chapter2\
Sls_Jrnl.xlsx. 

2. Save As C:\ExcelCEO\Excel 2016\Chapter2\mySls_Jrnl.xlsx. 

Figure 2.1

This is a file of the individual sales made in the month of May 2016 for Store No. 1026. Fields included are 
the store number (which is the same for all records as we are looking only at Store No 1026), Sale Date, 
Ticket Number, Item Code, Quantity Sold, Sale Price per item, the Discount percent given on the sale, 
Warranty Charge (if any), and a Delivery Charge (if any).  

The Underscore Character  
There is one thing I need to mention here that will save you a lot of headaches in your programming 
career. You may have noticed that many field names, like Sale_Date, Ticket_No and Item_Cd have 
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an underscore (_) character in place of the space. There is a reason for this. The underscore character 
is a commonly accepted symbol to use in place of a space, as computer languages read an underscore 
character much easier than space. Particularly when you use those column names in a PivotTable (to be 
discussed later) or in other applications like Access or SQL Server, it will be much less confusing if you 
use the underscore character in place of the space. Depending on the program, field names sometimes 
are required to be all contiguous (no spaces) as spaces can greatly confuse programming languages. No, 
it’s not real pretty, but you should get used to it. Another alternative is to take out all spaces and separate 
words with a capital letter (called CamelCase), like NetSales.
 
To make it easier for us to read the data in the file, we need to clean it up a bit. 
 

3. Resize all columns to fit, if necessary. 
4. Click on Column F (the entire column should be selected), hold down the [Ctrl] key, click on 

Columns H and I, release the [Ctrl] key, and click on the Accounting Number Format 
icon in the Number group from the Home tab. 

Figure 2.2

Format Painter  
Oops. It looks like the heading in Cell F1, H1, and I1 went away (H1 and I1 may or may not look blank, as 
above.) However, if you click on Cell F1, you will see in the Formula Bar that the words are still there. The 
Column F header text, Unit_Sale_Amt, is too wide when formatted as Accounting, so the cell appears 
to be blank. The other column headings are is still readable, so you just need to format Cell F1, H1, and 
I1 the same way. You can do that by using the Format Painter icon. This tool allows you to copy the 
formatting, but not the text of a cell and “paint” another cell with the same format. 
 

5. Click on Cell G1 (In actuality, you can click on any of the column headers except the ones we’re 
going to format). 

6. Click the Format Painter icon  in the Clipboard group of the Home tab. 
7. Click and hold on Cell F1, and drag to select Cells F1 through I1, and release. 
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The heading for Cells F1, H1 and I1 should now reappear.  

Figure 2.3

Trick: If you want to use the Format Painter to format multiple cells that are 
not in a contiguous range, double-click the Format Painter icon. When you 
click on each cell, the Format Painter will remain activated. To deactivate it, 
simply left-click on the Format Painter icon.  

Formatting Cells  
In Columns F, H and I, do you see how the “$” sign is left justified and the rest of the numbers are right-
justified? I don’t like that. I want the “$” to be next to the numbers. Also, I don’t like the dash (-) when 
there is a $0 dollar amount. I want it to appear as $0. There is another Currency option in the Format 
Cells dialog box, so let’s try that one and see if it works better. 
 

8. Select Column F. 
9. Navigate to the Format Cells dialog box and choose Currency, two decimal places with the $ 

symbol. 
10. Apply the same formatting to Columns H and I.

Increase and Decrease Decimal Icons  
That looks much better. But now that I’m looking at it, all of the sale prices are in dollars with two 
decimal places. I really don’t need two decimal places because there are no cents on any of the sale prices. 
Instead of going into the Format Cells dialog box, you can use the Increase Decimal  and Decrease 
Decimal  icons to do it a little quicker. These icons are located in the Number group of the Home tab. 
 

11. Select Columns F, H, and I. 
12. Click on the Decrease Decimal icon  twice. 

You can use the Increase and Decrease Decimal icons for other number formats as well. Let’s format 
Column G as Percent with one decimal place. 

13. Select Column G, and click on the Percent Style icon  in the Number group of the Home 
tab. 



ExcelCEO 

            Chief Excel Officer

SECTION 1: Beginning Excel   —   Formatting

47

2Chapter

14. Click on the Increase Decimal icon  to increase the decimal place to one. 
15. Resize all columns. 
16. Freeze Row 1 of the table. 

Using the formatting icons is a quick and easy way to format lots of data. 

Figure 2.4

Would you like to see how many sales we made? We’ll write the formula for that, but first let’s review 
some of the data’s field definitions. The Qty field is the quantity of items sold. The Unit_Sale_Amt field 
is the sale price per item sold. The Disc_Pct is the percentage amount of discounts that were given on the 
total sale, excluding warranty and delivery charge. The Warranty charge is a flat $50 per ticket no matter 
how many mattresses were sold (if purchased), and the Delivery charge is a one-time charge of $55, if 
purchased. So the total sale price of the ticket is the quantity times the unit sale price times (1-Disc_Pct) 
plus warranty and delivery charges. Let’s do that calculation. 
 

17. In Cell J1 type Total_SP (for sale price). 
18. In Cell J2 input the following formula: =E2*F2*(1-G2)+H2+I2 
19. Make sure Cell J2 is formatted as Currency with two decimal places. 

Figure 2.5

Now we’re starting to get into some more complex formulas. Multiplication in Excel is done by using 
the asterisk “*” and division is done by the slash “/” key. The result in Cell J2 should be $1,607.00. Now 
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all you have to do is to copy that formula down for all rows in the spreadsheet. You’ve done that before 
by clicking the Copy and Paste icons, but this time you have 93 rows of data to copy to. You don’t want 
to do it one at a time, so let me show you two ways to do a “mass copy” job. You learned how to do this 
in Chapter 1 with dates, but I want to make absolutely sure you understand this concept, so we’ll walk 
through it again. 
 

20. With the cursor on Cell J2, place the mouse pointer over the small black (or red) box in the 
lower-right corner of the cell. The pointer will change to a small plus sign “+” (Remember? 
This activates Data Fill.) 

21. Click, hold, and drag the pointer down to Cell J7 and release. 

The formula is copied down and the total sale price is calculated for every row of data. Now, you still have 
a bunch of rows to copy to, so let’s do it the REAL EASY way. 
 

22. Click on Cell J7.  
23. Place the mouse pointer over the Data Fill box in the lower-right corner of the cursor where 

the pointer changes to a small plus sign “+”. 
24. Double-click on the plus sign.

Figure 2.6

Pretty cool, huh? Just like it did for dates in Chapter 1, Excel copies this formula down to all rows in the 
table. It knows to stop copying when it runs out of rows. For that reason, it is very important to maintain 
all of your tables with contiguous rows and columns.   

AutoSum  
Now let’s add up all of the ticket sale prices in the whole table. You already know how to do a SUM() 
function. All you have to do is to go below the last cell in Column J and write the SUM() function. But 
there is another way to quickly look at the total sales. That is by using AutoSum in the Status Bar on the 
lower-right of Excel. 
 

25. Select Cells J2 through J9. 
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Figure 2.7

Look at the bottom-right portion of your screen and you should see a box that contains the script 
“Average: $852.25  Count: 8  Sum: $6,818.00” (or something similar, depending on the settings). This 
area of your screen is called the Status Bar. If you right-click on the Status Bar, you will see the following 
list of options: 

Figure 2.8
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In this list, you can turn off and on any of the options available. It allows you to select any range of 
numbers and automatically sum, average and count them. You see the results in this box without having 
to write any Formulas. 
 

26. Select all of Column J. The AutoSum box should read Sum= 81060.7. 

Notice that the AutoSum box reads the formatting of the first cell in the range (in this case, Cell J1). To 
make the formatting of the AutoSum box be the same as the data, you can format all of Column J as 
Currency, zero decimal places. 
 

27. Save and close the mySls_Jrnl.xlsx. 
 
The next exercise is to learn how to make reports pretty (or “purdy” as we say in Texas). Excel has 
provided a number of formatting icons that will help you with that. For this exercise, we will use the 
Net_Inc.xlsx file located in C:\ExcelCEO\Excel 2016\Chapter2. 
 

1. Open the file located at C:\ExcelCEO\Excel 2016\Chapter2\Net_Inc.xlsx. 
2. Save As C:\ExcelCEO\Excel 2016\Chapter2\myNet_Inc.xlsx 
3. Resize columns to fit, if necessary.

Figure 2.9

This workbook has only one sheet called Net_Inc_Stmt. It is a skeleton financial statement with no 
numbers in it. This is the general format in which upper management likes to see the Summary Income 
Statement for each store. Your job is to input the numbers and make it look nice by using the various 
formatting tools. You will populate the numbers, perform the calculations, and then make it look 
“purdy”. Let’s get started. 
 

3. Resize Column A to be a little wider than General Admin Expenses on Row 28. 
4. Select Cells B8 and C8.
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Custom Formatting  
Management likes to see headings above the numbers in the Month Year format, like “July 2017”. If you 
look in the Date category of the Format Cells dialog box, there is no such format. Therefore, we need to 
create that format using the Custom Format feature. 

5. Open the Format Cells dialog box. 

Figure 2.10

6. In the Category: field of the Number tab, select Custom. 
7. In the Type: field, delete the existing text, type mmmm yyyy, and click OK.  

Figure 2.11
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The cells change formatting to July 2017 and July 2016 respectively. When using the Custom formatting, 
four “m’s” returns the full month name (January, February and so on). Three “Ms” returns the 
abbreviated month (Jan, Feb), two “Ms” returns the month number with the leading 0 (01, 02) and one 
“m” returns the simple month number without the leading 0 (1, 2). On the Year, one or two “Ys” returns 
the two-digit year (16, 17) and three or four “Ys” returns the four-digit year. You can also use the day 
(“d”) format in the Custom type. One “d” returns the day number, two “Ds” returns the day number 
with the leading 0, three “Ds” returns the abbreviated day of the week (Mon, Tue, etc.) and four “Ds” 
returns the full name of the day of the week (Monday, Tuesday, etc.). 

Trick: Excel offers Special Formatting to format numbers as zip codes, phone 
numbers and US Social Security numbers. Try it! In a blank cell, type 
7134816515 (the ExcelCEO phone number). Right-click on the cell, choose 
Format Cells on the Number tab under Category, choose Special. Under 
Type, choose Phone Number, and click OK. This is useful when you want 
to store the phone number as a number, but make it appear in a phone 
number format. 

Figure 2.12

8. Input the following values for each line item on the financial statement, beginning with the 
Revenue section: 
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A B C
8 July 2017 July 2016
9 Revenue
10 Mattresses: 85211 68495
11 Pillows: 3536 3545
13 Services: 3510 3460
14 Discounts: -3689 -2145

17 Variable Expenses
18 Cost of Merchandise: 21358 18643
20 Selling Expense: 10786 9287

25 Fixed Expenses
26 Salary Expense: 8397 7864
28 General Admin Expense: 4838 5709
30 Building Expense: 1632 1712

Figure 2.13

9. Format all numbers below Cells B9 and C9 to be Number, zero decimal places, with the 
1000 separator. 
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10. Center the text on Rows 1, 3, 4 and 5 over the entire report 

Note: You can use the Merge & Center icon for only one row at a time, or you 
can use the Format Cells dialog box, click the Alignment tab and, in the 
Horizontal: drop-down box, click Center Across Selection. This allows you 
to center Rows 1, 3, 4 and 5 at once and avoid range selection issues later!

11. Go to Cell B12 and create a formula to sum the two cells above it. 
12. Copy Cell B12 over to Cell C12. 
13. Create a formula to calculate Total Merchandise+Services+Discounts in Cell B15. 
14. Copy that formula to Cell C15. 

 
As a check, the result in Cell B15 should be 88,568 and Cell C15 it should be 73,355.

15. Underline Cells B8 through E8, B11, C11, B14, and C14. 
16. Bold Cells A9, A15, B15 and C15. 

In Column D, we want to calculate the dollar difference in each Revenue line item, and we want to 
calculate the percentage difference in Column E. 
 

17. In Cell D10, calculate the dollar difference between the July 2017 Mattresses revenue number 
and the July 2016 Mattresses revenue number. 

18. Copy that formula down for all revenue line items. Format the cells as in Columns B and C. 
19. In Cell E10, type =B10/C10  (which is B10 divided by C10) 
20. Format Cell E10 as Percent, one decimal place, and copy Cell E10 down to all revenue line 

items using similar bold and underline formatting, as in the other columns.

Figure 2.14
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In analyzing at the Revenue section of this statement, it looks like things are going well. Total Revenue at 
this store is up 20.7% over the previous year. The only revenue line item that is down is Pillow revenue, 
and it’s only down by $9 or 0.3% from the previous year. Overall, it looks like this store is having a good 
year in terms of revenue. Now let’s work on the Expense section of the report. 
 

21. In Cell B22, calculate the sum of Cells B18 and B20.

Note: Do NOT use the =SUM() function to highlight B18:B20. The results 
would not be correct.

22. Copy the formula in Cell B22 to Cell C22. 
23. Calculate the appropriate formulas in Columns D and E. 
24. Bold the cells on Row 22.

Figure 2.15 

Review Questions: It is now time to complete the hands-on Review Questions. 
Log on to www.ExcelCEO.com with your Email address and Password, click 
on the Excel 2016 Review Questions, Chapter 2, Section 1 of 2 option in 
your Main Menu, and complete the Review Questions. 

 
Now we’ll get into a formula that’s a little tricky. I’m going to walk you through a few steps and we’ll 
calculate the wrong formula just so you can see why it’s wrong. Then we’ll do it the right way. 
 

1. In Cell B19, type =B18/B15 
2. Format it as Percent, one decimal place. 

Formatted as a percent, the result should be 24.1%. This number reflects the Cost of Merchandise as a 
percentage of Total Revenue. Now copy that formula down to Cell B21 and see what happens.  
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3. Copy the formula in Cell B19 to Cell B21. 

Figure 2.16

Handling Errors  
You should get a #DIV/0! (divide by zero) error. This happens when you try to divide a number by zero, 
which is mathematically impossible. There are numerous kinds of errors you can get when developing an 
Excel file. The table below lists the most common types of errors and what they mean.  

Excel Errors and Descriptions 
Error Error Description
######## The column isn’t wide enough to show the entire number.
#VALUE! There is an error in writing the formula (like you put a text string where a number is 

required)
#NAME? The formula includes a function or range name that Excel doesn’t recognize.
#REF! The formula is referring to a cell that doesn’t exist.
#DIV/0! The formula is trying to divide a number by zero.

Absolute, Mixed, and Relative References  
Let’s take a closer look at the formula. If you click on Cell B21, you will see that the formula reads “=B20/
B17”. In our spreadsheet, we want to divide all of the expense numbers by the Total Revenue line for each 
respective MTD number. You did that in the formula you wrote in Cell B19, but when you copied it to 
Cell B21, the denominator changed from B15 to B17. You need to make the denominator remain static, 
or fixed, and let the numerator (the number on top) move as you copy the formula. You do this by using 
Absolute, Mixed and Relative references. In our case, we want the formula in Cell B19 to always divide by 
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Cell B15. An Absolute reference means that cell reference (both the row and column) will remain fixed no 
matter where you copy it to. This is done by placing a dollar sign (“$”) in front of the Column and Row 
references. A Mixed reference is used when you want to allow the column OR row to remain fixed during 
the copy routine. A Relative reference is when there is no dollar sign before either the column or row 
reference.  Let’s try it. 

4. Edit the formula in Cell B19 to =B18/$B$15 
5. Copy Cell B19 to Cell B21. 

Figure 2.17

The result in Cell B21 should be 12.2% and you will see the formula: =B20/$B$15. It now appears to be 
working. Now let’s copy the formula to Column C. 

6. Copy Cell B19 to Cell C19. 
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Figure 2.18

Is it working? Let’s see. The formula in Cell C19 returns 21.0%. Is that the right number? Well, the 
calculation would be 18,643 divided by 73,355, which is 25.4%. Why did we get a different number? Take 
a look at the formula. When you copied it over, it is still using B15 as the denominator (because of the 
absolute reference) whereas it should be using C15. So in this case we need to make the row stay fixed 
and allow the column to change. This is a good lesson to learn – check and re-check your calculations to 
make sure they are working as expected. 
 

7. Edit the formula in Cell B19 to be =B18/B$15 
8. While on Cell B19, press [Ctrl]+c (to copy the formula into memory), click on Cell B21, hold 

down the [Ctrl] key, click on Cells C19, C21, B23 and C23, release the [Ctrl] key and press 
[Enter]. 

 
Trick: While typing a formula, you can toggle between an Absolute, Mixed, 

and Relative references by clicking the [F4] key. (Some keyboards are setup 
to use Fn+F4). Try it! In a blank cell, type =A1, but don’t press [Enter] yet. 
While in Edit mode (with the blinking cursor at the end of A1), click [F4] 
(or Fn+F4) key a number of times, and you will see it toggles between $A$1 
(Absolute), A$1, $A1 (Mixed), and A1 (Relative). The $ acts as an anchor.
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Figure 2.19 

9. Bold Cell A17. 
10. Perform similar calculations in the Fixed Expense section of the Net Income Statement to 

calculate Fixed Expenses. 
11. Calculate Total Expenses (Variable Expenses + Fixed Expenses) and Net Income (Total 

Revenue less Total Expenses) and the appropriate % of Revenue calculations. 
12. Input the appropriate formulas in the $ Diff and % Diff columns. 
13. Bold the rows for Fixed Expenses, Fixed Expenses Total, Total Expenses, and Net Income. 
14. Copy Cell B19 to all of the % of Revenue cells. 
15. Italicize all % of Revenue rows.  
16. Center all of the % of Revenue calculations, so they don’t appear to be right-justified with the 

other numbers. 
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Figure 2.20

Indenting  
Sometimes you will want to offset, or indent, text within a cell to make the report a little more readable. 
You do this by using the Increase and Decrease Indent icons. 
 

1. Click on Cell A19, and click on the Increase Indent icon.  
2. Indent all % of Revenue references in Column A. 
3. Bold the Nitey-Nite Mattresses title, and increase the font size to 14. 
4. Italicize Cells A3 and A4, and increase the font size to 12. 
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Figure 2.21

Fill Color and Font Color  
Let’s pretty it up a little more by adding some color. With Excel, you can change the color of the font 
(the text) by using the Font Color icon or you can add color to the background of the cell by using the Fill 
Color icon. 

1. Select Cells A1 through E5. 
2. Click on the drop-down button beside the Fill Color icon  in the Font group and choose 

Yellow. 
3. Click on the drop-down menu beside the Font Color icon  in the Font group and choose 

Dark Blue. 
4. Select every even-numbered row starting at Row 10 (Rows 10, 12, 14 and so forth through 

Row 38). 
5. From the Fill Color icon, choose White, Background 1, Darker 15%. 
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Note: If you do not find White, Background 1, Darker 15% in your default 
color palette, more palettes are available by going to the Page Layout tab 
in the Theme group under the Color option. White, Background 1, Darker 
15% is included with the Office 2007 - 2010 group, if not in Office.

Figure 2.22

Borders  
One feature of Excel that I really like (and use a lot) is the ability to draw lines or borders around, or 
within, a report. 
 

1. Select Cells A1 through E39 (the entire report). 
2. Click on the drop-down arrow beside the Borders icon  in the Font group and choose 

Outside Borders . 
 
Notice that the Borders icon is now changed to be the last border type used, which is the Outside Border. 
The same holds true for the Fill Color and Font color icons (they have changed to be the last color you 
used). Using the Borders icon, you can draw all kinds of borders and lines around any cell you want. 
 

3. Select Cells A1 through E5. 
4. Click on the Borders icon (which is now set to Outside Borders from Step 2 with a matching 

screentip and keyboard shortcut).
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5. Select Cells A7 through E39. 
6. From the Borders drop-down arrow, choose the All Borders icon. 

Undo and Redo Buttons  
Now that I look at it, I really don’t like the All Borders in the whole report. I believe the shading every 
other line is enough to break up the monotony of the report. 
 

7. Click the Undo icon  (in the Quick Access Toolbar, which we’ll discuss later) to undo the 
All Borders. 

I use Undo and Redo icons  all the time. As implied, these icons will undo and redo the previous 
action(s) performed. Notice that there is a drop-down arrow next to each of those icons. You can use this 
drop-down arrow to go backward or forward to a specific action you performed. Note that if you choose 
a previous action from the menu, it will undo or redo all actions up to that point.

Tip: The keyboard shortcuts for Undo ([Ctrl]+z) and Redo ([Ctrl]+y) can be 
big time-savers for making quick corrections to the most recent data entries, 
keystrokes, etc. Keep in mind that a few functions, including some PivotTable 
calculations, macros, and more do not allow an Undo feature.

Figure 2.23
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Now we are ready to analyze this store’s performance. Total Revenue is up 20.7% over the prior year, 
which is the right direction. Variable Expenses are also up, but at a lower rate (15.1% over prior year). 
Both Cost of Merchandise and Selling Expenses have increased slightly less than revenue, which may still 
be an area of concern. Fixed Expenses, however, are lower than in the prior year, which may mean that 
fixed expenses are under control, or at least we are improving year-over-year. Store management may not 
have the ability to alter Cost of Merchandise, as that is something that is determined by the vendors or 
by management. In our case, retail prices are mandated by the Home Office, so the primary means by 
which store management can affect business is through increased sales and managing Fixed Expenses. 
Total Expenses are up in comparison to the prior year, but they are not up in terms of percent as high as 
Total Revenue, which is good. That leads to a favorable year-over-year Net Income amount. Net Income is 
up 37.9% over the prior year, and it now represents 46.9% of Revenue. Last year, Net Income represented 
41.1% of Revenue, which seems to be reflective of improving financial management. 

Working with Graphics  
Another topic I want to review with you in this chapter is working with graphics and images. In this 
project, you can see that we typed the name of the company, Nitey-Nite Mattresses, at the top of the 
spreadsheet. You can also import a graphic, like a logo, onto a spreadsheet. Once it’s imported, you can 
move it to any position in the spreadsheet and resize it as well as change it in other ways. Let’s import the 
Nitey-Nite logo (a jpeg file which you will actually create in a later chapter) to work with as an example. 
 

1. Click on Cell G1 and click on the Insert tab. 
2. In the Insert tab in the Illustrations group, click on the Pictures icon.  

Figure 2.24

3. Navigate to C:\ExcelCEO\Excel 2016\Chapter2, click on the logo.png file, and click the 
Insert button. 
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Figure 2.25

The image should import into the spreadsheet. When the image is imported, you will see a new 
contextual tab appear called Picture Tools, Format. A contextual tab appears when certain objects are 
selected that need a unique set of tools. The Picture Tools, Format contextual tab appears whenever an 
image is selected. It allows you to use special tools to work with images. 
 
You can now drag the graphic to anywhere on the spreadsheet you want. You know the graphic is selected 
when the small circles appear around the graphic. The small circles are called handles. Let’s drag the 
image over the Nitey-Nite Mattresses text. 
 

4. Click and drag the image and position it over the blue Nitey-Nite Mattresses text.

Figure 2.26

As you can see, the graphic overlaps the “Summary Net Income Statement” text, but not to worry. We 
can resize the graphic to make it a little smaller by clicking the handles. 
 

5. Click the bottom-right handle and drag the graphic to the left and up. 
6. Resize it until it is big enough to fit over the Nitey-Nite Mattresses text, but not too big to 

cover the text below it. 
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7. Reposition the image to where it is centered over the report. 
8. Click anywhere outside the graphic to deselect it.
9. Click on Cell A1, and click [Delete] to remove the underlying text, if it shows through.

Figure 2.27

10. Save the myNet_Inc.xlsx file.

Templates  
You’ve spent a lot of time working on this file, haven’t you? And I must admit, that’s a dang good-looking 
report. Your manager also thinks it’s a great report, and he decides that he wants to use this format for 
ALL the summary financial statements from here on out. You suggest to him that you save this file as the 
standard, or template, for all future financial statements. He thinks that is a great idea, and you proceed 
to do so. 
 
A template is simply a pattern that is saved where you have all of the formatting and formulas designed 
just like you want them. A template should contain no data — just the format and formulas. To save an 
existing file as a template, you should first delete all of the data (NOT the formulas) and save it as a file 
type of template. Let’s use the myNet_Inc file as the base for the template. 
 

1. With the myNet_Inc.xlsx file open, take out the shading to the right of the statement. 

Hint: Select all cells to the right of Column E and choose No Fill from the 
Fill icon. A quick way to do this is to click Cell F1, click Ctrl+Shift+down 
arrow and then Ctrl+Shift+right arrow to select the shaded cells. 
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2. Delete all of the hard-coded numbers in the file (NOT the formulas). 
3. Change Cell A4 to be As of ??/??/???? 
4. Change Cells B8 and C8 to be mm yy. 

The statement should now look like this:  

Figure 2.28

The #DIV/0! error message will appear until there are numbers in the appropriate cells. 
 

5. Click on File, Save As, navigate to the Chapter2 folder, and in the Save As dialog box, click on 
the Save as type: drop-down menu, and choose Excel Template (*.xltx). 
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Figure 2.29

Figure 2.30

Notice that when you choose Excel Template (*.xltx), the directory is automatically changed to the default 
Custom Office Templates directory. It is a good idea to store templates in this directory so they will be 
available through the Templates dialog box.  
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6. Change the name of the file to myNet_Inc_Tmpl and click Save. 
7. Right-click on the Excel program icon  on your desktop Taskbar, locate myNet_Inc_Tmpl, 

hover your cursor over the Push Pin  icon, then click the push pin icon to Pin to this list.

Figure 2.31

8. Close the myNet_Inc_Tmpl.xltx file. 
 
After you closed the file, you realized that you still have Store No 1026 hard-coded. Changing a template 
is easy – just open it up and change it. 
 

9. Right-click on the Excel 2016 program icon on your Taskbar to access the Pinned and Recent 
lists available for you in Excel. (Recent files are also available from the File tab.) 

10. On the Pinned list, click on myNet_Inc_Tmpl (Files will initially appear in alphabetical 
order, but they can be re-ordered using click and drag). 

11. Change Cell A5 to Store No. ????
12. Save and close myNet_Inc_Templ.xltx. 

 
Your changes are now saved to the template.  
 

Review Questions: It is now time to complete the hands-on Review Questions. 
Log on to www.ExcelCEO.com with your Email address and Password, click 
on the Excel 2016 Review Questions, Chapter 2, Section 2 of 2 option in 
your Main Menu, and complete the Review Questions. 
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Conclusion  
In this chapter, you learned about the importance of the underscore character in field/column names. 
You learned more about formatting icons that are available in the Home tab. You used the Format Painter 
icon and different types of cell formats. You reviewed how to copy cells and performed a “mass” copy 
job. You learned how to use the AutoSum feature. You learned how to use Custom Formatting for special 
formats that aren’t already available in the standard formatting choices. You learned about the various 
kinds of errors and what they mean. You saw how to use Absolute, Mixed, and Relative references in 
formulas. You learned how to indent text within a cell. You added color and lines to a report using the 
Fill Color, Font Color, and Borders icons. You learned how to undo your mistakes and redo actions by 
using the Undo and Redo buttons. You used all of these tools to format an existing file to make it look 
much more presentable, and you created an income statement almost from scratch. The end result was 
a report that you could be proud to present to any level of management. We even took a little time to 
analyze the final report. You ended the chapter by importing, moving, and resizing a graphic. Finally, 
you created a template file and Pinned it for quick access.  

Chapter Exam  
You can now go to www.ExcelCEO.com, click on Sign In, log in and take the exam. Make sure that you 
take the exam on the same computer on which you completed the practice files, as some of the questions 
on the exam may refer to some of the completed projects. Chapter exams are intended to be hands-on.
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CHAPTER THREE — SIMPLE GRAPHICS AND FLOWCHARTS 
 
 

Chapter Objectives: 
 

•    Identify and customize the Quick Access Toolbar
•    Select a new folder from the Open dialog box
•    Choose illustrative Shapes and Objects to incorporate into a file
•    Recognize, resize, move, and format a Text Box
•    Identify Flowchart items by selecting predefined Shapes
•    Recognize and use WordArt to create pictures and graphics

Projects You Will Complete During This Chapter:

•	 Add Chapter3 folder to ExcelCEO Excel 2016 practice files folder
•	 myArt.xlsx

CPE Credits possible for this chapter: 2
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Quick Access Toolbar  
There are many useful icons available in Excel 2016. Most of the icons are the same as the ones in Excel 
2007—2013. You can also customize Excel 2016 to make it friendlier to the way you work. One of the 
customization features I like that makes things easier is the Quick Access Toolbar. The Quick Access 
Toolbar is located above the File and Home tabs and is where you can place the icons that you use most 
frequently. By default, the Quick Access Toolbar comes with the Save, Undo, and Redo icons. A picture of 
the default Quick Access Toolbar is illustrated below. 

Figure 3.1

If you hold your cursor over the drop-down menu to the right of the Quick Access Toolbar, you will see 
a screen tip that reads Customize Quick Access Toolbar. In this next exercise, you will add icons to the 
Quick Access Toolbar using two different methods. 
 

1. Open a Blank workbook in Excel 2016 (click on the File tab, then New, Blank Workbook). 
2. Click on the drop-down arrow to the right of the Quick Access Toolbar. 

 

Figure 3.2

The Customize Quick Access Toolbar menu appears. Twelve options appear in the first section. These are 
the standard options that Excel allows you to add to the Quick Access Toolbar. Let’s add a few icons that I 
use most frequently. 

3. Click on the Open option. 
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Figure 3.3

The menu disappears and the Open icon is displayed in the Quick Access Toolbar. 
 

4. Using the same method, add the New icon. 

You can also add icons that don’t appear as standard options in the first menu. 
 

5. Click on the drop-down arrow next to the Quick Access Toolbar , and click on More 
Commands… 

Figure 3.4
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The Excel Options dialog box appears. This dialog box is also available by clicking on the File tab and 
choosing Options, and then by clicking on Quick Access Toolbar. On the right side of the dialog box, 
you see the icons you’ve already added. Let’s add the Print Preview and Find icons. The Print Preview 
functionality will be discussed in more detail in Chapter 5. The Find icon allows you to find a text string 
or value in the spreadsheet or selection. 

6. Click on the Print Preview and Print icon  on the left section of the dialog box (you’ll have 
to scroll down to find it), then click the Add>>  button between the two sections. 

7. Click on the drop-down arrow that currently reads Popular Commands, and choose Home 
Tab.

8. Scroll about halfway down the list of available icons, and click on the Find… icon. 
9. Move it over to the section on the right. 
10. Click OK. 

 
The Print Preview and Print and Find icons are now added to the Quick Access Toolbar. Notice the 
Move Up and Move Down arrows to the right-most section of the dialog box. These arrows allow you to 
reposition the icons in the Quick Access Toolbar. Take some time to explore this dialog box and discover 
some of the available options that could make your Excel life a little easier.   

Create a Folder from the Open Dialog Box  
To prepare for the next exercise, you need to create a folder. You can easily create a folder from the Open 
dialog box. 
 

1. Click on the Open icon  on the Quick Access Toolbar, and navigate to the C:\ExcelCEO\
Excel 2016 folder. 
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Figure 3.5

As you can see, there is no Chapter3 folder. To create the folder, simply click on the New Folder icon. 
 

2. In the Open dialog box, click on the New Folder text icon, name the new folder Chapter3, and 
click Open. 

Figure 3.6
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The Chapter3 folder is now created. 
 

3. Click Cancel in the Open dialog box.  

Creating Shapes and Objects  
One toolbar that I really liked in Excel 2003 was the Drawing toolbar. In Excel 2016, the Drawing Toolbar 
functionalities are found in the Insert tab. There are many more icons available in Excel 2016 in the 
Insert tab than in the Excel 2003 Drawing toolbar. If you’re an artsy kind of person (which I am definitely 
NOT) these icons can be a lot of fun to use. Even for people like me, having these icons can significantly 
compensate for my lack of artistic ability. Let’s create a simple text box to show you how some of these 
functionalities work.  

Text Boxes  
Let’s begin our experimentation of creating objects by drawing a Text box. 
 

1. Return to the Blank workbook.
2. Click on the Insert tab on the Office Ribbon. 
3. In the Text group, click on the icon labeled Text Box. 
4. Move your cursor to bottom-right corner of Cell B2, and click and drag to the bottom-right 

corner of Cell C4. This action draws the text box. 
5. Release the mouse. 

Figure 3.7

You are now in the Edit mode for a text box. The text box doesn’t appear to be big enough for what we 
will do, but don’t worry. Increasing the size of the text box is easy. 
 

5. Place your cursor over the handle at the bottom-right corner of the Text box.  
 
When you place your cursor over any corner handle, it will turn to a diagonal arrow. When you click and 
drag on the corner handles, you adjust the height AND width of the text box at the same time. If you use 
the handles in the middle of the text box’s outside edges, your cursor will turn to horizontal or vertical 
arrows so you can adjust either the height OR the width.  
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6. Drag the bottom-right handle to the bottom-right corner of Cell D5, and release. 
7. Click inside the text box and type: Nitey-Nite Mattresses 
8. To exit out of Edit mode, press the [Esc] key twice. 

Figure 3.8

Let’s format the text and move the text box up a little. You can use the icons in the Drawing Tools, 
Format contextual tab and in the Home tab to format the text and background of text boxes. 

9. Click inside the text box (this puts the text box into Edit mode). 
10. Highlight all of the text with your mouse. 
11. Bold and italicize the text, and change the font to a size of 14 . 
12. Drag the right edge of the text box to the right until the text fits on one line (about Cell E5). 
13. Drag the bottom edge of the text box up to better align with the bottom of the text. 
14. In the Home tab in the Font group, click on the down arrow on the Fill Color icon, and 

choose Yellow. 
15. Click anywhere on the line around the text box (but not on the handles), and drag the text 

box to the upper-left portion of the spreadsheet with the upper-left corner of the text box 
somewhere in Cell A1. 

16. Click on any cell outside of the text box (to exit out of Edit mode). Resize, if necessary. 
 

Figure 3.9

You can now move this text box to anywhere in your spreadsheet and it will maintain its same format. 
You can also copy this text box for use in other spreadsheets. 
 

17. Click anywhere in the text box to put it in Edit mode), then click anywhere on the edge of the 
Text box (this selects the text box without being in Edit mode).
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18. Click the New Sheet icon  to create Sheet2.
19. Copy the text box (using the [Ctrl]+c key, or use the Copy icon) and paste ([Ctrl]+v, or the 

Paste icon) the text box somewhere on Sheet2. 
20. Save the file as C:\ExcelCEO\Excel 2016\Chapter3\myArt.xlsx. 

Review Questions: It is now time to complete the hands-on Review Questions. 
Log on to www.ExcelCEO.com with your Email address and Password, click 
on the Excel 2016 Review Questions, Chapter 3, Section 1 of 2 option in 
your Main Menu, and complete the Review Questions.  

WordArt  
One of the things I like about writing courses like this is the opportunity I have to criticize Microsoft. 
WordArt is a fun tool to create more advanced graphics, but they changed it a little bit from Excel 2003 
to later versions. I was all ready to slam Microsoft on their “enhancement” of Excel 2007’s version of 
WordArt, but I was disappointed in that effort. When I first looked at WordArt in Excel 2007, I didn’t like 
it. But after I started working with it, I liked it MUCH better than the WordArt in Excel 2003. WordArt 
in Excel 2016 is identical to the rest of the Office 2016 and Office 2013 programs, and much simpler to use 
than in previous versions.

If you have used WordArt in Excel or in other previous versions of Office programs, it may be time to 
revisit them and choose a new favorite setting or two.  Many of the functions are the same, but the layout 
may require some adjustment, as you can no longer see a preview of the text from the options box as with 
Excel 2007 and 2003. WordArt in Excel 2016 is simplified even from Excel 2010, as shown below.

Figure 3.10

When you click on the WordArt in the Text group of the Insert tab in Excel 2016, you get the following: 
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Figure 3.11

It doesn’t automatically show you the cool kinds of styles available as in the previous versions. However, 
let’s use it a little and explore some of the enhancements. 
 

1. Click on the New Sheet icon to create a  tab. 
2. Click on the WordArt icon  in the Text group of the Insert tab. 
3. Click on the letter A in the second row, first A on the left.

Figure 3.12

Once you click on the letter A, you see the beginning of an object with the text “Your text here”. 
Additionally, the Drawing Tools, Format contextual tab appears in the Office Ribbon that contains a 
number of tools you can use to modify the WordArt graphic. We will use several of those tools just to 
show you how they work. You can explore other icons on your own. 
 

4. Replace Your Text Here with Nitey-Nite Mattresses 
5. With your cursor, select the text Nitey-Nite Mattresses 
6. When you finish selecting the text, release the mouse without moving it. 

 
When you finish selecting the text and release the mouse (without moving it), you should see a faint 
image of miscellaneous controls, as in the following figure.  
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Figure 3.13

7. Move your cursor over the faint image and it will become clearer. 
8. In the Font Size box, replace the existing size with 20. 
9. Italicize the selection. 
10. Click anywhere outside the graphic to deselect it. 

Figure 3.14

The floating graphic is now formatted and can be moved to any part of the spreadsheet by simply clicking 
on it and dragging it to its new location just like you did with text boxes. When you click on the graphic 
to place it in Edit mode, you will see square handles (or boxes) on the corners and its sides. When you 
click and drag the handles, it adjusts the height and width of the graphic. The handles adjust the height 
or the width, whichever one you choose. The handle above the graphic controls its rotation. Click and 
drag these handles back and forth to see what they do. Click on the Text Effects button in the Format 
tab and click on the Transform button to give it some more pizzazz. Play around with it as much as you 
want. Feel free to explore this feature by using different WordArt styles, fonts and colors, as most of the 
selections in the FORMAT tab are self-explanatory. But now we’re going to explore one of my favorite 
utilities of using shapes, flowchart objects.  

Flowcharts  
There are many stand-alone flowcharting programs out there, but I have yet to see any of them that are 
easier to use as Excel. Excel flowcharting is basically putting a bunch of text boxes and other objects on 
a worksheet and connecting them with lines. You access the flowcharting tools from the Illustrations 
group of the Insert tab. 
 
In this next exercise, we will document in a flowchart an accounting process for submitting a journal 
entry to the General Ledger. The process is as follows: 1) The Senior Accountant creates a journal entry, 
2) The Senior Accountant emails the journal entry to the Accounting Supervisor, 3) The Accounting 
Supervisor Reviews it and either sends it back to the Senior Accountant for rework or, if approved, emails 
it to the Accounting Clerk, 4) The Accounting Clerk uploads the journal entry into the General Ledger 
system. It’s a straightforward process and easy to put into a flowchart. To start, we need to Insert a new 
worksheet. 
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1. Click on the New Sheet icon next to the  tab to create a new worksheet. 

2. Click on the Insert tab in the Office Ribbon, and then click on the Shapes icon  in the 
Illustrations group. 

Figure 3.15

The Shapes dialog box appears with several choices from which to choose. You can try others later, but 
for now we’ll concentrate on the Flowchart options. 
 

3. Click on the Flowchart: Preparation figure. 
4. With your cursor appearing as a “+” sign, draw a rectangle from the upper-left corner of Cell 

B4 to halfway through Cell D7, then release the cursor. 
5. In the Preparation box, type: Senior Accountant creates/reworks journal entry.  
6. While in Edit mode, click the Center  icon on the Alignment group on the Home tab (to 

center the text), and click outside the Preparation box. 
7. Resize the box using the handles, if necessary, to look like the following figure:
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Figure 3.16

8. Choose the Flowchart: Process graphic  from the Shapes option. 
9. Draw the Process box to the right of the Preparation box, beginning at about Cell F4. 
10. In the Process box, type: Senior Accountant emails journal entry to Accounting Supervisor. 

This is Process Box 1. 
11. Make sure the text is centered. Resize and/or reposition the box, as necessary, to appear as in 

Figure 3.17, and exit the box. 
12. From the Shapes list, under the Lines section, choose Arrow. 
13. Move your cursor (now in the shape of a “plus” sign) over the Preparation box, and all 

connection points will turn red or black. Position your cursor over the right-most connection 
point on the Preparation box, click, and hold. 

14. Now move your cursor over Process Box 1 and all connection points will appear. Click on the 
left-most connection point. 

15. Click outside the flowchart. 
16. Reposition Process Box 1 where the connecting arrow is a straight line from the Preparation 

box to Process Box 1. The arrow will remain connected to Process Box 1 as you move it.  

Figure 3.17

You can also move any of the objects with the arrow keys on your keyboard while the object is selected. 
 

17. Choose the Flowchart: Decision icon  from the Shapes icon, and draw the box to the 
right of Process Box 1. 

18. In the Decision box, type: Approval? 
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19. Connect Process Box 1 to the Decision box with an Arrow.  

Figure 3.18

At this point, look at Figure 3.19. You should be able to create the rest of the flowchart on your own. You 
can create the Yes and No boxes by using a Text Box and taking out the border. Try it on your own and 
see how close you can get to the end product. If you need a little help, follow steps 20 – 33. 
 

20. Below Process Box 1, create another Process box that reads: Accounting Supervisor emails 
journal entry back to Senior Accountant for rework. This is Process Box 2. 

21. Connect the bottom connection point on the Decision box to the right side of Process Box 2 
by using an Elbow Arrow Connector. 

22. Connect the Process Box 2 to the bottom of the Preparation box by using an Elbow Arrow 
Connector. 

23. Below and slightly to the left of the Decision box, insert a text box with the word No in it. 
24. Resize the text box to be small and take out the line around it (Right-click on the “No” text box 

border and click on the drop-down menu below the Outline icon and choose No Outline). 
25. Create another Process box to the right of the Decision box. In it, type: Senior Accountant 

emails journal entry to Accounting Clerk. This is Process Box 3. 
26. Connect the Decision box to Process Box 3 using an Arrow. 
27. Copy and paste the No text box. In the copied text box, change the text to Yes and move it to 

be positioned above the connecting line between the Decision box and Process Box 3. 
28. Below Process Box 3, create another Process box that reads: Accounting clerk uploads 

journal entry to General Ledger. This is Process Box 4. 
29. Connect the two using an Arrow. 
30. Below Process Box 4, create a Magnetic Disk object  and label it: General Ledger. 
31. Connect the two with an Arrow. 
32. Make sure the text in all text boxes is centered.
33. In the Show group of the View tab, uncheck the Gridlines box to remove visible gridlines 

behind your flowchart.

Your flowchart should look like the figure below:  
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Figure 3.19

33. Save and close myArt.xlsx. 
 
One note on using shapes – if you hold down the [Shift] key while drawing a shape, it will keep the 
shape’s proportions constant. For example, if you click on the Oval shape and draw it with your mouse, 
you will almost always get an oval shape. But if you hold down the [Shift] key while drawing the oval, it 
will be a circle. 
 
In this course, we will use many icons in most of the tabs.  The Shapes objects are just one example of 
the many functionalities available with Excel. I encourage you to explore other tools as you come across 
them. 
 

Review Questions: It is now time to complete the hands-on Review Questions. 
Log on to www.ExcelCEO.com with your Email address and Password, click 
on the Excel 2016 Review Questions, Chapter 3, Section 2 of 2 option in 
your Main Menu, and complete the Review Questions.  

Conclusion  
In this chapter, you learned how to create a folder from within the Open dialog box. You customized the 
Quick Access Toolbar by clicking on its drop-down arrow and choosing icons to be included in it. Next, 
you learned how to create and format shapes and objects, starting with text boxes. You discovered how to 
create graphics using WordArt. Finally, you created a Flow Chart by using the Flow Chart objects in the 
Shapes dialog box.  

Chapter Exam  
To take the examination for this chapter, you must have successfully completed the examination for the 
previous chapter. You can now go to www.ExcelCEO.com, click on Sign In, log in and take the exam. 
Make sure that you take the exam on the same computer on which you completed the practice files, 
as some of the questions on the exam may refer to some of the completed projects. Chapter exams are 
intended to be hands-on.
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CHAPTER FOUR - SORTING, SUBTOTALING AND FILTERING 
 
 

Chapter Objectives: 
 

•    Select and open multiple files of related data
•    Choose the appropriate Sort Ascending and Sort Descending icons
•    Select and use Custom Sort options
•    Identify subtotal functionality for summarizing data
•    Choose data filters for numeric and text data
•    Identify and use the Top Ten filter
•    Select Advanced and Search filtering

Projects You Will Complete During This Chapter:

•	 my2015_Sales.xlsx
•	 myItem.xlsx
•	 myQ3_Sales.xlsx

CPE Credits possible for this chapter: 2
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Introduction
Once I had an assignment to take over a report that someone else had developed. That employee had the 
responsibility of calculating incentive travel. She created reports showing who won the various trips the 
salespeople could earn. The top X number of salespeople who sold the most over their budget won an 
all expense paid trip, and EVERYONE wanted to win. My job was to see how this employee created the 
report, and take over the maintenance of the report. I was expecting to see sophisticated calculations, 
databases, and spreadsheets since I was doing these calculations for literally thousands of sales people. I 
discovered she was simply taking a spreadsheet that someone in the Accounting department had given 
her, summing each sales person’s sales, and sorting it in Descending order by the amount sold. The top 
producers were the first ones on the list, and they got to go on the trip. We spent a lot of money to take 
those people on the trip, and it was almost scary how easy it was to determine who got to go. 
 
Excel provides many wonderful tools that allow you to sort, summarize, and filter your data without 
having to do ANY complex calculations. Sorting data is very useful, particularly if you need to rank the 
data from top to bottom, or if you want to identify some type of trends that may exist in the data. After 
you’ve sorted your data, you may want to calculate subtotals to see sums of certain groups of numbers. 
Then you can filter out what you don’t need or display only what you want to see. This chapter will teach 
you how to do all of this in just a few easy clicks of the mouse. 

Working with Multiple Files  
To begin this chapter, however, I’d like to talk about combining files. Often, you will not be able to 
control the format or manner in which files or data are sent to you. When people give you information, it 
usually comes in the format that they are more comfortable with. Sometimes it comes to you in different 
files and you have to put it together. In the next exercise, you will open three files at once and combine 
them into one file. 
 

1. Open Excel 2016. 
2. Click on the Open icon and navigate to C:\ExcelCEO\Excel 2016\Chapter4. 
3. Click on the Aug_Sales.xlsx file, hold down the [Ctrl] key, and click on the Jul_Sales.xlsx and 

the Sep_Sales.xlsx files.
4. Release the [Ctrl] key, right-click on a selected file, then click Open. 

Figure 4.1
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Tip: If your computer settings do not allow opening multiple files directly from 
Excel 2016 due to single-click, you can also navigate to the Chapter4 folder 
from File Explorer from the Start Menu, then follow Steps 3-4.

All three files open at once. In older versions of Excel, you could only view one workbook at a time, 
and the program would make you toggle between them. Microsoft finally made it possible, by default, 
to open workbooks in separate windows, and view them side-by-side. This is a very useful enhancement 
that should feel natural to you soon, if not already. If you find you preferred the Cascading layout for 
workbooks, that is still available to use from the Windows group in the view tab of the Office Ribbon. 
The old features still work when you want to view multiple workbooks at once, so let’s explore some of 
them now. Below, you can see each file you opened is visible in a separate window rather than as tabs.

Figure 4.2

5. To see all of your open files, click on the Switch Windows icon on the View tab. The visible file 
will have a check mark next to it.
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Figure 4.3

6. If necessary, click to activate the Jul_Sales file.

Trick: Toggling between files can also be done from the snap menu on the 
Windows Taskbar, as seen on the bottom of the following figure which 
displays open files when you hover your cursor over the Excel 2016 icon.

Figure 4.4

7. Save the Jul_Sales.xlsx file as myQ3_Sales.xlsx. 
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We will combine the data in each of the files into one file called myQ3_Sales.xlsx. Now that you have 
all the files open, there are various options you have to quickly organize the view to help you work with 
them. Let’s arrange them in a cascading order. 
 
8. Click on the Arrange All icon  in the Window group of the View tab. 

Figure 4.5

The Arrange Windows dialog box appears. In this box, you can tell Excel how to arrange the view of the 
files, choosing from Tiled, Horizontal, Vertical, and Cascade. 
 

9. Click on the Cascade radio button, and click OK. 

You now see all of the open files overlapping in one screen. The July file does not appear because you 
saved it as myQ3_Sales.xlsx. To make a file active, just click on the name of the file in that corresponding 
file’s title bar. 
 

10. Click on the Aug_Sales file to make it active. 

Now we will copy the Aug_Sales tab into the myQ3_Sales file. 

11. In the Aug_Sales file, right-click on the  tab, and choose Move or Copy… 
from the pop-up menu.
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Figure 4.6

The Move or Copy dialog box appears. 

12. Click on the drop-down menu under To book: and choose myQ3_Sales.xlsx. 
13. Click on (move to end) in the Before sheet list, check the Create a copy checkbox, and click 

OK. 
 
Now the myQ3_Sales file has two tabs: Jul_Sales and Aug_Sales. 
 

14. Copy the  tab in the Sep_Sales file over to the myQ3_Sales file. 

The myQ3_Sales file should now contain three tabs of data: Jul_Sales, Aug_Sales and Sep_Sales. 
 

15. Click on the Maximize button on the myQ3_Sales file (to take off the Cascade View). 
16. Save and close the three files.  

Sorting  
The next topic is sorting. Let’s suppose that you want to see how many manufacturers you purchase 
products from. This is very easy to do, and you can do this by using the Sort Ascending and Sort 
Descending icons. In the next exercise, you will open the Item file and perform sorts on it. 
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1. Open the file at C:\ExcelCEO\Excel 2016\Chapter4\Item.xlsx. 
2. Save As C:\ExcelCEO\Excel 2016\Chapter4\myItem.xlsx. 

Figure 4.7

This file is the master list of all items that Nitey-Nite Mattresses stocks in their inventory. You can see 
that there are 69 rows of data in the list, with the first row being the column names. That means there 
are 68 items in the list. The fields include Item_Number, Manufacturer, Product, Size, Quality, Series, 
Retail_Price, and Cost.  

3. Resize all columns, so you can see the complete field name and contents of each cell. 
4. Underline the cells in Row 1. 
5. Click on the Freeze Panes icon  in the Window group of the View tab, and click on Freeze 

Top Row. 
 
This is one minor functionality that I really like in Excel - the ability to freeze the top row or left column 
without having to actually click on it. It’s not a big deal, but it can be a time-saver. 
 

6. Click on any single cell in the table to de-select Row 1.
7. Right-click on Cell B1, point to Sort, and choose Sort A to Z 

Note: There are many other ways you can sort data in an Excel 2016 table. One 
way is to click on the Data tab, and use the Sort A to Z (ascending), or Sort 
Z to A (descending) icons in the Sort & Filter group. If you want to sort 
multiple fields, or on formatting options like cell color or font color, you can 
use the Sort icon in the Sort & Filter group. 
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Pay attention to the various options available on the Sort option in the right-click menu, like sorting by 
the Cell Color and Font Color options, available if any cells meet those criteria. Using those options is 
beyond the scope of this chapter, but they come in handy when you need to sort on cells that contain 
conditional formatting (covered in Chapter 14).  

This list is now sorted in ascending order by Manufacturer. As you scroll down the list, you can see that 
there are four manufacturers whose names are repeated on numerous lines: Cama, Dream, Leavan and 
Sleepwell. Now you want to see all of the items sorted by Retail Prices from highest to lowest. 
 

8. Click on Cell G1 (In actuality, you can click on any cell in Column G, but DO NOT SELECT 
the entire column as doing so will sort only the data in that column, and can alter your data 
relationships to the other columns). 

9. Click on the Sort Z to A icon  in the Sort & Filter group of the Data tab. 
﻿

Figure 4.8

The highest priced item you have appears at the top of the list, which sells for $1,699.00. It is the King size 
Diamond series mattress from Sleepwell.  

10. Save and close the myItem.xlsx file. 
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Custom Sorting  
You can also sort on custom lists, like days of the week or months of the year. 
 

1. Open the file at C:\ExcelCEO\Excel 2016\Chapter4\Aug_Sales.xlsx. 
2. Save As C:\ExcelCEO\Excel 2016\Chapter4\myAug_Sales.xlsx. 

Figure 4.9

This is a listing of daily sales totals for all of Nitey-Nite’s stores. It shows the date, the weekday and the 
total sale amount. Your job is to find out the best and worst sales days of the week. You can do this in 
a number of ways. For the purposes of this exercise, we will sort the list by weekday beginning with 
Sunday. 
 

3. Right-click on Cell B1, point to Sort, and choose Custom Sort… 
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Figure 4.10

The Sort dialog box appears. In this dialog box, you can sort on many levels. Excel 2003 offered only 
three sort levels, but in Excel 2007 and beyond, you can sort on as many fields as you have in the table, up 
to 64.  
 

5. Make sure the My data has headers checkbox is checked. 
6. In the Sort By drop-down menu, choose Weekday.  
7. Leave the Sort on option on Values, and in the Order drop-down menu, choose Custom 

List…  
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Figure 4.11

This is the dialog box that allows you to sort your data using various lists. 

8. In the Custom lists section, click on Sunday, Monday, Tuesday, Wed… and click OK. 
9. Click OK in the Sort dialog box. 

 
Your data is now sorted by Weekday. To analyze the data, you could write some formulas, but you can 
also look at it on the fly. Scroll up and down the list and you can see that Fridays appear to have the 
lowest total sales. All Friday totals are less than $100,000, and most all of the other days’ totals are more 
than $100,000 per day. 

Subtotals  
To find out what the totals for each day are, you typically have to do some type of calculation. In this 
case, I would usually use a PivotTable (discussed later in this course), but for now we’ll use Excel’s quick 
and clean Subtotal feature. 
 

10. With the data sorted by Weekday, click on the Data tab, and click on the Subtotal icon 
 in the Outline group. 
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Figure 4.12

There are various sections included in the Subtotal dialog box. The At each change in: box allows you to 
specify the field you want to subtotal. In our case, we want a subtotal for each change in Weekday. You 
can choose Sum, Count, Average, Max, Min, and other functions in the Use function: box, depending 
on the type of subtotal you want. Typically, you perform calculations on numbers (sales, quantity, etc.) 
and you count non-numbers (weekdays, contracts, names, etc.). You check the fields you want to create 
subtotals for in the Add subtotal to: list. By default, Excel checks the last box. The next three check boxes 
allow you to replace subtotals that may currently be in the list, insert a page break between subtotal 
groups, and summarize groups below the data. Finally, you can remove all subtotals by clicking the 
Remove All button. 
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11. Choose Weekday in the At each change in: list. 
12. Make sure Sum is chosen in the Use function: list. 
13. Make sure the Amt field in the Add subtotal to: list is checked. 
14. Leave the Replace current subtotals and Summary below data boxes checked.  

Figure 4.13

15. Click OK.  
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Figure 4.14

Your data now contains subtotals after every change in weekday. With the Subtotaling tool, you can 
organize your data into levels. Look to the extreme upper-left of the spreadsheet and you will see 
grouping level boxes.  You can change the view of the data by simply clicking on the desired level 
box. 
 

16. Click on Level Box 1.  

Figure 4.15

The data is now summarized at a Grand Total level. 
 

17. Click on Level 2.  



ExcelCEO 

            Chief Excel Officer

SECTION 1: Beginning Excel   —   Sorting, Subtotaling, and Filtering

99

Chapter 4

Figure 4.16

The data is now summarized at the weekday level. With the data summarized at the Weekday level (Level 
2), you can easily see that Monday’s total of $719,342 is clearly the highest sale day for the month of 
August. Tuesdays and Wednesdays appear to be the next highest days. But wait! August has 31 days and 
there are five Mondays, Tuesdays, and Wednesdays in August 2016, so those days should obviously have 
more total sales. It would probably be a better analysis if we looked at the average daily sales instead of 
the total daily sales in August. Let’s change up our subtotaling to do that. 
 

18. With any cell in the subtotals selected, click on the Subtotal icon. 
19. In the Subtotal dialog box, change the Use function from Sum to Average, and click OK. 

The Subtotal list expands out to show all data and the Total for each day changes to Average. 
 

20. Click on the Level 2 box. 
21. Expand the column widths, if necessary, to see all the data. 

 

Figure 4.17

We see that Monday is still the highest average sale day, followed by Tuesday, then Saturday. The averages 
tell a slightly different story! Fridays still appear to be lackluster days, so you may want to suggest that 
Nitey-Nite Mattresses hold specials on Fridays to help boost sales on those days. You can display and hide 
further detail or subtotals by clicking on the Show Detail  or Hide Detail  buttons. 
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22. Click on the Show Detail icon  next to Friday. (Row 34). 

Figure 4.18

Now you see the detail and average for Friday. 

23. Click on the Level 3 box.  

Figure 4.19

The data returns to showing the subtotals for all data.  
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24. Save and close myAug_Sales.xlsx.  

Review Questions: It is now time to complete the hands-on Review Questions. 
Log on to www.ExcelCEO.com with your Email address and Password, click 
on the Excel 2016 Review Questions, Chapter 4, Section 1 of 2 option in 
your Main Menu, and complete the Review Questions. 

Multiple Subtotals  
The Subtotaling feature also allows you to perform subtotals on multiple levels of data. 
 

1. Open the file at C:\ExcelCEO\Excel 2016\Chapter4\2015_Sales.xlsx. 
2. Save As C:\ExcelCEO\Excel 2016\Chapter4\my2015_Sales.xlsx. 

When using Subtotals, it is important to remember to FIRST sort the data in the same order you want 
to subtotal for, THEN perform the subtotals. In this spreadsheet, monthly sales for each store are listed. 
The fields we have to work with are Region, State, Store_No, Year, Month, Sales, and Cost. We want to 
analyze Sales at ALL levels of the company, so we have to sort by Month, Store_No, State, and Region. 

To perform a cumulative sort on multiple levels of data, you must first sort by the field that contains the 
lowest level of data and work your way up to the highest. In this example, the lowest level is by Month, 
and the highest level is by Region. 
 

3. Sort the table on the Month field in Ascending Order. (Use the A-Z icon rather than Sort)
4. Continue to sort the data in Ascending Order in this order: Store_No, State, Region. 

Figure 4.20
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Tip: If you want to sort using the Sort dialog box, begin with the highest level 
and work toward the lowest level of data to achieve the same results.

Now that the data is sorted appropriately, let’s perform our multiple subtotals. 

5. With your cursor on only one cell on the spreadsheet, click on the Subtotal icon in the Outline 
group of the Data tab. 

6. In the Subtotal dialog box, make sure that: Region is chosen under At each change in:, Sum 
is selected under Use function:, Sales and Cost are both checked under Add subtotal to:, 
and that the Replace current subtotals and Summary below data boxes are checked.  

Figure 4.21

7. Click OK and resize columns, if necessary.

Subtotals are now added at the Region level. Now we will add another level of subtotals at the State level. 
To do this, you will change the At each change in: box to State and uncheck the Replace current  box. 

 
8.  With your cursor still inside the table, click on the Subtotal icon. 
9. Under At each change in: change Region to State. 
10. Uncheck the Replace current subtotals box, and click OK.  
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11. Resize the columns if necessary.

Subtotals at the State level are added.  

Figure 4.22

12. Add another Subtotal level at the Store_No level.   

Now you have five levels of subtotals. 

Figure 4.23
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13. Click on the 1, 2, 3, 4, and 5 level boxes, and the Show Detail and Hide Detail buttons to see 
the detail or summary levels you want. 

Filters  
While subtotaling is a very useful feature, sometimes you just want to filter the data without subtotaling. 
One option to get that accomplished is to use the Filter functionality. 
 

1. Click on the Subtotal icon and click on Remove All. 

2. Having selected only one cell in the table, click on the Filter icon  in the Data tab.
 

Figure 4.24

Drop-down arrows, or the filter arrows, appear to the right of each field in the table. 
 

3. Click on the State drop-down arrow.  

Figure 4.25
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A list of all the states available in the State field appears. In this list, you can choose as many or as few 
options as you want.  

4. Uncheck the (Select All) box (all options are deselected), check the IL box, and 
click OK.  

Figure 4.26

The table is now filtered for only the data where State equals “IL”. Notice that the Row numbers turned to 
blue (indicating they are filtered rows) and the State drop-down arrow has a small filter icon in it. 
 

5. Click on the Region drop-down menu. 
 
You see that only the North region appears. When you choose one filter, the remaining fields are also 
filtered for that selection, so when you picked State equals “IL”, which is in the North Region, only North 
appears under Region. 
 

6. Click Cancel in the Region filter list. 
7. Click on the State filter and choose GA in addition to IL, and click OK. 

 
Now you have a filtered list containing all records where the state is either IL (Illinois) or GA (Georgia).   

Number Filters  
You can custom filter a list based on a number of criteria. If you click on any filter, you will see different 
options based on the data type in the field. For example, if you click on the State field filter, you’ll see the 
Sort A to Z, Sort Z to A and Text filters options, among others. If you click on the Sales field filter, you’ll 
see a different set of filter options, as the Sales field contains numbers, not text. In this next exercise, we’ll 
filter the entire list to see the top 20 stores in terms of sales per month. 
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8. On the State drop-down menu, choose (Select All) (to take off the custom IL and GA filter), 
and click OK.

9. On the Sales drop-down menu, point to Number Filters and choose Top 10…  

Figure 4.27

The Top 10 AutoFilter dialog box appears. In this box, you don’t have to choose only the Top 10. You can 
choose Top or Bottom, and you can use the spinner button in the box that reads 10 to change the number. 
 

10. Click on the up arrow in the box that reads 10, and scroll up until it shows 20 (or you can just 
type 20 in the box). 

11. Click OK.  

Figure 4.28

You now have a list of all the top 20 stores and the months when they were in the top 20. Notice it 
doesn’t sort the data, but it simply chooses the top 20. On the lower-left of the Status Bar, notice “20 of 
348 records found” is displayed. When a filter is applied, you can look at the Status Bar to see a quick 
summary of how many records match the filter criteria set.
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12. Click on the Sales drop-down menu, and choose  (to take off the Top 
20 filter), then click OK. 

Search Filters  
Excel 2010 added a feature called Search filters. When you click on a filter drop-down arrow, a Search box 
appears. As you start to type the characters of the string or number you’re looking for, Excel filters the 
items displayed in the filter list for those characters. This comes in very handy especially when you have a 
list with hundreds or thousands of items. Let’s try an example using the Items file. 
 

1. With the my2015_Sales.xlsx file still open, open the Item.xlsx file. 
2. Resize all columns so you can read the headings and the data. 
3. Click on the Filter icon to apply an AutoFilter to the data. 
4. Click on the AutoFilter for Series.  

Figure 4.29

Notice that a Search box appears under the Text Filters option. You use this Search box to further filter 
the list. 
 

5. In the Search box, type the letter o (upper- or lower-case — it doesn’t matter), but don’t click 
OK yet.
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The list is filtered for all items that contain the letter “o”. As you type more characters, the list is filtered 
further. This same feature exists when we explore PivotTables in Chapters 11 and 12. I’m not going to 
spend any more time on the Search filter, but it is a cool thing to know. 

Figure 4.30

6. Click Cancel. 
7. Close the Item.xlsx file without saving it.  

Advanced Filtering  
Another nifty function is Advanced Filtering. With Advanced Filtering, you can set up a criteria range 
and query data that meets that criteria. Let’s try an example. 

1. On the my2015_Sales.xlsx file, click on the Filter icon to turn off the AutoFilter. 
2. Select Rows 1 through 5 and then click on the Insert icon (not the drop-down arrow next to it)

 in the Cells group of the Home tab. 

3. Copy Cells A6 through G6 and Paste the range to Cell A1.
4. In Cell E2, type the number 5 (which sets this filter up for May). 
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Figure 4.31

This setup will query all sales in the table where the month is equal to 5. 
 

5. Click on the Advanced icon  in the Sort & Filter group of the Data tab. 
6. Make sure the Filter the list, in place radio button under Action is selected. 
7. In the List range: box, select $A$6:$G$354 (or type, if it’s not already there) 
8. In the Criteria range box, type or select $A$1:$G$2.  

Figure 4.32
 

 9. Click OK. 
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Figure 4.33

The records below the criteria range are now filtered for all sales in Month 5. You can also query on 
multiple criteria and use wildcard characters in your criteria. When you do this, however, you must 
be careful. Remember that when you input criteria on more than one line, Excel will filter records that 
match EITHER criteria. Let’s suppose you want to filter for all records in May or June where the sales are 
greater than or equal to $100,000. 

10. In Cell E3, type 6. 
11. In Cells F2 and F3, type >=100000. 
12. Click on the Advanced button in the Sort and Filter group. 
13. In the Advanced Filter dialog box, change the Criteria range to $A$1:$G$3 (to add one 

more row in the criteria).  
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Figure 4.34

14. Click OK.  
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Figure 4.35

The list is now filtered for sales equal to or greater than $100,000 in May or June. 

Filtering for Unique Values  
With the Advanced Filter dialog box, you can query a table and extract a dataset of unique values. Let’s 
suppose you want to extract a list of unique store numbers from the 2015_Store_Sales table. In that table, 
the store numbers are repeated 12 times, one time for each month. All we want is a simple list of all the 
store numbers (we may need those numbers in another analysis we are doing). With Advanced Filtering, 
it’s a snap. 
 

1. Click on the Clear icon  in the Sort & Filter group of the Data tab to turn off the 
Advanced Filter. 

2. Click on the Advanced icon. 
3. In the Advanced Filter dialog box, choose the Copy to another location radio button. 
4. Edit the List range: to read $C$6:$C$354 (Column C contains the store numbers). 
5. Delete the range in the Criteria range box. 
6. In the Copy to box, type I1 (This is where we want to put the filtered list.). 
7. Check the Unique records only box.  
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Figure 4.36

8. Click OK. 

Figure 4.37

You now have a list of unique store numbers in Column I. Pretty easy, huh? 
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9. Save and close the my2015_Sales.xlsx file. 

Review Questions: It is now time to complete the hands-on Review Questions. 
Log on to www.ExcelCEO.com with your Email address and Password, click 
on the Excel 2016 Review Questions, Chapter 4, Section 2 of 2 option in 
your Main Menu, and complete the Review Questions.  

Conclusion  
In this chapter, you opened and worked with multiple files, arranged them in Cascading order and 
copied tabs from one file to another. You learned how to use the Sort A-Z (Ascending) and Sort Z-A 
(Descending) icons. To re-emphasize, when using these icons, click on only ONE CELL in the column 
you want to sort. DO NOT SELECT THE ENTIRE COLUMN. You also learned how to perform custom 
sorts on the data. You worked a few examples using the Subtotal feature, which comes in handy when 
analyzing tables with many rows of data. You performed multiple subtotals on various levels of data. You 
also learned how to filter data on a spreadsheet including using Filter, custom filtering, Top 10 filtering, 
Search filters and explored Advanced Filters. 

Chapter Exam  
To take the examination for this chapter, you must have successfully completed the examination for the 
previous chapter. You can now go to www.ExcelCEO.com, click on Sign In, log in and take the exam. 
Make sure that you take the exam on the same computer on which you completed the practice files, 
as some of the questions on the exam may refer to some of the completed projects. Chapter exams are 
intended to be hands-on. 
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CHAPTER FIVE — PRINTING 
 
 

Chapter Objectives: 
 

•    Recognize components of the Print and Print Preview dialog boxes
•    Identify how to print a multiple page report
•    Select Page Breaks and Margins using multiple dialog boxes
•    Pick the appropriate customized Headers and Footers to a report using multiple available 

features
•    Choose non-contiguous cells to create the print range of a report
•    Recognize the functionality to hide Rows and Columns within a printed report
•    Identify the Grouping functionality
•    Select the Page to Fit functionality
•    Identify how to save an Excel file as a PDF document

Projects You Will Complete During This Chapter:

•	 myInc_Stmt.xlsx
•	 myTop_Ten_May_16.xlsx
•	 myTop_Ten_May_16.pdf

CPE Credits possible for this chapter: 1.5
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Introduction
“The paperless office will never exist.” At least in my lifetime it won’t. You can quote me on that one. 
Excel gives you a wide variety of tools to create, organize, manipulate, slice, and dice your data, but many 
people will want to see a printed report or presentation. It will always be necessary to share information 
with others, and printing a report, graph, or table is essential in a working office environment, and more 
particularly in an accounting environment. 
 
When considering your Excel reports, it’s best to begin with the end in mind. By that I mean think about 
how you want your report to look. How far from the edges (top, bottom, right, left) do you want the 
report? Do you want it on one page or multiple pages? Landscape or portrait? Large or small font? Color 
or black and white? If you can picture in your mind how you want the report to look, you’re halfway 
there. Let’s start off with designing a simple one-page report. 
 

1. Open the file at C:\ExcelCEO\Excel 2016\Chapter5\Inc_Stmt.xlsx. 
2. Save As C:\ExcelCEO\Excel 2016\Chapter5\myInc_Stmt.xlsx.  

Figure 5.1

The file is similar to the financial statement you created in Chapter 2. 

Print Preview  
In Excel 2016, there are a number of ways to display the various print features. We’ll explore those 
methods in the next few exercises. To preview how the report will look when it is printed, you first need 
to set the print range.  
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3. Select the area of the report (Cells A1 through E39). 
4. Click on the Page Layout tab, click on the Print Area  icon in the Page Setup group, and 

select Set Print Area . 

The Print_Area is now set, as seen in the Name Box, so you can now preview the report by clicking on 
the Print Preview and Print icon. If you don’t set the print area, Excel 2016 usually does a good job of 
figuring out what your print area should be, unless there are a lot of blank rows and/or columns, so most 
of the time you don’t even need to set the print area. I do a lot of non-contiguous ranges, so I use the Set 
Print Range functionality quite a bit. On my computer, I have the Set Print Area icon as one of the icons 
in my Quick Access Toolbar. Another icon we placed in the Quick Access Toolbar in Chapter 3 is the 
Print Preview icon. Print Preview allows you to look at a graphic of the report as it will print. 
 

5. Click on the Print Preview and Print icon  in the Quick Access Toolbar.  

Figure 5.2

Since we haven’t adjusted any of the margins, or centered the report yet, the document appears at the top 
of the page and over to the left.
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There are a number of settings in Print Preview mode. The Print button prints the document. The Printer 
status button allows the user to choose a different printer, add a printer, and print to file (meaning to send 
the document to file such as a PDF or OneNote). The Printer Properties link opens the Printer Properties 
dialog box for the selected printer and gives you selected options to apply to the printed document for 
the printer option. Under the Settings section are several icons that allow the user to change various 
settings, such as print area selections, Page Orientation, paper size, margins, and scaling. The Page Setup 
link below the Settings section is a link to the Page Setup dialog box that many people used in previous 
versions of Excel. In the lower-right corner of Print Preview view are two icons: Show Margins and Zoom 
to Page. You use the Show Margins button to see the lines in Print Preview where the margins are set. The 
Zoom to Page button allows you to see a larger and smaller view of the page as it will print out. In the 
lower-center section of Print Preview mode are navigation buttons that allow you to scroll to the previous 
page or next page in multiple page reports. To close out of Print Preview, just click on the back arrow 
button in the extreme upper-left corner. As always, feel free to explore options that you would use.

In the past, I used the Page Setup dialog box to perform all of my printing functions, and there are some 
functionalities in the Page Setup dialog box that are necessary to use, so let’s explore using that dialog 
box. 
 

6. Click on the Page Setup dialog expander link and the Page Setup dialog box opens. 
7. Make sure the Page tab is selected. 

Figure 5.3

On the Page tab, you can do things like change the Orientation of the page (make it Portrait or 
Landscape), reduce or increase Scaling, make the document Fit to a specified number of pages (wide by 
tall), and change the paper size and print quality. For now, we will accept the default values (Portrait, 
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100% of normal size, using 8.5 x 11 inch (Letter) paper with high-quality 600 dpi print quality). 

8. Click on the Margins tab. 
 

Figure 5.4

In this tab, you can set the left, right, top, bottom, header, and footer margins. You can also center the 
report horizontally and/or vertically. 
 

9. Check the Horizontally and Vertically boxes, and click Print Preview. 
 
You should now see a full page preview of how your document should appear before it is printed, centered 
horizontally and vertically.  
 

10. Click the Zoom to Page icon. 
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Figure 5.5

The document increases in size (i.e.- it zooms in). Click the Zoom to Page icon again to return the print 
preview to it full size. 
 

11. Click the Zoom to Page icon again (to zoom out from the document). 
12. Click the Back Arrow icon (to get out of Print Preview view and return to the worksheet). 
13. Click the Custom Views icon in the Workbook Views group of the View tab.
14. In the Custom Views dialog box, click Add... and type Centered_IncStmt.
15. Click OK.

This adds a printer preset you can access quickly for this report when you want it centered horizontally 
and vertically. You could apply other presets to this file as well, if preferences change.

16. Save and close the myInc_Stmt.xlsx file.  

Multiple Page Reports  
Let’s open another report for a more complex printing exercise. In this example, you will set up a report 
to print on multiple pages. 
 

1. Open the file at C:\ExcelCEO\Excel 2016\Chapter5\Top_Ten_May_16.xlsx. 
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2. Save As C:\ExcelCEO\Excel 2016\Chapter5\myTop_Ten_May_16.xlsx. 

This file is similar to the Top Ten file you completed in Chapter 1. We will work with it to prepare a 
printed report. 
 

3. Open the report in Print Preview.  

Figure 5.6

By default, Excel sets up your report in a Portrait format. In our report, we have 11 columns of data, 
consisting of one column of dates and 10 columns of people, and it doesn’t appear to all fit in a Portrait 
mode, as there are only eight fields of data that appear in this first page of the report. If you click on the 
Next Page button a few times, you’ll see that the column headings don’t repeat and that there is partial 
data on some of the pages. One option to make it fit appropriately is to make the report appear with a 
Landscape orientation.  
 

4. Click on the Portrait Orientation button in the left section of the screen, and change it to 
Landscape Orientation.  
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Figure 5.7

The report looks better, but still needs some work. If you click the Next button a few times, you will see 
that the report is now eight pages long (we want it to be three pages long – one page for each month) and 
that the last person, Evan Thurston, is on a page by himself. To make Evan Thurston fit on the same page 
as the other people, we need to adjust the margins of the report. 

5. Click on the Back arrow button, then click the Margins button in the Page Setup group of the 
Page Layout tab, and choose Custom Margins... 

6. Reduce the Left: and Right: boxes down to .25, and the Top: and Bottom: margins down to 
.50. Check the Horizontally and Vertically boxes. and click OK. 

7. View the report in Print Preview mode.

Your Print Preview should now appear as follows:
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Figure 5.8

Page Breaks  
The report is now down to three pages, but there is some data from April that is still on the first page. We 
want to display only one month on each page. One option is to play with the Top and Bottom margins 
until the months all fit on one page each, but in this example we will use a Page Break. 

1. Click on the back arrow button, then click on the Page Layout tab. 
2. Click on Cell A36 (where the date changes from March to April). 
3. On the Page Layout tab in the Page Setup group, click on Breaks, and choose Insert Page 

Break. 
4. Insert another Page Break on Cell A69 (where the date changes from April to May). 
5. View the report in Print Preview mode. 

Now each month appears on its own page.

Print Titles  
As you scroll through the report in Print Preview mode, notice how the names don’t repeat on the second 
and third pages. You will now format the report where those names repeat on every page. In Excel 2016, 
you set the titles for each page from the Page Layout tab. 
 

1. Exit out of the Print Preview mode 
2. In the Page Setup group of the Page Layout tab, click on the Print Titles icon  . 
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This opens the Page Setup dialog box with the Sheet tab selected. 
 

3. Click inside the Rows to repeat at top: box. 
4. If the box is empty (it may show $1:$1), choose Row 1 on the spreadsheet, and click OK.  

Figure 5.9

In this dialog box, you can also make columns to the left repeat on subsequent pages by clicking in the 
Columns to repeat at left: box and then choose on the columns you want to repeat. Now if you click on 
Print Preview, you will see the three pages on the report with the title row repeating on each page.

5. View the report in Print Preview mode to ensure the names are repeated on pages 2 and 3.
 

Review Questions: It is now time to complete the hands-on Review Questions. 
Log on to www.ExcelCEO.com with your Email address and Password, click 
on the Excel 2016 Review Questions, Chapter 5, Section 1 of 2 option in 
your Main Menu, and complete the Review Questions. 

Headers and Footers
Let’s add a header and footer to the report. In Headers and Footers, you can make text, dates, numbers 
and even images appear at the top or bottom, respectively, on every page of the report. 
 

1. Go to the Print Preview (if you closed the report for Review Questions) and click on the Page 
Setup link. 

2. Click on the Header/Footer tab. 
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3. Click on the Custom Header… button. 
4. Click in the Center section and type: TOP TEN REPORT and press [Enter] (use plain text). 
5. On the second line, type: As of May 31, 2016 
6. With your cursor, select the TOP TEN REPORT text.  

 

Figure 5.10

You can change the font in a header or footer section just like you can on a spreadsheet. 
 

7. Click on the Format Text button  in the Header dialog box (the Font dialog box appears). 
8. Under Font style: choose Bold. 
9. Under Size: choose 16, and click OK.  
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Figure 5.11

Now that I see it, I don’t want for the header to be that big, so let’s change it a little. 
 

10. In the Header dialog box, select TOP TEN REPORT, and click the Format Text button. 
11. Under Font style, choose Bold Italic. Choose 12 under Size, and click OK twice. 
12. In the Page Setup dialog box, click on the Custom Footer… button. 
13. Click in the Right section box. 
14. Type Page, and click the Insert Page Number button. 
15. Type of, and click the Insert Number of Pages button , then type Pages (with the 

appropriate spaces between words), and click OK in each dialog box as you exit Page Setup. 
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Figure 5.12

View the report in Print Preview.

Figure 5.13
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Hmmmmmm. The Header looks okay, but it would be nice to have a bit more room between the Header 
and the report. On the Margins tab of the Page Setup dialog box, the Header and Footer margins are set 
to .50 and the Top and Bottom margins are also set to .50. One way to rectify this is to reduce the Header 
and Footer a bit until they appear above the titles.  
 

16. Click on the Page Setup link on the Page Layout tab, and click on the Margins tab. 
17. Reduce the Header and Footer margins to 0.25, make the Top margin 0.75, and click OK. 

Figure 5.14
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Figure 5.15

Now click on the Next and Previous buttons in Page Preview mode to see how the report will print.

Do you see how Page 1 is offset a little different than the other pages? That is caused by the vertical 
setting. Let’s uncheck that box. 

18. In the Page Setup dialog box, in the Margins tab, uncheck the Vertically check box, Click 
OK, and scroll through to Print Preview of the report.

I encourage you to click on the other buttons in the Header and Footer dialog boxes to see what they do. 
Note that in these dialog boxes you can insert and format a picture (or image). 
 

Tip: You can insert a header or footer without opening the Page Setup dialog 
box, if there are not frozen panes in the worksheet (or the Page Setup dialog 
box will open). To do this, click on the Header & Footer icon in the Text 
group of the Insert tab. This opens the worksheet in Page Layout view and 
creates the Header & Footer Tools Design contextual tab. 

Non-Contiguous Ranges  
Sometimes you want to print sections of a report that are not located next to each other. These are called 
non-contiguous ranges. There are a few ways to handle this. One way is to hide the rows and/or columns 
you don’t want to print. Hiding a row or column is just that – hiding. It does not delete the data. Another 
way is to select only the range you want to print. Let’s try both methods. Let’s suppose that you want to 
print the report only for the months of March and May. 

Hide Rows  
1. Return to the workbook. 
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2. With your cursor, select Rows 36 through 68. 
3. On the Home tab, click on the Format button in the Cells group. 
4. Point to Hide & Unhide, and choose Hide Rows.  

Figure 5.16

Rows 36 through 68 are now hidden. If you click on Print Preview, you will see the rows are also hidden 
in that view of the report. However, it’s kind of ugly because Page 2 appears with just the column names 
and no data.
 

5. Click the Print Preview button, and click the Next button (to see that the rows are hidden). 
6. Click on the Back Arrow icon to return to the workbook. 
7. Click the Undo icon to bring back the hidden rows back into view. 
8. With your cursor, select Cells A2 through K35, release the mouse, press the [Ctrl] key, select 

Cells A69 through K101, and release the [Ctrl] key and mouse. 
9. Set that range as the print area (by clicking on the Page Layout tab, Print Area icon, Set Print 

Area), and click Print Preview. 
 
Now only those selections appear in Print Preview.  

Hide Columns  
You can also hide columns. Let’s suppose that you don’t want to show the data for Lee Underwood. 
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10. Click on the Home tab. 
11. Select Column I. 
12. On the Home tab, click the Format icon  in the Cells group, point to Hide & Unhide, and 

choose Hide Columns. 
13. Click Print Preview.   

Figure 5.17

Lee Underwood’s data is now hidden. But since we took out one individual, it is really now the Top Nine 
report. A little spacer appears between Column labels H and I to show hidden data. Let’s bring Lee back.

14. Click on the Home tab and unhide Column I (you can use the same method to unhide as to 
hide).

Grouping  
Another way to hide and unhide rows is to group the data. Grouping is similar to subtotals, which you 
already learned in Chapter 4, but Grouping does not calculate subtotals. It simply groups the data. Using 
Grouping is a great alternative when you want the user to be able to easily hide and unhide rows and/or 
columns. Let’s take a minute to revise the spreadsheet before we do grouping.  
 

1. In Cell L1, type Total. 
2. Calculate the total sales for each day of sales for each row, as well as the monthly totals, and 

apply the appropriate formatting. 
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3. Include Column L in the print range. 
4. Select Columns B through K. 
5. On the Data tab, click on the Group icon (not the drop-down arrow) in the Outline group.  

Figure 5.18

The Level boxes (like you saw when you used subtotals) appear in the upper-left corner of the spreadsheet 
with a long line centered over Columns B through K, and a Hide Detail button over Column L.  

6. Click the Hide Detail button .  
 

Figure 5.19

The columns are now hidden and can be easily unhidden or expanded by clicking the Show Detail (+) 
button. You can also click on the Level boxes (1 and 2) to hide the detail (Level Box 1) or show the detail 
(Level Box 2). You can group and ungroup rows of data using the same methodology. 

7. Click the Show Detail button to expand out the columns. 

Page to Fit  
Excel also has a Page to Fit feature that I find very useful. Typically I use this feature when I don’t want 
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to mess around with the margins and font sizes trying to get a report to print on just one or a few pages. 
Let’s explore that feature. 

8. Click on the Print Preview button. 
 
Oops! You see that there are now six pages in the report. That happened when you added the Total 
column to the report. By clicking the Next Page button a few times, you will see that pages 4, 5, and 6 
contain only one column of data, the Total column. We want the report to be contained to three pages.  

9. Click on the Scaling button (the last button in the left section) and choose Fit All Columns on 
One Page.

Figure 5.20

Now that the report is formatted correctly, you can let other people see it.   

Save as PDF  
 Sometimes, you want to send a file to someone who just wants to print it out. Other times, you’ll want 
to save it out on the Internet without letting anyone use the Excel functionalities. There is a way to save 
an Excel report to another format where everyone can see it, whether or not they have Excel. It is called 
a PDF file. PDF stands for Portable Document Format, and is a non-proprietary file format, meaning all 
you need to have to read it is a viewer. The Adobe Corporation has a PDF reader that is downloadable for 
free and is called Adobe Acrobat Reader. It is also the most common reader of PDF files. To create a PDF 
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file from Excel, simply save the workbook in a PDF format. Before you create the PDF file, however, you 
need to make sure the worksheet is formatted exactly as you would if the report were to be printed out, as 
that is how it will appear in the PDF file. 

10. Click on Save As. 
11. Navigate to C:\ExcelCEO\Excel 2016\Chapter5, click on the Save As type: drop-down 

menu, and choose PDF. 
12. Make sure the Open file after publishing checkbox is checked, then click Save. 

 After a few seconds, the PDF file will appear in your default PDF reader. 
 

13. Close the PDF file, then Save and close myTop_Ten_May_16.xlsx. 
 

Review Questions: It is now time to complete the hands-on Review Questions. 
Log on to www.ExcelCEO.com with your Email address and Password, click 
on the Excel 2016 Review Questions, Chapter 5, Section 2 of 2 option in 
your Main Menu, and complete the Review Questions.  

Conclusion  
 Printing a report and setting up the print properties is probably one of the easiest things to do with Excel, 
and it is something that could get you brownie points when done well, or big time black marks, if it’s not 
done at all. It is good practice to always set a print range and make the report look presentable before 
you send the file to anyone, particularly inexperienced Excel users. Lots of management personnel like 
to open a file and automatically click Print. You could look bad if they print a report when the print 
properties are not formatted correctly. It is such an easy thing to do, so why not format ALL of your 
reports BEFORE you send them out? If you don’t do it, it could result in others having less confidence in 
your abilities. Trust me – been there, done that, and I’ve got the battle scars to prove it. 

  In this chapter, you learned how to use the Print dialog box. You used the Print Preview icon numerous 
times. You set up a report to print on one page and another report to print on multiple pages. You 
worked with page breaks to begin a new page at certain places in the spreadsheet. You worked with 
margins, inserted headers and footers, and printed non-contiguous ranges. You learned how to hide 
rows and columns without deleting the data. You worked an exercise where you grouped and ungrouped 
columns of data. You also used the Page to Fit feature, which allows you to automatically fit the text of 
a spreadsheet within certain page parameters without having to adjust margins. Finally, you saved your 
report as a PDF file.  

Chapter Exam  
  To take the examination for this chapter, you must have successfully completed the examination for the 
previous chapter. You can now go to www.ExcelCEO.com, click on Sign In, log in and take the exam. 
Make sure that you take the exam on the same computer on which you completed the practice files, 
as some of the questions on the exam may refer to some of the completed projects. Chapter exams are 
intended to be hands-on. 



SECTION II: INTERMEDIATE EXCEL 

 I believe writing formulas is the lost art of Excel, as many Excel users have become overly dependent on 
the nifty buttons and icons. Writing formulas is the foundation of Excel, and we will spend a significant 
amount of time in this course writing formulas and using functions. The entire intermediate section 
is dedicated to writing formulas and understanding how to use functions. A ﻿function is a predefined 
word in Excel that performs a task or calculates a number based on one or more criteria or arguments. 
A function is always followed by an opening parenthesis, typically with a series of arguments and ends 
with a closing parenthesis. In many years of working with Excel, I have used numerous functions, and I 
have compiled in this section the list of the ones that I use most frequently. In the following chapters, we 
will explore each of these functions individually and you will work many examples to better familiarize 
yourself with these powerhouses of analysis tools. 
  
 We start off in Chapter Six by learning the basics of operators (Arithmetic, Comparison, and Text), and 
learning how to write simple IF() statements. You will review all of the major categories of functions 
in Chapter Seven, as well as learning about Text functions. Chapter Eight is the longest chapter in the 
course, and in that chapter you will learn about Financial and Math functions. Additionally, you will 
learn about methods of estimating value and use the Find and Replace functionality. In Chapter Nine, 
you will learn about Date, Statistical, and Lookup functions. You will take also a brief tour of database 
functions. Chapter Nine ends with a discussion of Data Validation and using the Text to Columns 
functionality. Chapter Ten is an expansion of Chapter Nine, where you will learn some of the advanced 
uses of Lookup functions. In this chapter, you will also learn about Logical functions, and you’ll finish 
the chapter by building a complex spreadsheet that calculates bonuses based on numerous criteria. 
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CHAPTER SIX — INTRO TO FORMULAS AND FUNCTIONS 
 
 

Chapter Objectives: 
 

•    Determine which functions to use when writing formulas
•    Recognize Arithmetic, Comparison, and Text Operators that are usable in Excel formulas
•    Identify conditional arguments within the IF() function
•    Select functions and formula argument definitions using the Insert Function dialog box
•    Recognize formula performance with nested IF() logic
•    Identify the purpose of an Assumptions Page
•    Recognize the reason why to not hard-code variables into formulas
•    Identify a defined data set as a Named Range
•    Select a calculated and a formatted number within a text string using concatention
•    Choose the components of the TEXT() function to identify cell content categories

Projects You Will Complete During This Chapter:

•	 myJune_Sales.xlsx

CPE Credits possible for this chapter: 2
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Introduction
Soon after graduation from college in the 1980s, I began working at a Big 8 accounting firm. I quickly 
became the spreadsheet guy in the office. There weren’t too many people at the time who had significant 
spreadsheet experience, and I was very lucky to be one of the few who knew my way around a computer. 
Many people asked me to put their data into a spreadsheet. Most of the time was spent just inputting their 
data using Lotus 1-2-3 and summing it up, and maybe a few sorts. One day a manager came to me with a 
fun project. He had mailed out surveys to some clients and the completed surveys were coming back in. 
He wanted a program written where a clerk could enter the data from the survey onto a spreadsheet and 
press a button that would copy the data into a database and refresh the screen to be ready to enter a new 
survey. It sounded real interesting, so I took it on.  
 
I spent about a day programming it and came up with the greatest spreadsheet ever created! It took about 
180 keystrokes to enter in all of the information from one survey. I was so proud of that program! I took 
the 5 1/4” floppy disk to him (which tells you how long ago that was) and proudly gave it to him. I felt 
like I had really accomplished something great that day. After about an hour, he came back, gave me 
the diskette and said, “I made some changes to it. You may want to look them over.” My first thought 
was, “YOU made changes to MY spreadsheet? How dare you mess with perfection!” I slapped in the floppy 
diskette to see what he had done, and I got the education of a lifetime. He had completely torn apart my 
spreadsheet and built it back up again, and it was SO much more efficient. Instead of 180 keystrokes, it 
now took only about 90. He had formulas and functions that I had never heard of before. Truly, this man 
was a spreadsheet god!  
 
In the following chapters, I will introduce you to many functions – and how to use them in writing some 
very useful formulas. A formula is a logical equation that performs calculations on the spreadsheet. A 
formula always begins with an equal sign (=), and may or may not include one or more functions. But 
before we get into an in-depth discussion of functions, let’s talk about operators. Operators are critical 
in writing formulas, and it is imperative that you understand them. Operators are special characters that 
specify the type of calculations performed in formulas. Excel offers three types of operators: Arithmetic, 
Comparison, and Text. 

Arithmetic Operators  
Arithmetic operators perform basic mathematical operations, such as addition, subtraction, 
multiplication, division and exponentiation. 

Arithmetic Operators Definition (Example)
+ (Plus sign) Addition (3+3, 3 plus 3)
- (Minus sign) Subtraction (4-2, 4 minus 2), or Negation (-5, negative 5)
* (Asterisk) Multiplication (6*5, 6 times 5)
/ (slash) Division (12/8, 12 divided by 8)
^ (Caret) Exponentiation (3^2, or 3 squared)

In formulas, the precedence of arithmetic operators (or the order in which they work) perform just like 
you learned in high school algebra: 
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1. ^, Exponentiation 
2. * and / — Multiplication and Division 
3. + and - — Addition and Subtraction 

Let’s try an example. 
 

1. Open Excel to a Blank workbook. 
2. Input the following numbers in the corresponding cells: 
 A1: 5; A2: 3; A3: 4; A4: 8; A5: 2; A6: 2 
3. Write the following formula in Cell B1: =A1+A2*A3-A4/A5^A6  

Figure 6.1

The result of this formula is 15. You can change the order of precedence by putting parentheses () around 
the part of the formula you want calculated first: 
 

4. Edit the formula in Cell B1 to include parentheses around A1+A2. 
 

Figure 6.2

The result changes to 30. In some formulas, parentheses aren’t necessary, but sometimes it helps to 
include them to help you organize your logic, particularly in long, complex formulas. 
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5. Close the file (no need to save it). 

Comparison Operators  
Now let’s talk about Comparison operators. Comparison operators are used to compare two values to 
each other.
 
Comparison Operators Definition (Example)
= (Equal sign) Equal to (A1=B1, A1 is equal to B1)
> (Greater than sign) Greater than (A1>B1, A1 is greater than B1)
< (Less than sign) Less than (A1<B1, A1 is less than B1)
>= (Greater than or equal to) Greater than or equal to (A1>=B1, A1 is greater than or equal to 

B1
<= (Less than or equal to) Less than or equal to (A1<=B1, A1 is less than or equal to B1)
<> (Not equal to) Not equal to (A1<> B1, A1 is not equal to B1)

The IF() Function 
When using comparison operators, it is helpful to understand how to use the IF() function. In my 
opinion, Excel is the best “what-if” tool available, and the IF() function is central to “what-if” scenarios. 
In this and later chapters, you will see many examples using the IF() function. According to Microsoft 
Excel Help, the IF function “Use the IF() function, one of the logical functions, to return one value if a 
condition is true and another value if it’s false”. The IF() function is a statement that is written to check 
whether or not a condition is met, and has one condition and two arguments. First is the logical_test, or 
the condition to be evaluated. Next is the argument if the condition is true, followed by the result if the 
condition is false. Arguments and conditions in all functions are separated by commas (,). Let’s work 
some examples of how to use the IF() function and comparison operators. 

1. Open the file C:\ExcelCEO\Excel 2016\Chapter6\June_Sales.xlsx. 
2. Save As C:\ExcelCEO\Excel 2016\Chapter6\myJune_Sales.xlsx. 

 

Figure 6.3
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This file contains the sales by store for the month of June 2016. It includes fields for Region, State, 
Store_No, Year, Month, Sales, and Budget. The Budget is the monthly  amount of sales that each store is 
supposed to sell. If the store reaches or surpasses 100% of Budget, the store manager gets a bonus of 1% of 
the sales for that store. Stores are categorized by small, medium, and large stores. Management calls these 
levels Paper (small), Scissors (medium), and Rock (large) stores. Your job is to create a schedule using this 
data that identifies: 
 

•    The percent of Budget the store attained (call this column %_Budget, calculated as the Sales 
divided by the Budget, formatted as Percent, one decimal place), 

•    An indication if the manager receives a bonus (call this column Qual_Bonus, calculated as 
“Yes” if the store’s sales for the month are at least 100% of Budget, and “No” if it is not), 

•    The amount of bonus the store manager receives (call this column Bonus_Amt, calculated as 1% 
of Sales if the previous column is “Yes”, otherwise 0, formatted as Number with one decimal 
place), and 

•    The type of store it is: Paper, Scissors, or Rock (call this column Store_Type, calculated as: 
Paper if the Budget is less than or equal to $50,000, Scissors if the Budget is $70,000, Rock if the 
Budget is $100,000). 

Let’s get started.

3. In Cell H1, type: %_Budget 
4. In Cell I1, type: Qual_Bonus 
5. In Cell J1, type: Bonus_Amt 
6. In Cell K1, type: Store_Type 
7. Underline all titles and resize all columns as necessary. 
8. In Cell H2, type the formula: =F2/G2 

This formula tells Excel to divide the Sales (Cell F2) by the Budget (Cell G2). 
 

9. Format Cell H2 as Percentage with one decimal place, and copy the formula down to all cells 
below.  
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Figure 6.4

It worked very well, at least most of it. In Cell H14, the formula returned #DIV/0!, which is the divide by 
zero error message. This error occurs when you try to divide a number by zero, which is mathematically 
impossible. To correct this, you need to edit the formula to reflect the following logic: if the Budget (or 
the number on the bottom) is zero, then return a zero, otherwise divide Sales by the Budget (i.e.- the 
formula that we wrote). We can do that by using an IF() function.  

Insert Function Dialog Box  
There are basically two ways to write an IF() statement: 1) Type the formula directly into the Formula 
Bar, and 2) Use the Insert Function dialog box. In this course, you will be writing most formulas directly 
into the Formula Bar, but sometimes it helps to use the Insert Function dialog box, particularly when 
using complex functions. In the next exercise, you will write an IF() statement using the Insert Function 
dialog box. 

1. Delete the formula in Cell H2. 
2. Click on the Insert Function button  to the left of the Formula Bar.  
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Figure 6.5

The Insert Function dialog box appears.  
 

3. In the Search for a function box, replace the existing text with IF, and click Go. 
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Figure 6.6

The Select a function: box below is now filtered for all functions that are similar to an IF() function, 
including lots of logical functions. 
 

4. Make sure IF is selected in the Select a function box, and click OK.  
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Figure 6.7

At this point, the Function Arguments dialog box appears. In this box, you can type in the arguments, 
conditions and criteria for the function to work. The text boxes in the Function Arguments box change 
according to the function you chose, as the arguments, conditions and criteria are different for most 
every function. In our case, we’re using the IF() function. 
 

5. In the Logical_test box, type (or click on) G2=0. 
6. Press the [Tab] key to move to the next box.  

Figure 6.8

The first logical test evaluates if the value in Cell G2 is equal to zero. In the case of Cell G2, it’s not zero 
(the value in Cell G2 is 70,000), so the condition tested FALSE, hence the FALSE reference in the Logical_
test box. The next two boxes return the value if the condition is TRUE or FALSE, respectively. 
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7. In the Value_if_true box, type 0 (as we want the formula to return a zero if the Budget or 
denominator is 0), and press [Tab] to move to the next box. 

8. In the Value_if_false box type F2/G2, and press the [Tab] key.  
 

Figure 6.9

Now the dialog box returns the right answer for the formula at the bottom left of the dialog box where it 
reads “Formula result =  97.9%”. 

9. Click OK. 

Figure 6.10
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You now return to the spreadsheet where the formula in Cell H2 reads “=IF(G2=0,0,F2/G2)”. The formula 
says if the denominator (Cell G2) is zero, then return a zero as the result. If the denominator is not zero, 
then perform the calculation F2/G2. That is exactly what we want, so you can copy the formula to the 
cells below. 
 

10. Copy the formula down for all cells below. 
 
The result in Cell H14 now reads 0.0%, which is correct. 

Review Questions: It is now time to complete the hands-on Review Questions. 
Log on to www.ExcelCEO.com with your Email address and Password, click 
on the Excel 2016 Review Questions, Chapter 6, Section 1 of 2 option in 
your Main Menu, and complete the Review Questions.

Now that we have all of the %_Budget numbers calculated correctly, we can write a formula in Column I 
that will calculate if the manager of that store receives a bonus or not.  

Note: For the remainder of the course, you will type the formulas into the cell 
or Formula Bar without using the Insert Function dialog box. I want you 
to do this to get used to typing the formulas and functions as it is important 
for your future programming experience. If you think you need to use Insert 
Function dialog box to help you better understand the function, feel free to 
use it. 

 
11. In Cell I2, type the following formula: =IF(H2>=1,“Yes”,“No”) 

Tip: When typing a text string as part of a formula, as with “Yes” and “No”, 
remember that these results are different when evaluated as compared to 
TRUE and FALSE, which are logical argument evaluations. If you type 
quotation marks around values, they are evaluated as text strings, so make 
sure to distinguish between text strings and logical argument evaluations.

This formula says that if the result in Cell H2 is greater than 1 (meaning if the sales was more than 100% 
of budget), return the word “Yes”, indicating the store manager qualified for a bonus. Otherwise, return 
“No”. 
 

12. Copy the formula down to all cells below.  
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Figure 6.11

As shown in this example, an IF() function can return text strings as well as numbers. Whenever you 
want to type a text string like “Yes”, “No”, “Gold”, “Blue”, or “01ABC” within a formula or function, you 
must put that string between quotes. Now let’s calculate the bonus. 
 

13. In Cell J2, write the following formula: =IF(I2=”Yes”,F2*0.01,0) 
 
This formula means that if the store qualifies for a bonus, take the amount in the Sales column and 
multiply it by 0.01, or 1%. Otherwise, return a zero. Alternatively, you could have written a formula like 
=IF(H2>=1,F2*0.01,0). Either one would work. 

14. Format Cell J2 for Number, two decimal places, with 1000 Separator(,) and copy down.  

Figure 6.12
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Nesting IF() Functions 
In this next exercise, you will determine the store type, which is a little trickier. Instead of just one 
condition, there are three conditions. Luckily, you can use multiple IF() functions within one formula. 
In Excel 2003, you were limited to seven functions in one formula. But from Excel 2007 to 2016, you can 
write up to 64 functions in a single formula. New for Excel 2016 is the IFS() function which allows for 
up to 127 logical arguments! I don’t recommend using that many functions in one cell unless you want 
to drive a first year auditor (and possibly yourself) to the funny farm. Using multiple functions in one 
formula is called nesting functions. Excel evaluates logic within a formula from left to right, so the first 
IF() function you write is evaluated first, the second is evaluated next, and so on. When writing multiple 
functions in a formula, you have to remember to place the parentheses in the right places. Let’s try it. 

15. In Cell K2, write the following formula: 
=IF(G2<=50000,“Paper”,IF(G2<=70000,“Scissors”,“Rock”)) 

The first argument in the formula says if the number in the Budget column (Column G) is less than or 
equal to 50,000, then return “Paper”. If it is not less than or equal to 50,000, then we’ll write another 
test, which is if the Budget column is less than or equal to 70,000, return “Scissors”. For everything else, 
return “Rock”. All numbers will fall into one of these three categories. Sometimes it is confusing doing 
the condition in the middle, which could also be phrased as if the Budget is between 50,000 and 70,000 
then return “Scissors”. But since Excel evaluates conditions from left to right, we’re OK. 
 

16. Copy the formula down to all cells below.  

Figure 6.13

17. In Cell A31 type: TOTALS 
18. Write formulas in Row 31 that sum the Sales, Budget, and Bonus Amt columns, and copy 
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the formula that calculates the % Budget to Row 31. 
19. Bold Row 31, and resize the columns as necessary. 

The Total Bonus should be $20,703.64. Pretty cool analysis, huh? Do you want to make it even better? 
Stay with me for a little while longer.   

Assumptions Page  
One thing I like to do in my spreadsheets, particularly if the variables I’m using could change, is to 
include all variables on one page called an Assumptions Page. An Assumptions page is simply a tab or 
sheet that contains any possible variable that may change. Let’s do that now. 
 

1. Insert a new sheet tab and rename it Assumptions. 
2. Click and drag the  tab to the left of the  tab, and release. 

 
This repositions the Assumptions tab to the left of the June_Sales tab. I prefer to have the Assumptions 
tab as the first tab in the workbook. 
 

3. Right-click on the  tab, point to Tab Color, and click on Red. 

Sometimes I like to make a tab a different color so it will stand out. 
 

4. On the  tab, in Cell A1 type: Bonus Percent 
5. In Cell A3, type: Total Bonus Payable 
6. Resize Column A to fit. 
7. Input 0.01 into Cell B1 and format it as Percent, one decimal place. 
8. Click on Cell B3. Type the = sign, then click on the June_Sales tab, click on Cell J31, and press 

[Enter]. 
9. Make sure Cell B3 is formatted as a Number, two decimal places. 

Figure 6.14

The formula in Cell B3 of the Assumptions tab should now read: =June_Sales!J31. This is Excel’s way of 
linking to cells in other tabs. Note the exclamation point (!) separates the cell reference (J31) from the tab 
named June_Sales. 
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10. Click on the June_Sales tab, Cell J2. 

The formula in Cell J2 of the June_Sales tab currently reads: =IF(I2=”Yes”,F2*0.01,0). The “0.01” reference 
is hard-coded, meaning that it is a number, value, or text string that is written into the formula and 
cannot change, unless someone changes or retypes the formula. It is my heartfelt belief that numbers in 
a formula should NEVER be hard-coded. I always set up another tab, like the Assumptions page, where 
I can store all of the variables. If your manager asked you to change that number to 0.015 just to see how 
much bonus would be paid out, you would have to go into each cell and make that change (or at least 
change it in one cell and copy it to all others). We want to make it REAL EASY for the manager to change 
any variable he wants and immediately see the results. That is why I believe that Excel is the best “what 
if” tool available today — it is SO EASY to set up these kinds of analyses. 
 

11. In Cell J2 of the  tab, select 0.01 with your mouse, click on the 

 tab, click on Cell B1, press the [F4] key once to make Cell B1 an 

Absolute Reference, and press [Enter].  

Figure 6.15

The formula in Cell J2 of the June_Sales tab should now read: =IF(I2=”Yes”,F2*Assumptions!$B$1,0) 
 

12. Copy the formula down for all cells, except the last cell that contains the total summation. 
 
This formula means that if Cell I2 is “Yes”, then multiply Cell F2 by whatever value is in Cell B1 on the 
Assumptions tab. When you copy the formula down, the Assumptions!$B$1 remains the same in all 
Formulas, hence the use of the absolute reference. The total Bonus_Amt column should still be 20,703.64. 

13. Click on Assumptions tab, Cell B1. 
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14. Change the Bonus Percent cell (Cell B1) to 0.015 (or 1.5%), and press [Enter].  
 

Figure 6.16

Instantaneously, the Total Bonus Payable changes to $31,055.46. Now your manager can use any bonus 
percent he wants and can instantly see the change in the total bonus payable.  

Named Ranges  
Sometimes while writing formulas, it is confusing looking at a reference like Assumptions!$B$1. If you 
wanted to see what value is contained at Assumptions!$B$1, you would have to click on that tab and 
find that particular cell. Excel has a way that you can rename a cell or a range of cells to something that 
makes a little more sense and easier to program and audit in formulas. This is called a Named Range 
sometimes called a List Range. A Named Range is a word or string of characters that represents a cell, 
range of cells, formula, or constant value. It’s a good idea to use easy-to-understand names when naming 
ranges. In the next exercise, we will create an input called Bonus Entry Point and create a named range 
called EntryPoint and refer to it in the formula. 
 
Let’s suppose your manager wants to know how much would be paid if the entry point to start earning a 
bonus was raised to 110% instead of 100%. That’s easy, since we know how to do it. 
 

1. On the Assumptions page, insert two rows below Row 1. 
2. In Cell A3, type: Bonus Entry Point 
3. In Cell B3, type 110%  
4. Format Cell B3 as Percent, zero decimal places. 
5. With your cursor on Cell B3, click in the Name Box just above Column A (it should read B3), 

type EntryPoint, and press [Enter].  

Figure 6.17
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Typing EntryPoint in the Name Box creates a name for that cell. Note that you cannot use spaces or 
wildcard characters (*, ? or ~) in a Named Range name. You can also create Named Ranges for multiple 
groups of cells, which we will do in later chapters. 
 
Since the Bonus_Amt field in the June_Sales tab refers to the Qual_Bonus field to determine if the store 
earned a bonus or not, all we have to do is modify the Qual_Bonus formulas and the bonus calculation 
should be correct. Let’s try it. 
 

6. Click on Cell I2 of the  tab. 

7. Replace the formula:  =IF(H2>=1,“Yes”,“No”)  with =IF(H2>=EntryPoint,“Yes”,“No”), then 
press [Enter]. 
 

Notice there are no quotes around EntryPoint. This is because it is not a text string, but a Named Range, 
which Excel recognizes just like a value. Notice the Named Range tag that appeared as you typed 
EntryPoint into the formula. You can click to add and it shows the Named Range from Name Manager.

8. Copy the edited formula down to all cells below. 
9. Click on the  tab. 

The Bonus Payable is now $26,037.41. At this point, you can change the Bonus Percent and/or the Bonus 
Entry Point to anything you want and the Bonus Payable will immediately re-calculate. 
 

10. Change the Bonus Percent to 1.2%, and the Bonus Entry Point to 105% (Answer: 
$22,355.82)  

By using Comparison Operators and the IF() function in writing formulas, you are limited only to your 
creativity.  

Text Operators  
Now let’s take a look at Text Operators. The most useful Text operators are the Ampersand sign (&) and 
the quote (“). 

Text Operators Definition (Example)
& (Ampersand) and 
“ ” (Quote)

Connects or concatenates two values to produce one contiguous text string. 
Example: Assuming Nitey-Nite is in Cell A1 and Mattresses is in Cell B1, 
=A1&“ ”&B1 produces Nitey-Nite Mattresses

Concatenation 
Let’s try an example using text operators on the Assumptions tab. In this example, you will write a 
sentence that contains the amount of the Bonus Payable concatenated within the phrase. 
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1. On the Assumptions tab, Cell A7, type: =“The Total Bonus Payable is ”&B5  

Figure 6.18

The TEXT() Function  
 The number for the Total Bonus Payable is correct, but it’s not formatted. To format a number within a 
﻿concatenation string like this, you need to use the TEXT() function. The ﻿TEXT() function formats text 
into almost any kind of format. In our case, we want to format the result in a currency format. This is 
how to do it: 
 

2. Edit the formula in Cell A7 to be as follows: 
 =“The Total Bonus Payable is ”&TEXT(B5,“$0,000.00”)  

Figure 6.19

Notice that the ﻿TEXT() function has two arguments: the cell reference or string you want to format, 
and the format type. The format type is surrounded by quotes. I encourage you to play around with this 
function and try to create some of your own formats. To create a Percent format with one decimal place, 
the format type would be “0.0%”. To concatenate more text at the end of the formula, simply type the & 
sign followed by a quote and the text you want. If the formula ends with a function, you can simply end 
the formula with the closing parenthesis. Otherwise, you need to end the formula with an ﻿ampersand 
sign and a quote. Let’s suppose you want to end the sentence with a period and then a statement that says, 
“Please forward to the Accounts Payable department.” 
 

3. Edit the formula in Cell A7 to be as follows: 



ExcelCEO 

            Chief Excel Officer

SECTION 2: Intermediate Excel   —   Intro to Formulas and Functions

155

Chapter 6

=“The Total Bonus Payable is ”&TEXT(B5,“$0,000.00”)&“. Please forward to the Accounts 
Payable department.” 

Figure 6.20

4. Now change the Bonus Percent to be 1.8%. 
 
 The Total Bonus Payable AND the Bonus sentence change when the Bonus Percent is modified. 

5. Save and close the myJune_Sales.xlsx file. 

 Text Operators make it simple to put data in an English sentence which makes it easy for people who 
don’t do well with numbers on a spreadsheet. You will find this very useful for putting two or more 
strings of data together in one cell. 

Review Questions: It is now time to complete the hands-on Review Questions. 
Log on to www.ExcelCEO.com with your Email address and Password, click 
on the Excel 2016 Review Questions, Chapter 6, Section 2 of 2 option in 
your Main Menu, and complete the Review Questions.  

Conclusion  
 In the chapter, you learned the basics of writing formulas. Behind the basics of formula-writing are 
Arithmetic, Comparison, and Text Operators, which you should now know very well. You were 
introduced to the IF() function, which is one of the most common functions you will use in Excel. To 
help you write an IF() function (or any other function), you were exposed to the Insert Function dialog 
box. You learned how to use multiple IF() functions in a formula, which is called nesting functions. You 
developed an ﻿Assumptions page where you stored all of the variables used in your analysis. Using an 
﻿Assumptions page makes it useful to avoid hard-coded numbers into formulas. You also created a ﻿Named 
Range, which makes writing and auditing formulas much easier. Finally, you concatenated a calculated 
number and formatted it using a TEXT() function within a text string, making an accurate, easy-to-
understand, and updatable sentence.  

Chapter Exam  
  To take the examination for this chapter, you must have successfully completed the examination for the 
previous chapter. You can now go to www.ExcelCEO.com, click on Sign In, log in and take the exam. 
Make sure that you take the exam on the same computer on which you completed the practice files, 
as some of the questions on the exam may refer to some of the completed projects. Chapter exams are 
intended to be hands-on. 
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CHAPTER SEVEN — TEXT FUNCTIONS 
 

Chapter Objectives: 
 

•    Recognize uses for capabilities with text functions
•    Select the correct arguments in a LEFT() function 
•    Indicate the correct arguments in a MID() function
•    Identify how the LEFT(), RIGHT(), MID() functions work 
•    Indicate the proper uses for the UPPER(), LOWER(), and PROPER() functions 
•    Identify the correct use of a PROPER() function 
•    Indicate when to use the LEN() function into a formula to count characters  
•    Determine how to remove extra spaces with the TRIM() function 
•    Identify the proper uses of the VALUE() function
•    Recognize the way Flash Fill recognizes and displays patterns based on user inputs 

Projects You Will Complete During This Chapter:
 

•	 myEmployees.xlsx 

CPE Credits possible for this chapter: 2
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Introduction
I LOVE writing Formulas. Here are two of my favorites:

=IF(ISERROR(VLOOKUP(MATCH(G5,Assumptions!$E$3:$E$10,1),Assumptions! $D$3:$F$10,3,FALSE)*
D5),0,VLOOKUP(MATCH(G5,Assumptions!$E$3:$E$10,1),Assumptions!$D$3:$F$10,3,FALSE)*D5) 
 
This one calculates a bonus based on a criteria table. It’s similar to the one we did in Chapter 6, but it does 
everything in one cell. 
 
=MID(B2,FIND(“,”,B2)+2,100)&“ ”&LEFT(B2,FIND(“,”,B2)-1) 
 
This formula takes a name which is formatted as “LastName, FirstName” in Cell B2 and switches it to a 
“FirstName LastName” format. You will become an expert at this formula in this chapter. 
 
This is what the meat of Excel is all about – writing formulas. In this and the three following chapters, 
you will work many examples using popular and useful functions. Following are the most common 
functions I have used. There are  lots of other functions in Excel. However, in my work as an accountant 
and financial analyst, these are some of the ones I’ve found to be most useful: 

Common Functions (* New since Excel 2010)

TEXT FINANCIAL DATE & TIME
FIND() FV() DATE()
LEFT() IRR() DAY()
LEN() NPV() MONTH()
LOWER() PMT() NOW()
MID() PV() TODAY()
PROPER() WEEKDAY()
RIGHT() MATH YEAR()
SEARCH() ABS()
TEXT() INT() STATISTICAL
TRIM() RAND(),  RANDBETWEEN() AVERAGE()
UPPER() SUM() AVERAGEIFS()*
VALUE() ROUND() COUNT()

SUMIF(), SUMIFS()* COUNTIF()
LOGICAL COUNTIFS()*
AND() LOOKUP & REFERENCE MAX()
CELL() HLOOKUP(),  VLOOKUP() MEDIAN()
IF(), IFS()* INDEX() MIN()
ISERROR(),  IFERROR()* LOOKUP() MODE()
OR() MATCH() RANK()
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Text Functions 
Let’s first talk about Text Functions. Text functions are basically things you can do with text strings. 
 

1. Open the file C:\ExcelCEO\Excel 2016\Chapter7\Employees.xlsx. 
2. Save As C:\ExcelCEO\Excel 2016\Chapter7\myEmployees.xlsx. 
3. Click on the  tab. 

 
This file is a list of the employees at Nitey-Nite Mattresses. Note that the names in this tab are in a Last 
Name, First Name format. We’ll use this list of names as the example behind your lesson on TEXT 
functions. In the next few pages, you will write a formula in one cell that will turn these names from a 
Last Name, First Name format into a First Name Last Name format. To accomplish this, you will write 
a series of formulas using only TEXT functions to break apart the first and last names, and then write 
a formula to put it back together again. (We WILL do better than all the king’s horses and all the king’s 
men). The trick is to write one formula that will accomplish all of this. We will use some of the TEXT 
functions listed at the beginning of this chapter, as well as our experience in working with concatenating 
strings you learned in Chapter 6 to accomplish it. But first, let’s go over each function.  

The FIND() and SEARCH() Functions  
The first text functions we’ll learn how to use are the FIND() and SEARCH() functions. The FIND() 
function finds a text string (find_text) within another text string (within_text), and returns the number 
of the starting position of the find_text, from the first character of the within_text. You can use the 
SEARCH() function to find one text string within another, but unlike SEARCH(), FIND() is case-
sensitive and doesn’t allow wildcard characters. Following is the list of wildcard characters used in Excel. 

Wildcard Character Using SEARCH() Finds:
? (Question mark) Any single character 

Example: sm?th finds 
“smith” and “smyth”

* (Asterisk) Any number of characters 
Example: *east finds 
“Northeast” and “Southeast”

~ (Tilde) followed by ~?, ~* to 
find the ? or * characters

A question mark, asterisk, or tilde 
Example: How does this work? 
“How does this work~?”

 
The FIND() and SEARCH() functions have two required arguments and one optional argument. The 
first argument is the find_text, or the text you want to find. The second argument is the within_text, or 
the string in which you want to search. The optional argument is the start_num argument. You use this 
optional argument when you don’t want to start at the first character in the string. The functions return 
the number position of the text string you’re searching for and then other functions return the actual 
value. In the next example, you’ll use the FIND() function, although writing either function would work. 

In this example, we want to find the number position of the comma (,) in the cells that contain the 
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employees’ names. The comma is the common character in all of the names, and so it acts as a sort of 
anchor we can use to tell Excel where to split the names. You may not understand why we do this right 
now, but humor me for a few minutes and follow along. 
 

4. In Cell F1, type: Find 
5. In Cell F2, type: =FIND(“,”,C2)  

Figure 7.1

The result of this formula is 8, meaning that the comma in Cell C2 is in the eighth character from the left 
in the string: Goodson, Virgetta. 
 

6. Copy the formula in Cell F2 down to all cells below. 
 
You see that the comma in the next few cells is found as the sixth character, the ninth character, and so 
on. FIND() is a very simple yet valuable function that returns a simple value. 

The LEFT() Function  
The LEFT() function returns the left-most characters in a text string, based on the number of characters 
you specify. This function has two arguments: first is the text from where you want to extract the string. 
Second is the number of characters you want to extract, starting from the first character on the left. Let’s 
work an example. 
 

7. In Cell G1, type: Last Name 
8. In Cell G2, type the following formula: =LEFT(C2,7)  
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Figure 7.2

This formula tells Excel to return the left seven (7) characters in the text string in Cell C2. The result 
is “Goodson”. In this manner, we can extract that last name of the names in Column C. However, the 
last name won’t always be seven characters long, like we programmed into the function. How can we 
calculate the length of the last name? Well, we’ve already calculated where the comma is, and the last 
name will always end one character before the comma. For “Goodson, Virgetta”, the comma is the 
eighth character, so the last name should be at the comma (or the eighth place) less one. Let’s modify our 
formula to see if that works. 
 

9. Edit the formula in Cell G2 to the following: =LEFT(C2,F2-1) 
10. Click [Ctrl]+[Enter] to copy down to all cells below, and resize Column G as needed.  

Figure 7.3

That seems to work. All we’re doing here is taking the number in Column F less one to populate the 
num_char argument in the LEFT() function. 
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The RIGHT() Function  
The RIGHT() function operates in the same way as the LEFT() function, except it returns characters from 
the right. 

11. In Cell H1, type: First_Name 
12. In Cell H2, type the following formula: =RIGHT(C2,8)  

Figure 7.4

Again, hard-coding the “8” in this formula will work for the first cell, and it will work for all first names 
with eight characters, but it won’t work for all names. In this case, we could use a nested left/right 
function to extract the correct value, but it’s a lot easier to use the MID() function.  

The MID() Function  
The MID() function operates in the same manner as the LEFT() and RIGHT() functions, with one 
additional argument – it requires you to specify which character to start on. 
 

13. In Cell H2, delete the previous formula, and type this formula: =MID(C2,10,8) 

Figure 7.5

This formula tells Excel to return the eight right-most characters starting from the 10th character from 
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the left. When we analyze all the names in the list, there are two variables we need to calculate: first, 
the character to start on, and second, how many characters are in the first name. Since we’ve already 
calculated the position of the comma, we know that the beginning character of the first name is always 
going to be at the comma plus two (remember to include the space after the comma as a character). I 
usually put 100 as the number of characters in the first name, as I don’t know ANY first names with more 
than 100 characters. This way, Excel will return all of the characters in the first name. Don’t worry - if 
there are less than 100 characters in the first name, this exercise will not add spaces to make up for the 
missing characters. Let’s try it. 
 

14. Edit Cell H2 to the following: =MID(C2,F2+2,100) 
15. Copy down to all cells below, and resize columns as necessary.  

Figure 7.6

Since you already know how to concatenate cells, all you have to do now is to write a formula in Cell I2 to 
put the first name and last name together. 

16. In Cell I1, type: Full Name 
17. In Cell I2, type the following formula: =H2&“ ”&G2 
18. Copy down to all cells below and resize the column as necessary. 

We now have the full name, but we would like to put the formula in ONE cell. So far, we have used four 
columns to come up with the full name. To put it all in one cell, all we have to do is some copying and 
pasting. As you can see, the formulas so far contain cell references. Let’s put the formula together! 
 

19. Click on Cell H2. 
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20. With your cursor, highlight the entire formula in the Formula Bar without the “=” sign, press 
[Ctrl]+c to copy the formula into memory, then press [Esc] to take the action out of copy 
mode. 

Figure 7.7

All we did here was to put the formula in Cell H2 (without the “=” sign) into memory. 

21. With the formula in Cell H2 now in memory, click on Cell I2, highlight H2 in that formula, 
press [Ctrl]+v (to paste the H2 formula), and press [Enter]. 

The formula in Cell H2 should now read as follows:  
=MID(C2,F2+2,100)&“ ”&G2 
 
All we did was to replace H2 with the formula in Cell H2. Let’s do the same for Cell G2. 
 

22. Click on Cell G2. 
23. With your cursor, highlight the formula (without the “=” sign), press [Ctrl]+c to copy the 

formula into memory, and press [Esc] (to take the action out of edit mode). 
24. With the formula in Cell G2 in memory, click on Cell I2, highlight G2 in the formula, and 

press [Ctrl]+v (to paste the G2 formula) and press [Enter]. 
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Figure 7.8

The formula in Cell I2 should now read as follows:  
=MID(C2,F2+2,100)&“ ”&LEFT(C2,F2-1)  

Come to think of it, the two occurrences of F2 in this formula are also formulas, so we can replace those 
references as well. 
 

25. Click on Cell F2. 
26. With your cursor, highlight the formula (without the “=” sign), press [Ctrl]+c to copy the 

formula into memory, and press [Esc] (to take the action out of edit mode). 
27. With the formula in Cell F2 in memory, click on Cell I2, highlight the first occurrence of F2 

in the formula, and press [Ctrl]+v (to paste the F2 formula), then do the same for the second 
occurrence of F2, and press [Enter]. 

 
The formula in Cell H2 should now read as follows:  
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=MID(C2,FIND(“,”,C2)+2,100)&“ ”&LEFT(C2,FIND(“,”,C2)-1) 

Figure 7.9

28. Copy down to all cells below and resize the column.  

At this point, you don’t need Columns F, G, and H, so you can delete them. 
 

29. Delete Columns F, G, and H.  
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Figure 7.10

Review Questions: It is now time to complete the hands-on Review Questions. 
Log on to www.ExcelCEO.com with your Email address and Password, click 
on the Excel 2016 Review Questions, Chapter 7, Section 1 of 2 option in 
your Main Menu, and complete the Review Questions. 

The UPPER(), LOWER() and PROPER() Functions 
There is another thing that we can do to clean up the formula just a little more. Look at Cell F25. The 
first name BLAIR is in caps, whereas all other names are in upper and lower-case. Excel has a formula 
to change text to upper-case, lower case or proper case. Proper-case is where the first letter of each word 
is capitalized and the remaining letters are lower-case. Let’s enclose our formula with the UPPER(), 
LOWER(), and PROPER() functions. 
 

30. Edit Cell F2 and input UPPER( just to the right of the “=” sign and close the formula with an 
ending parenthesis. 

 
The formula in Cell E2 should now read as follows: 

 =UPPER(MID(C2,FIND(“,”,C2)+2,100)&“ ”&LEFT(C2,FIND(“,”,C2)-1)) 
 
The name is now shown as VIRGETTA GOODSON. 
 

31. In the formula in Cell F2, replace the word UPPER with LOWER. 

The name is now shown as virgetta goodson. 
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32. In the formula, replace the word LOWER with PROPER. 
33. Copy down to all cells below. 

 
The PROPER() function capitalizes the first letter in a text string and any other letters in the text 
that follow any character other than a letter. It then converts all other letters to lower case. Using the 
PROPER() function in this formula now converts the name to Virgetta Goodson.  
 

Note: When you use the PROPER() function, names like Jim McGowen and 
Joe Smith III will appear as Jim Mcgowen and Joe Smith Iii. Although this 
function is very useful in some cases, there are still some quirks to using it. 

 
Tip: Work this example as many times as necessary to lock it in your memory. 

You will find MANY uses for formulas similar to this one.   

The LEN() and TRIM() Functions  
Now we’ll discuss the LEN() and TRIM() functions. These functions are very useful when analyzing data 
that may not quite be in the right format. Sometimes when data is copied or imported from one database 
to another, numbers are copied over as text strings and vice-versa. This sometimes happens when 
databases are not programmed correctly and sometimes it may add characters to the data that are almost 
invisible to the user. 
 

1. Click on the  tab of the myEmployees.xlsx file.  

Figure 7.11

This is a listing of the stores that Nitey-Nite Mattresses owns. It was copied directly from a SQL Server 
database and has not been cleaned up yet. Let’s suppose we want to create a formula in one cell that 
concatenates the Address, City, and State. 
 

2. In Cell I1 of the Stores tab, type: Location 
3. Format Cell I1 as the other headings. 
4. In Cell I2, type the following formula: =D2&“, ”&E2&“, ”&F2  



ExcelCEO 

            Chief Excel Officer

SECTION 2: Intermediate Excel   —   Text Functions

169

Chapter 7

Figure 7.12

This formula puts the Address, City, and State into one cell, separated by commas. After you type the 
formula, you see there is a long string of spaces after the address. It also appears there are some spaces 
before the address, as the address appears to be indented from the left. This adding of spaces happens 
frequently when data is copied from a poorly-designed database into Excel (or one that was designed to 
teach about poorly designed databases). Let’s play around with the Address field and see what is there. 
 

5. In Cell J2, type the following formula: =LEN(D2)  

Figure 7.13

The LEN() function counts the number of characters in the text string in Cell D2 (the address). The string 
“1082 Glynn Court” has only 16 characters (including two spaces), so the result of the formula should be 
16, but we see the LEN() function returned 30. This indicates that there are additional spaces before, after, 
and/or between the words in the address. You can solve the issue by enclosing the address with a TRIM() 
function. The TRIM () function removes all spaces from a text string except for one space between each 
word. 
 

6. Delete the contents of Cell J2. 
7. Edit the formula in Cell I2 to be the following:  
=TRIM(D2)&“, ”&E2&“, ”&F2 
8. Copy the formula down for all cells below, and resize the column. 

Now the concatenation of the Address, City, and State appears correctly.  
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Figure 7.14

The VALUE() Function  
Another useful function is the VALUE() function. This function turns numbers that are shown as text 
strings into numbers. For example, sometimes US ZIP codes contain five digits and sometimes ten digits 
(a five and four digit code separated by a dash). In this example, when the data was copied over from a 
database, Excel recognized the five digit codes as numbers and the ten digit codes as text, as you can’t 
have a dash character in a number. Let’s suppose that we really don’t care about the four digit extension – 
all we really want is the five digit ZIP code formatted as a number. 
 

9. In Cell J1, type New ZIP 
10. Format the heading like the others. 
11. In Cell J2, type the following formula: =LEFT(G2,5) 

Figure 7.15

When you use a text function like LEFT(), Excel turns the result into a text string. To make that text 
string a number, you must first be sure there are only numbers in the string. Then you can use the 
VALUE() function. 

12. Edit the formula in Cell J2 to be as follows: =VALUE(LEFT(G2,5)) 
13. Copy down for all cells.  
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Figure 7.16

Now you have a clean column with five-digit ZIP codes, all in a number format. You can usually tell if 
a number is formatted as text or as a number by 1) seeing if the number is left- or right-justified (a left-
justified number usually indicates it is text); 2) if you can add the number(s) (if the numbers don’t add up 
in the Status Bar, they are formatted as text), or 3) if the number(s) contains a leading zero (leading zeros 
indicate a text field). 
 

Trick: A quick and dirty way to turn a text string containing only numbers into 
a number format is to just add 0 at the end of the formula. (Actually, any 
mathematical calculation will work.) In this example, you would use this 
function: =LEFT(G2,5)+0. However, don’t tell this to programmers. Being 
the purists they are, they will tell you I’m crazy, but guess what. It works! Try 
it. 

14. Save the myEmployees.xlsx file, but don’t close yet. 

Flash Fill
Flash Fill is a feature new since Excel 2013 which allows you to quickly organize and reorganize data 
based on text patterns Excel detects from cell content in contiguous columns in your spreadsheet. In 
other words, the data in which you are establishing the pattern must be touching the cells immediately 
to the left. Flash Fill can break data apart, and put it back together in very sophisticated ways, even to the 
point of replacing many of the functions you learned earlier in this chapter. Rest assured you’ve learned 
those functions and formula-writing abilities for good reason! Flash Fill detects patterns, but you do have 
the ability to override them by clicking [Esc]. Since Flash Fill is setup to enhance your Excel experience, 
let’s see how it works.

1. In Cell K2, type the visible contents of Cell I2, followed by a comma, then the first five digits of 
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the ZIP Code in Cell G2.
2. In Cell K3, type the first three characters of what you see in Cell I3.

﻿
Figure 7.17

You will see the contents of Cell K3 expand to match Cell I3 plus the ZIP Code from Cell G3, and ghost 
text will appear in the remainder of the contiguous cells in Column K. At this point, you can either click 
[Enter] to accept the predicted pattern, or [Esc] to continue on your own, including if Flash Fill is not 
recognizing your pattern as intended.

Tip: If you find Flash Fill to not be working when you are typing the patterns 
specified, your Flash Fill may be disabled. To correct this, click the File tab, 
click Options on the bottom-left, which opens the Excel Options dialog box. 
On the Advanced tab, make sure the Automatically Flash Fill check box is 
checked.

3. Click [Esc] to halt the Flash Fill and press the [Enter] key.

 The Flash Fill data disappears, and Cell K3 expands to finish the pattern you began without copying the 
pattern down the remainder of the contiguous column.

4. With your cursor on Cell K3, click the Fill  icon in the Editing group of the Home tab.
5. From the Fill drop-down menu, click Flash Fill .
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Figure 7.18

 The text now copies down. Click on any cell in Column K to see that all the references are hard-coded 
into the cells as values rather than as formulas. While Flash Fill is very powerful and can extract data in 
some very creative ways, such as identifying and isolating email domain names in an email address, it 
is limited to cells adjoining on the left of the same spreadsheet to work. Once the values are established, 
you cannot update the way you would a formula any more than you could any other hard-coded values. 
For this reason, I still recommend you learn to master formula-writing, and the rest of the concepts I 
teach in this course, so you can be in control of your data, and be able to make updates quickly. 

6. Close the myEmployees.xlsx file without saving. 

Review Questions: It is now time to complete the hands-on Review Questions. 
Log on to www.ExcelCEO.com with your Email address and Password, click 
on the Excel 2016 Review Questions, Chapter 7, Section 2 of 2 option in 
your Main Menu, and complete the Review Questions.

Conclusion  
 In this chapter, you learned about many of the most common functions, and we explored in depth 
the various types of Text functions. You split apart a name in a last name, first name format using the 
FIND(), LEFT(), and MID() functions. You also worked an example using the RIGHT() function. You 
then concatenated the first name and last name fields in one impressive formula. You saw how to change 
the case sensitivity of text by working examples using the UPPER(), LOWER(), and PROPER() functions. 
You learned how to use the LEN() function to find out how many characters are in a cell. You used the 
TRIM() function to take out unnecessary spaces in a text string. You learned how to use a VALUE() 
function to turn a number formatted as text into a number. Finally, you used Flash Fill to give you 
another data input weapon in your arsenal.

Chapter Exam  
 To take the examination for this chapter, you must have successfully completed the examination for the 
previous chapter. You can now go to www.ExcelCEO.com, click on Sign In, log in and take the exam. 
Make sure that you take the exam on the same computer on which you completed the practice files, 
as some of the questions on the exam may refer to some of the completed projects. Chapter exams are 
intended to be hands-on. 
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CHAPTER EIGHT — FINANCIAL AND MATH FUNCTIONS 
 
 

Chapter Objectives: 
 

•    Identify the proper uses of Financial Functions, including PMT(), PV(), FV(), IRR(), and NPV() 
•    Determine the various parts on an amortization schedule
•    Recognize specific scenarios within Scenario Manager
•    Identify components of and create a Proforma Income Statement
•    Determine the procedure and appropriate Formulas necessary for a business valuation exercise
•    Select the appropriate functionalities for a Find and Replace procedure
•    Identify and use Math Functions, including RAND(), INT(), ROUND(), ABS(), SUMIF(), and 

SUMIFS() 

Projects You Will Complete During This Chapter:

•	 my1017_Mattresses.xlsx
•	 myAmort.xlsx
•	 myMath.xlsx
•	 myProforma.xlsx
•	 myScenario.xlsx

CPE Credits possible for this chapter: 3.5
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Financial and Math Functions  
I just LOVE math. My idea of a good time is solving algebraic problems on the white boards in my office. 
I do realize, however, that some people don’t share my enthusiasm for math. I’ll assume if you’ve made it 
this far in the course, you either share my enthusiasm or someone is forcing you to take it (hopefully the 
first).  

Financial Functions  
If you’ve ever taken a Finance class, you should remember the discussions on calculating a payment 
(PMT), Present Value (PV), Future Value (FV), Internal Rate of Return (IRR), and Net Present Value 
(NPV). With Financial functions, Excel makes it easy to calculate those values. Let’s begin with the 
PMT() function.  

The PMT() Function  
The PMT() function is one of the most commonly used functions for financial people. We always want to 
know what the payment is, particularly when we are analyzing our own home loan or applying for some 
other type of loan. The PMT() function has three required arguments: interest rate, number of periods 
and present value. You can also include two optional arguments: future value and type. Future value is 
the cash balance you want to have after the last payment is made. A type of one means payments are 
made at the beginning of the period, and a type of zero means payments are made at the end of the 
period. If the future value and type arguments are left out, Excel assumes a zero for each of the missing 
arguments. In this first exercise, you will calculate the mortgage payment for a $200,000 loan. 
 

1. Open Excel to a Blank workbook. 
2. Save As C:\ExcelCEO\Excel 2016\Chapter8\myAmort.xlsx. 
3. Type data onto the spreadsheet to look as follows:  

Figure 8.1

4. In Cell B4, type =PMT(B1/12,B2*12,B3) 
5. Format Cell B4 as Currency, two decimal places. 
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Figure 8.2

Let’s discuss the different parts of the formula. The interest rate in our analysis is 8%, which is an annual 
interest rate. To calculate a monthly payment, we have to convert the annual interest rate to a monthly 
interest rate. We do that by dividing Cell B1 by 12. The number of periods is 30, or 30 years. That is a 
common number of periods for a home loan. Again, this is an annual number that we need to convert 
into a monthly number, and we do that by multiplying the number of periods by 12. Finally, we input the 
present value of the loan, or $200,000. Note that we input that loan amount and not the sale price of the 
house. You can buy a $250,000 house and put $50,000 down for a loan amount of $200,000, or you can 
buy a $300,000 home with $100,000 down and you would have the same loan amount and payment. The 
payment is calculated on the loan amount, not the purchase price of the home. 
 
Notice that the formula returns a negative number. If the present value of the home is a positive number, 
then the payments should be negative to support that payment. One value is a cash inflow (the present 
value of the home) and the other is the cash outflow (the payments). You can make the payments be a 
positive number by simply putting a minus sign in front of the formula or the reference to Cell B3, but 
not in both places. 
 

6. In the formula in Cell B4, put a minus sign (-) before the reference to Cell B3.  

Figure 8.3

Create an Amortization Schedule  
Whenever you purchase a Home, the lending institution will give you an amortization schedule. An 
amortization schedule shows the loan balance after every payment, as well as the interest amount and 
principal applied to each loan payment. In this next exercise, we will create an amortization schedule for 
the home loan we’ve modeled.  
 

7. Type the labels in Cells A6 through F6 as follows: 
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Figure 8.4

8. In Cell A7, type: 1 
9. With your cursor on Cell A7, click the Fill icon in the Editing group of the Home tab and click 

on the Series... option.
10. In the Series dialog box, set the Series in radio button to Columns, keep Type set to Linear, 

and Step value is set to 1 (because we want to increase the count by one at a time).
11. In the Stop value box, type 360, then click OK. 

 
This action creates a column of payment numbers. Click [Ctrl]+[down arrow] to scroll down to Cell 
A366, and then [Ctrl]+[up arrow]. These commands take you down and up the column your cursor is in.
 

11. Freeze the panes at Cell A7. 
12. In Cell B7, type: 1/15/2017 
13. Format Cell B7 as Date in the format M/YYYY 
14. In Cell B8, type: =B7+(365.25/12) 
15. Using Format Painter, copy the format of Cell B7 to Cell B8. 
16. Copy Cell B8 down to all cells below ending at Payment No. 360.  

Figure 8.5
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Tip: To use DataFill for dates such as a payment due on the last day of the 
month, if such an issue arises, you could type 1/31/16 in Cell B7, 2/29/16 in 
Cell B8, 3/31/16 in Cell B9, select all three cells, double-click the DataFill 
button to make last days of each month appear. This accounts for leap years 
too. Be careful though, as this method does not update the way formulas 
do. Hopefully you are seeing why I recommend formulas in favor of “quick”, 
automated tools so much.

The last date in the range should be 12/2046. I like to begin using the 15th of the month and add 
365.25/12 (the .25 accounts for a leap year day every four years) for each month to get the next month. 
Trust me, if you start with the first day of the month, you will end up with some complications in 
February.

Next you will create names for the various cells to make it easier to write your formulas. We did an 
example of this in Chapter 6. 
 

17. Name the following cells with the following names:  

Cell Name
B1 rate
B2 no_pds
B3 pv
B4 payment

 

Figure 8.6
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It’s easier to audit formulas when you have logical names for the variables in the formulas. Notice the 
word “payment” in the Name Box in the upper-left corner of the figure above. 

18. In Cell C7, type: =payment 
19. Format Cell C7 as Number, two decimal places, Use 1000 Separator(,) and copy down to 

all cells below. 

Figure 8.7

So far it’s been relatively easy, but here comes the tricky part. We now need to calculate the interest 
attributed to the first payment. That is done by taking the interest rate multiplied by the balance of the 
loan divided by 12 (since it is a monthly payment). 
 

20. In Cell D7, type: =pv*rate/12 
21. Format Cell D7 as Number, two decimal places, Use 1000 Separator (,). 
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Figure 8.8

We can’t copy this formula down yet because the balance of the loan will change with each payment. 
Now we will calculate the principal portion of the payment by simply subtracting the interest payment 
from the total payment. We will then calculate the ending balance of the loan by reducing the beginning 
balance by the principal paid. Let’s model it. 

22. In Cell E7, type: =C7-D7 
23. In Cell F7, type: =pv-E7 (to calculate the loan balance) 
24. Format both cells as Number, two decimal places, Use 1000 Separator (,), if Excel did not 

do that for you. 

Figure 8.9

Now that we have the balance of the loan after the first payment, we can write formulas that will calculate 
the interest, principal, and new balance of the loan after each payment. 
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25. In Cell D8, type: =F7*rate/12 (which calculates the interest paid on the new balance) 
26. Copy the formula in Cell E7 to Cell E8. 
27. In Cell F8, type: =F7-E8 
28. Format Cells D8, E8 and F8 as Number, two decimal places, Use 1000 Separator (,). 
29. Copy Cells D8, E8, and F8 down to all cells below.

Figure 8.10

If you did it correctly, the first few rows will look like the above schedule. Scroll down to the last cell in 
Column F (Cell F366) and you will see the balance of the loan is exactly zero. Now you can play around 
with the interest rate, number of periods and loan amount (present value) numbers. If you change the 
interest rate to 10%, the new payment will automatically calculate at $1,755.14. Change the number of 
periods to 20 and the payment changes to $1,930.04. The amortization schedule also changes with every 
change in the input. 
 

30. Save the myAmort.xlsx file, but don’t close it yet. 

Review Questions: It is now time to complete the hands-on Review Questions. 
Log on to www.ExcelCEO.com with your Email address and Password, click 
on the Excel 2016 Review Questions, Chapter 8, Section 1 of 4 option in 
your Main Menu, and complete the Review Questions.  

Scenario Manager  
As I have said previously, it is my opinion that Excel is the best “What-if” analysis tool on the market 
today. One of the features to help users manage various analyses is called Scenario Manager. Within 
Scenario Manager, Excel allows you to create various scenarios or alternative values for cells in the 
spreadsheet. You can add, edit, delete, and summarize these scenarios. In this next exercise, you will 
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build on the skills you learned using the PMT() function to analyze various interest rates, number of 
periods, and loan amounts of a prospective loan. 
 
For this exercise, let’s use the home loan example. Let’s say you live in an area where home prices average 
around $300,000 for the type of home you want to purchase. You have about $75,000 in cash for the 
down payment on the home, but you don’t know if you want to spend all of that money on the down 
payment. Alternatively, you could put part of that money into a money market fund, or just have it in a 
savings fund for emergencies. With more money paid down on the loan, however, you could get a lower 
annual interest rate on the home loan. Therefore, you want to build an analysis that shows the monthly 
payment, total money paid into the loan, and the total interest paid under different scenarios. 
 

1. Open up a new Blank workbook. 
2. Save As myScenario.xlsx in the C:\ExcelCEO\Excel 2016\Chapter8 folder.
3. Create the analysis as shown in the following figure: 

Figure 8.11

4. The formulas for Cells B5, B9, B10, and B11 are as follows: 

Cell B5: =B3-B4 
Cell B9: =PMT(B6/12,B7,-B5) 
Cell B10: =B9*B7 
Cell B11: =B10-B5
Cell B12: =B10+B4 

 
5. Format the dollar cells to zero decimal places (except for the Monthly Payment cell), and 

format all other cells as shown. 
6. Name the following cells with the indicated ranges: B4: down_payment; B6: annual_interest_

rate; B7: number_of_months; B9: monthly_payment; B10: total_payments; B11: total_
interest; B12: total_paid 
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This is the first, or base, scenario. It assumes you will purchase a home for $300,000 and pay $75,000 
down. As such, you can get a 30 year (360 month) loan at a 6.25% APR. The monthly payment calculates 
to be $1,385.36. The Total Payments to be made over the life of the loan is $498,731 (not counting the 
down payment), and the total interest paid over the life of the loan is $273,731. The questions you want 
answered are: 1) what would the monthly payment, total payments, and total interest figures be if you 
were to pay only $50,000 down and have a higher interest rate; 2) what would the same amounts be if 
you were to pay a higher down payment of $100,000 and get a lower interest rate, and 3) what would the 
numbers be if you were to get a 20 year loan which would qualify you for a slightly lower interest rate? All 
of these assumptions can be managed by Scenario Manager. Let’s start off by creating the base scenario 
in Scenario Manager that analyzes the purchase and loan if we paid $75,000 down over 360 months (30 
years) at an interest rate of 6.25%.
 

7. On the spreadsheet, select Cells B4, B6, and B7. 
8. Click on the Data tab, then click on the What-If Analysis  button in the Forecast group, 

and choose Scenario Manager .  

Figure 8.12

The Scenario Manager dialog box appears.  

9. Click the Add… button.
10. In the Scenario name box, type Base Scenario.
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Figure 8.13

10. Click OK.  
 
The Scenario Values dialog box appears. 

Figure 8.14

11. Click OK in the Scenario Values dialog box to accept the current assumptions. 
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Figure 8.15

The Scenario Manager now has one scenario listed, the Base Scenario. To add more scenarios, just click 
Add... and follow the same procedure while changing the assumptions in the Scenario Values box for 
each scenario. 
 

12. Click Add... in the Scenario Manager box to add another scenario. 
13. Call the next scenario Low down, high interest rate, and click OK. 
14. Change the values in the Scenario Values dialog box to be consistent with the following 

values, then click OK.  

Figure 8.16
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15. Create another scenario called High down, low interest rate with $100,000 down at a 5.5% 
interest rate over 360 months. 

16. Create the last scenario with $75,000 down at 6.00% interest rate over 20 years (240 months). 
Call it Average down, low terms.  

Figure 8.17

The Scenario Manager should match the figure above. To display the assumptions in each scenario in the 
Excel spreadsheet, simply click the Show button. 
 

17. Click on the Low down, high interest rate scenario, and click the Show button.  
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Figure 8.18

Make sure cases are consistent. The My Home Analysis cells are now updated according to the figures 
you input. You see that the down payment changed to $50,000 and the Annual Interest Rate changed to 
7.00%. The Monthly payment went up to $1,663.26 and all of the other numbers in the analysis changed 
according to the changes. 

18. Click on the Average down, low terms scenario, and click the Show button.  

Figure 8.19
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The My Home Analysis changes according to the assumptions in the Average down, lower terms scenario. 
But what if you wanted to see all scenarios next to each other? You can do that too. 
 

19. Change the current scenario back to the Base Scenario, and click the Summary... button. 
20. Select Cells B9 to B12.  
21. Make sure the Scenario summary radio button is checked, and that the Result cells: reads 

=$B$9:$B$12 and click OK.

Figure 8.20

Excel creates another tab with the Scenario Summary on it. 

Figure 8.21

22. Delete Column D (Current Values) in the Scenario Summary tab.  
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Figure 8.22

Now you have a scenario summary anyone can be proud of. Scenario Manager is more of an advanced 
tool that most Excel users don’t know how to use, but it can be very useful for experienced users. 
 

23. Save and close the myScenario.xlsx file. 

The PV() Function  
The Present Value function, or PV() function, returns the present value of an investment. The present 
value is the total amount that a series of future payments is worth in today’s dollars, discounted back 
at a certain discount rate. This function has three required arguments and two optional arguments. 
The three required arguments are rate (interest rate or discount rate), number of periods, and payment. 
The optional arguments are future value (or a cash balance you want to attain after the last payment is 
made) and type, which indicates when the payments are due. A type of 0 represents payments at the end 
of the period and a type of 1 represents payments made at the beginning of the period. If the optional 
arguments are omitted, 0 is assumed for both. Note that the PV() function requires the payment to be in 
equal amounts, like an annuity. 

Let’s assume you took the advice of the fortune cookie you had at lunch today and chose the numbers 4, 
7, 10, 20, 21, and 26 in the state lottery and you won $20,000,000! I assume if that happened, you wouldn’t 
be taking this course. That aside, the state says you can take your winnings in 20 annual payments of 
$1,000,000 per year for the next 20 years, or you can take a one-time lump sum payment of $10,000,000. 
The lump sum payment represents the present value of the 20 annual $1,000,000 payments. Is that a good 
deal or not? Which one would you take? The answer lies in the discount rate. Let’s suppose that you 
read in the paper that investors were paying an 8% discount rate on lottery winnings. All you have to 
do is calculate the lump sum payment (or the present value) at an 8% rate and compare that with the 
$10,000,000 the state is offering, and you choose the larger of the two. Let’s do it. 
 

1. Click on the New Sheet icon of the myAmort.xlsx file. 
2. Rename Sheet2 as PV. 
3. Input the following values in the indicated cells, and resize Column A. 
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Figure 8.23

4. In Cell B4, type this formula: =PV(B1,B2,B3,0,1) 
5. Format Cell B4 as Number, zero decimal places, Use 1000 Separator (,). 
6. Resize Column B, if necessary.

Cell B3 needs to be a negative number as if we were making payments so the present value will calculate 
as a positive number. I included the optional arguments of 0 as the future value (as the state will not make 
any payments after the last payment) and a 1 for the type, assuming you will receive the first $1,000,000 
payment immediately. The answer is $10,603,599, as follows:  

Figure 8.24

This means the investor would make you a lump sum payment of $10,603,599, which is higher than the 
$10,000,000 the state offered you. Since your name is splattered all over the front page after your win, you 
get a letter in the mail from another investor offering you a 10% discount rate. That sounds better, doesn’t 
it? Just to make sure, let’s change our discount rate assumption. 

7. Change the Discount Rate to 10%. 

Figure 8.25
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Uh-oh! Did we do something wrong? The value went down to $9,364,920. That is correct! The higher the 
discount rate is, the lower the present value will be. Different investors have different investment criteria, 
and a higher discount rate indicates the investor’s perception of the risk associated with the investment. 
The higher the risk, the more the investor needs to make on the investment, thus the lower present value, 
or the lower the amount the investor is willing to pay for the investment. Another way to look at this is 
that the Discount Rate represents the amount the seller is discounting the sale for the buyer.

The FV() Function 
The Future Value, or FV() function, is similar to the PV() function except it calculates the future value 
of an investment based on periodic, constant payments and a constant rate of interest. It has the same 
arguments as the PV() function, except it allows you to input a present value in place of the future value 
in the optional arguments. All other assumptions are the same. 
 
Let’s do an example of a Future Value calculation. We will assume that you will receive the $1,000,000 
every month from the state and put it into an investment earning an average of 7.5% per year over the 
next 20 years. What would the value of that investment be in 20 years, compounding the 7.5% earned? 

1. Copy the  tab, and rename the new tab FV (press [Ctrl] and click on the PV tab and 
drag it to the right and release). 

2. Change Cell A1 in the  tab to be: Interest Rate 
3. Lower the Interest Rate in Cell B1 to 7.5%
3. Add one decimal place to Cell B1. 
4. Change Cell A4 to be: Future Value 
5. Change the formula in Cell B4 to the following: =FV(B1,B2,B3) 

Holy Cow! Could that be correct? Yes, it is. Many people don’t realize the power of compounded interest 
until they experiment with formulas like this one. In this example, I didn’t use the optional arguments as 
they don’t apply. 

Figure 8.26

6. Save and close the myAmort.xlsx file.  
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Review Questions: It is now time to complete the hands-on Review Questions. 
Log on to www.ExcelCEO.com with your Email address and Password, click 
on the Excel 2016 Review Questions, Chapter 8, Section 2 of 4 option in 
your Main Menu, and complete the Review Questions.  

Proforma Income Statement  
When analyzing the value of a property or business, many investors or analysts look at a business’ ten-
year income statement. In this next exercise, we will build a proforma (or projected) ten-year income 
statement for one of Nitey-Nite’s stores to estimate the value of the business. First we will populate the 
proforma income statement with all of the appropriate numbers and then apply functions and formulas 
to analyze the store’s anticipated performance. 
 

1. Open the file located at C:\ExcelCEO\Excel 2016\Chapter8\Proforma.xlsx. 
2. Save As C:\ExcelCEO\Excel 2016\Chapter8\myProforma.xlsx. 

This file is the shell of a ten-year proforma operating statement for Store No. 1021. The accountants have 
delivered this statement to you so you can estimate the value of the business. It contains the amount of 
the initial investment (-$203,649, shown as a negative number), the actual revenue and expense numbers 
for the year 2016, and columns for ten more years of income statement data. In actuality, it is an 11-year 
statement, as we’ll be using the 11th year Net Income number later. 

Figure 8.27

There are numerous ways to estimate the value of a business, investment, or income-producing property. 
Two of the more popular ways are the Direct Capitalization method and the Discounted Cash Flow (DCF) 
method. The Direct Capitalization method is by far the easiest. Using the Direct Capitalization method, 
you divide the Net Income from the investment by a capitalization rate. In our example, let’s suppose 
the capitalization rate is 8%. The value of the business using this method is estimated by dividing the 
net income of $57,032 by 8%, resulting in a value of $712,900, rounded to $713,000. While this is an easy 
way to estimate the value of a business, it is sometimes inaccurate, particularly when the net income for 
the year isn’t representative of a typical year. An example of an atypical year is if the store was hit by a 
tornado and was closed for a couple of months, or if it was a new store and operated for only part of the 
year.  
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The DCF method is more complex. This method is performed by discounting each year’s net income back 
to a present value. If this is not making a lot of sense to you yet, just stay with me for a while longer. It will 
make much more sense when we complete the proforma and you can look back to see what you’ve done. 
 
In applying the DCF method, the most common practice is to estimate the Net Income for eleven years, 
apply the Direct Capitalization method to the 11th year Net Income and discount each year’s net income 
PLUS the capitalized value of the investment in the 11th year (per the Direct Capitalization method) back 
to a present value. Capitalizing the 11th year Net Income assumes we sell the business at the end of the 
11th year. We do this as we can assume the investment is operating at a stabilized rate after 11 years 
of operations. We don’t really plan on selling it at the end of the 11th year, but it is done as a valuation 
technique. We will apply this methodology in our analysis. 
 
Let’s suppose that this store is a relatively new store, and that it opened on January 1, 2016. From our 
experience in opening similar stores, we believe that revenue should increase by 20% in 2017, 10% in 2018 
and should increase at approximately the rate of inflation thereafter. Let’s also assume that fixed expenses 
should increase at the rate of inflation. Variable expenses are expected to be the same percentage of 
revenue as they were in 2016, and we will use a 3% general inflation rate. With that said, let’s modify the 
spreadsheet to include the above assumptions. 

3. In Cells A35 through B39, input the following data: 
 

Revenue Inflation Year 1 20%
Revenue Inflation Year 2 10%
General Inflation 3%
11th Year Capitalization Rate 10%
Discount Rate 7%

 

Figure 8.28

4. Name the following cells with the following names: 
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Cell Cell Name
C18 com_pct
C20 sell_pct
B35 rev_infl_1
B36 rev_infl_2
B37 infl
B38 cap_rate
B39 disc_rate

 
5. Copy all cells in Column C that contain formulas (not hard-coded numbers) to Column D. 
6. In Cell D9, type the following formula: =C9*(1+rev_infl_1)  

Figure 8.29

This formula takes the dollar amount in Cell C9 and increases it by the rate of revenue inflation for year 
1, or 20%. We will apply this formula to all Revenue accounts in 2017. 
 

7. Copy the formula in Cell D9 down to Cells D10, D12, and D13, and apply the appropriate 
formatting.
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Figure 8.30

Now we have estimated the revenue for 2017. Let’s go on to the expenses. 

8. In Cell D17, write the following formula: =D14*com_pct 
 
As you type the named ranges (like com_pct), notice how the intelli-sense menu appears that shows the 
name of the range or a function that has the same first letters. For example, when you type =D14*com, 
you will see a menu with four items on it (com_pct, the cell that we named, and three functions, 
COMBIN, COMBINA, and COMPLEX). Excel keeps track of functions and named ranges there.

9. Press the [Tab] key when com_pct is selected then click Enter to input that name into your 
formula.  

 
This formula takes the total estimated revenue for 2017 and calculates the cost of merchandise on that 
revenue, using the same cost of merchandise percentage as calculated in 2016. We need to do the same for 
the Selling Expense line, except we need to use the Selling Expense % of Revenue number. 
 

10. In Cell D19, type the following formula: =D14*sell_pct 
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Figure 8.31

As a check, the Gross Margin line for 2017 should read 113,901. Now let’s go on to Fixed Expenses. 
 

11. In Cell D26, type the following formula: =C26*(1+infl) 
12. Copy the formula in Cell D26 to Cells D27 and D28.  

All we’re doing in this formula is increasing the 2016 Salary Expense, General Admin Expenses, and 
Building Expenses at the rate of inflation. 

Figure 8.32

13. Format all cells in Column D to be the same as in Column C. 
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Trick: A quick way to do this is to select Cells C9 through C33, click the 
Format Painter icon, and click on Cell D9. 

Your spreadsheet should now look something like the following figure:  

Figure 8.33

Now we need to copy the formulas in Column D to Column E. We will first copy all of the formulas over 
then make the necessary changes. 
 

14. Copy Cells D9 through D33 to E9 through E33. 

Find and Replace  
Copying those cells worked fine, except for one thing. Remember the inflation rate that you used for 
2017? You’re still using it for 2018 after you did the copy. You need to change it to be the revenue inflation 
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rate for 2018, or Year 2. You can use the Find and Replace functionality to quickly change it: 
 

15. Select Cells E9 through E13. 
16. Type [Ctrl]+h on your keyboard, and the Find and Replace dialog box appears. 
17. Make sure the Replace tab is selected. 
18. In the Find what: box, type: rev_infl_1 
19. In the Replace with: box, type: rev_infl_2  

Figure 8.34

Note: You can also click the Find icon (the magnifying glass icon) you placed 
on your Quick Access Toolbar and click on the Replace tab.

 
20. Click the Replace All button.  

Figure 8.35

21. Click OK, then Close the Find and Replace dialog box. 
 

Trick: Another way you can “go to” a place in your workbook is to type the 
[F5] key (or Fn+F5). When you press the [F5] key, the following dialog box 
appears: 
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Figure 8.36

Just type in the cell reference or select the named range you want to go to and click OK. 
 
Excel should have replaced four formula references of rev_infl_1. Since that is the only change needed to 
the formulas, you can now copy everything in Column E to Column F. 
 

22. Copy all cells in Column E to Column F. 
23. Replace rev_infl_2 with infl in all Revenue cells (you should again have four replacements). 
24. Copy all cells in Column F to Columns G through M. 
25. Format the statement to have a dark bold line (Thick Outside Borders) surrounding the 

entire statement.  

Figure 8.37
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The next step in creating our proforma is to divide the Net Income number in 2026 by the 11th year 
capitalization rate. You also need to footnote that number so it is clear in the proforma what the last 
year’s Net Income number represents. 
 

26. Edit the formula in Cell M33 to be the following: =(M14-M31)/cap_rate, and resize, if 
necessary.

27. In Cell N33, type: ‘(1) (the apostrophe is necessary to make the cell a text reference rather 
than a number). 

28. Italicize Cell N33. 
29. In Cell D35, type: =“(1) Capitalizes Net Income of ”&TEXT(M14-M31,“$0,000”)&“ as if 

the store was sold.” 
30. Italicize Cell D35.  

Figure 8.38

The IRR() Function  
And Presto! You have built a complete proforma income statement where you can change any one of a 
number of assumptions and immediately see the result. Now we are ready to analyze it using the IRR() 
function (Internal Rate of Return). The IRR() function returns the internal rate of return for a series of 
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cash flows represented by the numbers in values. These cash flows do not have to be the same, as with the 
PV() function. However, the cash flows must occur at regular intervals, such as monthly or annually. The 
internal rate of return is the rate received for an investment consisting of payments (negative values) and 
income (positive values) that occur at regular periods. The IRR() function has two arguments: the series 
of values (income stream, cash flows, whatever you want to calculate the IRR for), and a guess at what the 
approximate IRR would be. 
 

31. In Cell A40, type: Internal Rate of Return 
32. In Cell B40, write the following formula: =IRR(B33:M33,0.2)  

Figure 8.39

The range B33:M33 includes the initial investment outflow of $203,649 and all the other net income 
numbers, including the last year’s theoretical sale of the business. For the second argument, I chose 0.2, 
or 20%. It really doesn’t matter what you choose for the guess, as long as it’s reasonable. You should have 
calculated an internal rate of return of 41%. 
 

Review Questions: It is now time to complete the hands-on Review Questions. 
Log on to www.ExcelCEO.com with your Email address and Password, click 
on the Excel 2016 Review Questions, Chapter 8, Section 3 of 4 option in 
your Main Menu, and complete the Review Questions. 
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The NPV() Function  
The Net Present Value, or NPV() function returns the Present Value of the future income (or cash flows) of 
an investment net of the initial investment. The NPV() function contains two arguments: rate and range. 
In our example, we paid a total of $203,649 to set up the store and we forecast annual income of $57,032, 
$74,879, and so on. The Net Present Value formula is written as follows: 
 

1. In Cell A41, type: Net Present Value 
2. In Cell B41, type the following formula: =NPV(disc_rate,B33:M33) 
3. Format Cell B41 to be Currency, zero decimal places. 

Figure 8.40

The Net Present Value formula returns a value of $855,520, meaning that if you spend $203,649 on the 
initial investment, you have a store that has a net present value of $855,520. You can also trick the NPV() 
function to return a present value number. Remember, if you use a PV() function, you must have equal 
payments, like an annuity. In our example, the annual net income is different every year, so we can’t use 
a PV() function. Using the NPV() function, you can have unequal payments to calculate the investment’s 
present value – just eliminate the initial investment number. Let’s try it. 
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1. In Cell A42, type: Present Value 
2. In Cell B42, type the following formula: =NPV(disc_rate,C33:M33) 
3. Format Cell B42 to be Currency, zero decimal places. 

Figure 8.41

The result is $1,119,055, which represents the present value of the investment. Just remember, the present 
value does not consider the initial investment, whereas the net present value includes it.

Note: If you tried to subtract the Present Value calculation from the Net 
Present Value calculation, you would recognize that the result does not 
equal $203,649. Why? Remember that the disc_rate is included, and does 
not equal zero, so there is currently a rate applied to the initial investment. 
For proof, you could set the disc_rate to zero. At this point, the difference 
equals the initial investment of $203,649.

 
4. Save and close the myProforma.xlsx file. 
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Math Functions  
Math functions are very useful and easy to learn, assuming you have a relatively good grasp on math. 
Let’s start off with the RAND() function.  

The RAND() Function  
Sometimes when creating spreadsheets, I need to input some test, or fictitious data. One of the most 
useful math functions in creating fictitious data is the Random, or RAND() function. It is a function that 
simply creates a random number between 0 and 1. Let’s try it. 

1. Open a Blank workbook. 
2. Save As C:\ExcelCEO\Excel 2016\Chapter8\myMath.xlsx. 
3. In Cell A1 of Sheet1, type: =RAND()  

Figure 8.42

Keep in mind that my number will be different from yours, as Excel is generating a random number. 
Excel 2016 also provides a function called RANDBETWEEN(). It is a great function if you need random 
numbers between two ranges and are too lazy (like me) to write the formula inside the RAND() formula. 
Let’s create random numbers between 1,000 and 9,999. 
 

4. Edit Cell A1 to be: =RANDBETWEEN(1000,9999) 
5. Copy Cell A1 down through Cell A10.  

Figure 8.43
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Again, your numbers will be different than mine. Every time you make a change to the spreadsheet, or 
when you press the [F9] key, the RAND() or RANDBETWEEN() numbers change. Try it. Press the [F9] key 
several times and watch the numbers generated by these functions change.  

The INT() and ROUND() Functions  
The INT() function rounds a number down to the nearest whole integer, and the ROUND() function rounds 
a number up or down to a level you specify. Normally, I use the ROUND() function, but I’ve found the 
INT() function to be very useful in certain situations. To illustrate the difference, try the following: 
 

6. Insert a New Sheet in the myMath.xlsx file. 
7. Type the following values in the corresponding cells:  

Figure 8.44

8. In Cell B2, type: =INT(A2) 
 
The result is 3, as the formula takes 3.2529 and rounds it down to the nearest whole integer, which is 3. In 
other words, the INT() function truncates or deletes all numbers to the right of the decimal point. Note 
that the INT() function has only one argument – the number that you want to apply the function to. 
 

9. Copy the formula down for all cells through Cell B5.  

Figure 8.45
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The ROUND() function allows you to specify the decimal place you want to round to. You make that 
determination in the second argument of the function. 

10. In Cell C2, write the following formula: =ROUND(A2,2) 

Figure 8.46

You can round to as many decimal places as you want by simply changing the number in the second 
argument.  
 

11. In Cell C3, write the following formula: =ROUND(A3,0) 
12. Copy Cell C3 down to Cell C4.  

Figure 8.47

You can also round a number to a significant level, such as 10s, 100s, 1000s, etc. You do this by typing 
a negative number in the second argument. For example, suppose you want to round 12,594.43 to the 
thousands of dollars. 
 

13. In Cell C5, write the following formula: =ROUND(A5,-3) 
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Figure 8.48

Changing the formula to be =ROUND(A5,-2) rounds to the hundreds of dollars and returns 12600. 

The ABS() Function 
 
The next helpful math function is the Absolute Value, or ABS() function. An absolute value is simply 
the positive value of any number, or the distance it is from zero. It has only one argument, which is the 
number for which you want to calculate the absolute value. Over the years, I’ve used this function in a 
handy little formula that calculates year-over-year performance. Sometimes the year-over-year numbers 
get kind of weird, and the ABS() function has helped save the day. 
 

1. Insert a New Sheet. 
2. Create a table similar to the following:  

Figure 8.49

Typically, a percentage change formula is calculated by taking the current year number less the prior year 
number, divided by the prior year number. 
 

3. In Cell D3, type the following formula: =(B3-C3)/C3 
4. Format as Percent, one decimal place. 
5. Copy that formula down to Cells D4 through D6. 
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Figure 8.50

The numbers calculate with no error message, but look at the results. The % Change for Store No. 1 looks 
reasonable (indicating a 14.1% increase in income), but Store No. 2 had negative income in 2016 and 
positive income in 2017, yet the % Change calculates to be a negative percentage, which can’t be correct. 
Mathematically it is correct, but logically it is not. You can use the ABS() function in the formula to 
correct the calculation: 
 

6. Edit the formula in Cell D3 to the following: =(B3-C3)/ABS(C3) 
7. Copy the formula down to the cells below.  

Figure 8.51

Now let’s look logically at the results. Store No. 2 did much better in 2017 than it did in 2016 and the 
percentage change reflects a big increase. Store No. 3 was very positive in 2016, but went down below zero 
in 2017, as reflected in the -107.8% number. Store No. 4 is negative in both years, but it is less negative in 
2017, which indicates a positive trend. Trust me – this formula works. It is a very handy formula. Keep it. 
 

8. Save and close the myMath.xlsx file. 

The SUMIF() Function  
We already introduced the =SUM() function in Chapter 1. However, the SUMIF() function is very useful 
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in extracting summary data from databases by adding cells that meet a specified criteria. Let’s try an 
example using this function. 
 

1. Open the file C:\ExcelCEO\Excel 2016\Chapter8\1017_Mattresses.xlsx. 
2. Save As C:\ExcelCEO\Excel 2016\Chapter8\my1017_Mattresses.xlsx.  

Figure 8.52

The AP tab (AP stands for Accounts Payable) contains a detailed list of all of the mattresses purchased by 
Nitey-Nite at Store No. 1017 in August 2017. Your job is to create a summary report that lists the name of 
the manufacturer, the total number of units purchased from that manufacturer, and the total cost. The 
Summary tab contains a shell of the report. You need to write the SUMIF() formula to calculate the total 
units and total costs. 
 

3. Click on the  tab. 
4. In Cell B2, write the following formula: =SUMIF(AP!D:D,A2,AP!G:G)  

Figure 8.53
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Remember, instead of typing the formula, you can type “=SUMIF(” then click on Column D in the AP 
tab, type a comma, click on Cell A2 in the Summary tab, type a comma, and click on Column G in 
the AP tab. For me, that way is easier than typing in the formula. As long as there are no subtotals or 
anything else that is inconsistent with the data in the referenced tab, the formula will work. 
 
This formula says to look at Column D in the AP tab, and for every occurrence of whatever is in Cell A2, 
sum the contents of Column G in the AP tab, or the number of units. The answer is 52. Let’s check that 
number. 
 

5. Sort the list in the  tab by Manufacturer. 
6. Select Cells G2 through G29 (which should be the Quantity sold by Cama). 

 
The AutoSum number should be 52. 

7. Copy the formula in the Summary tab, Cell B2, to Cells B3, B4, and B5.  

Figure 8.54

Note: Since we selected the entire columns D and G in our formula, we had no 
problems with unrelated data involved when we copied the formula down. 

 
The formula indicates that Leavan sold no mattresses. Is that correct? If you look at the AP tab, you 
will see that is not correct, as Leavan has a number of entries. What could be wrong? In order for the 
SUMIF() function to work, the criteria in the database (i.e.- the Manufacturer name) and the criteria in 
the Summary tab must be exactly the same. But they appear to be the same! Remember, sometimes text 
comes from programs with spaces in screwy places. In this case, there is a space after the letter “n” in 
Leavan in Cell A4 of the Summary tab. Take out that space and the formula will work. 
 

8. Edit Cell A4 of the  tab to take out the space after the letter n. 
 
Alternatively, you could surround the A4 reference in the formula with a TRIM() function. Either way 
would work. 
 

9. Write a SUMIF() formula to calculate the total cost for each manufacturer. 
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10. Underline Cells B5 and C5. 
11. Sum the number of mattresses, and the cost in Cells B6 and C6. 
12. Format the values as follows:  

Figure 8.55

13. Check your answers with the  tab. 

 The SUMIFS() Function  
The SUMIFS() function, which was new in Excel 2010, allows the user to use a SUMIF() function to 
input multiple criteria. You could probably nest an AND() function (discussed later in this course) to 
accomplish the same purpose, but it sure is convenient to have the SUMIFS() function be able to contain 
multiple criteria, which is very handy when you want a sum to filter on multiple criteria such as Dream 
King Size Excellent mattresses sold in June 2016.
 
Let’s say you want to repeat the same cost calculation as you did in the previous exercise, but you want to 
include only the items that have a unit cost greater than $200. Management believes that the items with 
a cost lower than $200 would distort what they are trying to accomplish in this analysis. I’ll give you the 
formula and then we’ll discuss it. 

14. In Cell D1, type Cost (>$200), underline the cell and resize the column. 
15. In Cell D2, write the following formula and press [Enter]: =SUMIFS(AP!I:I,AP!D:D, 

“=CAMA”,AP!H:H,“>200”) 

Let’s take a look at this formula. It looks similar to a SUMIF() function, but it has more stuff in it. The 
first part of the formula is the sum_range. It says that we want to sum up the values in Column I of the 
AP tab. Then we have to program in the criteria. If you notice in the screen tip that appears when you 
click inside the formula in the Formula Bar on AP!D:D, the text criteria_range1 appears in bold. This is 
the range of the first criteria. As it appears without brackets, it is a required field. Our formula indicates 
that the range is in Column D of the AP tab, which shows the name of the manufacturer. The last two 
arguments are to filter only the values in Column H for those that havea unit cost greater than $200. 
As you can see in the screen tip, you can have several additional criteria, indicated by the arguments in 
brackets ([criteria_range3, criteria3], etc.). If you did it right, Cells C2 and D2 return the same result as 
there are no unit costs for CAMA less than $200.
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In the criteria1 argument, we have “=CAMA” typed all in upper-case. I just wanted to do that to show 
you that this criteria is not case-sensitive. Let’s change the criteria to look like Cell A2. 

16. Change the formula in Cell D2 to show Cama. 
17. Copy the formula in Cell D2 to Cells D3 through D5. 

Figure 8.56

What happened there? It should be easy to figure out. The manufacturer Cama is hard-coded in the 
formula, so no matter what the name of the manufacturer is in Column A, the formula will return the 
results for Cama. Let’s correct that. Now, since the name Cama is a text string, we need to convert this 
formula to read whatever is in Column A. To do that, we need to replace Cama with “&A2&”.  
 

18. In the formula in Cell D2, replace Cama with “&A2&”, copy to all cells below, and format 
the same as in Column C.  

Figure 8.57

If you check the data in the AP tab, you’ll see that the only manufacturer with items that cost less than 
$200 is Leavan. The cost for all of the other manufacturers is the same as in the SUMIF() function. The 
sample data here is small, but SUMIF() and particularly SUMIFS() can be very powerful for filtering very 
specifically on your data. One word of caution: The larger the dataset, the more of a resource hog these 
functions can become. If the filtering becomes too complex, a PivotTable may become a better option as 
those tend to calculate quicker. 
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19. Save and close the my1017_Mattresses.xlsx file. 

Review Questions: It is now time to complete the hands-on Review Questions. 
Log on to www.ExcelCEO.com with your Email address and Password, click 
on the Excel 2016 Review Questions, Chapter 8, Section 4 of 4 option in 
your Main Menu, and complete the Review Questions.  

Conclusion  
In this chapter, you learned about the various Financial functions. You used the PMT() function to 
help in the creation of a basic amortization schedule. You used Scenario Manager to keep track of your 
scenarios of a mortgage/home purchase analysis. You created a Proforma Income Statement that had 
variables you could change and instantly see the results. You learned some of the ways that appraisers 
and analysts estimate the value of a business, investment, or income-producing property (the Direct 
Capitalization and the Discounted Cash Flow (DCF) method), and worked an example using both 
methods. You created other formulas using the PV(), FV(), IRR() and NPV() functions. You used the 
Find and Replace functionality to look for and replace text within formulas. Finally, you learned about 
Math Functions and worked examples using the RAND(), RANDBETWEEN(), INT(), ROUND(), 
ABS(), SUMIF() and SUMIFS() functions.  

Chapter Exam  
To take the examination for this chapter, you must have successfully completed the examination for the 
previous chapter. You can now go to www.ExcelCEO.com, click on Sign In, log in and take the exam. 
Make sure that you take the exam on the same computer on which you completed the practice files, 
as some of the questions on the exam may refer to some of the completed projects. Chapter exams are 
intended to be hands-on. 
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CHAPTER NINE — DATE, STATISTICAL AND LOOKUP FUNCTIONS 
 
 

Chapter Objectives: 
 

•    Identify Date Functions, including: 
	 o NOW() 
	 o TODAY() 
	 o MONTH() 
	 o DAY() 
	 o YEAR() 
	 o DATE() 
	 o WEEKDAY() 

•    Recognize Statistical Functions, including: 
	 o COUNT() 
	 o AVERAGE() and AVERAGEIFS() 
	 o MEDIAN() 
	 o MODE() 
	 o MAX() 
	 o MIN() 
	 o COUNTIF() and COUNTIFS() 
	 o RANK() 

•    Choose the appropriate Statistical functions create a summary and an item-by-item margin 
analysis

•    Identify database Functions, including: 
	 o DSUM() 
	 o DCOUNT() 

•    Recognize Lookup Functions, including: 
	 o Develop VLOOKUP() Formulas for establishing complex relationship in your data 
	 o Understand HLOOKUP() functionality for when tables are setup in a horizontal format 

•    Choose the methodology for creating drop-down menus using Data Validation
•    Determine how to separate data into columns using Text to Columns

Projects You Will Complete During This Chapter:
my1018_Sales.xlsx, myDate.xlsx, myEmployees.xlsx, myItem.xlsx, myItem_2.xlsx, myLookup.xlsx

CPE Credits possible for this chapter: 3
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Introduction
Back in the 1960’s, there was a game show hosted by Monty Hall called “Let’s Make a Deal”. On stage, 
there were three doors: Door No. 1, Door No. 2, and Door No. 3. Behind one of the doors was a grand 
prize, like a car, a living room suite, or something else very expensive. Behind the other two doors were 
booby prizes, like a candy bar or a box of pencils. The contestant would pick one of the doors and win 
whatever prize was behind it. Before the contestant saw the prize behind the door he or she picked, Monty 
would show the contestant and the audience one of the booby prizes behind one of the doors not picked. 
Then Monty would give the contestant a choice: Do you want to stay with the original door chosen, or do 
you want to pick the other one? What should the contestant do? Should the contestant A) always switch 
to the other door; B) always stay with the original door they picked; or C) it doesn’t matter. Most people 
would say C, as there appears to be a 50/50 chance. However, if the contestant would always switch, he/
she would have a 67% win rate. How is that so? Answer: The magic of statistics. A programmer friend 
of mine once argued with me about this until he was blue in the face. He finally proved it to himself by 
writing a program that played the game and made those choices. He came back humbled and told me 
that the win rate was 68% out of 10,000 iterations, if he always switched doors in his program.  

Date Functions  
We’ve already introduced the concepts of formatting dates in Chapter 1, but now we’ll review date and 
time functions. Remember that a date is simply a number that is formatted to look like a date. The 
number 1 represents January 1, 1900, 2 represents January 2, 1900. March 4, 2017 is 42,798, or in other 
words, there are 42,798 days from 1/1/1900 to 3/4/2017. Sometimes you will want to perform calculations 
based on the day of the week (Monday, Tuesday, etc.) and other times you may want to split apart the 
month, day, and year into separate cells. Let’s experiment with each of those functions.  

The NOW() and TODAY() Functions  
1. Open Excel to a Blank workbook, and make Sheet1 look like the following:  

Figure 9.1

2. Save As C:/ExcelCEO/Excel 2016/Chapter9/myDate.xlsx. 
3. In Cell A2, type: =NOW() 
4. In Cell A3, type: =TODAY() 
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Figure 9.2

The NOW() and TODAY() functions are very similar, except that the NOW() function returns the current 
date and time, whereas the TODAY() function includes only the current date. Your results will reflect the 
date and time you performed this exercise.  

The MONTH(), DAY(), YEAR(), and DATE() Functions  
You can split out the Month, Day and Year from a date using the MONTH(), DAY(), and YEAR() functions. 
 

6. In Cell B2, type: =MONTH(A2) 

This formula returns the number 2, as I was writing this portion of the course on February 4, 2016. You 
can now treat this number just like any other number. 
 

7. Edit Cell B2 as follows: =MONTH(A2)-1 
8. Format Cell B2 as Number with no decimal places. 

 
The result in my example is now 1, which is 2 less one. You have to be careful with the MONTH() 
function, though. I had a student do a similar example in January and ended up with 0. Just remember 
that this function returns a number, not a month. 
 

9. Take out the -1 in Cell B2. 
10. In Cell C2, type: =DAY(A2) 
11. In Cell D2, type: =YEAR(A2)  

Figure 9.3

The MONTH(), DAY(), and YEAR() functions are very easy to understand. Sometimes data can come 
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to you in different ways, and many times dates are split up into Month, Day, and Year columns. You 
can easily put them back into one cell by using the DATE() function. The DATE() function has three 
arguments: Year, Month, and Day. 
 

12. In Cell E2, type: =DATE(D2,B2,C2) 

Figure 9.4

The result is 2/4/2016, which is the same date as the NOW() and TODAY() functions we input into 
Column A.  

The WEEKDAY() Function  
Sometimes you need to know the day of the week (i.e., Sunday, Monday, Tuesday, etc.). Do you think 
it would be important to understand the daily highs and lows of a retail sales operation based on the 
days of the week? You bet it’s important. If your lowest sales day of the week is on Wednesday, you may 
want to run a “Wicked Wednesday” special to try and drive sales on that day. For this, you can use the 
WEEKDAY() function. 
 

13. In Cell E3, type: =WEEKDAY(E2)  

Figure 9.5

The result is 5, meaning that 2/4/2016 falls on the fifth day of the week, Thursday. To display the word 
“Thursday” instead of the number five, simply format the cell. 
 

14. While on Cell E3, press [Ctrl]+1 (which is another way to display the Format Cells dialog 
box). 

15. Click on the Custom category, and input dddd in the Type box. 
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Figure 9.6

16. Click OK.  

Figure 9.7

Dates in Excel can be seemingly difficult to understand, but if you’ve completed this simple exercise, you 
should now have a relatively good grasp on dates. 
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17. Save and close the myDate.xlsx file. 
 

Review Questions: It is now time to complete the hands-on Review Questions. 
Log on to www.ExcelCEO.com with your Email address and Password, click 
on the Excel 2016 Review Questions, Chapter 9, Section 1 of 4 option in 
your Main Menu, and complete the Review Questions. 

Statistical Functions 
Managers love statistics. In many companies, statistics are the life-blood of the organization. Since Nitey-
Nite Mattresses is an up-and-coming company, there are numerous vendors who try to convince us to 
use their products. We would be interested in using other vendors if their products made sense to the 
organization, both financially and in terms of making the product fit into our line. In the next exercise, 
you will prepare a report that analyzes the profit margins of all the products that Nitey-Nite sells. When 
vendors approach us, management can use this report to compare our current line with their products to 
make a first-pass decision on whether or not a relationship should be investigated. To do so, we will use a 
number of statistical functions.  

The COUNT() Function  
Probably the easiest statistical function to understand in the COUNT() function. The COUNT() function 
simply counts the number of cells in the selected range that contain any numeric value. Let’s prepare an 
example to use. 
 

1. Open the file C:\ExcelCEO\Excel 2016\Chapter9\Item.xlsx. 
2. Save As C:\ExcelCEO\Excel 2016\Chapter9\myItem.xlsx.  

Figure 9.8

This file is a listing of every mattress and pillow that Nitey-Nite sells. The first thing you need to do is to 
prepare the file to return the statistics you need. Then you will set up an area on the spreadsheet which 
will contain summary statistical information about the items in the list. 
 

3. In Cell J1, type: Margin, and underline it. 
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4. In Cell J2, write a formula that calculates the margin (the margin is the inverse of the cost over 
the retail price, or one minus (cost / retail price) ). 

5. Format Cell J2 to be Percent with two decimal places, and copy to all cells below. 

Figure 9.9

6. In Cell L1, type: Summary Statistics 
7. Using the Merge & Center icon, center Summary Statistics over Cells L1 and M1. 
8. In Cell L2, type: Number of Items 
9. In Cell L3, type: Average 
10. In Cell L4, type: Median 
11. In Cell L5, type: Mode 
12. In Cell L6, type: Maximum 
13. In Cell L7, type: Minimum 
14. Resize Column L to fit. 
15. In Cell M2, type the following formula: =COUNT(J:J)  

Figure 9.10
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Remember, the COUNT() function counts the number of cells in the range that contain numbers, not 
text strings. If you select the entire Column J and look at the Count in the Status Bar, you’ll see the result 
is 69 (the count of cells with content, which includes the Margin heading in Cell J1. 

The AVERAGE(), MEDIAN(), MODE(), MAX(), and MIN() Functions  
With the spreadsheet set up this way, we are now prepared to use other statistical functions. The 
AVERAGE() function is a simple average, or arithmetic mean, of the data range. The MEDIAN() function is 
the number in the middle of a set of numbers; that is, half the numbers have values that are greater than 
the median, and half have values are less. The MODE() function returns the most frequently occurring 
value. The MAX() function returns the highest value in the selected range and the MIN() function returns 
the lowest value. Let’s populate our example with these functions. 
 

1. Copy Cell M2 down to Cell M3, and change COUNT to AVERAGE in Cell M3. 
2. Copy Cell M3 down through Cell M7, and change AVERAGE to MEDIAN, MODE, MAX, 

and MIN, respectively. Format as Percentage with two decimal places.

Figure 9.11

In our example, there are no duplicate margin values, so Excel returns an #N/A error for the MODE() 
function. Since it returns an error, we don’t need that field in our summary statistics, so we will move the 
Maximum and Minimum cells on top of it.

Note: Don’t delete the row as it will delete the data in the base table to the left. 

3. Select Cells L6 through Cell M7. 
4. Position your cursor over the top bold line of the selected range, and your cursor will turn to a 

pointer over a cross with up, down, left, and right arrows  
5. Click, hold, and drag the selection where the word Maximum is in Cell L5 and release.  
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Figure 9.12

6. Click OK. 

Figure 9.13

The COUNTIF() Function 
In our Summary Statistics table, we know the number of items in the table (68), but we don’t yet know the 
count of items for manufacturer. For that, we can use the COUNTIF() function. 
 

1. Select Cells L3 to M6, and move the range down where Average is in Cell L7. 
2. In Cells L3 through L6, type the following: Cama, Dream, Leavan, and Sleepwell. 
3. Select Cells L3 through L6, and click the Increase Indent icon in the Alignment group of the 

Home tab. 
4. In Cell M3, type the following formula: =COUNTIF(C:C,L3) 

 
This formula counts all of the cells in Column C (Manufacturer) that equal the value(s) in Column L. If 
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you had placed spaces before the manufacturer name instead of using the Indent functionality, the results 
would have been wrong. You did a similar function in Chapter 8 when you wrote the SUMIF() function. 
 

5. Copy the formula in Cell M3 through Cell M6. 

Figure 9.14

The count for each manufacturer populates correctly. As a check, you can see that the Status Bar returns 
a Sum of 68, which is the correct total. If we had inputted spaces rather than indenting, results would 
have been zero, or no matches, since we know spaces report as characters which are not present in the 
Manufacturer names in Column C.

The AVERAGEIFS() and COUNTIFS() Functions  
As with the SUMIF() and SUMIFS() functions, the AVERAGEIF() and COUNTIF() functions also have 
new capabilities since Excel 2010: the AVERAGEIFS() and COUNTIFS() functions. Like the SUMIFS() 
function, these functions allow the user to filter for multiple criteria. The syntax for the AVERAGEIFS() 
function is exactly the same for the SUMIFS() function, so if you need to know more about that function, 
please refer to it where it was introduced in Chapter 8. The syntax for the COUNTIFS() function is 
COUNTIFS(criteria_range1, criteria1, [criteria_range2, criteria2], [criteria_range3, criteria3], etc.), 
with the second criteria and range forward being optional. The only difference is that the COUNTIFS() 
function does not include a data_range argument.  

The RANK() Function  
Another statistical function I’ve found to be very useful is the RANK() function. The RANK() function 
returns the rank of a number in a list of numbers. The rank of a number is its size relative to other values 
in a list. It contains two required arguments (the number or cell you want to rank and the range of the 
ranking) and one optional argument, order. A zero order, or if it is omitted, means to sort the rank as if 
the range was in descending order (highest to lowest). An optional argument of 1 means to sort the rank 
as if the reference range was in ascending order. We will now use the RANK() function to rank all of the 
items in the list based on a descending order or margin, where the highest margin appears with a rank 
number of one. 
 

1. Insert a column between Columns K and L. 
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2. In Cell K1, type: Rank, and underline it. 
3. In Cell K2, type the following formula: =RANK(J2,$J$2:$J$69) 

Figure 9.15

Make sure to include the absolute references in the second argument, as you want to keep this range 
intact when copying. 
 

4. Copy the formula in Cell K2 to all cells below. 
5. Sort the table in Ascending Order (smallest to largest) on Column K. 

Figure 9.16

Now you see that Rank is sorted in Ascending order, and Margin in Descending order. You can use 
statistical functions to really impress upper-management. You may even consider a new career as an 
actuary! 
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6. Save and close the myItem.xlsx file. 

Review Questions: It is now time to complete the hands-on Review Questions. 
Log on to www.ExcelCEO.com with your Email address and Password, click 
on the Excel 2016 Review Questions, Chapter 9, Section 2 of 4 option in 
your Main Menu, and complete the Review Questions.  

Database Functions  
I’ll be the first to say that database functions are not my favorite functions in Excel. If you find yourself 
using a lot of database functions, you are probably doing a project that should be done in Access or some 
other database, rather than Excel. Many times, you can use a PivotTable (discussed in Chapters 11 and 
12) to replace a database function, which is usually my preference. However, knowing database functions 
are necessary to becoming an Excel master, so it is necessary to briefly review them here. 
 
In the Statistical Functions section in this chapter, you learned about a lot of different types of functions 
like COUNT(), MAX(), MIN(), AVERAGE() and the like. Database functions work very similar to 
statistical functions, but you are able to define criteria with a database function. One obvious difference 
between database and statistical functions is that database functions begin with the letter “D” at the 
beginning of the name, like DSUM(), DCOUNT() and DMAX(). As the syntax for most database 
functions is basically the same, we will do examples of only two database functions, DSUM() and 
DCOUNT(). If you need to use other database functions, you should be able to figure out the syntax 
easily enough. 
 
To illustrate, you will use the 1018_Sales file. 

1. Open the 1018_Sales.xlsx file under the C:\ExcelCEO\Excel 2016\Chapter9 folder. 
2. Save As my1018_Sales.xlsx in the same folder. 

Figure 9.17
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The DSUM() Function  
The file is a simple spreadsheet that contains detail sales data by ticket for Store No. 1018 for all sales 
in 2016. We will create a database function that will calculate the total sales amount in July 2016 using 
the DSUM() function. To do this without a database function, you could sort and/or filter the data and 
sum all of the sales in July. Alternatively, you can write a database function to sum it for you. To use a 
database function, you first have to set up a criteria range. That is usually done by copying the titles of 
each column to another part of the spreadsheet and using the row under that range as the inputs for the 
criteria. 

3. Copy the range Cell A1 to F1 to Cell I1. (This will be used as the Criteria input range for the 
database functions.)

4. Resize the columns, as necessary. 
5. In Cell K2, type 7 (as we want to filter the list for sales in July).  

Figure 9.18

6. In Cell H5, type July Sales:, and resize the column. 
7. In Cell I5, write the formula =DSUM(A1:F2110,“Total Sale”,I1:N2) 
8. In the Number group of the Home tab, click on the Number Format drop-down arrow, and 

choose Currency.  

Figure 9.19

Let’s talk about the formula. It has three arguments. The first is the database, or the list/table where 
you want to pull the data from (in this case, the range is Cells A1 to F2110). Next is the field, or the 
specific column you want to total, count, etc. (the Total Sale column). Last is the criteria range (Cells I1 
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to N2). The criteria range should include the names of the field as well as one row beneath it to include 
the criteria you want to type in. In this example, it tells us that there was $111,301.00 in sales in July 2016 
at Store No 1018. 

The DCOUNT() Function  
To get a count of the number of sales, you can use the DCOUNT() function in a similar way. 
 

9. In Cell H6, type July Count:, then resize the column. 
10. In Cell I6 write the formula =DCOUNT(A1:F2110,“Total Sale”,I1:N2) 
11. Format Cell I6 as Number, zero decimal places, and Use 1000 Separator (,).  

Figure 9.20

Another trick is to use arithmetic operators in the criteria range. Suppose you wanted to see the year-
to-date sales and count for July, meaning all sales from January through July. You can use arithmetic 
operators in the criteria section. 

12. Change Cell K2 to be <=7
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Figure 9.21

As soon as you press [Enter], the July Sales and Count numbers change. Like I said, if you want to use 
other database functions, learn how to use the normal statistical function then apply the database 
function syntax we have reviewed here. And again, I would advise you to re-examine your project, if 
you find yourself using a lot of database functions. I get nervous when people use database functions in a 
spreadsheet, just like I’m wary of doing what-if analyses in a database. 
 

13. Save and close the my1018_Sales.xlsx file.  

Lookup Functions  
In my humble opinion (although some people say there’s nothing humble about my opinion), there are 
three things that EVERY Excel user should know how to do: a nested IF statement (which we talked 
about in Chapter 6), PivotTables (Chapters 11 and 12), and a VLOOKUP() function, which is the next 
subject.  

The VLOOKUP() Function  
The VLOOKUP() function is one of the most, if not THE most powerful, functions in standard Excel. It 
is similar to creating a join, or establishing a relationship, between two tables in a relational database. 
The “V” in VLOOKUP stands for vertical, meaning that the data in the table must be in a vertical 
format (from top to bottom, or that the fields must be in columns, not rows). VLOOKUP searches for 
a value in the left-most column in a range, and then returns a value in the same row from a column 
you specify in the range. The VLOOKUP() function has three required arguments and one optional 
argument, although I contend that the optional argument should be required in most cases. The three 
required arguments are: 1) the lookup_value, or the value you want to find in the table; 2) the table, array 
or database range that you want to use to find the values; and 3) index number, or the column in the 
table, array or database you want to return a value from.  

The optional argument, which I will tell you to almost always include, is a TRUE/FALSE argument 
(Excel defines this as the range/lookup argument, but I think that definition is not very meaningful). The 
TRUE/FALSE argument tells the function whether or not to return the closest value. If the argument is 
set to TRUE, or if it is omitted, it will return the largest value that is less than or equal to lookup value. I 
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rarely use that functionality. Therefore, I set the optional argument in a VLOOKUP() function to FALSE, 
as I want to return an exact match or an error when there is no exact match. In most of your work, you 
will probably do the same. 
 
Let’s start with a simple example. 
 

1. Open a Blank workbook. 
2. Save As C:\ExcelCEO\Excel 2016\Chapter9\myLookup.xlsx. 
3. Starting with Cell A1, create a table with the following data: 

State Abb. State Name
AL Alabama
AK Alaska
AZ Arizona
CA California
CO Colorado
DE Delaware
FL Florida
GA Georgia
HI Hawaii
IA Iowa

 
 4. Underline Cells A1 and B1, and resize the columns, if necessary.  

Figure 9.22
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Next you will write a VLOOKUP() statement where the user inputs the state abbreviation in one cell and 
the VLOOKUP() statement will return the corresponding state name in the adjacent cell. 
 

5. In Cell D1, type State Abb. and in Cell E1 type State Name. Underline both cells and resize 
both columns. 

6. In Cell D2, type AL. 
7. In Cell E2 write the following formula: =VLOOKUP(D2,A2:B11,2,FALSE) 

Figure 9.23

Let’s review the formula. Cell D2 is the value you want to look up, or the value you want to find the state 
name for. The range A2:B11 is the range of the database. It is important to remember that the left-most 
column in your database must contain the same values as those contained as your formula’s lookup_value 
argument. If you don’t set it up that way, the VLOOKUP() function will not work. The third argument, 2, 
tells the function that you want to return the value that is contained in the second column of the database 
range. Finally, FALSE tells the function that you want an exact match. Typing TRUE or omitting the 
argument could return an incorrect result, such as if you had the [range_lookup] set to TRUE and typed 
AR (the abbreviation for Arkansas) into Cell D2. In this case, with Arkansas not present, the formula 
would return Alaska, which is not correct. Sometimes “close enough” is not close enough.
 
This is the basic syntax behind a VLOOKUP function. Seems pretty simple, huh? Let’s play around with 
our formula using FALSE as the [range_lookup]. 
 

8. In Cell D2, type: CO 
 
Cell E2 changes to “Colorado”
 
9. In Cell D2, type: HI 
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Cell E2 changes to “Hawaii”

10. In Cell D2, type: TX 

Figure 9.24

Cell E2 returns an #N/A error, because TX is not contained in the left-most column of the database range. 
So you need to include Texas in your list of states. 
 

11. In Cell A12, type: TX 
12. In Cell B12, type: Texas 

 
Cell E2 still returns a #N/A error. That is because the database range in the formula is still shown as 
A2:B11. TX and Texas are listed in Cells A12 and B12. Therefore, you need to revise the database range in 
your formula to incorporate the new cells. 
 

13. Edit the database range in your VLOOKUP() formula to include the Texas cells on Row 12.
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Figure 9.25

Now the formula returns the correct value. 

Data Validation  
As we saw in our example, if you input a value other than those contained in range A2 through A11, it 
returned an error message. To force users to choose one of the values in the list, you can create a drop-
down menu. This is done using Data Validation. Let’s deviate from lookup functions for a short while and 
create a drop-down list in our example to require users to choose one of the values. 
 

1. Click on Cell D2. 
2. Click on the Data tab, then click on the Data Validation button in the Data Tools group. 

 
The Data Validation dialog box appears. 
 

3. Make sure the Settings tab is selected. 
4. In the Allow: drop-down menu, choose List. 
5. Click in the Source box, and use your mouse to select the range A2 to A12, and click OK.  
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Figure 9.26

You can use the mouse to select the range or you can type it in. If you use the mouse to select the range, 
Excel will automatically input the range using an Absolute Reference, with $s around the cell references. 
The Absolute Reference fixes the range to where it will not change if it is copied to another cell. The $ acts 
as an anchor where it is placed, fixing both the column letter and the row number for Absolute Reference.
 
Cell D2 now has a drop-down menu attached to it. The drop-down menu will appear only when the cell 
is selected. 

Figure 9.27
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You can use this functionality to restrict values that can be used. Let’s make the drop-down menu a little 
more functional. 
 

6. While Cell D2 is selected, click on the Data Validation button to open the Data Validation 
dialog box. 

7. Click on the Input Message tab. 
8. In the Title: box, type State. In the Input message: box type Choose a state from the list. 

Figure 9.28

9. Click in the Error Alert tab. 
10. In the Style: box, make sure Stop is selected. 
11. In the Title: box, type OOPS! 
12. In the Error Message box, type, You must choose a state from the list.  
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Figure 9.29

13. Click OK. 

By typing in a title and message in the Input Message tab, the title and message automatically appear 
whenever the cell is selected.  

Figure 9.30

14. Click on the drop-down menu in Cell D2, and choose DE. 
15. Click on any cell other than Cell D2.
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The state name Delaware appears in Cell E2. To see the complete name of the state in Cell E2, you must 
click on any cell outside of Cell D2 so the drop-down arrow disappears. 
 

16. In Cell D2, type: UT, then press Enter.

You get the OOPS! error message telling you that you have to choose a state from the list. 
 

18. Click Cancel, and Save the myLookup.xlsx file. 

Validation Rules 
You can also create validation rules on existing data. Excel provides a nifty tool for you to identify cells 
with invalid data. 
 

1. Open the Item_2.xlsx file located at C:\ExcelCEO\Excel 2016\Chapter9.  

Figure 9.31

This file is simply a copy of the Item file used previously. Let’s assume that you want to have a validation 
rule that says the size should be either King, Queen, Double, or Twin. Let’s create that rule. 
 

2. In Cells L1 through L5, create the following list: 
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Figure 9.32

3. Select Cells E2 through E69, and click on the Data Validation  button to 
open the Data Validation dialog box. 

4. Make sure the Settings tab is displayed. 
5. On the Allow: drop-down menu, choose List. 
6. In the Source: box, type (or select) =$L$2:$L$5 and click OK. 

Note: If you do not include the equal sign in your Source reference, Data 
Validation will view the entry as a value rather than as a range reference, 
and all options would end up circled.

7. With the Range E2:E69 selected, click on the Data Validation drop-down arrow and choose 
Circle Invalid Data . 

8. Scroll down to the bottom of the list.  

Any cell that is not King, Queen, Double, or Twin now has a red circle around it. 
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Figure 9.33

9. Click on the Data Validation drop-down arrow, and choose the Clear Validation Circles 
option. 

10. Close the myItem_2.xlsx file (no need to save it). 

Review Questions: It is now time to complete the hands-on Review Questions. 
Log on to www.ExcelCEO.com with your Email address and Password, click 
on the Excel 2016 Review Questions, Chapter 9, Section 3 of 4 option in 
your Main Menu, and complete the Review Questions.  

The HLOOKUP() Function  
Let’s now explore the HLOOKUP () function. The HLOOKUP() function behaves in the same way as the 
VLOOKUP() function, except that the database or reference table is contained in a horizontal format 
rather than a vertical format. The lookup is done in rows instead of columns, but everything else is the 
same as with a VLOOKUP(). As databases are typically contained in vertical formats, the HLOOKUP() 
function is less common than VLOOKUP(), but every now and then it’s necessary to use it, so let’s do an 
example. 
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11. Create a New sheet in the myLookup.xlsx file. 
12. Input data in the cells as follows:  

Figure 9.34

13. In Cell F1, type: S 
14. In Cell G1, type the following formula: =HLOOKUP(F1,A1:D2,2,FALSE)  

Figure 9.35

The formula now works using a table in a horizontal format rather than a vertical format. Easy to 
understand, huh?
 

15. Save and close the myLookup.xlsx file.  

Text to Columns  
One of the things that make people like us very valuable is our ability to manipulate data. Many times, 
we don’t get to choose the format in which we receive data. Sometimes, the data is just flat ugly. Data can 
come in multiple formats, and sometimes it’s contained all in one column. 

1. Open the file at C:\ExcelCEO\Excel 2016\Chapter9\Employees.xlsx. 
2. Save As C:\ExcelCEO\Excel 2016\Chapter9\myEmployees.xlsx. 

This is a simple file of the store managers at Nitey-Nite and the stores they manage. In this file, all of 
the data is contained in one column. The data is actually in six columns, but sometimes when data is 
copied from one system to another, it copies to one column. In this case, you can use a Text to Columns 
procedure to split out the data into separate columns. If you notice, the data in this spreadsheet is 
separated by a comma, otherwise known as Comma Separated Values (.csv). The comma is known as 
the delimiter, or the character that separates the fields of data. Other common delimiters include a space, 
semi-colon, or a tab. Some of the more sophisticated databases use other characters that are rarely used 
in text strings, like a tilde (~) or pipe symbol (|). Let’s use the Text to Columns functionality to separate 
this data into its respective columns. 
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3. Select Column A. 
4. Click on the Data tab, then click on the Text to Columns  icon in the Data Tools group 

(the Convert Text to Columns Wizard opens). 
5. In Step 1 of the Convert Text to Columns Wizard, make sure the Delimited radio button is 

selected, and click Next. 

Figure 9.36

6. In Step 2, uncheck the Tab checkbox (or any other checkbox that is checked), check the Comma 
checkbox, and click Next.  
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Figure 9.37

7. In the last step of the wizard, under Data preview, click on the second column (that reads 
General and Empl_No on the first and second lines), click on the Text radio button in the 
Column Data format section, and click Finish.  
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Figure 9.38

8. Make sure the column widths are set appropriately. 
 

Note: In the last step where you clicked on the Empl_No field, I had you check 
the Text radio button. That ensured that the values in that field would be 
converted as Text, not Numbers. Had we left it alone, Excel would have 
brought in the data as numbers with no leading zeroes.

The data is now separated out into six columns.  

Numbers vs. Text Strings in a VLOOKUP() Function  
Sometimes you want to use numbers instead of text strings in your lookup values. For the next exercise, 
we need to clean up the file to be in a more useable format.  
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Figure 9.39

9. In Cell G1, type: Full Name and underline all title headings. 
10. Write a formula in Cell G2 to concatenate the first name and last name to be the full name, 

copy to all cells below, and resize all columns. 

Figure 9.40
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11. In Cell I1, type: Empl_ID 
12. In Cell I2, type: 10 
13. In Cell J1, type: Full Name 
14. In Cell J2, write a formula that looks up the value in Cell I2 in the database, and returns the 

employee’s full name. 
15. Resize Column J, if necessary. 

Figure 9.41

Now let’s try the same VLOOKUP() using the Empl_No (not the Empl_ID). 
 

16. Replace the contents of Cell I1 with: Empl_No. 
17. Edit the range in the formula in Cell J2 to be: =VLOOKUP(I2,B2:G24,6,FALSE) 

In the formula, we needed to change the range to start with Column B as those are the values we want to 
base our formula on. We also changed the 7 to a 6 because now the data we want to return is in the sixth 
column of the table if we begin with Column B. The formula right now should return an #N/A error, 
because Cell I2 still contains the number 10 which is an employee ID and not the employee number. 
 

18. In Cell I2, type 007386, then click Enter. 
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Figure 9.42

It still returns the ﻿#N/A error. Why? This one problem has been the cause of hours of frustrations for 
me and many other Excel users. When you input “007386”, Excel recognized that as a number and 
consequently changed it to a number format and eliminated the leading zeros. The data in Column B 
is formatted as text, not numbers. You can tell it is text because of the leading zeros. Another way to 
tell if numbers are formatted as text is to select the numbers in question and look to see if the ﻿AutoSum 
feature in the Status Bar is working. You can also try to write a SUM() function using those numbers. If it 
returns an error or doesn’t add up, chances are the numbers are formatted as text. 
  
 In this case, we can do one of two things. The fastest and easiest way (but not recommended by me) is 
to change the data in Column B (the Empl_No field) to numbers format. You can do this very easily by 
selecting the entire column, and choose Text to Columns and walk through the Convert Text to Columns 
Wizard. Let’s do that. 
 

1. Select Column B. 
2. Click on the Text to Columns button in the Data Tools group of the Data tab.  
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Figure 9.43

3. Leave the Delimited data type checked and click Next > 
4. In Step 2 of the Wizard, uncheck all boxes in the Delimiters section (if there are no boxes 

checked, check and uncheck any box) and click Next >. 
5. In Step 3 of the Wizard, make sure the General radio button is selected, and click Finish. 

 The values in Column B are changed to numbers and the formula in Cell J2 works. Although this way 
works, I do not suggest doing it. I often set up my spreadsheets so I can easily update the data, and if I 
were to refresh this table with new data, the Empl_no values would come in again as text and I would 
have to go through the motions again of converting the text values to numbers. I try to program my 
spreadsheets to have as little human intervention as possible. 
 

6. Click the Undo icon  (or press [Ctrl]+z on your keyboard).

 The Text to Columns procedure was undone and the values in Column B are now converted back to text. 
 

7. Edit the formula in Cell J2 to be as follows: 
=VLOOKUP(RIGHT(“000000”&I2,6),B2:G24,6,FALSE) 
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 Now stay with me on this one. I PROMISE you will love this trick once you understand the logic. This is 
an example of a nested function, or a function within a function. At Nitey-Nite, the Empl_No is always 
a six-digit number with leading zeros. The ﻿concatenation string “000000”&I2 will take the number that 
is in Cell I2 and add six leading zeros. RIGHT(“000000”&I2,6) will return the six right-most characters 
from that string. Remember that whenever you use a Text function, it turns the number into a text string. 
In this case, that is exactly what we want.  

Figure 9.44

Sometimes you may want to go the other way and convert a text string into a number. Let’s add a column 
beside the Empl_No column which will convert the Empl_No’s from text strings to numbers. 
 

8. Insert a column after Column B. 
9. In Cell C1, type: Empl_No #, and resize the column. 

 
There are different functions that you can use for this procedure, but I found a formula that works 
perfectly. In Chapter 6, we saw that we could use the VALUE() function to do this conversion, but there is 
another way. I’ll ask you not to tell this trick to any programmers, as they will tell you it won’t work, but 
just between you and me, it does. 

10. Click in Cell C2, and change the Number Format from Text to General to reset the cell’s 
formatting which was inherited from Column B.

11. In Cell C2, type: =B2+0 
11. Copy the formula to all cells below.  
12. In Cell K2, change the VLOOKUP() col_index_num to 7, since you inserted a column.
13. Right-align the numbers. 
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Figure 9.45

That’s it? Yep, that’s it. All you have to do is to add zero (or multiply by 1) to a text string of numbers to 
convert it to a number. Of course, there can be only numbers (no alpha characters) in the text string. 
Since I believe LOOKUP Formulas are critically important, we will continue the discussion of LOOKUP 
Formulas in the next chapter and introduce the last set of functions, Logical Functions. 
 

14. Save and close the myEmployees.xlsx file. 
 

Review Questions: It is now time to complete the hands-on Review Questions. 
Log on to www.ExcelCEO.com with your Email address and Password, click 
on the Excel 2016 Review Questions, Chapter 9, Section 4 of 4 option in 
your Main Menu, and complete the Review Questions.  

Conclusion  
In this chapter, you learned about Date Functions, and used the NOW(), TODAY(), MONTH(), DAY(), 
YEAR(), DATE() and WEEKDAY() functions in many formulas. You learned about Statistical Functions 
in formulas, including the COUNT(), AVERAGE(), MEDIAN(), MODE(), MAX(), MIN(), COUNTIF(), 
and RANK() functions. You used these functions to create a summary and an item-by-item margin 
analysis. You learned about database functions and wrote formulas using the DSUM() and DCOUNT() 
functions. You learned about one of the most important types of functions, Lookup Functions. 
Additionally, you used the Data Validation functionality to create drop-down menus and validation 
rules and you used the Text to Columns functionality several times. You used the Circle Invalid Data 
functionality to help identify formulas that didn’t meet specific criteria. Finally, you saw how to switch 
back and forth between using numbers and text strings by using the RIGHT() function and the +0 trick.  

Chapter Exam  
To take the examination for this chapter, you must have successfully completed the examination for the 
previous chapter. You can now go to www.ExcelCEO.com, login to your ExcelCEO student profile, and 
take the exam. Make sure that you take the exam on the same computer on which you completed the 
practice files, as some of the questions on the exam may refer to some of the completed projects. Chapter 
exams are intended to be hands-on. 
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CHAPTER TEN — ADVANCED LOOKUP AND LOGICAL FUNCTIONS 
 

Chapter Objectives: 
 

•    Recognize Absolute Reference ranges in VLOOKUP() formulas
•    Determine data to return using the LOOKUP() function
•    Select the appropriate criteria in a MATCH() function
•    Identify cell contents by type using the CELL() function
•    Select the components of an IFERROR() function 
•    Recognize the uses of the AND() and  OR() functions 
•    Identify formula errors by tracing cell dependents 

Projects You Will Complete During This Chapter:

•	 myBonus.xlsx
•	 myBonus2.xlsx

 

CPE Credits possible for this chapter: 2
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Introduction
Once I was teaching an Excel class to a group of accountants. The primary purpose of the class was to 
show them how to connect an Excel file to an OLAP cube (an external database), and pull in data. Once 
the data was in the spreadsheet, I showed them how to write a complex VLOOKUP() function to bring 
the data to different parts of the spreadsheet. One of the participants was bored with the class, as she 
already knew how to do all of that. Then I showed them the trick on how to turn a text string to a number 
by simply adding zero, and nesting that formula in a VLOOKUP() function. Her eyes almost popped out 
of her head and she said, “No way! It CAN’T be that easy!” She jumped up out of her chair, ran out of the 
room and into her office. She was back within two minutes shouting, “IT WORKS! IT WORKS!” Writing 
formulas is what Excel is all about, and I sincerely hope you’ve found this course to be useful so far.  

Advanced Lookup Functions  
Sometimes you will run into a situation where you need to look up a number that falls between a range of 
numbers. In Chapter 6, I introduced you to the IF() function and showed you how to write this formula: 
 
=IF(G2<=50000,“Paper”,IF(G2<=70000,“Scissors”,“Rock”)) 
 
This formula tells us if the value in Cell G2 is less than or equal to 50,000, then return the word “Paper”. 
If Cell G2 is less than or equal to 70,000, return “Scissors”, and for all other values, return “Rock”. The 
IF() function works very well in this situation, as there are only three options: Paper, Scissors, and 
Rock. In Excel 2003, you could nest only seven IF() functions in one formula. However, in Excel 2007 
and beyond, you can nest up to 64 IF() functions in one formula. Honestly, I don’t know why Microsoft 
allowed so many IF() functions in one formula, because it would be a full-time job just keeping track of 
all those conditions. In the first part of this chapter, I’ll introduce you to some alternative methods of 
looking up values where many IF() statements could be used. 
 
Over the years, I have been given many schedules like the following on which to calculate bonuses:  

% of Budget Bonus %
Less than 100% 0.00%
100% 0.50%
105% 0.75%
110% 1.00%
125% 1.50%
150% 2.00%
200% 3.00%
250% 4.00%
300% 5.00%

In this case, the Store Manager has a budgeted amount of sales he/she should attain every month. 
If the store manager reaches 100% of that budgeted number, they begin to receive a bonus based on 
the percentage over budget on his/her actual sales. Depending on the amount of their sales to budget 
determines their bonus amount: the higher the sales, the higher the bonus amount.  
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1. Open the file located at C:\ExcelCEO\Excel 2016\Chapter10\Bonus.xlsx. 
2. Save As C:\ExcelCEO\Excel 2016\Chapter10\myBonus.xlsx. 

Figure 10.1

Let’s review this file. On the Assumptions tab that reflects the data above. This schedule means that if 
the Store Manager (SM) achieves less than 100% of budget, he/she receives no bonus. If the SM sells 
between 100% and 105%, he/she earns a bonus equal to 0.50% of actual sales. Once the SM reaches 105%, 
the bonus percentage increases to 0.75%, going back to dollar one. So if the SM sells $104,000 and has a 
$100,000 budget, his percent of budget is 104% (104,000/100,000), and he qualifies for a 0.50% bonus. The 
bonus equates to $520, or $104,000 x 0.50%. The Sep_16_Data tab contains the total mattress and pillow 
sales for each store in September 2016. The Managers tab contains the names of the managers for each 
store and the Budget tab contains the Budget numbers for each store. 
 
Let’s first organize the data where it is easier to work with.  
 

3. Copy the  tab, and rename the new tab Bonus. 
 
It’s always good practice to save the original data and perform calculations in a copied version of the 
data, just in case you need to start over. 
 

4. In the  tab, Cell E1, type: Full Name 
5. Format Cell E1 like Cell D1. 
6. Write a formula in the Full Name column that creates the manager’s full name for all rows. 

Resize column, if necessary.  
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Figure 10.2

7. In the Bonus tab, Cell D1, type: Total Sales 
8. Format Cell D1 like Cell C1. 
9. Calculate the total sales for each store in Column D. 
10. Format the Mattress Sales, Pillow Sales, and Total Sales fields as Number, no decimal 

places, Use 1000 Separator (,).  

Figure 10.3

11. Insert a column between Store and Mattress_Sales. 
12. In Cell B1, type: Manager 

VLOOKUP() and Absolute References  
Remember that when you copy a formula down, up, or over, the cell references shift as well. This will 
also happen to a range in a VLOOKUP() function unless 1) the range is named or 2) the range is in 
Absolute References. As you learned in Chapter 2, you can press the [F4] key (or Fn+[F4], depending on 
your keyboard) to toggle between Absolute, Mixed, and Relative references. In our case here, we will use 
an Absolute Reference in our VLOOKUP() function. 
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13. In Cell B2, write a VLOOKUP() formula to lookup the full name of each manager listed on 
the  tab, based on the store number. 

14. Make the range in the VLOOKUP() function be an Absolute Reference. 
15. Copy the formula down to all cells below. 
16. If any of the rows grow in size, format all rows in the tab to be 15.00 in height. 
17. Left-justify all manager names and adjust the column width to fit. 

Figure 10.4

Note that when you refer to cells in another tab, the name of the tab and the data range in the formula are 
separated by an exclamation point, as in this VLOOKUP() function. If you refer to a different workbook, 
the name of the workbook appears in brackets (like =[Book1.xlsx]Sheet1!$A$1). This type of a reference 
is called a 3-D reference, as it refers to the three parts of the link’s path. If there are spaces in the name of 
the workbook or in the tab name, the name will be surrounded by apostrophes. As such, when writing 
formulas that refer to ranges or cells in different tabs and/or workbooks, it is usually easier to choose the 
range with your mouse rather than manually typing the entire formula. 
 

18. In Cell F1, type: Budget 
19. Format Cell F1 like Cell E1. 
20. In Cell F2, write a VLOOKUP() formula to look up the budget number in the  

tab based on the Store number. 
21. Format as Number, no decimal places, and Use 1000 Separator (,), then copy Cell F2 

down to all cells.  
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Figure 10.5

22. In Cell G1, type: % Budget 
23. Format Cell G1 appropriately. 
24. In Cell G2, calculate the percent of budget by dividing the Total Sales by Budget. 
25. Format Cell G2 as Percentage, one decimal place, and copy down to all cells below. 

Figure 10.6

The LOOKUP() Function
Now we’re ready to do the actual bonus calculations. The first thing we need to do is to find out the bonus 
percentage for each Store Manager. We will do this with a LOOKUP() function. The LOOKUP() function 
has two arguments in the way we use it: the value to look up and the range. Remember, the lookup value 
and the left-most column in the range must be the same numbers. Let’s go forward. 
 

26. In Cell H1, type: Bonus % 
27. Format Cell H1 accordingly. 
28. Select the Range A2 to B11 on the  tab, and name that range Bonus_Table. 
29. In the Bonus tab, Cell H2, type the following formula: =LOOKUP(G2,Bonus_Table) 
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30. Format Cell H2 as Percentage, two decimal places, and copy down to all cells below.  

Figure 10.7

You should spot check some of these numbers with the Bonus Table on the Assumptions tab to make 
sure the bonus percentages are correct. 

The MATCH() Function  
Another function you can use in this scenario is the MATCH() function. I use this function more 
frequently than the LOOKUP() function as it is more versatile. The MATCH() function returns the relative 
position of an item in a table or array that matches a specified value in a specified order. You should use 
the MATCH() instead of one of the LOOKUP functions when you need to see the position of an item in 
a range instead of the item itself. The MATCH() function has two required arguments and one optional 
argument. The two required arguments are the lookup value and the lookup array (which is the database 
range or table). It is important to know that the table or array must be sorted by the lookup value. Let’s 
try an example. 
 

1. In Cell I1, type: Match 
2. Format Cell I1 appropriately. 
3. In Cell I2, type the following formula: =MATCH(G2,Assumptions!$A$2:$A$11) 
4. Copy to all cells below.  
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Figure 10.8

The MATCH() function returns the position of the lookup value. The first lookup value, 72.7%, 
is positioned between 0% and 100% in the database range and is in the first position. The next value, 
155.7%, is between 150% and 200%, in the seventh position, and so forth. To find the Bonus % value in 
the table, we need to edit the Assumptions tab a bit. 
 

5. On the  tab, insert a column to the left of the % of Budget column. 
6. In Cell A1, type: Position 
7. Underline Cell A1. 
8. Type the numbers 1 – 10 in Cells A2 through A11.  

Figure 10.9
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9. On the Bonus tab, Cell J1, type: Match Bonus % 
10. Format Cell J1 like the others in Row 1, and resize the column. 
11. In Cell J2, write a formula that looks up the value of Cell I2 in the database range A2 to C11 

on the  tab, and returns the value in the third column. 

12. Format Cell J2 as Percentage, two decimal places, and copy to all cells below. 

Figure 10.10

Nesting MATCH() within a VLOOKUP()  
The percentages in Column J should exactly match the percentages in Column H. In order to make the 
formula take up only one column instead of two, you can nest the MATCH() function in Column I into 
the VLOOKUP() Formulas in Column J.  

13. Copy the formula in Cell I2 (everything after the “=” sign), and replace the I2 reference in the 
formula in Cell J2 with it. 

14. Copy to all cells below. 
15. Delete Column I.  
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Figure 10.11

Since we don’t need two columns with the exact same data in them, you can delete one of the columns. 
Let’s keep the column with the MATCH() function in it. 
 

16. Delete Column H. 
17. Rename Cell H1 Bonus %, and resize the column to fit.  

Figure 10.12

Up to now, the formula is only calculating the percentage at which the SM earned a bonus. Now we have 
to write a formula that multiplies the Bonus % by the Total Sales column. 
 

18. In Cell I1, type: Bonus Earned 
19. Format Cell I1 like the other headers in Row 1, and resize the column. 
20. In Cell I2, write a formula that multiplies the Bonus % by the Total Sales. 
21. Format Cell I2 to be Number, two decimal places, Use 1000 Separator(,), and copy down. 
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Figure 10.13

22. In the  tab, Cell E4, type: Bonus Earned 
23. In Cell F4, write a SUM() formula that will sum the values in the Bonus tab, Column I. 
24. Format Cell F4 as Number, two decimal places, use 1000 Separator(,). 
25. Bold Cells E4 and F4. 
26. Resize Columns E and F.  

Figure 10.14

Now you can change the numbers in the Assumptions tab and see the total Bonus Earned number 
change accordingly. Too cool! 

Review Questions: It is now time to complete the hands-on Review Questions. 
Log on to www.ExcelCEO.com with your Email address and Password, click 
on the Excel 2016 Review Questions, Chapter 10, Section 1 of 2 option in 
your Main Menu, and complete the Review Questions. 

Logical Functions  
Let’s talk a little about Logical functions. Logical functions are the essence of writing formulas. All of 
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the functions and formulas that you have previously written can be incorporated into logical functions. 
The most common logical function by far is the IF() function. You have already experimented a little 
with the IF() function in Chapter 6. We will expand on that knowledge and introduce some other logical 
functions in the next few exercises.  

The CELL() Function  
How many times have you printed a report and then months or even years later someone shows 
you the report and wants you to update it? It happens more often than you realize. When I create 
spreadsheets, I like to put the name of the file and its path onto the report. There is a function you 
can use to help with this: the CELL() function. The CELL() function displays information about 
the formatting, location, or contents of the upper-left cell in a reference. There is one argument in a 
CELL() function, info_type. Following is a list of all the available info_types in the CELL() function.  

Info_type Value Returned
“address” Reference of the first cell in reference, as text.
“col” Column number of the cell in reference.
“color” 1 if the cell is formatted in color for negative values; otherwise 

returns 0 (zero).
“contents” Value of the upper-left cell in reference; not a formula.
“filename” Filename (including full path) of the file that contains reference, 

as text. Returns empty text (“”) if the worksheet that contains 
reference has not yet been saved.

“format” Text value corresponding to the number format of the cell. The 
text values for the various formats are shown in the following table. 
Returns “-” at the end of the text value if the cell is formatted in 
color for negative values. Returns “()” at the end of the text value if 
the cell is formatted with parentheses for positive or all values.

“parenthesis” 1 if the cell is formatted with parentheses for positive or all values; 
otherwise returns 0.

“prefix” Text value corresponding to the “label prefix” of the cell. Returns 
single quotation mark (‘) if the cell contains left-aligned text, 
double quotation mark (“) if the cell contains right-aligned text, 
caret (^) if the cell contains centered text, backslash (\) if the cell 
contains fill-aligned text, and empty text (“”) if the cell contains 
anything else.

“protect” 0 if the cell is not locked, and 1 if the cell is locked.
“row” Row number of the cell in reference.
“type” Text value corresponding to the type of data in the cell. Returns “b” 

for blank if the cell is empty, “l” for label if the cell contains a text 
constant, and “v” for value if the cell contains anything else.

“width” Column width of the cell rounded off to an integer. Each unit of 
column width is equal to the width of one character in the default 
font size.
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The most common argument in the CELL() function I use is filename. Let’s use this function in the 
spreadsheet we just modified. 
 

1. In Cell A16 of the Assumptions tab, type the following formula: =CELL(“filename”) 
2. Italicize Cell A16. 
3. Select Cells A15 through D15 and draw a line at the bottom of the cell using the Border icon.  

Figure 10.15

4. Save and close the myBonus.xlsx file. 
 
Since I create SO MANY spreadsheets, I like to use this function, if for no other purpose, to help me find 
the file when someone has a printout. 
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Let’s open another file so we can practice with Logical Functions a little more. 
 

1. Open the file at C:\ExcelCEO\Excel 2016\Chapter10\Bonus2.xlsx. 
2. Save As C:\ExcelCEO\Excel 2016\Chapter10\myBonus2.xlsx. 
3. Click in the  tab.  

Figure 10.16

This is the same file as the Bonus.xlsx file you just worked with, except I’ve added in a little more data. 
The first change is that there are different levels of bonus percentages. The levels (Paper, Scissors, Rock) 
are based on the Budget for each location. I’ve already taken the liberty of naming the % of budget 
ranges appropriately (Paper, Scissors, and Rock). The range name for the Budget Levels, found on the 
Assumptions tab Cells D2 through Cell E4, is Bgt_Levels, and the named range for the Budgets found in 
the Budget tab is Budget. Your job is to complete the bonus calculations with the available data. Let’s get 
started. 
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The first thing we have to do is to bring in the Budget numbers into the Bonus tab.  

4. Click on the  tab. 

5. In Cell F2, write a VLOOKUP() formula that brings the Budget numbers by store number 
from the  tab. 

6. Copy down.  

Figure 10.17

We already have a problem. Look at Store No. 1053 on Row 25. We’re getting an #N/A error message. 
Why is that? If you look in the Budget tab, you will see that there is no budget for Store 1053. This is a 
new store that we haven’t established a budget for yet. Our manager tells us that if there is no budget, just 
make it 0. That store manager won’t qualify for a bonus this month. 
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The IFERROR() Function  
The IFERROR() function is one solution to error handling. We can write a formula using the IFERROR() 
function to make the formula that produces an error return something other than the ugly #N/A or 
#DIV/0! messages, like 0. Let’s first write the formula in an adjacent cell, then we’ll combine the two. 

7. In Cell G2, write the following formula: =IFERROR(F2,0), then copy down. 

Figure 10.18

This formula says that if the value in Cell F2 is an error, return a 0, otherwise, return the value of Cell F2. 
Now we will incorporate the formulas in Cells F2 and G2 into one cell. In previous versions of Excel, you 
had to combine an IF() function with an ISERROR() function. That was an effective work-around, but 
having the formula work the way it was intended is even better! For reference, the old formula would have 
looked like this: =IF(ISERROR(F2),0,F2)
 

8. Copy the formula in Cell F2 (without the “=” sign) and replace the F2 reference in the formula 
in Cell G2. 

9. Move Cell G2 to Cell F2. 
10. Copy down to all cells in Column F, and delete the formulas in Column G. 
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Figure 10.19

The Budget for Cell F25 now reads “0” instead of the error message. 
 

11. In Cell G2, write the following formula: =E2/F2 
12. Format as Percentage, one decimal place, and copy down. 

Figure 10.20

Dang it! Another error. Notice in Cell G25 there is a #DIV/0! message. As you learned previously, 
this happens when you try to divide a number by zero. In this case, you could use an ISERROR() or 
IFERROR() function to correct it, but I usually try to keep things simple, so we’ll use an IF() function to 
solve when the denominator is 0. 
 

13. Edit the formula in Cell G2 to read: =IF(F2=0,0,E2/F2) 
14. Copy down.
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Figure 10.21

Problem solved. Note that there are other functions like ISNA() that will help you find errors. I tend to 
use the IFERROR() function as it will handle all errors, not just the #N/A error. Let’s continue on.

15. Write a formula in Cell H2 that brings in the Budget Levels using the named range Bgt_
Levels.

16. Copy to all cells below, and resize the column.
  

Figure 10.22
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Now comes another tricky part. The bonus calculation depends on the level. If the level is Paper, then use 
the Paper range. If it is Scissors, use the Scissors range, and if it is Rock, use the Rock range. Let’s try it. 

17. In Cell I2, write the following formula: =IF(H2=“Paper”,LOOKUP(G2,Paper),IF
	 (H2=“Scissors”,LOOKUP(G2,Scissors),LOOKUP(G2,Rock)))
18. Format as Percentage, two decimal places, and copy down.

Figure 10.23

This formula says that if the Level is Paper, then do a LOOKUP() function on Cell G2 using the range 
called Paper. If that argument is false, then the logic moves to the second argument using the Level 
Scissors, then do a LOOKUP() function on Cell G2 using the range called Scissors. For everything else 
(only the Rock Level remains), do a LOOKUP() function on Cell G2 using the range called Rock. This is 
another example of a nested IF() statement, or an IF() function within an IF() function.  

To complete the project, calculate the bonus. 

19. In Cell J2, write a formula that calculates the bonus by multiplying Cell I2 by Cell E2. 
20. Format as Number, two decimal places, Use 1000 Separator (,), and copy down.  

Figure 10.24
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The total bonus payable should be $33,093.47. 

The AND() and OR() Functions  
The last two logical functions we will cover are AND() and OR(). The AND() function returns TRUE 
if all of the conditions in the statement are true, and FALSE if any one of the statements is not true. The 
OR() function behaves in a similar manner, except that it returns TRUE if any of the statements are true 
and FALSE if all of them are false.   

For example, let’s say you want to include a column of Yes/No values indicating whether or not the store 
is a “Rock” store AND they qualified for a bonus. You can have up to 30 logical conditions in an AND() 
or OR() function, but please don’t put that many in. That will drive you crazy trying to find an error. 
 

21. In Cell K1, type: Rock Qualifiers, and format accordingly. 
22. In Cell K2, type: =IF(AND(H2=“Rock”,I2<>0),“Yes”,“No”) 
23. Copy down to all cells.

Figure 10.25

There should be three “Yes” values: Store numbers. 1026, 1034, and 1040.  
 
Now let’s work on an example using the OR() function. Upper management wants to send letters of 
congratulations to all of the Store Managers who made equal to or above 125% of budget, and inquiry 
letters to all managers whose stores were below 75% of budget. You want to know how many letters will 
be sent out, irrespective of the type of letter. 
 

24. In Cell L1, type: Letter List, and format appropriately. 
25. In Cell L2, write the following formula: =IF(OR(G2>=1.25,G2<0.75),“Yes”,“No”) 
26. Copy down to all cells below.  
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Figure 10.26

There should be 14 “Yes” values in the Letter List field.

27. Save and close the myBonus2.xlsx file. 

Error Finding and Checking  
Let’s talk a little about errors. Have you ever opened a workbook that was created by someone else and 
had trouble trying to follow their logic? Hopefully, the last user kept the formulas in the worksheet, so 
other users could try to understand what they did. Excel has some great error checking and auditing 
tools that make it visually easier to discover how the formulas were written and can help save a lot of 
time when you are trying to follow someone else’s logic. You can see the cells that are active in a formula 
by tracing the cell’s precedents. You can also find not-so-obvious errors in the calculations. Let’s explore 
some of these tools. 
 

1. Open the Errors.xlsx file at C:\ExcelCEO\Excel 2016\Chapter10\ 
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Figure 10.27

The file is a spreadsheet that contains the store number, the name of the manager, the mattress sales, 
pillow sales, and total sales, along with the store’s budget. There are two obvious errors in the table: Cells 
F25 and F32. You can see some of the errors because of the #N/A error messages. Let’s first look at which 
cells make up the error in Cell F32. 
 

2. Click on Cell F32. 
3. Click on the Formulas tab, then click on the Trace Precedents button in the Formula 

Auditing group.  

Figure 10.28
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A red arrow appears going from Cell F2 through F32. These are the ﻿precedent cells for Cell F32. The cell 
range is also encircled by a blue line. Now you can visually see which cells are included in the formula, 
and you should see that Cell F25, which is included in the range, is the source of the error. 
 

4. Click on the Remove Arrows button. 

 All arrows and the blue box are now removed.  
 

5. With your cursor on Cell F32, click on the drop-down arrow next to the Error Checking 
button, and choose Trace Error.  

Figure 10.29

Excel shows you the path to the source of the ﻿errors, which first goes to Cell F25, then to Cell A25. Cell 
F25 is a VLOOKUP() formula based on Cell A25. 
 

6. Click on the Remove Arrows button. 
 
 We can easily identify those two errors because of the ﻿#N/A error message. But are there any other errors? 
Error messages like the #N/A error are very obvious, but there may be other errors in the spreadsheet that 
you can check for. Let’s run a formula error check on the table. 
 

7. With your cursor on Cell F32, click on the Error Checking button (not the drop-down menu).  
﻿
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Figure 10.30

The Error Checking dialog box appears. In the upper-left corner of the dialog box you will see “Error in 
cell F32” with the cell’s formula below it. It tells you what kind of an error is occurring as well. We won’t 
do anything about this error for now, so let’s continue. 

8. Click Next.  

Figure 10.31

The dialog box goes to Cell F8 and finds an inconsistent formula, based on the cells surrounding it. The 
formula “VLOOKUP(A9,Budget!Budget,2,FALSE)” should be referring to Cell A8 instead of Cell A9. 
 

9. Click the Copy Formula from Above button.   
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Figure 10.32

After you click the button, it takes you to another inconsistent cell, Cell E20. 
 

10. Click the Copy Formula from Above button again. 

Next, it takes you to Cell F25, which has the VLOOKUP() error. We’ll skip that one. 
 

11. Click Next.  

Figure 10.33

12. Click OK. 
13. Close the Errors.xlsx file without saving it. 
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I would encourage you to continue to explore all of the auditing tools available in Excel. We only touched 
on a few of them here, but it gave you a good introduction to get you thinking about some tools that 
would be helpful to you.  
 
Writing formulas is what Excel is all about. We reviewed a lot of functions and formulas in the last five 
chapters. It may have been painful, but most good medicine doesn’t taste real good. I hope you will learn 
to use these functions in your everyday work. They can make your job MUCH easier and will result in 
better analyses and reports. I encourage you to make up some examples of your own using data in your 
world. You will remember these concepts much easier that way. 
 

Review Questions: It is now time to complete the hands-on Review Questions. 
Log on to www.ExcelCEO.com with your Email address and Password, click 
on the Excel 2016 Review Questions, Chapter 10, Section 2 of 2 option in 
your Main Menu, and complete the Review Questions.  

Conclusion  
In this chapter, you learned some of the advanced uses of LOOKUP functions. You learned why and how 
to use Absolute References in a VLOOKUP() functions. You learned to use a LOOKUP() function and 
wrote a number of formulas using that function. You also learned how to use a MATCH() function. You 
worked examples of nesting a MATCH() function within a VLOOKUP() function. You learned about 
Logical functions and wrote formulas containing the ISERROR(), CELL(), AND(), and OR() functions. 
You saw how to find and check for errors using Formula Auditing functionality. You also built a complex 
spreadsheet that calculates bonuses based on multiple criteria and set it up where the criteria could easily 
be changed. 

Chapter Exam  
To take the examination for this chapter, you must have successfully completed the examination for the 
previous chapter. You can now go to www.ExcelCEO.com, login to your ExcelCEO student profile, and 
take the exam. Make sure that you take the exam on the same computer on which you completed the 
practice files, as some of the questions on the exam may refer to some of the completed projects. Chapter 
exams are intended to be hands-on.

 
 



SECTION III: ADVANCED EXCEL 2016 
 
 
One of my beliefs is that the developer of a report or analysis should make it as easy as possible for 
the user to manipulate. For example, I’ve written courses to train upper management personnel to 
manipulate PivotTables and use VLOOKUP() functions. I have found that some executives love the 
capability of manipulating PivotTables so they can find out the answers to the questions they have 
without having to ask me to run it for them each time. Others, however, lack the willingness to learn. 
Therefore, I try to make my spreadsheets very easy to use. In this section, we will continue to explore 
many procedures and functionalities that can assist you in analyzing data, understanding it, and sharing 
it with others. 
 
PivotTables was the major technological breakthrough with the release of Office 95. Before PivotTables, 
users could use Data Tables, but they were clunky to program. I remember thinking when I did my first 
PivotTable that this was the wave of the future. PivotTable technology has significantly improved the 
ease of manipulating large amounts of data to the point where just about anyone can do it with minimal 
instruction. I believe that PivotTables are key to understanding grouping of data - not only in Excel, but 
in database programs like Access, SQL Server, and Oracle. If you understand the concept of PivotTables, 
the concepts of the GROUP BY statement in Access, and writing transact SQL code will come much 
easier.  
 
Chapter 11 introduces you to PivotTables. In that chapter, you will create a simple PivotTable, show and 
hide the PivotTable Fields list, add rows, columns, and data fields to an existing PivotTable; filter fields, 
and move or “pivot” fields around in a PivotTable. You will create a calculated field, explore PivotTable 
Options and learn how to sort data within a PivotTable. In Chapter 12, you will explore more advanced 
functions of PivotTables. You will create complex calculated fields, set up a PivotTable with drill-down 
capability, and learn about formatting PivotTable and PivotChart reports. You will start to work with 
External Data Sources, and finally, pull external data containing hundreds of thousands of rows of data 
directly into a PivotTable. 
 
The remaining chapters of this section address various advanced topics where the goal is to teach you 
some of the advanced tools I’ve found most helpful in making spreadsheets “user-friendly”, but very 
powerful. These include charts and graphs, inserting graphics, analysis tools, protection and sharing, 
macros, using the Developer tab (which contains some very cool tools), and exposure to working with the 
Web.  
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CHAPTER ELEVEN — INTRO TO PIVOTTABLES 
 
 

Chapter Objectives: 
 

•    Identify the correct method to create a simple PivotTable
•    Recognize the PivotTable Fields list utilizing the Analyze contextual tab
•    Choose Row, Column, and Data Fields in a PivotTable
•    Select field formats in a PivotTable with Value Field Settings
•    Identify data fields from the PivotTable Fields list to be viewed in an existing PivotTable
•    Recognize the methodology to create basic Calculated Fields from the insert Calculated Field 

dialog box
•    Select PivotTable settings with the PivotTable Options dialog box
•    Indicate the appropriate way to sort data within a PivotTable using simple filters

Projects You Will Complete During This Chapter:

•	 myAnnual_Sales.xlsx

 

CPE Credits possible for this chapter: 2.5
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Introduction
With the massive databases that exist in most companies, there is a desperate need to be able to capture 
that data and present it in a meaningful format, with the ability to extract, summarize, sort, filter, and 
organize the data in a meaningful and actionable way. Once you have captured data, you need to be able 
to create reports that analyze the data, make comparisons, detect patterns and relationships, and analyze 
trends. All of this is possible, and very easy to do, with PivotTables. 
 
If there is any chapter in this course I want you to learn inside and out, it’s this one. PivotTables are a pre-
cursor to “grouping”, or a “GROUP BY” statement in Access and SQL. PivotTables are simply subtotaling 
data by using different fields and filters. You can dynamically “pivot” a field as a row, column, or page 
filter and instantly see the results.  
 
I speak three languages (English, which is my native language, Portuguese, and Spanish). When I 
speak in English, I think in English. When I speak in Portuguese, I think in that language, and I do 
the same with Spanish. People who speak only one language seem to have a hard time grasping how 
one can “think” in a different language, but it comes very easy to those who speak the language fluently. 
Similarly, it takes a change in thought pattern to understand grouping and relational databases, and using 
PivotTables is a great way to introduce that concept. 

A Simple PivotTable  
There are many ways to manipulate data within a PivotTable, and data can come into an Excel 
spreadsheet in various manners, like copy and paste from an Access database, or link to a SQL Server 
table, import from a .CSV file, among other ways. In this chapter, I will assume that you don’t have to 
worry about the source of the data. We covered that in previous chapters. We will assume the data is 
correct and your job is to manipulate and reorganize the information, as necessary, to present to upper 
management. Let’s rock and roll! 
 

1. Open the file C:\ExcelCEO\Excel 2016\Chapter11\Annual_Sales.xlsx. 
2. Save As C:\ExcelCEO\Excel 2016\Chapter11\myAnnual_Sales.xlsx.  

Figure 11.1
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This file is a table of sales by store. Fields in the table include the Store_No, City, State, Region, Year, 
Month, Merchandise Sales, Warranty Sales, and Delivery Sales. The Region field is a geographic 
assignment that Nitey-Nite has created to make groups of stores easier to manage. Each Region has a 
Regional President. The Regional Presidents report to the President of the company. In this exercise, you 
will calculate the total sales for the Company by year.  
 

3. Click on Cell A2 (or any single cell within the table), click on the Insert tab, and click on the 
PivotTable button in the Tables group. 

 

Figure 11.2

The Create PivotTable dialog box appears. In Excel 2003, a similar action launched the PivotTable 
Wizard, but in Excel 2016, there is no such wizard. For this and other reasons, I think you will prefer the 
way Excel 2016 handles PivotTables. 
 

4. Click OK. 
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Figure 11.3

On a wide screen, your expanded View would appear as below:

Figure 11.4
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Since you began with a table in Excel, Excel automatically assumes you want to use the table where your 
cursor is. 

Note: When creating a PivotTable in this manner (i.e., by clicking on only one 
cell within the table), Excel includes all of the contiguous cells (columns and 
rows) in the PivotTable. Therefore, there should be no blank columns, rows, 
or field names in the table you want to use.

The value in the Table/Range: box should read $A$1:$I$1074, which is the range of our data.  

The PivotTable Fields list  
When the shell of the PivotTable is created, you will see the PivotTable Fields list on the right side of the 
screen (as well as several contextual tool boxes you will see and use later). This Fields list contains all of 
the column headings in the data tab (Excel automatically assumes that the first row of your database 
contains the correct headings, so it is important that the headings are appropriately named). The Office 
Ribbon will automatically change to include a new grouping of contextual tabs called PivotTable Tools 
which contains two tabs: Analyze and Design. We will be working extensively with these new tabs. You 
can click on the Field List button to hide or show the PivotTable Field List. Note that your cursor must be 
somewhere in the PivotTable (anywhere in the Page Fields, Column Fields, Row Fields, or Data Fields) for 
the icons in the PivotTable Tools group to become active and usable.   

Row, Columns, and Data Fields  
Your task is to calculate the year-over-year sales for all data in this table, so let’s start moving fields into 
the row, column, and data areas of the PivotTable. 

5. In the PivotTable Fields list, click on the checkbox beside the Region field. 

Excel automatically assumes that you will be using the Region field as a row item, so it places the two 
values for Region (Northern Region and Southern Region) as rows. If you don’t want Excel to guess 
where you want the fields, you can drag them to the area you want them. 
 

6. Drag the Year field down to the Columns group of the PivotTable Fields list. 
7. Drag the Merchandise Sales field to the section in the PivotTable Fields list called Values. 

Figure 11.5
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Congratulations! You just created a PivotTable. But those numbers look kind-of ugly. Let’s apply some 
formatting to make them easier to read.

8. Click on the Sum of Merchandise Sales field in the PivotTable (it should be on Cell A3). 
9. Click on the Field Settings button in the Active Field group of the Analyze contextual tab. 

Figure 11.6

The Value Field Settings dialog box appears. With this dialog box, you can change the setting and 
formatting of a PivotTable field. It is already summing the data correctly (i.e., we don’t want a COUNT or 
AVERAGE summarization), but we will format the field to be Number with zero decimal places. 

10. Click on the Number Format button. 
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Figure 11.7

The Format Cells dialog box appears, but unlike the typical Format Cells dialog box, this one has only 
the Number tab. 
 

11. Format the field to be Number with zero decimal places, check the Use 1000 Separator (,) 
option, and click OK. 

12. Click OK in the Value Field Settings dialog box. 
 
Your PivotTable should now look something like the figure that follows:
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Figure 11.8

Note that when a field in the Field List box is used in a PivotTable, it appears bold and checked.  

Filtering Fields  
Per the PivotTable, there were Merchandise Sales of $95,602,924 for all years in the data. It also tells 
us what the corresponding Merchandise Sales for each year. Look at the amount for the Year 2017. It is 
significantly lower than the other years. That is because the data for the sales stopped in January 2017. 
Most likely, this data was extracted from the system after 2016 had closed and picked up some data that 
had already been posted in 2017. We don’t need the 2017 data in our PivotTable, so let’s exclude it. The 
filter functionality in a PivotTable works very similar to a data filter you learned previously. 
 

1. In the PivotTable, click on the drop-down arrow next to Column Labels, and uncheck the 
2017 checkbox. 

2. Click OK.  
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Figure 11.9

Once you click OK, the 2017 data is filtered out of the PivotTable. By default, the (Select All) option is 
selected when filtering Row, Column and data fields. Now you have a list of Merchandise Sales for each 
region in each year, excluding 2017. That wasn’t too hard, was it?  

Adding Fields  
Now, upper management would like to see Merchandise Sales by state within the Regions. Let’s add in 
the State field in our PivotTable. 
 

3. In the PivotTable Field List, drag the State field down to the Rows section under Region.  
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Figure 11.10

Now you have columns for the Region, State, and Merchandise Sales for 2014, 2015, and 2016. Are you 
getting the picture now? Manipulating a PivotTable isn’t much more difficult than that – just clicking and 
dragging the fields where you want the data to be organized.  
 
This PivotTable shows what I consider to be one of the most significant changes from Excel 2003 to what 
is available in Excel 2007 and beyond. In Excel 2003, the State field would have shown up in its own 
column. In versions from Excel 2007 on, multiple columns of rows appear in a Compact View, which has 
the show (+) and hide (-) buttons to the left of the field values.  You can switch between compact, outline, 
and tabular Views of a PivotTable by clicking on the Report Layout button in the Layout section of the 
Design tab. 
 

4. Click on the Report Layout button in the Layout group of the Design tab, and choose Show 
in Outline Form. 

Figure 11.11
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Play around with the different layouts for a PivotTable. I prefer the Compact Layout as it saves on space 
(all of the row fields are contained in one column). Right now, our PivotTable includes only Merchandise 
Sales, but we also have Warranty Sales and Delivery Sales. We want to include those fields in our 
PivotTable as well. 
 

5. Set the PivotTable to a Compact form. 
6. From the PivotTable Fields list, drag the Warranty Sales field and drop it below the Sum of 

Merchandise Sales in the Values section. 
7. Drag the Delivery Sales field, and drop it below the Sum of Warranty Sales in the Values 

section. 

When you drag a second level of data into the Values section, you will see the field appear in the Columns 
section. This tells you that the values in the Values section will appear as columns. We want the values to 
appear as rows, so you need to move the  field into the Rows section.  
 

8. Move the  field from the Columns section to the Rows section of the PivotTable 
Fields list. 

9. Click on any one of the Sum of Warranty Sales cells in the PivotTable and set the format to 
Number, zero decimal places. Check the Use 1000 Separator (,) box.

10. Apply the same formatting for Sum of Delivery Sales.
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Figure 11.12

Review Questions: It is now time to complete the hands-on Review Questions. 
Log on to www.ExcelCEO.com with your Email address and Password, click 
on the Excel 2016 Review Questions, Chapter 11, Section 1 of 2 option in 
your Main Menu, and complete the Review Questions.  

Report Filter  
As you can see, the PivotTable gets more complex each time you add a field. Let’s suppose that upper 
management is not really interested (for this analysis) in a year-over-year analysis, but rather they want 
to see each year by itself with the corresponding sales figures. We can let them choose to see the year they 
want by making the Year field a Report Filter. A Report Filter filters the entire PivotTable for a chosen 
item. 
 

1. Drag the Year field from the Columns section to the Filters section. 
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Figure 11.13

The Year indicator changes to (Multiple Items) since we had previously deselected 2017. To include all 
years, simply click on the Year drop-down menu and check the 2017 checkbox. 
 

2. Click the Year drop-down arrow, uncheck all boxes except for 2014 and click OK. 
 
All of the data now changes to reflect only the sales in 2014. I think it’s kind of clunky looking at the sales 
fields (Merchandise, Warranty and Delivery) on top of one another. Let’s pivot the data around where the 
sales fields appear in columns rather than in rows. 
 

3. Move the  field over to the Columns section of the PivotTable Fields list. 
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Trick: If more than one level of data is dropped into the Columns or Rows 
section of the PivotTable grid, the Values drop-down will appear below the 
Field boxes. You can move this between Columns and Rows to change how 
the drop-down data is displayed in the PivotTable. Be careful though! The 
amount of data being displayed can make the transition time-consuming.

Figure 11.14

The columns are kind-of wide, so let’s rename the fields to save space.

4. Click on Cell B3, which currently reads Sum of Merchandise Sales.
5. Rename Sum of Merchandise Sales to Merchandise.
6. Replace Sum of Warranty Sales with Warranty, and Sum of Delivery Sales with Delivery.
7. Adjust the column widths to fit.

Figure 11.15
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Calculated Fields  
At this point, let’s talk about calculated fields. There is not a field in the Annual_Sales tab or in the 
PivotTable that sums up all sales, so let’s do that in the PivotTable itself. 
 

1. Make sure your cursor is somewhere on the PivotTable, and click on the Fields, Items, & Sets 
button in the Calculations group of the Analyze contextual tab. 

2. Choose Calculated Field…  

Figure 11.16

3. In the Name: field in the Insert Calculated Field dialog box, type Total_Sales. 
4. Delete the 0 in the Formula: box 
5. In the Fields: box, click on Merchandise Sales and click the Insert Field button. 
6. In the Formula: box, to the right of “Merchandise Sales”, type the “+” key. 
7. Double-click on the Warranty Sales field in the Fields: box. 
8. Type the “+” key. 
9. Double-click on the Delivery Sales field in the Fields: box.  
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Figure 11.17

The formula should read =‘Merchandise Sales’ + ‘Warranty Sales’ + ‘Delivery Sales’.

Note that when there is a space in the field name, Excel will surround the field name with apostrophes.
 

10. Click OK.  

Figure 11.18

Now you have created a new field that calculates Total Sales. It is called Sum of Total_Sales. Again, that 
name is too long, so let’s change it. 

11. In the PivotTable, change Sum of Total_Sales to Total. 
12. Resize the column.
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Figure 11.19

Now you have an analysis that means something. You send this to your manager and he loves it. Then he 
says, “You know, we really do need to look at annual sales in one table, but it needs to show total sales, not 
the individual sales categories. Can your PivotTable do that?” Your response is, “Yes, but it’s REAL hard to 
do, and I’m the only one in the company who can do it.” We’ll keep the truth just between us. 
 
To do what he requested, we need to get rid of the Merchandise, Warranty, and Delivery fields, keep the 
Total field and bring the Year field back down as a Column Label. That shouldn’t be too hard, should it? 
Let’s see. 
 

1. Uncheck the Merchandise Sales, Warranty Sales, and Delivery Sales fields from the 
PivotTable Fields list (this takes those fields out of the PivotTable), but leave the Total_
Sales field. 

2. Drag the Year field from the Filters section to the Columns section. 
3. Click on the Column Labels drop-down menu in the PivotTable, and select all years except 

2017.  

Figure 11.20
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PivotTable Options  
The Grand Total column (Column E) really doesn’t add anything to our analysis, so we can take it out. 
We do that by using PivotTable Options. 
 

1. Right-click anywhere in the PivotTable and choose PivotTable Options…  

Figure 11.21

The PivotTable Options dialog box appears. 
 

2. Click on the Totals & Filters tab. 
3. Uncheck the Show grand totals for rows box and click OK. 

 
You can also click on the Options button in the PivotTable section of the Analyze tab to display the 
PivotTable Options dialog box. After you click OK, the Grand Total column in the PivotTable goes away. 
Take a moment and review the various options available in this dialog box. You will use many of them. 

Sorting within a PivotTable 
Now that we’ve created fields within our PivotTable and pivoted the information around a bit, let’s do 
some sorting. Sorting a PivotTable in Excel 2003 was a bit cumbersome, as you had to use the Sort and 
Top 10 functionality. Excel 2016 provides a cool Sort section for sorting within a PivotTable. Let’s suppose 
you want to sort the PivotTable to make the States with the most Total Sales appear on top (Descending 
order) within each region. 
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4. Right-click on any cell under the 2016 column. 
5. Point to the Sort option in the drop-down menu, and select More Sort Options...  

Figure 11.22

The Sort By Value dialog box appears. By default, the Smallest to Largest and Top to Bottom radio 
buttons are selected. The Summary section below reads that this will sort the State field by the Total 
in Ascending order using the values in the 2016 column. Since we want to sort from high to low (or 
descending order), we need to click on the Largest to Smallest radio button. 
 

6. Click on the Largest to Smallest radio button. 
7. Click OK. 

Your PivotTable should now look like the figure below: 

Figure 11.23



Excel Tips, Tricks and Training for You to Become the Chief Excel Officer of Your Company

ExcelCEO 

            Chief Excel Officer 298

The data is now sorted by State. Easy, huh? 
 

8. Rename the sheet containing the PivotTable to Pivot. 
9. Save and close the myAnnual_Sales.xlsx file. 

 
As you can see, PivotTables are very useful tools for organizing, slicing, and dicing your data. Go over the 
exercises in this chapter again and again until you thoroughly understand the concepts of PivotTables. It 
will significantly enhance your future understanding of the “GROUP BY” clause in SQL. We’ll explore 
more about PivotTables in the next chapter. 
 

Review Questions: It is now time to complete the hands-on Review Questions. 
Log on to www.ExcelCEO.com with your Email address and Password, click 
on the Excel 2016 Review Questions, Chapter 11, Section 2 of 2 option in 
your Main Menu, and complete the Review Questions. 

Conclusion 
In this chapter, you began your introduction to PivotTables. First, you created a simple PivotTable. You 
learned how to show and hide the PivotTable Field list, and added rows, columns, and values to the 
PivotTable. You learned how to format fields and filter fields within a PivotTable. You added fields, moved 
fields around, added a Report Filter and even calculated a new field. You learned how to work with the 
PivotTable Options dialog box. Finally, you learned how to sort data within a PivotTable. 

Chapter Exam  
To take the examination for this chapter, you must have successfully completed the examination for the 
previous chapter. You can now go to www.ExcelCEO.com, click on Sign In, log in and take the exam. 
Make sure that you take the exam on the same computer on which you completed the practice files, 
as some of the questions on the exam may refer to some of the completed projects. Chapter exams are 
intended to be hands-on. 
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CHAPTER TWELVE — ADVANCED PIVOTTABLES 
 
 

Chapter Objectives: 
 

•    Identify a PivotTable’s Field Settings to customize data appearance
•    Recognize how to develop complex calculated fields in a PivotTable
•    Indicate levels of data within a PivotTable to use drill-down capability
•    Determine how to create a PivotChart Report
•    Identify the procedure on how to connect to an External Data Source
•    Recognize how to pull external data directly into a PivotTable

Projects You Will Complete During This Chapter:

•	 mySales_Summary.xlsx
•	 myAccess.xlsx
•	 myGL_Summary.xlsx

CPE Credits possible for this chapter: 3
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Introduction
Once I received a phone call from a financial manager in another state. She had a database of personnel 
information and wanted to roll it up to various management levels within our organization. This 
manager had heard of PivotTables, but understood they were very complex, and wanted to know the 
name of a good consultant to do the PivotTable for us. I said, “Yes. You.” I asked why she couldn’t do the 
PivotTable for herself. Her response was that she didn’t have the time to learn how to use PivotTables 
before the report had to be ready. I asked her to send me the database via email, and then I spent about 15 
minutes showing her how to manipulate a PivotTable on the phone. She was fascinated with how easy it 
was to create and manipulate PivotTables, as I hope you are as well. 
 
Now that you have a taste of PivotTables, we’ll have a little more fun with them. Again, the main concept 
I want you to learn here is how to pivot fields within the database to group and summarize the data. You 
can use just about any of the fields in the database for such a summary and you can do just about any 
calculation. 
 
Let’s suppose that your manager wants to look at annual sales activity and wants to see a percentage 
growth year-over-year, by state. He also wants the capability to drill-down to find out which stores are 
the lower performers. Remember, sometimes you receive data in different ways, from different files, and 
in different formats. In this chapter, I used the same base data as in Chapter 11, but I’ve changed it around 
a little, so you can experience the different data formats. Instead of having a Year field and each category 
of sales in columns, the Category is one column and the Year is contained in four different columns with 
the sale amounts. Let’s review that file. 
 

1. Open the C:\ExcelCEO\Excel 2016\Chapter12\Sales_Summary.xlsx file. 
2. Save As C:\ExcelCEO\Excel 2016\Chapter12\mySales_Summary.xlsx. 

Figure 12.1

In this file, the amount fields are called 2014, 2015, 2016, and 2017. These are amounts that correspond 
with each Store, Month, and Category. Note that the data under the 2017 column is mostly blanks, as 
there are no sales recorded yet for March 2017 and beyond. Also in this data, Store No. 1009 was closed 
in September 2016, and that store consequently has blanks from September 2016 forward in its sales data. 
You will now create a PivotTable that shows sales by state by year from 2014 - 2017. 
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3. Create a new PivotTable by clicking on the Insert tab, PivotTable button, and click OK. 
4. Drag the State field to the Rows section. 
5. Drag the 2014 and 2015 fields and drop them in the Values section. 
6. Make sure the Values field appears in the Columns section. 
7. Double-click on the Sum of 2014 cell in the PivotTable (to display the Value Field Settings 

dialog box). Format the field as Number, zero decimal places, and Use 1000 Separator (,). 
8. Apply the same formatting to the Sum of 2015 field.  

Figure 12.2

9. Drag the 2016 field and place it in the Values section.  

Figure 12.3
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Change a Field’s Settings  
When you brought in the data for 2016, you may have had some odd results. Since some of the fields 
within the 2016 data are blank, Excel tried to count the cells rather than sum them, resulting in much 
lower numbers than in Years 2014 and 2015. Notice that the name of that column is “Count of 2016” 
instead of “Sum of 2016” (Some versions of Excel 365 are updated to correct for this). Let’s fix that. 
 

10. Right-click on the Count of 2016 cell (it should be Cell D3). 
11. On the pop-up menu, choose Value Field Settings… 

Figure 12.4

12. In the Value Field Settings dialog box, choose Sum. 
13. Click on the Number Format command button and format the field as Number, zero 

decimal places. Click the Use 1000 Separator (,) box.
14. Click OK twice to exit the Format Cells and Value Field Settings dialog boxes.

 
Let’s rename the fields to something that looks better than Sum of 2014, etc. When you rename a field 
within a PivotTable, you can’t use the exact name as it appears in the data. In this example, you can name 
the 2014 column anything except 2014. 
 

15. Rename the Column fields 2014 Sales, 2015 Sales, and 2016 Sales. 
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Figure 12.5

Complex Calculated Fields  
Now we’ll do a more complex calculation and calculate the percentage growth from one year to the next. 
 

1. In the Analyze tab, click on Fields, Items, & Sets, and create a new calculated field. 
2. Name the Calculated Field 15/14_Chg. 
3. Create the formula: =(‘2015’-‘2014’)/ABS(‘2014’) 
4. Click OK. 
5. Format the new field as Percentage, one decimal place. 
6. Rename the new field 15/14 Change. 
7. Move the new 15/14 Change field to the right of 2015 Sales (click on the 15/14 Change field in 

the Values section and move it to between the 2015 Sales and 2016 Sales fields). 
8. Create a similar calculated field for the 16/15 Change. 
9. Resize columns as needed. 

Figure 12.6
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Drill Down in a PivotTable  
Now there’s an analysis you can sink your teeth into. Although we see similar changes between states 
from 2014 to 2015 (ranging from 3.5% to 5.3%), the more current data (2016) shows we may have concerns 
about at least two states, NJ and PA. The PA data even shows sales are declining when we know there was 
an overall price increase. We need to look at more detail about these states to see if there is a problem we 
need to address with local management. But how do you get down to the detail? Before you get on the 
phone and start screaming at the field management, let’s analyze the data a little further. We may need to 
drill down to the Store level and then maybe down to the Category and/or Month level. Let’s set it up. 
 

1. From the PivotTable Field List, drag the Store_No field to below the State field. 
2. Click on the first Row Label (it should be DC in Cell A4), and click on the Collapse Field 

button  in the Active Field group of the Analyze tab. 
3. Drag the Category field below the Store_No field. 
4. Drag the Month field below the Category field. 

Figure 12.7

Clicking on the Show Detail icon (the + button) in the Row Labels column displays all of the data below 
it, and the Show Detail (+) button turns to the Hide Detail (-) button. Since we want to see what’s going 
on in PA, let’s drill down on that state first. 
 

5. Click on the Show Detail (+) button next to PA. 



ExcelCEO 

            Chief Excel Officer

SECTION 3: Advanced Excel   —   Advanced PivotTables

305

Chapter 12

All of the data below PA displays. To collapse the data at the Store No level, click on any Store No and 
click on the Collapse button in the Active Field group. 
 

6. Click on Store No 1005, and click on the Collapse Field button in the Active Field group of 
the Analyze tab. 

Figure 12.8

You now see that Store No 1009 has a 36.9% decrease in sales in 2016 from the 2015 levels. Why is that? 
Let’s drill down on that store. 
 

7. Click the + sign (or double-click on the Store number) on Store 1009 to expand it.  

Figure 12.9
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Now we’re getting somewhere. For the months of September through December, there is no data in any of 
the Delivery, Merchandise, or Warranty categories. Remember? Store No. 1009 was closed in September 
2016, so it won’t have any sales thereafter. It looks kind of strange to have cells in the PivotTable with null 
or no values – it should at least have a zero. Remember that a zero is a number, but this data has no values 
for this store from September through December, and is thus returning nothing. There is a table option 
where you can make null values become zeros, just to make the report look better. 
 

8. Right-click anywhere in the PivotTable and choose PivotTable Options… 
9. In the Layout & Format tab of the PivotTable Options dialog box, make sure the For empty 

cell, show: checkbox is checked, and type 0 in the text box. 
10. Click OK. 

 
Those cells that were null are now populated with 0s, but remember that Store 1009 was closed in 
September 2016, and as such we should probably exclude that store from our analysis to get a true year-
over-year picture. Since the Store No. field is a couple of levels down in the PivotTable, we’ll have to find it 
first then filter out Store No 1009. 
 

11. Click on the Row Labels drop-down menu, and then under the Select Field drop-down 
menu, choose Store_No. 

12. Uncheck Store No 1009 and click OK. 

The PivotTable now collapses to show only the Store numbers, and Store No 1009 is not there. PA now 
shows a 2.2% increase over the prior year, which is much more reasonable than the -1.1% figure. It looks 
like the state of NJ also has some issues. Let’s look into that. 
 

13. Collapse PA and expand NJ. 
 
In reviewing the data, we see that Store No. 1002 has a -1.0% change from 2016 as compared with 2015. 
Typically, we shouldn’t see any stores with negative sales growth from one year to the next, so let’s drill 
down on that store to see what happened there. Remember in analyses like this, you can sort by value 
fields and have the best or worst numbers on top or bottom. 
 

14. Drill into Store No 1002.  

Figure 12.10
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As you can see, there were several months at Store No. 1002 that had Merchandise and other sales that 
were lower than the 2015 levels. Now is the time to get on the phone with the store manager to see what’s 
going on. You can continue to drill down to various levels – any level of data available in your database. 

PivotTable Styles  
At this point, you should get the picture on PivotTables. You should now be able to set up data in a 
PivotTable and be able to drill down to find any level of detail available. Calculated fields make it very 
easy to analyze your data to facilitate drill down analyses. However, the report looks, kind of, bland. Let’s 
work through some examples on making the PivotTable report look a little better. 

1. Hide the detail in the PivotTable by double-clicking NJ. 
2. Click on the Design tab under PivotTable Tools. 
3. In the PivotTable Styles group, click on the More down arrow.  

Figure 12.11

A menu appears that shows all of the pre-formatted PivotTable styles. In addition to the styles provided, 
you can create your own style by clicking on the New PivotTable Style… button. Since there are so many 
professionally designed styles available here, I like to use them. 
 

4. Move your cursor over any of the PivotTable Style options, but don’t click on any yet. 

When you move your cursor over a style, you can see the style being applied to the PivotTable in the 
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background. I really like this feature in Excel 2016 as it allows you to see what the PivotTable Report will 
look like without actually clicking on the style. You can move your cursor relatively quickly through all 
the different styles and see in the background which one you like the best. 
 

5. Click on Pivot Style Medium 19.  

Figure 12.12

6. Rename the tab containing the PivotTable as Pivot.  

Search Filters in PivotTables  
The last topic I want to cover in this section is Search Filters. In Chapter Four, I showed you a feature in 
Excel 2016 called Search Filters. These are filters that you can use to limit the items that appear in the 
filter list. In PivotTables, not only can you use this feature, but you can also toggle between different row 
or column fields within one filter. Let’s do an example of that. 
 

7. Click on the Row Labels filter arrow. 
 

Figure 12.13
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The Search box here works just like the one we did in Chapter Four, but the one difference here is that 
you can use any field that is set up as a Row Label.  

8. Click on the drop-down arrow under Select Field: (It should have State currently displayed). 
9. Click on Store_No.  

Figure 12.14

It now shows the filter items for Store_No. Notice that Store_No 1009 is unchecked, as we did previously. 
If you type “09” in the Search box, it will filter the list to include Store_No 1009. The trick here is that the 
Select Field: items must already be set up as a Row Label in the PivotTable Field list. 
 

10. Click Cancel, then Save and close the mySales_Summary.xlsx file. 
 

Review Questions: It is now time to complete the hands-on Review Questions. 
Log on to www.ExcelCEO.com with your Email address and Password, click 
on the Excel 2016 Review Questions, Chapter 12, Section 1 of 2 option in 
your Main Menu, and complete the Review Questions.  

External Data Sources  
Let’s pause our PivotTable discussion for a while and talk about data sources. Up to now, all of the data 
that you have used has been contained in spreadsheets. In reality, data can come from various sources. 
One time, a prestigious East Coast consulting firm I was working with had an Excel model that was 
designed very well. However, one of the things about it that bugged me was that the user had to copy data 
from an Access database and paste it into the Excel file and then run a PivotTable based on that data. I 
showed them how to create a connection directly to that Access database (or any other database for that 
matter). It was kind of fun consulting the consultants! 
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Now we’ll do a simple example of bringing data into an Excel file from an External Data Source using 
two different methods, including a new-for-Excel 2016 Query method. It’s actually very easy to do, IF 
you know the right buttons to push. In the Chapter12 folder, you will find an Access database called 
Data.accdb. Access is a very good desktop relational database program that Microsoft created. I strongly 
encourage you to continue to the next course in the ExcelCEO training series, Access 2016 and SQL, so 
you can learn about Access and the capability to create powerful queries, reports, and forms based on 
databases for analysis that would further enhance what you are about to learn. For now, we will simply 
open the Access database and view the data in the table. The following screenshots are from Access 2016.

Note: Depending on the version of Microsoft Office you have installed on your 
computer, you may not have Microsoft Access available. If this fits your 
situation, do not panic! You can still follow along with the majority of the 
following exercise hands-on and understand the concepts at very least. The 
ability to work with external databases is a powerful skill, so if you can find 
a way to use Access for this project, I would encourage you to try. Otherwise, 
you can skip to Step 14, if you don’t have Microsoft Access available to you.

 
1. Open a Blank workbook in Excel. 
2. Save As C:\ExcelCEO\Excel 2016\Chapter12\myAccess.xlsx. 
3. Open Microsoft Access. 

Figure 12.15

4. In Access, click the Open Other Files icon on the left side of the screen, and navigate to C:\
ExcelCEO\Excel 2016\Chapter12\Data.accdb, and Open it. 

 
A Microsoft Access 2016 database is stored as a .accdb file. 
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Figure 12.16

5. If the Security Warning line appears, click on the Enable Content. 
6. Double-click on the Employee table to open it. 

Figure 12.17

This table lists all of the current and terminated employees of Nitey-Nite. An employee who is currently 
employed with Nitey-Nite has an End_Date of 1/1/2099. For now, we want to import the data from this 
table into an Excel spreadsheet. The easiest way to copy records from an Access table or query into an 
Excel file is to select all of the records in the table, then copy and paste them into Excel. Let’s try that.  



Excel Tips, Tricks and Training for You to Become the Chief Excel Officer of Your Company

ExcelCEO 

            Chief Excel Officer 312

7. Select all records in the Employee table by clicking in the gray box with the white triangle to the 
left of the Employee_ID field. 

8. Type [Ctrl]+c to copy the data into memory. 
9. Toggle over to the Excel Blank workbook (click on the Excel 2016 icon at the bottom of your 

screen). 
10. Click on Cell A1 of Sheet1 and type [Ctrl]+v.  

Figure 12.18

11. Click on the Wrap Text icon in the Alignment group of the Home tab twice. 
12. Resize all columns to fit. 
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Figure 12.19

Now you have a table in Excel that contains all of the Employees at Nitey-Nite. You can manipulate 
this table in any way you want. However, what happens when an employee leaves or a new employee is 
hired? The table in Access will change (assuming that table is the primary database for employee data), 
but then you have to copy it over to your Excel file in again and repeat the process every time the data 
changes, which may be every day or even multiple times during the day. You can write a macro to do the 
formatting in Excel, but it would be nice if you could create a direct link to that data. You can do that by 
using an External Data Source link.  
 
In this next exercise, you will create a link to a Microsoft Access database. In the Access course, you will 
learn much more about external data sources and will create a Data Source Name (DSN) tied to a SQL 
Server database. But in the Excel course, we’ll stick to a simple example linking to an Access database. 
 
One important concept when linking to an Access database in Excel is that you should not have the 
Access file you’re linking to open at the same time with the Excel file that contains the link. You should 
have only the Excel OR Access file open at one time when linked databases are involved. 
 

13. Close the Data.accdb database, and Access. (Choose No, if a warning messages asks if you 
want to keep the copied data in memory.) 

14. Click on the Data tab in Excel, then click on the New Query  button in the Get & 
Transform group. (If using Excel 365, your version may display the icon as Get Data).  

15. Select From Database then click From Microsoft Access Database.
16. Navigate to the C:\ExcelCEO\Excel 2016\Chapter12 folder and choose Data.accdb, and 

click Import. 
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Figure 12.20

You want to link to the Employee table. 
 

5. Make sure the Employee table is selected, click the Load drop-down, and click Load To... 

Figure 12.21

The Table radio should be selected in the Load To dialog box. 
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6. Make sure the Select how you want to view this data in your workbook radio button is set to  
Table and Select where the data should be loaded radio button is set to New worksheet 
in Cell $A$1 and click Load. 

Figure 12.22

7. Save the myAccess.xlsx file. 
 
Excel imports the data into Sheet2 beginning at Cell A1. If we already had a Sheet2, we could have clicked 
Existing worksheet. Let’s try opening the Access database with this link established to see what happens. 

Note: If you do not have a copy of Microsoft Access, you can skip Steps 8-10 
and 12-19.

8. Open Microsoft Access. 
9. In Access, Open the file at C:\ExcelCEO\Excel 2016\Chapter12\Data.accdb.  

Figure 12.23
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A security warning appears telling you that the database has been opened in read-only mode. This is 
because the Excel file that is linked to the Access database is open. As such, you can’t make any changes 
to the Access database. Let’s make a change in the Access database, but first we have to close it. 

10. Close the Data.accdb database. 
11. Save and close the myAccess.xlsx file. 
12. Open the Data.accdb database. 
13. Open the Employee table. 
14. On the first record on the Employee_ID table, change the First_Name to Padraic1. 

Figure 12.24

15. Click anywhere outside of that record (to save the change), and close Access. 
16. Open the myAccess.xlsx file.  
17. If you get the Security Warning, click on the Enable Content button. 

Figure 12.25
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18. Right-click anywhere in the table, and choose Refresh . 

To refresh a link, you can also use the Refresh All button on the Data tab.  

Figure 12.26

The data that you updated in the Access table (Padraic1) is now updated in Excel. Again, you will learn 
much more about external data connections in the Access course, but this exercise should at least get you 
thinking about what kinds of data you can connect to in Excel. 

19. Save and close the myAccess.xlsx file. 

Let’s do another example just to make sure you’re ready to enter the PivotTable world on your own. This 
one will be the ultimate analysis with PivotTables – you’ll see why in a few minutes. 

Using External Data in a PivotTable  
Having more than 1,000,000 rows of data available in Excel 2016 can be a double-edged sword. It 
would be great to have that many rows in which to work, but once you start to get a lot of rows of data, 
Excel starts to slow down. Particularly if you have a lot of formulas in the spreadsheet, refreshing those 
formulas can take a long time, or your computer might freeze up, depending on its capabilities. If your 
spreadsheet seems to take a long time to calculate, I’ll suggest a couple of things:  
 

1) The VLOOKUP() function, although it is a very useful function, can be a resource hog. See 
if you can use another function, like SUMIF() or INDEX() to accomplish the same thing. 
Those functions take up significantly fewer processor resources, and they work quicker 
than VLOOKUP(). The VLOOKUP() function is many times the culprit of a worksheet that 
takes a long time to refresh.  

2) Try keeping large amounts of data in databases like Access, SQL Server, or Oracle (databases 
designed to hold voluminous information), and link to them in an Excel PivotTable for your 
analysis.  
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In this next example, you will link a PivotTable to a database with almost 300,000 rows of data, and Excel 
will fly through it like it was 20 rows of data! Before you begin this example, I must warn you. If you’ve 
previously worked with large amounts of data and have found Excel to be very limiting, you may get 
too excited. What I am about to show you could possibly cause your heart to start racing too fast, which 
could lead to other injuries, and I don’t want that on my conscience. So, before you start this example, get 
a drink of water, take your medication, do whatever you have to do to get settled down before this wild 
ride. Done? Good. Let’s get started! 
 
What we are going to create here is the ultimate financial statement analysis tool. The data is contained in 
the same Access database we used in the previous example, so let’s open up that database again. 

Note: If you do not have a copy of Microsoft Access, you can skip Steps 1-2.

1. Open the Access database at C:\ExcelCEO\Excel 2016\Chapter12\Data.accdb. 
2. Click Enable this content in the Security Alert, if necessary. 
3. Open the Excel_Data table (if you do not have Access, preview the table using New Query).  

Figure 12.27

Feel free to scroll up and down through the data. Let me explain the table. It is a table that was created 
by one of Nitey-Nite’s accountants for analysis of General Ledger activity for 2014 – 2016. It actually 
combines three tables. From the General_Ledger table, she brought in the Month, Account, and the 
three Year columns (2014, 2015, and 2016). She retrieved the Store and Region fields from the Stores 
table and the Lv11_Acct_desc, Lv12_Acct_desc and Lv13_Acct_desc fields came from an account rollup 
table. With the data in this format, it is easy to put it into a PivotTable. Notice that there are 293,068 
records of data in the table. Even though it’s possible to use that many rows of data in Excel, it can be 
very slow depending on your computer. One solution to analyze this data is to bring the data directly 
into a PivotTable without first dumping it onto a spreadsheet. This way, the data is in memory behind the 
spreadsheet. You won’t be able to see all of the individual records, but you don’t need to. All you want to 
do is to summarize the data, and that can be done in the PivotTable. And let me tell you, it’s REAL EASY 
to do. Let’s do it. 
 

4. Close the Excel_Data table, and the Data.accdb database. 
5. Open a Blank workbook in Excel. 
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6. Save As C:\ExcelCEO\Excel 2016\Chapter12\myGL_Summary.xlsx 
7. Click on the Get External Data icon in the Data tab, then click on the From Access button. 
8. In the Select Data Source dialog box, navigate to C:\ExcelCEO\Excel 2016\Chapter12\Data.

accdb, and double-click on that file.  
9. Click on the Excel_Data table, and click OK.

Figure 12.28

10. In the Import Data dialog box, choose PivotTable Report, leave the Existing worksheet set 
to =$A$1. 

Figure 12.29
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11. Click OK.

Figure 12.30

Note: At the bottom of the PivotTable Fields list, there is a check box called 
Defer Layout Update. If you have a PivotTable that is connected to a very 
large database, and it takes a lot of time to update the PivotTable each time 
you add or take away a field, you can check this check box, and it will not 
update the PivotTable until you uncheck it. This can be a huge time saver 
when working with large databases. 

 
It may take a few seconds to make the connection, and then you will see the shell of the PivotTable. Let’s 
analyze the data. 
 

12. Set Region, Store, and Month as Filters fields. 
13. Set Lvl1_Acct_Desc, Lvl2_Acct_Desc, Lvl3_Acct_Desc, and Acct as Rows fields. 
14. Bring in the Amt_2016, Amt_2015, and Amt_2014 fields in as Values fields. 
15. Rename the Values fields 2016, 2015, and 2014. 
16. Format the amount data in the PivotTable to be Number, zero decimal places, and Use 

1000 separator (,) 
17. Click on 308-0, Rent Expense, and click the Collapse Field  icon in the Active Field 

group of the Analyze tab. 
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After all of that, you should have a PivotTable that looks like the following image:  

Figure 12.31

 Remember that you can click on the Expand/Collapse icons to Show or Hide any level of detail you want. 
Keep in mind that this data comes directly from the General Ledger so the data carries GAAP signs (i.e.-
revenues are credits, or minus signs). If you set up your workbook in this manner, you can now write any 
formula you want to analyze year-over-year changes. Your limit depends on your imagination.  

  In this PivotTable, Expenses shows up before Revenue, and in a typical Income Statement, Revenue 
appears before Expenses. Reordering this data is easy to do – just click and drag.  

18. Click on the cell that contains the word Revenue. 
19. Place your cursor over the top edge of the cell, and it will turn to a thin plus sign with an 

arrow on each tip. 
20. Click on the cell and drag it above the cell containing Expenses, and release. 

 
 You will see a gray horizontal bar appear as you move the Revenue cell. Once you release it, the 
PivotTable is reordered to where Revenue appears on top. 
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Figure 12.32
﻿
Let’s say you now want to look only at the first quarter (January, February, and March) data for all those 
years. The Month is contained in a Report Filter, and Report Filters were historically (before Excel 2007) 
set up to handle only one filter. In Excel 2007 on, you can select multiple values in a Report Filter field. 
 

21. Click on the Month drop-down arrow in Cell B3
22. Click on the Select Multiple Items checkbox (all the months will have check boxes beside 

them and all are checked.) 
23. Deselect the (All) checkbox, then check Months 1, 2, and 3 

Figure 12.33

24. Click OK.  
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Figure 12.34

The Month report filter now reads “Multiple Items”, since it can’t display months chosen in Cell B3.  

Slicers  
Although this feature is very cool, it has its limitations. Just by looking at the PivotTable, you can’t tell 
which months were selected. To help with managing multiple selected items in a PivotTable, Excel 2016 
offers a feature called Slicers. A Slicer is simply a view of what is selected in the PivotTable, or a change in 
the PivotTable’s state. Inputting a Slicer is really easy – just click on the Insert Slicer icon.  
 

1. In the Filter group of the PivotTable Tools Analyze contextual tab, click on Insert Slicer 

Figure 12.35
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2. Click on the Month checkbox and click OK. 

Figure 12.36

The Month slicer appears with the months 1, 2, and 3 selected, because those are the selections we did 
previously. To change the month, just click on the month you want in the slicer. 

3. Click on Month 4 in the slicer.  

Figure 12.37

Notice that Month 4 in the slicer is selected and the Month Report Filter in the PivotTable reflects 4, and 
the data in the PivotTable changes. 
 

4. Click on Month 1 in the Slicer, hold down the [Ctrl] key and click on Month 2 and 3, and 
release the [Ctrl] key. 



ExcelCEO 

            Chief Excel Officer

SECTION 3: Advanced Excel   —   Advanced PivotTables

325

Chapter 12

Figure 12.38

Note when you selected value while holding down the [Ctrl] key, the values in the PivotTable don’t 
change, but as soon as you release the [Ctrl] key, all the values in the PivotTable change and the Month 
Report Filter reads “Multiple Items”.  

Other PivotTable Tricks  
Let me show you a few other things that you can do with PivotTables that will help out in certain 
situations. This first exercise doesn’t apply very well to the data we have in our current PivotTable, but it 
will show you the power of right-clicking. 
 

1. Right-click anywhere under the 2015 field in the PivotTable, point to Summarize Values By 
and click on Average. 

The values for 2015 now reflect an average numbers instead of a summation. Make sure to review all of 
the options available in the right-click menu. It can greatly speed up your development of a PivotTable. 

2. Click on the Undo button (or [Ctrl]+z on your keyboard). 
3. Click on the PivotTable Tools Design contextual tab. 
4. Click on the Banded Rows checkbox of the PivotTable Style Options group.  

The PivotTable now displays banded rows. This is useful when there are many rows of data and you want 
to make it more readable. Remember when you were using the old style of PivotTables, and the row labels 
didn’t repeat? That drove me nuts when I was trying to do a VLOOKUP() on data within a PivotTable. 
Excel 2016 now has the functionality to repeat items in a PivotTable. We’ll first set up the PivotTable in a 
tabular form (the old style), then I’ll show you how to repeat items. 
 

5. In the PivotTable Tools Design contextual tab, Layout group, click on the Report Layout 
icon, and click on Show in Tabular Form. 

6. Move the Slicer out of the way, if necessary.  
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Figure 12.39

7. Click on the Report Layout icon again, and choose Repeat All Item Labels. 

Figure 12.40
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8. Save and close the myGL_Summary.xlsx file. 
 
Whew! Are you ready for a break? That was an intense chapter, but one that will help you tremendously 
as you start to use PivotTables in your work. You are now ready to manipulate just about any field in a 
PivotTable. Please make note of a few more notes: 
 

1. Right-click is your friend. If you are in a PivotTable and you want to do something, but you 
don’t know how, try right-clicking within the PivotTable, and you may find the answer to 
your question. 

2. Double-clicking makes things fast and easy. If you make a mistake, you can almost always use 
the Undo button. Don’t worry about screwing it up. Have fun with it! 

 
Review Questions: It is now time to complete the hands-on Review Questions. 

Log on to www.ExcelCEO.com with your Email address and Password, click 
on the Excel 2016 Review Questions, Chapter 12, Section 2 of 2 option in 
your Main Menu, and complete the Review Questions.  

Conclusion  
In this chapter, you changed a PivotTable field setting from Count to Sum. You created a complex 
formula using the ABS() function in a PivotTable calculated field. You set up a PivotTable to include drill 
down capability by using the Show Detail (+) or Hide Detail (-) buttons or by double-clicking on the 
value you want to drill down on. You formatted a PivotTable Report using the available standard styles. 
You connected to an external data source to bring data into a spreadsheet, and you pulled data from 
an Access database directly into a PivotTable. Lastly, you learned about Slicers and the various options 
available in the PivotTable Tools Options and Design contextual tabs. 

Chapter Exam  
To take the examination for this chapter, you must have successfully completed the examination for the 
previous chapter. You can now go to www.ExcelCEO.com, click on Sign In, log in and take the exam. 
Make sure that you take the exam on the same computer on which you completed the practice files, 
as some of the questions on the exam may refer to some of the completed projects. Chapter exams are 
intended to be hands-on. 
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CHAPTER THIRTEEN — CHARTS, GRAPHICS, AND OBJECTS 

Chapter Objectives: 
 

•    Identify how to use Chart Elements to create and edit a basic chart
•    Recognize the appropriate Chart Elements to adjust appearance of a chart
•    Choose the correct way to insert Sparklines into spreadsheet cells
•    Determine data trends by adding a Trendline in a chart
•    Identify how to link a PivotTable to a PivotChart
•    Recognize how to import and export objects to and from Excel

Projects You Will Complete During This Chapter:

•	 myAnnual_Sales.xlsx
•	 myAnnual_Sales_Forecast.xlsx
•	 mySales_Summary.xlsx
•	 mySmartArt.xlsx

CPE Credits possible for this chapter: 2
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Introduction
It is said, “A picture paints a thousand words.” Truer words have never been spoken. However, they can 
also be deceiving. Consider the following charts:   

Chart A: Sales

Chart B: Sales

Which one would you choose for your company, Chart A or Chart B? Most people would choose 
Chart A. It appears that sales in Chart A are going through the roof. The sales in Chart B appear to 
be increasing, but not by much. However, both charts contain exactly the same information. The only 
thing I did different was to change the scaling of the chart. The bottom range of Chart A is $9,000,000 
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and the upper-range of the scale is set at $15,000,000. In Chart B, the bottom value is $0 and the top 
level is $35,000,000. Thus, the higher the range, the less dramatic the lines appear to be. So even though 
charts can tell a lot, they can also be deceiving. For that reason, you should design your charts to present 
accurate information and allow management to make solid business decisions based on the underlying 
data. 

In its simplest form, a chart is a visual representation of a collection of data. As the developer of the chart, 
you have the ultimate control over how that chart is created. You can change the scale, colors, series, 
formatting, etc. You can estimate future activity by adding a trendline. In this chapter, you will learn how 
to create and customize various types of charts, add a trendline based on data in a spreadsheet, and tie a 
chart to a PivotTable. 
 

1. Open the file C:\ExcelCEO\Excel 2016\Chapter13\Annual_Sales.xlsx. 
2. Save As C:\ExcelCEO\Excel 2016\Chapter13\myAnnual_Sales.xlsx.  

Figure 13.1

Basic Charts  
This is a very simple table. It shows annual sales for each of the two regions in the company. Let’s put this 
data into a chart to visually show the sales activity over these five years. 
 

3. Enable editing, if necessary, then click on Cell A4 (Actually, you can click on any cell in the 
data table to begin building a chart). 

4. Click on the Insert tab.  

Figure 13.2

In the Charts group of the Insert tab, Excel allows you to pick the type of chart you want, then build it. 
Excel 2003 forced you to go through a multi-step wizard to create a chart, but Excel 2007 on allow you to 
first create the chart, then modify it. Let’s create a basic column chart. Excel 2013 improved this process 
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considerably through Quick Analysis, Recommended Charts, and Chart Elements. First, some basics 
about Excel charts. 

5. Click on the Insert Column or Bar Chart button  in the Charts group, and choose the 
first chart option in the 2-D Column group called a Clustered Column. 

6. Click on the plus sign icon to the right of the active chart to access Chart Elements. 

Figure 13.3

Excel does a few things. First, it creates a chart and places it in the middle of the spreadsheet. Second, 
it activates a new contextual tab called Chart Tools. Under Chart Tools, there are two sub-tabs: Design 
and Format. If you are familiar with Excel 2010, the contextual tab Layout has been replaced by Chart 
Elements - to the right of an active chart. Chart Elements is much more user-friendly than chart editing 
from versions of Excel before 2013, and provides SO MANY different options when creating charts that 
it is impossible to explore each of the tools in these exercises. As with other exercises, I encourage you to 
explore the different options that would apply to your specific projects or interests on your own.   
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Edit an Existing Chart  
In this next exercise, we will add a title to the chart to match the data in the table. 
 

7. Click on the Chart Title right-arrow button in the Chart Elements box, and choose Centered 
Overlay. 

8. Click inside the Title box in the chart, replace Chart Title with Annual Sales 2012 – 2016, 
and click outside the chart. 

Figure 13.4

Excel creates a title for the chart. But, as you can see, the title appears within the chart itself. To fix this, 
we need to adjust the chart. 
 

9. Return to Chart Elements (by clicking anywhere in the chart area and clicking the Chart 
Elements plus sign to the right), and change the title location back to Above Chart in Chart 
Title. 

 
Just like text boxes, the active chart is identified with round handles on the outer edges. The Chart 
Elements functionality now adjusts the chart automatically based on your selection. You do still have the 
option to adjust elements in the chart manually.
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Figure 13.5

Now let’s add some titles for the horizontal and vertical axes. In Excel 2016 charts, the axis on the bottom 
of the chart (formerly called the X axis in Excel 2003) is called the Primary Horizontal (or Category) axis. 
The axis on the left side of the chart (formerly called the Y axis in Excel 2003) is called the Primary 
Vertical (or Value) axis. The data inside the chart is referred to as the Series, grouped by Point and Value.
 

10. Click the right arrow next to the Axis Titles button in the Chart Elements, and check the 
Primary Horizontal axis box, then click out of the Chart Elements dialog box.  

Tip: Use your mouse to hover over the different options in the dialog boxes to 
see previews of how those options would appear in your chart.

11. Click on the Horizontal Axis title text box (now visible in the chart area below the year 
numbers), and type Year. 

12. Click on the Axis Title right-pointing arrow in Chart Elements, and check the box to the left 
of Primary Vertical to activate the Axis Title Textbox to the left of the chart area. 

13. In the Vertical Axis Title box, type Sales. 
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Chart Elements automatically centers Year and Sales titles on each chart axis.

14. Click anywhere outside the chart to deselect it.  

Figure 13.6

Now that our chart is done, we show it to the boss. His first reaction is, “It looks great, but it doesn’t 
look like sales are going up much in either region. I’d like to see it where the sales growth in every year is 
more pronounced within the chart. Also, I don’t like the names “Northern Region” and “Southern Region” 
in the legend. Make them say “North” and “South”. Can you do that?” Again, your answer is, “I can do 
anything!”, and you get to work.

Tip: You can change many more features using the More Options… link, and 
using the Format tools box (where the PivotTable Fields box would be) for 
the drop-down menu option selected. Contextual tab redundancies are also 
available.

 
First, let’s change the names in the legend. Changing the names of the regions is easy: 

15. Click on Cell A4, and change the name to North.  
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Since the chart is tied to the cell, the name in the cell AND the name in the chart automatically change to 
North.
 

16. Click on Cell A5, and change the name to South. 
 
The Series names are updated, and the chart legend is reformatted to accommodate the shorter names for 
the Series Legend Entry.  

Figure 13.7

Making the sales more “pronounced” is a little more challenging, but we can do it. Perhaps the best thing 
to do is change the Sales scale by starting the sales figures at say $12,000,000 instead of at zero. 
 

17. Right-click on any sales number in the Vertical axis, and choose Format Axis…  
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Figure 13.8

The Format Axis dialog box appears. There are numerous options in this dialog box, way too many for us 
to review in this exercise. You can explore the different options on your own. For now, we will change the 
Minimum option to be $12,000,000 and the Maximum option to $22,000,000. 

18. Click in the Text box to the right of Minimum (to activate). 
19. In the Text box, replace 0.0 with 12000000. 
20. Change the Maximum box to be 22000000, and make sure the Major Unit is set to 2000000. 



Excel Tips, Tricks and Training for You to Become the Chief Excel Officer of Your Company

ExcelCEO 

            Chief Excel Officer 338

Figure 13.9

Note: You will see large numbers, such as the 12 million and 20 million we 
used, converted to Scientific Notation for numbers this big after you click 
[Enter].

21. Close the Format Axis tool box. 

The columns in the chart appear a little bolder and you can see more of a change from year to year. Let’s 
add some more customization to the chart. 

22. Right-click in a white space within the chart but outside of the actual chart in the middle of the 
chart, and choose Format Chart Area…  

Figure 13.10
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The Format Chart Area dialog box pops up. 
 

23. Expand the Fill option .

Figure 13.11

24. Click on the Gradient fill radio button. 

Once you click on Gradient Fill, the Gradient Fill options appear in the section below. In the chart 
preview, you can see Excel also pre-fills a type of popular gradient fill option. 

25. Click on the Preset gradients button, choose Light Gradient - Accent 5 (it should be the fifth 
button to the right on the top row), and click the Close “x” button to close the tool box.
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Figure 13.12

The chart is now formatted with a Light Gradient - Accent 5 background. Let’s do a little more 
formatting. 
 

26. Right-click on the Chart Title, and choose Font… 
27. Choose Bold Italic under Font Style in the Font dialog box. 
28. Click OK. 
29. In the same manner, change the Vertical and Horizontal titles (Sales and Year) to have a 

font size of 12. 

The chart should appear like the chart image below: 
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Figure 13.13

Now your chart looks much nicer. Some people, like me, prefer simple charts with little or no formatting 
or colors. I prefer that because I print in black and white, and black and white printers don’t show colors 
very well.  Those color toner cartridges are too dang expensive. 

Positioning a Chart  
Positioning or moving a chart is easy – just click and drag it. 
 

1. Make sure the chart area is deselected by clicking anywhere outside of the chart. 
2. Click and hold anywhere in the blank gradient space, and drag the chart to where the upper-left 

corner of the chart is positioned at the upper-left corner of Cell A9. 
3. Drag the right-middle sizing handle of the chart and drag the right edge of the chart to be in line 

with the right edge of Column F. 
4. Adjust the bottom of the chart to be at the bottom of Row 23. 
5. Deselect the chart.  

 



Excel Tips, Tricks and Training for You to Become the Chief Excel Officer of Your Company

ExcelCEO 

            Chief Excel Officer 342

Figure 13.14

The chart should now be positioned under the table with the sales data. Keep in mind that the data in 
the table is tied directly to the columns in the chart, so if you change the data in the table, the chart will 
automatically update. 

Sparklines  
One of the features introduced new in Excel 2010 was sparklines. Sparklines are small, simple charts that 
show only one data set displayed as a Line, Column, or Win/Loss chart, and are contained in one cell. A 
line or column sparkline is a compact version of a line or column chart, and a win/loss sparkline shows 
whether a single cell’s value is positive (win), negative (loss) or a zero (a tie). Let’s add a line and column 
sparkline.
 

1. Select Cells B4 through F4. 
2. On the Insert tab, and in the Sparklines group, click on the Line icon. 
3. In the Create Sparklines dialog box, the cursor should be blinking in the Location Range box. 
4. Click on Cell G4 and click OK. 
5. Select Cells B5 through F5, click the Quick Analysis  icon that appears to the right of the 

selection, select Sparklines from the header section of the Quick Analysis dialog box, and 
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choose Column.

Figure 13.15

Now that I see the Column sparkline, I don’t like it, so let’s change it to a Line sparkline. 
 

6. With Cell G5 selected, click on the Line icon in the Type group of the Sparkline Tools Design 
contextual tab. 

Figure 13.16

Note: Sparklines are a cool tool for quickly visualizing your data (which 
is a major benefit of charts), but use Sparklines sparingly. If you find 
yourself using too many Sparklines, consider using a regular chart to avoid 
unnecessary clutter.  

Add a Trendline  
While looking at our chart, enhanced by the Sparklines, it looks like sales are going up each year. What 
do you think sales will do in 2017 or 2018 if they stay at the same rate of growth? We can use a trendline 
to show us. A Trendline is a graphical representation of trends in a data series, such as sales over a period 
of years. 
 

1. Click in the chart area to activate edit mode. 
2. In Chart Elements, check the box next to Trendline. 
3. Click the right-facing arrow next to Trendline to open the Add Trendline dialog box. 
4. Choose North, then click OK.  
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Figure 13.17

Figure 13.18

When using a Trendline, most people use a Linear type. That is because most people really don’t 
understand the other types (Exponential or Two Period Moving Average). In this exercise, we want to 
forecast a linear trend over two periods, so we should use the Linear Forecast Trendline. 

5. Click on the Undo button (to remove the first Trendline we created). 
6. Create a Trendline using the Linear Forecast Trendline option for the North and South.  

Chart Elements has centered and aligned the chart, the title, the axis labels and titles, and even the 
Legend, which is below the chart. Remember that each element in the chart is customizable, and can 
probably suit your charting interests.
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Figure 13.19

8. Deselect the chart.  
 
The trendlines show that the North’s sales are increasing, but the rate of growth for the South is 
noticeably faster. It looks like they should intersect at about the Year 2022, if the trend continues. 
 

Tip: Check out the various icons in the Chart Tools Design tab, particularly 
those in the Type, Data, and Chart Layouts groups, or from the Format 
Trendline tool box. These tools can speed up your chart development 
significantly. 

 
Review Questions: It is now time to complete the hands-on Review Questions. 

Log on to www.ExcelCEO.com with your Email address and Password, click 
on the Excel 2016 Review Questions, Chapter 13, Section 1 of 2 option in 
your Main Menu, and complete the Review Questions.  

Pie Charts  
Another chart type that is very useful is a pie chart. Pie charts are named for their shape, and typically 
illustrate divisions by percentage. Companies love to use pie charts to view the distribution of sales, 
assets, or a host of other business measures. Used correctly, Pie charts can significantly enhance a 
presentation, or simply help you make more informed decisions.

1. Click on the  tab in the workbook.
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Figure 13.20

This is a simple table that represents 2016 sales in each state. 
 

2. With your cursor on any cell within the chart, click on the Insert tab, then click on the Pie icon 
 in the Charts group. 

3. Choose the first option (Pie).  

Figure 13.21

Excel automatically inserts a Pie chart with a legend below based on the data table. As with the Column 
chart (or any other chart), we need to do some formatting to the automatic chart Excel gave us. We’ll 
rename the title of the chart to 2016 Sales by State and make the sections of the pie chart easier to read. 
 

4. Click on the 16 Sales chart title and rename it 2016 Sales by State. 
5. In the Chart Elements box, click the Data Labels right-facing arrow, and choose More 

Options… 

The Format Data Labels box appears on the right, as shown in the following figure:



ExcelCEO 

            Chief Excel Officer

SECTION 3: Advanced Excel   —   Charts, Graphs, and Objects

347

Chapter 13

Figure 13.22

The Label Options group opens with Label Options expanded. Within the Format Data Labels tool box, 
you have Label Options and Number sub-categories (vertically) with Text Options to the right of Label 
Options, and several options within those groups for customizing your labels and text. Explore these 
groups to see the many ways you can customize the appearance of your data labels.

6. In the Label Contains group, check the Category Name and Percentage boxes, and uncheck 
the Value box. 

7. In the Label Position group below, click the Outside End radio button. 
8. Click the small “x” in the top-right of the tool box to Close (not to be confused with the X for 

closing the Excel workbook). 

With the percentages under each state in the Pie chart, you really don’t need the Legend, so you can get 
rid of it.

9. Click on the legend box below the chart, and delete it. 
10. Reposition the chart to be to the right of the data.
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Figure 13.23

This chart is looking better, but it could still use some improvement. Chart Elements has more 
functionality to help, including Chart Styles and Chart Filters. As you might guess, Chart Styles allows 
you to see how your chart would look with different formats using a preview and select option, and you 
can also change the color themes in this tool box. Chart Filters makes it possible to exclude data, or 
columns of data from the chart, if you want to show your data in a different way.

11. Open the Chart Styles group of Chart Elements (Click on the paint brush icon below the plus 
sign), and scroll down to Style 9, and select it.
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Figure 13.24

Now your chart has color-matching labels and no white lines to separate the slices in the pie. As you 
hover over the other style choices, you can see previews of how your chart would look. 

You can see that PA is still a large part of the sales pie chart. Let’s make PA stand out more in this chart.

12. With the chart activated, click twice (with a pause between clicks) in the Series area, on the 
PA slice of the pie to select only that slice, then right-click on the selected pie slice for PA.

13. At the bottom of the menu, click Format Data Point...
14. In the Format Data Point tool box, in the Series Options group, slide the Point Explosion 

bar to 9%.

Note: You can also type specific values in the boxes to the right of the sliders, 
including the option for changing the rotation degrees of the Pie chart by 
using its Angle of first slice option.
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Figure 13.25

The PA slice of the pie chart is now moved away from the chart by nine percent (9%).

15. Save and close the myAnnual_Sales.xlsx  file.  

Chart Elements contains so many options and tool boxes for you to explore and make charts and 
presentations that best fit your needs. As usual, I encourage you to keep exploring this functionality.

PivotChart Reports  
Since you are now an expert with PivotTables, you can create a chart using a PivotTable as the data 
behind the chart, and make it interactive. This is called a PivotChart report. It’s easy to do, and you can 
build the chart while you’re building the PivotTable, or even begin the PivotChart directly in Excel 2016. 
Let’s build a PivotChart using the PivotTable. 
 

1. Open the file C:\ExcelCEO\Excel 2016\Chapter13\Sales_Summary.xlsx. 
2. Save As C:\ExcelCEO\Excel 2016\Chapter13\mySales_Summary.xlsx.  

Figure 13.26
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This is basically the same table format that you used to create a PivotTable in Chapters 11 and 12. In 
creating a PivotChart, you will build the PivotTable and the chart will automatically be built as you build 
the PivotTable. 
 

3. Click inside the data table on the  worksheet.
4. On the Insert tab, in the Charts group, click the drop-down arrow below the PivotChart icon.  
5. Select PivotChart & PivotTable, make sure the New Worksheet radio button is selected, and 

click OK. 
6. Format PivotChart Fields to show Year in Legend (Series) Columns, Region in Axis 

(Categories) Rows, and Sales in Values. 
7. In the data table, format the Sales data as Number, zero decimal places, and Use 1000 

Separator (,). 
8. Rename each column 2014 Sales, 2015 Sales, and 2016 Sales, and resize the columns to fit. 
9. Reposition the chart under the PivotTable. 
10. Uncheck the Grand Totals for Columns and Grand Totals for Rows check boxes in the 

Totals & Filters tab of the PivotTable Options dialog box from the Analyze tab. 
11. Select the PivotChart. 

Your screen should look similar to the following image:  

Figure 13.27

At this point, you can click on the chart and format it just like any other chart. The data in the chart is 
related to the PivotTable data. And in the PivotTable Fields list, Columns is replaced with Legend (Series), 
and Rows is replaced with Axis (Categories). But the chart doesn’t tell us too much at this point, does it? 
Let’s rearrange the PivotTable to have it show sales by state instead of by region. 
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11. Take out Region in the Axis (Categories) section and replace it with State. 
12. Reposition the chart to see all of the data in the PivotTable, if necessary.

Figure 13.28

Clearly, PA has the largest amount of annual sales with a slight decline in 2016, with DC and MD 
running neck and neck for second and third places. A PivotChart is good for visual data, and data can be 
grouped into any sub-category that exists in the original table.
 

13. Save and close the mySales_Summary.xlsx file. 
 
PivotCharts are a very convenient way to create and manipulate charts in a fast and effective manner. 
Just remember that you can double-click and right-click just about anything you want to change. Use the 
Design and Layout contextual tabs that come with chart development. And always remember that you 
can click the Undo to correct your mistakes. 

SmartArt Graphics  
Do you remember how we created a flowchart by using objects in the Insert tab? Excel has similar, pre-
formatted charts that are accessible by using the SmartArt functionality. In SmartArt, there are many 
types of diagrams that can be useful to an organization. You can access these objects from the Insert 
tab, or you can search for features using the Tell me what you want to do box, which is similar to using 
Cortana in Windows 10, and new for Office 2016. 
 

1. Open a Blank workbook and Save As mySmartArt.xlsx in the C:\ExcelCEO\Excel 2016\
Chapter13 folder. 
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2. On Sheet1, click in the Tell me what you want to do box to the right of the Office Ribbon tab 
names, and type SmartArt , then select the Insert SmartArt drop-down option.  

Figure 13.29

The Choose a SmartArt Graphic dialog box appears. As you can see, there are many types of SmartArt 
objects from which to choose. Feel free to click on each one to see what it does, and play around 
with each, if you think it would be useful to your organization. For the next exercise, we’ll use the 
Organization Chart object in the Hierarchy section. 

3. Click on Hierarchy in the left section of the dialog box, then click on Organization Chart (the 
first object) in the middle section, and click OK.  
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Figure 13.30

You use the SmartArt objects just like charts or other objects. The sizing handles on the corners and 
middle of the outside edges of the chart make it easy to resize and position the chart exactly how you 
want it. We will now create an organization chart. 

4. With the first box (on top) selected, type President in the Type your text here dialog box.

Figure 13.31

Notice that as you type, the sizes of all the boxes change to accommodate the text. 
 

5. Click on the [Text] box under President and type President Assistant. 
6. In the lower three boxes, type Vice President of Sales; Vice President of Purchasing; Vice 

President of Operations. 
7. Click outside the Organization Chart to deselect it. 
8. Take off the gridlines on the spreadsheet by clicking on the File tab, click on Options, click on 

the Advanced section, and uncheck the Show Gridlines box in the Display options for 
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this worksheet: section. (An option is also available in the Sheet Options group of Page 
Layout.)

9. Click OK.  

Figure 13.32

Now let’s add some more levels. 
 

10. Right-click on the Vice President of Operations box, point to Add Shape, and choose Add 
Shape Below. 

 
Notice that all the objects in the entire box become smaller. That is because Excel had to add the new box 
into the area defined by the organization chart. To make the boxes larger or smaller, simply adjust the 
outside edges of the chart itself. 
 

11. In the new box, type Director, Accounting. 
12. Below Director, Accounting, create an Add Assistant box called Director, Accounting 

Assistant. 

You should get the picture now. You should be able to complete the rest of the chart on your own. 

13. Under Director, Accounting, create a box for Manager, General Ledger. 
14. Create another box under Director, Accounting called Manager, Accounting Systems. 
15. Drag the Manager, Accounting Systems box over to the left to be on the same level as 

Manager, General Ledger. 
16. Resize the President box to be larger than the others (our president has a real big ego). 
17. Resize the organization chart as you work on it to fit all of the text boxes, then click outside the 

diagram to deselect it. 

Your diagram should now look something like this:   
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Figure 13.33

18. Save the mySmartArt.xlsx file 
 
Many people use costly programs to create these types of charts, but I really like Excel’s built-in tools.  

Importing Objects 
To finish up the chapter, let’s talk a little about importing objects to and exporting objects from an 
Excel file. In this first example, we’ll import a slide from a PowerPoint presentation into a blank Excel 
spreadsheet. 

1. Click the New sheet icon to create Sheet2 of the mySmartArt.xlsx file. 
2. On the Insert tab, click on the Object button in the Text group.
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Figure 13.34

The Object dialog box appears.

3. Click on the Create from file tab, and click the Browse... button.
4. Navigate to the C:\ExcelCEO\Excel 2016\Chapter13 folder, click on AnnualReportCover.

pptx, and click Insert.
5. In the Object dialog box, check the Link to file check box, and click OK.  
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Figure 13.35

Figure 13.36

The object appears on the spreadsheet. Notice that the function box reads: =PowerPoint.Show.12|’C:\
ExcelCEO\Excel 2016\Chapter13\AnnualReportCover.pptx’!’’’’. This means that the object is linked to the 
Excel file. To edit the object in PowerPoint, just use your right-click friend. 
 

6. With the linked object selected, right-click on the object, point to Presentation Object, and 
click Edit. 
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PowerPoint opens up to the file you linked to. To edit the object in Excel, you must open the PowerPoint 
file first (clicking Edit should have opened it), save it, then it will be updated in the spreadsheet. 
 

7. When PowerPoint opens up, change the Years from 2015 to 2016, Save and close the 
AnnualReportCover.pptx PowerPoint file (Make sure to save the PowerPoint file as its 
original name, AnnualReportCover).  

Figure 13.37

The object in the spreadsheet is now updated for 2016. 
 

8. Save and close the mySmartArt.xlsx file.  

Embedding Objects  
In the last exercise, you linked a PowerPoint slide (or object) to an Excel file. One advantage on linking 
a file is that when the source file changes, the linked object changes as well. A disadvantage is that the 
location of the source file may change, or the linked file may be sent to another person who doesn’t have 
the same source file in their system or they don’t have access to it. When this happens, the link will 
not work. To overcome this issue, you can embed an object. An embedded object stays with the file it 
was embedded in. You can embed objects to another Microsoft Office program just as easily as you can 
import them to Excel. The only difference in the procedure to link an object and to embed an object is 
when you embed an object, don’t check the “Link to file” checkbox in the Object dialog box, as illustrated 
in Figure 13.35. As long as you don’t have space or size considerations, embedding an object can many 
times be a better alternative to linking an object. 
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Review Questions: It is now time to complete the hands-on Review Questions. 
Log on to www.ExcelCEO.com with your Email address and Password, click 
on the Excel 2016 Review Questions, Chapter 13, Section 2 of 2 option in 
your Main Menu, and complete the Review Questions.  

Conclusion  
In this chapter, you learned how to work with charts. You created and edited a basic chart using Chart 
Elements, were exposed to Chart Styles within Chart Elements, and used several of the tool boxes and 
elements of that new Excel chart tool. You learned how to reposition or move a chart to another part of 
the spreadsheet. You learned how to create a Sparkline. You added a trendline to show the direction the 
data is moving on a chart. You created a pie chart and explored PivotCharts. You learned how to use 
Excel’s SmartArt functionality by creating and modifying an organizational chart diagram. Finally, you 
learned how to import objects to and export objects from Excel.  

Chapter Exam  
To take the examination for this chapter, you must have successfully completed the examination for the 
previous chapter. You can now go to www.ExcelCEO.com, click on Sign In, log in and take the exam. 
Make sure that you take the exam on the same computer on which you completed the practice files, 
as some of the questions on the exam may refer to some of the completed projects. Chapter exams are 
intended to be hands-on. 



ExcelCEO 

            Chief Excel Officer

SECTION 3: Advanced Excel   —   Analysis Tools

361

Chapter 14

CHAPTER FOURTEEN — ANALYSIS TOOLS 
 
 

Chapter Objectives: 
 

•    Identify scenario outcomes by setting variable constraints on Goal Seek and Solver projects
•    Recognize Descriptive Statistics using Data Analysis
•    Determine data visually by defining variable actions with Conditional Formatting
•    Identify Data Bars within Conditional Formatting
•    Determine the way to turn Full Screen functionality off and on
•    Choose the correct process for Inserting a hyperlink
•    Recognize how to use the Quick Analysis functionality

Projects You Will Complete During This Chapter:

•	 my2016_Forecast.xlsx
•	 myMay_Sales.xlsx
•	 mySales_2016.xlsx
•	 mySolver.xlsx

CPE Credits possible for this chapter: 2.5
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Introduction
When I was learning to program web pages, I decided to create a project of my own. Since I am a family 
history novice, I set out to write a genealogy program on the Internet. After about a year of part-time 
programming, I showed it to my sister-in-law, an avid genealogist. All I had programmed was the 
functionality – I hadn’t made it look good yet. Her response was kind of “ho-hum” and she was obviously 
not thrilled with it. I took a couple of weeks to put in some graphics, some colors and images, and 
showed it to her again. When she saw it, her eyes lit up and said, “This is GREAT!” I hadn’t touched 
the functionality, but colors and a little cleanup work with solid functionality basics sold the project 
much better. I enjoy creating tools that are easy for inexperienced end-users to navigate through and 
manipulate. Typically, the easier a spreadsheet is to use, the harder it is to develop. Still, this can be an 
opportunity to increase productivity for you or your team, and could still end up saving you time after it 
is implemented. One tool that is easy to use and allows you to arrive at an answer very quickly is called 
Goal Seek. We’ll begin this chapter by discussing Goal Seek.  

Goal Seek  
Goal Seek is a tool sometimes called a “What-if Analysis.” When you know the desired result of a single 
formula but not the input value, and the formula needs to determine the result, you can use Goal Seek. 
When using Goal Seek, Excel changes the value in one cell potentially hundreds of times until the 
formula returns the result you want. 
 
Let’s try an example.  
 

1. Open the file C:\ExcelCEO\Excel 2016\Chapter14\2016_Forecast.xlsx. 
2. Save As C:\ExcelCEO\Excel 2016\Chapter14\my2016_Forecast.xlsx.  
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Figure 14.1

This is a simple file that calculates the Net Income for one store. In this file, the Mattress Sales are hard-
coded, as are the Fixed Expenses. Pillow sales are estimated at 10% of Mattress Sales, and the formula in 
Cell B4 reflects that assumption. The Variable Expenses are estimated as a percentage of Total Revenue. 
Your manager has asked you to find out what level of sales we should have in order to have Net Income 
of $150,000. Right now, Net Income is at $114,230, $35,770 off from where it needs to be. Let’s increase 
Mattress Sales by $85,000 and see what the Net Income figure changes to. 
 

3. Change Cell B3 (Mattress Sales) to $350,000. 
 
Net Income changes to $172,200. We would probably spend quite a bit of time playing around with the 
Mattress Sales number to reach an exact $150,000, but Goal Seek will help us in one step. 
 

4. On the Data tab, click on What-If Analysis in the Forecast group, and choose Goal Seek…  
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Figure 14.2

5. Change the Set cell: box to B20 (which is Net Income). 
6. Type 150000 in the To value: box 
7. Type B3 (or choose Cell B3 with your mouse) in the By changing cell: box. 
8. Click OK. 

 
Here we are telling Excel to make Net Income $150,000 by changing the Mattress Sales cell. 

Figure 14.3
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Excel runs through a few iterations (almost instantly), as we would do by manually changing the Mattress 
Sales cell, but Excel does it a lot faster than we can. 

9. Click OK in the Goal Seek Status dialog box.  

Figure 14.4

The result is that Mattress Sales need to be $317,449 in order to have Net Income of exactly $150,000. 
Notice that the exact amount changed in Cell B3 is $317,448.680351906, so Excel had to go through a 
bunch of iterations to arrive at that exact figure. The more formulas tied to a cell, the more the iterations. 
 

10. Save and close the my2016_Forecast.xlsx file.  

Solver  
Goal Seek is a great tool if you want to find a solution based on changing one variable, but what if there 
are multiple inputs in your analysis that could change? For that, Excel provides a nifty tool called Solver. 
Solver does not come with the standard installation of Excel, so when you launch Solver, you may be 
prompted to install it. You must go through the installation of Solver to continue with the exercise. 
 
In this next exercise, you have a charitable opportunity. Area management has been asked to 
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donate mattresses that are slated to be discontinued to a local homeless shelter. Nitey-Nite should 
give away as many mattresses to the shelter as possible without going over a retail price of $10,000 
in total. The schedule in the next file we will work with shows the item number, manufacturer, 
description, and retail price of each item that could be donated. Your job is to find out the 
maximum number of each item that could be donated without going over the $10,000 budget.  

One advantage to using Solver is that it allows you to use constraints. A constraint is simply a limitation 
placed on Solver to control the outcome. For example, one constraint in our analysis is that the budget, 
or total retail price of the mattresses donated, cannot exceed $10,000. Another constraint placed on us by 
management is that we must give away at least two of each mattress type. You can have more than two 
constraints when using Solver, as you will see in this next exercise. In fact, to get the best analysis, you 
should input as many constraints as necessary to make the analysis as reliable as possible. Let’s first make 
sure that Solver is installed and then set up the analysis. 
 

1. Open the file at C:\ExcelCEO\Excel 2016\Chapter14\Solver.xlsx. 
2. Save As C:\ExcelCEO\Excel 2016\Chapter14\mySolver.xlsx 

If the Solver button does not appear in the Forecast group of the Data tab, you need to install it. To do so, 
follow Steps 3 – 7 below. If you already have it, skip to Step 8. 
 

3. Click on the File tab and click on the Options button at the bottom of the screen (the Excel 
Options dialog box appears) 

4. Click on the Add-Ins option on the left side of the screen.  
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Figure 14.5

You should see Solver Add-in listed in the list of add-ins. If you don’t see it, Solver was not installed with 
your version of Excel, and you will have to obtain a version of Excel that has this add-in to complete this 
exercise. 
 

5. Click on Solver Add-in. 
6. Make sure Excel Add-ins is chosen in the Manage: box at the bottom of the Excel Options 

dialog box and click Go. 
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Figure 14.6

7. In the Add-Ins dialog box, check the Solver Add-in box, and click OK. 
 
After you load Solver, it will be available in the newly-created Analyze group of the Data tab.   

Let’s talk a little more about constraints. We’ve already mentioned two constraints, but there are more. 
The goal here is to give away as many mattresses as possible while working within the budget we have. 
Let’s input all of the constraints and parameters for this analysis. 
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Figure 14.7

•    The budget for this opportunity is $10,000. 
•    We must give away all of the Daisey mattresses (we have a total of four in stock). 
•    The only cells we can change are the number of items to donate (Cells G2 through G6). 
•    The minimum number of mattresses to donate per item is two, except for the Daisey series, 

which we will give away all four. 
•    The maximum number of each mattress item to donate is five. 
•    The number of mattresses (Cells G2 through G6) should be integers (no fractions, like 2.6 

mattresses). 
 
With these constraints in mind, let’s set up Solver to do the analysis. 

8. Click on the Solver button on the Analyze group on the Data tab.  
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Figure 14.8

9. In the Solver Parameters dialog box, set the Set Objective to $G$7. 
10. Make sure the Max radio button on the To: line is chosen, as we want to donate as many 

mattresses as possible. 
11. Click in the By Changing Variable Cells: box and choose Cells G2 through G6. 
12. Click the Add button to add a constraint.  

Figure 14.9
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This is the box where you will add all the constraints. 
 

13. In the Cell Reference box, choose Cell H7. 
14. Make the Operator box display “<=”. 
15. In the Constraint box, choose Cell B10. 

 
This constraint sets a maximum dollar amount of mattresses to give away, or $10,000.  

Figure 14.10

16. Click the Add button to add another constraint. 
 
You should be able to input the remaining constraints yourself. 
 

17. Using the Add Constraint box, add all of the constraints previously discussed. 
18. Once you have added all constraints, click the OK button. 
19. Check your parameters with the following figure. 

Tip: If you get stuck, in the center drop-down Constraint box, int is integer.
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Figure 14.11

20. Click the Options button, and make sure the Ignore Integer Constraints is unchecked, then 
click OK.
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Figure 14.12

21. Click the Solve button in the Solver Parameters box.
22. Move the Solver Results dialog box to see the results.
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Figure 14.13

And after a few seconds, Solver goes through a whole bunch of iterations, trying different values in Cells 
G2 through G6 and comes up with the highest solution for the number of mattresses to be donated. This 
analysis returns 22 mattresses in Cell G6 to donate at a total retail price of $9,528.00. Twenty-two is the 
maximum mattress count Nitey-Nite can give under the criteria given, and Solver would return this 
solution consistently. 

Tip: If you have a sharp eye for analysis, or read the Solver Results caution, 
you would notice there is still room in the budget to give away nicer 
mattresses within the Total Budget, for a maximum value of $9,978. Solver 
is not perfect, but it is quick with a focus on changing the constraints toward 
maximum allowed and does provide a solution that matches all constraints 
we set. In the end, it may depend on whether No. to Donate or Total 
Budget matters more.

At this point you can save this analysis as a scenario, cancel out of it, keep the solution, or restore the 
original values. 
 

23. Make sure the Keep Solver Solution radio button is selected, and click OK. 
24. Save and close the mySolver.xlsx file. 
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Review Questions: It is now time to complete the hands-on Review Questions. 
Log on to www.ExcelCEO.com with your Email address and Password, click 
on the Excel 2016 Review Questions, Chapter 14, Section 1 of 2 option in 
your Main Menu, and complete the Review Questions. 

Descriptive Statistics  
Another handy tool that Excel has is Descriptive Statistics. Descriptive Statistics allows you to run a series 
of statistical analyses on a set of numbers without having to write each formula. This is not a feature I 
use often; however, real geeky people like to use it to display a set of statistical numbers that analyzes the 
entire dataset. This is not a tool that comes with the standard installation of Excel, so you may have to 
install it to do this next exercise. 
 

1. Open the May_Sales.xlsx file at C:\ExcelCEO\Excel 2016\Chapter14
2. Save As myMay_Sales.xlsx in the same folder

 
If the Data Analysis button does not appear in the Analyze group of the Data tab, you need to install it. 
To do so, follow Steps 3 – 6 below. If you already have it, skip to Step 7. 
 

3. Click on the File tab and click on the Options button at the bottom of the Excel Options 
dialog box. 

4. Click on the Add-Ins option on the left side of the screen. 
5. Make sure Excel Add-ins is chosen in the Manage: box at the bottom of the Excel Options 

dialog box and click Go... 
6. Check the Analysis Toolpak check box and click OK.
 

Figure 14.14

After you load Data Analysis, it will be available on the Analysis group of the Data tab.  
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This file is a simple file with daily sales for one month. We want to perform a comprehensive statistical 
analysis on the data in the file, and we’ll do it using Descriptive Statistics. 
 

8. Click on the Data Analysis button in the Analysis group of the Data tab. 

Figure 14.15

9. In the Data Analysis dialog box, select Descriptive Statistics and click OK. 
10. In the Descriptive Statistics dialog box, select the Input range B2 to B32. 
11. Make sure the Columns radio button in the Grouped By: option is checked and that the New 

Worksheet Ply: radio button in the Output options is selected. 
12. Check the Summary statistics check box.  
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Figure 14.16

13. Click OK. 
 
You should get a new worksheet in the May_Sales file that looks as shown below:  

Figure 14.17

Again, I don’t use this feature much because I don’t typically do some of these in-depth types of statistics, 
but it may come in handy when you have a manager who thrives on statistical analysis, like actuaries and 
statisticians. By the way, do you know the difference between an actuary and an accountant? An actuary 
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doesn’t have the personality to be an accountant! (with apologies to actuaries, but it is funny!) 

14. Save and close the myMay_Sales.xlsx file.  

Conditional Formatting  
The next topic is Conditional Formatting. I have seen conditional formatting used extensively on 
spreadsheets where the user wanted to make numbers that meet certain criteria stand out. 
 

1. Open the file C:\ExcelCEO\Excel 2016\Chapter14\Sales_2016.xlsx. 
2. Save As C:\ExcelCEO\Excel 2016\Chapter14\mySales_2016.xlsx.  

Figure 14.18

This file is similar to an exercise we did in Chapter 10. The Sales tab contains a database for sales for 
each location by month in 2016. It also contains the Budget, Budget_%, Store_Type, and Bonus fields. 
The Budget_%, Store_Type, and Bonus fields contain calculations. You learned how to do all of these 
calculations in previous chapters, so I’m not going to review them here. The Assumptions tab contains 
the assumptions (Budget % for all types and the type values based on Budget). Your assignment in this 
chapter is to make this spreadsheet easier to read and use. 
 
Conditional Formatting is creating a format in a cell (like font style or background color) where the value 
meets a certain criteria. Let’s suppose that you want to identify all of the stores that did not earn a sales 
bonus. You also want to highlight all of the stores where the manager made more than $2,000 in bonus 
for any given month. With a report like that, it would be very easy for management to scan down the list 
of stores in the Sales tab and quickly see who is performing and who is not. For those who did not earn a 
bonus, let’s format all cells that are equal to zero with a bright yellow background with bold red font. 

3. In the  tab, click on Cell K2. 
4. On the Home tab in the Styles group, click on the Conditional Formatting  button. 

 
When you click on the Conditional Formatting button, a number of different options appear. In Excel 
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2003, Microsoft allowed you to set the formatting of the font and cell background color. In versions 
since then, including Excel 2016, there are numerous additional options available, far too many for me 
to review in this exercise. As you go through this exercise, explore other options you see that may better 
suit your needs or style. For this exercise, we will identify all of the cells in the Bonus column that have a 
0 with a yellow background with bold red font. Bonuses of $2,000 or more will be displayed with a green 
bold text. 
 

5. On the Conditional Formatting menu, place your cursor over Highlight Cells Rules, and 
choose Equal To.  

 

Figure 14.19

The Equal To dialog box pops up. If you click on the drop-down menu on the right side of the dialog box, 
you will see that a yellow background with bold red text is not an available option, so you’ll have to create 
that custom option. 
 

6. Click on the drop-down menu on the right side of the text box, choose Custom Format…  

Figure 14.20
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7. With the Font tab selected, click on the drop-down menu under Color and choose Red. 
8. Under Font style, click on Bold. 
9. Click on the Fill tab, choose Yellow and click OK. 
10. Click OK in the Equal To dialog box. 
11. Use the Format Painter icon to copy the format in Cell K2 to all of the cells beneath it (or 

copy the formula to all cells below).

Figure 14.21

Now you see that all of the cells that contain a zero (i.e.- no bonus is paid) are formatted as bold red text 
with a yellow background. We also want to format all cells with a value of $2,000 or more with a bold, 
green, italicized font. However, there is no standard option in the Highlight Cells Rules for Greater Than 
or Equal To, so we’ll have to create another custom format. Let’s do that now. 
 

1. Select the range K2:K349. 
2. Click on the Conditional Formatting button and click on New Rule…  
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Figure 14.22

The New Formatting Rule dialog box opens. This is the dialog box in which you will create the new rule. 
 

3. Make sure the Format only cells that contain option is selected. 
4. In the Edit the Rule Description section, make sure Cell Value appears in the first box, 

change the second box to greater than or equal to and type 2000 in the third box. 
5. Click the Format… button. 
6. In the Format Cells dialog box, click on the Font tab, and choose Green color, and Bold Italic 

font style. 
7. Click OK in both dialog boxes. 
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Figure 14.23

All of the formatting you applied now appears. Note that we applied two styles of conditional formatting 
to these cells. You can see all of the formatting you applied by looking at the Conditional Formatting 
Rules Manager dialog box. 
 

8. Click on Conditional Formatting, and then on Manage Rules… 
9. If necessary, click on the Show formatting rules for: drop-down menu and choose This 

Worksheet.  

Figure 14.24
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In the Conditional Formatting Rules Manager, you can see all of the formats that are applied in the 
current selection, on this worksheet, or on other worksheets in the workbook. In this example, we have 
three conditional formatting rules, when we really only need two. The second rule should be applied to 
the range $K$2:$K$349, so let’s fix that and delete the third rule. 
 

10. Change the second rule’s range to be $K$2:$K$349. 
11. Click on the third rule, click the Delete Rule button, and click OK. 

Tip: To overcome this formatting issue, you can use the Data Fill feature after 
the first Conditional Formatting is set, and the range would then adjust 
without creating two separate rules for the same intended range.

Let’s explore one more type of Conditional Formatting: Data Bars. Data Bars were introduced in Excel 
2007, and Microsoft made some minor but necessary changes to Data Bars in Excel 2010 — 2016. A 
Data Bar is simply solid or gradient shading behind a number. In Excel 2007, the length of the shading 
represented each number’s position relative to other numbers in the dataset. In Excel 2010 — 2016, Data 
Bars compare values between the numbers based on their distance from zero.  
 
First, we’ll sort the table. 
 

1. Click on Cell B4 (or any populated cell in Column B) and click the Sort Smallest to Largest 
icon on the Data tab. 

2. Right-click on Cell C4 (or any populated cell in Column C), point to Sort, and click on Sort 
Smallest to Largest. 

 
You did this to sort the table in preparation for this next exercise. 
 

3. Select Cells G2:G349. 
4. On the Home tab, Styles group, click on Conditional Formatting, point to Data Bars, and 

choose the Green Data Bar under Solid Fill. 
5. Click anywhere outside the selection.  
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Figure 14.25

The figure above shows the Conditional Formatting applied with the green bars in Column G 
representing the number values compared to the others in the range. For example, G145 is the largest, so 
the the entire cell is green. This provides a quick visual for comparison. In Column K, the Conditional 
Formatting automatically applies the color and font formats you setup to the cells in that range, and also 
helps you see data patterns grouped at a glance. Multiple conditional formats can be applied to a specific 
cell or range, so as long as they visually make sense, you can set them up to meet your needs using 
presets, or using formulas you define for yourself.

Take some time to explore the other options available in Conditional Formatting. Management really 
likes to see a report in color with the different colors that make values stand out.  

Full Screen  
Sometimes, I don’t know who of my users has Excel knowledge and who doesn’t. Therefore, I try to make 
the applications as easy and dummy-proof as I can. One way of doing this is to hide the tabs and menus 
so the user is forced to use the commands on the spreadsheet. This can be accomplished in one easy step 
– by changing the view of the spreadsheet to Full Screen. Microsoft has made this option very simple for 
users of Excel 2016.
 

1. Click on the  tab. 
2. Click on the Ribbon Display Options  button in the upper-right corner of the Excel 

window  (by your display name) and click the Auto-hide Ribbon 

option.   
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Tip: You can also right-click on the Office Ribbon to hide or show different 
parts of the Ribbon area.

Figure 14.26

The Office Ribbon and Name Box are now hidden and the top item to appear is the Formula Bar. In Excel 
2016, the full screen option has an ellipsis symbol (...) in the upper-right of the screen for viewing the 
hidden Office Ribbon options temporarily. You can choose between hidden features long-term, or simply 
Auto-hide to provide more workspace while you complete your work. 
 

3. Click the Ribbon Display Options icon, and choose Show Tabs and Commands. 
 

Trick: To customize the ribbon using Excel Options, click Advanced, and 
uncheck options in the Display Options for this workbook group. You can 
also right-click on any sheet tab and choose Hide, as long as at least one 
stays visible, or right-click the File tab, and choose Collapse the Ribbon.
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Hyperlinks  
Believe it or not, there are some users that don’t know you can click on the tabs at the bottom of the sheet 
to access other sheets. Sometimes, I don’t want them to have that capability, so I have the option of hiding 
the sheet(s). With the tabs hidden, the user still needs a way to navigate from one sheet to another. In this 
case, I like to use Hyperlinks, or a macro contained in a Command button. In this chapter, we’ll look at 
Hyperlinks. We’ll review Macros and Command Buttons to perform similar functions in Chapter 16. In 
the next exercise, we will insert a Hyperlink to take the user from the Assumptions tab to the Sales tab. 
 

1. On the  tab, insert two rows above Row 1. 
2. In Cell A1, type: Sales 
3. Right-click on Cell A1, and choose Hyperlink (if using Excel 365, this option is labeled Links).

 

Figure 14.27

The Insert Hyperlink dialog box appears. 
 

4. Click on the ScreenTip… button. 
5. In the Set Hyperlink ScreenTip dialog box, type: Go to the Sales tab. 
6. Click OK.  
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Figure 14.28

7. Under the Link to: heading on the left, choose the Place in this Document option.  
8. Under Type the cell reference, type: K1 
9. Under Cell Reference, choose Sales. 

Figure 14.29

10. Click OK. 
 
When you hold your mouse over the hyperlink, the screentip “Go to the Sales tab” appears. When you 
click on the hyperlink, it will automatically go to Cell K1 of the Sales tab. 
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Figure 14.30

11. In the Sales tab, insert two rows above Row 1, and Insert a Hyperlink that sends the usr to 
the Assumptions tab, Cell A3. 

Figure 14.31

To edit a hyperlink, simply place your cursor over the linked text, right-click and choose Edit Hyperlink. 
The Edit Hyperlink dialog box will pop up which is identical to the Insert Hyperlink dialog box. All you 
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have to do is make the modifications and click OK. You can also remove a hyperlink, if needed. 

Quick Analysis
A new feature for Excel 2013 was Quick Analysis. You likely noticed the Quick Analysis icon when you 
copy text down a column manually or using DataFill. Recommended Charts is closely linked to Quick 
Analysis, and is a decent way to visualize your data. Be careful with large tables though, as the chart 
can end up being more confusing than useful. Let’s try the new functions, and see the benefit they can 
provide.

12. On the Sales tab, select the entire table, and click the Quick Analysis icon to the upper-right 
of the highlighted table.

13. Click the Charts header, and hover your mouse over the various Clustered Column chart 
options.  

Figure 14.32

The Quick Analysis box pops up with several visual analysis headers from which to choose. 
These Recommended Charts provide many ways to visualize data. The more useful charts 
are highlighted, but you can also choose your own options by searching through the menus.

14. Escape out of Quick Analysis, then Save and close the mySales_2016.xlsx file. 

Review Questions: It is now time to complete the hands-on Review Questions. 
Log on to www.ExcelCEO.com with your Email address and Password, click 
on the Excel 2016 Review Questions, Chapter 14, Section 2 of 2 option in 
your Main Menu, and complete the Review Questions.
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Conclusion  
In this chapter, you learned how to change parameters to get a desired result by using Goal Seek and 
Solver. You used Data Analysis to calculate Descriptive Statistics. You learned how to work with 
Conditional Formatting, how to turn the Full Screen off and on, and you created Data Bars. You created 
a hyperlink that helped to move users from one place on the spreadsheet to another.  Finally, you used 
Quick Analysis to see various chart options which can be previewed.

Chapter Exam  
To take the examination for this chapter, you must have successfully completed the examination for the 
previous chapter. You can now go to www.ExcelCEO.com, click on Sign In, log in and take the exam. 
Make sure that you take the exam on the same computer on which you completed the practice files, 
as some of the questions on the exam may refer to some of the completed projects. Chapter exams are 
intended to be hands-on. 
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CHAPTER FIFTEEN — GRAPHICS, PROTECTION, AND SHARING 
 
 

Chapter Objectives: 
 

•    Recognize graphics in Paint to create images in a spreadsheet
•    Identify protections for vital workbook and cell contents prior to sharing with others
•    Determine how to share a workbook and setup tracking for changes
•    Select the appropriate actions to merge and compare workbooks
•    Identify how to consolidate data from multiple files into a single workbook

Projects You Will Complete During This Chapter:

•	 myQ1_Sales.xlsx
•	 myQ1_Sales_Link.xlsx
•	 mySales_2016.xlsx
•	 mySales_2016_Changes.xlsx

CPE Credits possible for this chapter: 2
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Graphics Using Paint 
To begin this chapter, let’s talk a little bit about graphics. A graphic is simply an image that you can use 
in your documents to give them a little variety and pizzazz, and they are easy to create. I like using a 
program called Paint to create graphics. Paint is a simple program that comes standard in all Windows 
packages. I like it because it’s very easy to use and most of the graphic type work I do is very simple. My 
artistic ability is limited to drawing a straight line with a ruler, and I usually mess that up. You can use 
the graphic, usually saved as a .jpg or .png file, in Excel, Access, Word, HTML, and in a host of other 
programs. Let’s create a graphic using Excel’s WordArt, and Paint. 
 

1. Open a Blank workbook in Excel. 
2. Click on the Insert tab, click on Insert WordArt in the Text group, and choose the fourth “A” 

in the second row labeled Fill: White; Outline: Blue; Accent color 1; Glow: Blue, Accent 
color 1. (The WordArt descriptions change, so if this is not available, find something close).

3. Replace Your Text Here with Nitey-Nite Mattresses 
4. Make the font size 20. 
5. Leave the default style Calibri (Body). 
6. On the Format tab of the Drawing Tools contextual tab, click on the Text Effects button of the 

WordArt Styles group. 
7. Place your cursor over Transform, scroll down and hover your cursor over the Double Wave: 

Down-Up icon, and click. 
8. Click anywhere outside the graphic. 

 
You should get a graphic that looks as follows:  

Figure 15.1

9. Open Paint (click on Cortana, type Paint, and select Paint Desktop App below the Best 
Match heading). If needed, click My Stuff instead of searching the Web.

Note: Cortana is designed to be a computer-based search engine bridge of sorts, 
so you may see options from the Store, Documents, Web, or by different 
categories on your computer. If you have been using your computer for a 
while, your results will probably vary slightly depending on use and updates. 
If you have Paint 3D available, more options are available to make your 
logo look nicer, including making the background transparent.
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Figure 15.2

10. Go back to Excel, make sure the graphic is selected (handle bars will appear around the 
graphic), and copy the graphic ([Ctrl]+c). 

11. Toggle over to Paint and paste it ([Ctrl]+v). 
12. Resize the graphic in Paint (using the blue handle at the bottom-right) to match as below.  

Figure 15.3

13. Save the Paint file as C:\ExcelCEO\Excel 2016\Chapter15\logo.jpg. 
14. Close Paint. 
15. Close the blank Excel file without saving it. 

Now you have a logo that you can use in your reports. Let’s place the graphic in a file. 
 

16. Open the mySales_2016.xlsx file in the C:\ExcelCEO\Excel 2016\Chapter14 folder. 
17. Save As mySales_2016.xlsx (the same name) in C:\ExcelCEO\Excel 2016\Chapter15. 
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18. Click on Cell G1 on the  tab. 
19. Click on the Insert tab, choose Pictures in the Illustrations group, navigate to C:\ExcelCEO\

Excel 2016\Chapter15\logo.jpg, click on the logo file, and click Insert. 

Figure 15.4

20. Click anywhere outside the logo to deselect it. Right-click to Crop, if necessary. 

Figure 15.5

With the image on the spreadsheet, you can now drag it to any place in the document you wish. Pretty 
easy, huh?  
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Protection  
Once you have a spreadsheet designed just the way you want it, you need to protect it. In the Sarbanes-
Oxley awareness world in which we live, it is vitally important to protect the formulas and analyses in 
your spreadsheets. One great way of protecting your spreadsheet is by using the Protection tools available 
in Excel 2016.  

1. While on the  tab of the file, click on the Review tab, then click on the 
Protect Sheet button in the Changes group.  

Figure 15.6

The Protect Sheet dialog box appears. There are multiple items you can protect or leave unprotected. For 
this exercise, we want to protect the entire spreadsheet. Note that this action protects only the spreadsheet 
you are currently on. To protect the entire workbook, use Protect Workbook from the Review tab. 
 

2. In the Password to unprotect sheet box, type: abc and click OK. 
3. Retype the abc password in the Confirm Password dialog box, and click OK. 

 
Now if you try to change anything on the spreadsheet, you will get a message telling you it is protected. 
This works great if you want to protect the entire spreadsheet, but what if you want to allow the user the 
ability to change selected cells in the spreadsheet? In the next example, we want users to be able to change 
the values in certain cells in Columns B, C and E, but nothing else. To do this, we first have to unprotect 
the sheet. 
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4. Click on the Unprotect Sheet button in the Changes group of the Review tab.  

Figure 15.7

5. Type abc in the Unprotect Sheet dialog box, and click OK. 
6. On the Assumptions tab, select the cell ranges B4-C9, B13-C18, B22-C27, and E4-E6 (i.e.- 

all of the cells that users could possibly change).  

Figure 15.8
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7. Click on the Allow Users to Edit Ranges  option in the Changes 
group.  

Figure 15.9

8. In the Allow Users to Edit Ranges dialog box, click New…  

Figure 15.10

9. Leave Range1 as the title of the named range, do not enter a password in the range password 
box, and click OK. 
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Figure 15.11

10. Click Protect Sheet… in the Allow Users to Edit Ranges dialog box. 
11. Use the abc password in each of the next two dialog boxes. 
12. Now Password Protect the entire  tab with the same password. 

 
Now you have a file that your users can manipulate without the worry of anyone changing the formulas. 
 
You can also lock and hide cells in the Format Cells dialog box. A locked cell cannot be changed when 
protection is turn on, and a hidden cell hides the formulas in a spreadsheet.  
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Figure 15.12

The exercises we just completed were designed to teach you how to protect data within an Excel file. You 
can also protect the entire file. 

13. On the File tab, click on Save As, and choose Chapter 15 under Current Folder. 
14. Click on the Tools option inside the Save As dialog box and click on the General Options... 

option.  

Figure 15.13

15. In the Password to open box, type 123 and click OK.  
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Figure 15.14

16. Type 123 in the Confirm Password dialog box. 
17. Save the mySales_2016.xlsx file, and click Yes in the Confirmation Save As dialog box. 

Note: This simple password exercise is for illustrative and education purposes 
only. While you should choose a password you will remember when securing 
a file like the one you have just worked with, I recommend you choose a file 
password that is unique for you that will protect your own files. 

Passwords  
A few words of caution about passwords: DO NOT FORGET THE PASSWORD. In the past, if you 
forgot the password, you could not get it open again. However, in today’s tech-savvy world, there are a 
number of applications you can buy on the Internet to recover a lost password. But it would be a lot easier 
on yourself to just not forget the password, or at least write it down somewhere. Remember that Excel 
passwords are case-sensitive, so typing ABC will not work to unprotect our worksheet. Note that if you 
use password protection in an Excel 2010 — 2016 file and allow users to edit a range, it will not work in 
some earlier versions of Excel.  
 
The best passwords consist of a lot of characters and will contain upper- and lower-case characters, as 
well as numbers and special characters. Typically, the longer the password, the harder it is to hack into 
it. I like to create a file, paper or electronic, with all of my user IDs and passwords in it. There are so 
many applications out there where you have to use a user ID and password to sign on, and many of them 
require the user IDs and passwords be set up in a certain way. There is no guarantee that your standard 
user ID or password you use for everything will work in all applications. In fact, it most likely won’t. 
Therefore, it’s a good idea to keep those user IDs and passwords documented and in a safe place. 
 

Review Questions: It is now time to complete the hands-on Review Questions. 
Log on to www.ExcelCEO.com with your Email address and Password, click 
on the Excel 2016 Review Questions, Chapter 15, Section 1 of 2 option in 
your Main Menu, and complete the Review Questions. 
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Sharing a Workbook  
When a user opens a standard Excel file that is stored on a shared drive, they typically open it with 
exclusive rights, meaning that no one else can make changes to it while they have it open. However, 
sometimes it is necessary for more than one person to work with the same spreadsheet at the same time. 
This presents a problem, as most workbooks are setup where only one person at a time can work on it. To 
solve this issue, you can turn on Excel’s sharing capability. When a workbook is shared, multiple users 
can use it at the same time. The owner of the workbook can then review and track the changes made and 
accept or reject the changes he/she wants. 
 

1. Click on the Share Workbook button in the Changes group of the Review tab.  

Figure 15.15

2. Check the Allow changes by more than one user at the same time check box, and click the 
Advanced tab.  
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Figure 15.16

There are many settings on the Advanced tab, but the two that are most used concern keeping history 
and conflicting changes. I typically keep these default settings. 
 

3. Leave the default settings, and click OK. 

Figure 15.17

4. Click OK in the Microsoft Excel caution dialog box.
5. Save and close the mySales_2016.xlsx file. 
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Tracking Changes to a Shared Workbook  
Excel allows you to track and review changes that you made and changes that others have made to a 
shared file. In this next exercise, you will open the Sales_2016_Changes.xlsx file and work with it to see 
how changes are captured in a shared file. 
 

1. Open the Sales_2016_Changes.xlsx file at C:\ExcelCEO\Excel 2016\Chapter15. 
2. Unprotect Sales_2016_Changes.xlsx with password 123.
3. Save As C:\ExcelCEO\Excel 2016\Chapter15\mySales_2016_Changes.xlsx.

Note: This file is essentially a continuation of the file you just closed (with a few 
changes), so the password used to protect that file will unprotect this one.

Figure 15.18

In this exercise, you will pretend your name is Joe Smith. Whenever Joe logs on to his computer, his 
computer name is Joe Smith. 
 

4. Click on the File tab and choose Options. 
5. In the General section of the Excel Options dialog box, change the user name to Joe Smith, 

and click OK. 
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You are now operating your computer as if you were Joe Smith. Now you will turn on the tracking 
changes functionality. 
 

6. In the Changes group of the Review tab, click on the Track Changes button, and choose 
Highlight Changes…  

7. Click the Track changes while editing... checkbox, set When: to All, and click OK. 

Figure 15.19

8. Click OK in the warning dialog box that appears. This action saves the workbook and shares it. 
 
Notice that the name of the file at the top of the title bar appears as mySales_2016_Changes [Shared]. 
The [Shared] indicates that the sharing functionality is turned on. 
 

9. In the spreadsheet, change Cell B8 to 130%, Cell B9 to 150%, Cell E5 to 80,000, and Cell E6 
to 120,000. 

When you make a change to a cell, a thin blue line surrounds the cell, and Excel creates a flag in the 
upper-left corner of the cell. This is a type of comment. When you hold your cursor over the cell, the 
comment box appears telling you who made the last change, and what the changes were. 
 

10. Save the mySales_2016_Changes.xlsx, but don’t close it yet. 
11. Change the user name (Steps 3 and 4) back to your user name. 
12. In the spreadsheet, change Cell E5 to 75,000 and Cell E6 to 115,000. 
13. Save mySales_2016_Changes.xlsx. 
14. In the Changes group of the Review tab, click on Track Changes, then choose Highlight 

Changes… 
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The Highlight Changes dialog box appears. It is in this box where you will define what changes are 
tracked by whom and where. You can also choose where to review the changes — either on the screen or 
on a new sheet. 
 

15. In addition to the default settings as shown in Figure 15.19, check the List changes on a new 
sheet box and click OK. 

 

Figure 15.20

The Highlight Changes dialog box disappears. Additionally, a new tab called History was created in the 
file. This new tab records the changes that were made by others since you last saved it. If you click on the 
History tab, you will see that four changes were made by Joe Smith and two changes were made by you. 
You will have the chance in this exercise to accept or reject those changes.  
 

16. Click on the  tab, if you were not taken there already.
17. Click on the Track Changes button from the Changes group, then click on the Accept/Reject 

Changes button.  
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Figure 15.21

18. Click OK in the next dialog box. 

Figure 15.22

These next few dialog boxes walk you through all of the changes that have been made to the workbook. 
In these dialog boxes, you can accept or reject changes made to the file. In this first dialog box, you see 
that there were six changes made to the file. For the first change, Joe Smith changed Cell B8 from 150% to 
130%. Joe Smith is the User Name of the computer that made the change. Typically, people use their own 
name as their computer’s User Name. That value is OK with us, so let’s keep Joe’s 130% number. 
 

19. Click Accept.  
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Figure 15.23

Once you click Accept, it changes the worksheet to accept the new figure and then goes to the next 
change. Let’s accept the second change that Joe Smith did as well. 
 

20. On the change for Cell B9, click Accept. 

Figure 15.24

The next dialog box is a little different. This cell has been changed more than once, and all of the changes 
are listed in the dialog box. We see that Cell E5’s original value was 70,000, then Joe Smith changed it to 
80,000, then ExcelCEO (or your computer name) changed it to 75,000. Since we control the file, we also 
control which changes to accept or reject. In this case, we’ll accept the 75,000 number. 
 

21. Click on the 75,000 line and click Accept.  
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Figure 15.25

22. In the last dialog box for the changes to Cell E6, click on the 110,000 (Original Value) line, 
and click Accept. 

Figure 15.26

All of the changed figures are now incorporated into the new file. 
 

23. Save and close the mySales_2016_Changes.xlsx file.  

Consolidating Data  
Many times, you will get data from different people, and you need to put all of the data in one place. 
In our next example, you will open three files that contain data for three months and consolidate the 
data in another file for the quarter. This process is called data consolidation. I personally don’t use 
data consolidation much. I prefer to load all of the data into one table and create a PivotTable to do my 
analysis. However, there are many people who use data consolidation, so we’ll do an example of it. If it 
works for you, then use it. 
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1. Click on the Open icon, and navigate to C:\ExcelCEO\Excel 2016\Chapter15. 
2. Click on the Q1_Sales.xlsx file, hold down the [Ctrl] key, and click on the Jan_Sales.

xlsx, Feb_Sales.xlsx, and Mar_Sales.xlsx files and click Open to open all four files 
simultaneously. 

3. Activate the Q1_Sales.xlsx file.  

Figure 15.27

The Q1_Sales.xlsx file will hold the summed results of the Jan, Feb, and Mar files. 
 

4. Click on Cell D2 and click the Consolidate  button from the Data Tools group 
on the Data tab.  

Figure 15.28

The Consolidate dialog box appears. In this dialog box, you will define the ranges you want to 
consolidate. 
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5. Make sure the selected function is Sum. 
6. With your cursor in the Reference box, toggle over to the Jan_Sales file (to activate it), select 

Cells D2 through F30 in the Jan_Sales file, and click Add.  

Figure 15.29

7. Perform the same procedure to add the range D2 to F30 in the Feb and Mar files into the All 
references section of the Consolidate dialog box.   

Figure 15.30
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8. After the Consolidate dialog box looks as above, click OK.  

The data from all three files is now consolidated into one file. One rule that you must remember is that 
the data must be in the same format and in the same order in all data sources when you perform a 
data consolidation procedure. For that reason, I prefer to copy/import the data into a PivotTable. In a 
PivotTable, you have much more control in manipulating the data.  

Figure 15.31

9. Save As C:\ExcelCEO\Excel 2016\Chapter15\myQ1_Sales.xlsx and close it (leaving the 
other three files open). 

Linking Data  
Let me show you another way to consolidate data – linking files. If you prefer to use the keyboard instead 
of the mouse, this may be a preferable alternative. In this exercise, we will link the data in all three files 
into the Q1_Sales file by simply clicking on the data. 
 

1. Open the Q1_Sales.xlsx file again. 
2. Click on Cell D2, type the “=” key, toggle over to the Jan_Sales file, click on Cell D2 of the 

Jan_Sales file, press the [F4] key three times, and press [Enter].  

Figure 15.32
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The formula in Cell D2 in the Q1_Sales file should now look Figure 15.32. Pressing the [F4] key should 
make the formula a relative reference (i.e.- no dollar sign anchors around the cell reference) to Cell D2 in 
the Jan_Sales file. We need to make that cell a relative reference as we will be copying the cell soon. Now 
all we have to do is to add in February and March to the same cell.  
 

3. Click in the Formula Bar, click to the right of the formula, type the “+” key, click on Cell D2 of 
the Feb_Sales file, make it a relative reference, type the “+” key again, click on Cell D2 of 
the Mar_Sales file, make it a relative reference, and press [Enter]. 

4. Make sure all of the D2 references are relative values.  

Figure 15.33

5. Drag right to copy the formula in Cell D2 to the Warranty Sales and Delivery Sales columns, 
then down to all cells below using Data Fill. 

Figure 15.34

All of your data is now consolidated in one file. 
 

6. Save As myQ1_Sales_Link.xlsx, and close all four files. 
7. Open the myQ1_Sales_Link.xlsx file again. 
8. Click Enable Content, if necessary.

 
Look at the formula in in Cell E2. It should read: 
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=’C:\ExcelCEO\Excel 2016\Chapter15\[Jan_Sales.xlsx]January’!E2+’C:\ExcelCEO\Excel 2016\Chapter15\
[Feb_Sales.xlsx]February’!E2+’C:\ExcelCEO\Excel 2016\Chapter15\[Mar_Sales.xlsx]March’!E2 

This formula now displays the full path of the linked files. I’ve seen many files like this where these links 
are set up and then someone moves or deletes the supporting files. When that happens, you will see an 
error message like the figure below:

Figure 15.35

The data will be the same as it was the last time you saved it, but you may want to save the original values 
and get rid of the links. That’s really easy to do using the Edit Links dialog box. In the Connections 
group of the data tab, you should now see the Edit Links icon activated. With this link, you can manage 
links to external Excel files.  

8. Click the X on the upper-right of the Microsoft Excel caution dialog box to close it, if needed.
9. On the Data tab, click the Edit Links  icon in the Connections group.  

 
Using this dialog box, you can update the values, change the source, open the source, break the link(s) or 
check the status. In this case, we want to break the link. 

Figure 15.36
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10. With the Feb_Sales.xlsx link selected, hold down the [Ctrl] key, click on the Jan_Sales.xlsx, 
and the Mar_Sales.xlsx links, and click on the Break Link button. 

Figure 15.37

11. Click on the Break Links button in the Edit Links dialog box. 

Figure 15.38

12. Click on the Close button in the Edit Links dialog box. 

The links are now broken and all of the data remains intact, but it is not linked to any source. Clicking 
on the different cells, you can now see the data is not formula-based anymore. You can tell how a link 
is broken as in Figure 15.37 above. In this case, Feb_Sales was actually moved from the location Excel 
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linked to while the file was still linked. Since we’re breaking the link anyway, that doesn’t matter here, but 
remember that moving files that are linked to other files will also break the link.
 

13. Save and close the myQ1_Sales_Link.xlsx file. 

Review Questions: It is now time to complete the hands-on Review Questions. 
Log on to www.ExcelCEO.com with your Email address and Password, click 
on the Excel 2016 Review Questions, Chapter 15, Section 2 of 2 option in 
your Main Menu, and complete the Review Questions.  

Conclusion  
In this chapter, you created graphics using Paint and you learned how to work with Excel’s protection 
features. You learned how to share a workbook with multiple users and track the changes the users made. 
Finally, you consolidated similar data from multiple files into one file using two different methods.  

Chapter Exam  
To take the examination for this chapter, you must have successfully completed the examination for the 
previous chapter. You can now go to www.ExcelCEO.com, click on Sign In, log in and take the exam. 
Make sure that you take the exam on the same computer on which you completed the practice files, 
as some of the questions on the exam may refer to some of the completed projects. Chapter exams are 
intended to be hands-on. 
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CHAPTER SIXTEEN — MACROS AND THE DEVELOPER TAB 
 
 

Chapter Objectives: 
 

•    Identify macro security settings
•    Recognize VBA (Visual Basic for Applications) to evaluate steps within a macro
•    Determine how to create, edit, run, and delete a macro
•    Identify Relative References in macros
•    Recognize the working parts of a macro with Step Into functionality
•    Choose Shortcut Keys for executing macros
•    Determine how to create a Command Button and link it to a macro
•    Identify a macro in the Quick Access Toolbar
•    Recognize how to create and use Spin Buttons to adjust spreadsheet variables
•    Determine how to form a Check Box for including and excluding formula variables

Projects You Will Complete During This Chapter:

•	 mySales_2016.xlsm

CPE Credits possible for this chapter: 3
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Introduction
The first thing I want to discuss in this chapter is Macros. A macro is simply a mini-program that 
executes a task. Anytime you have a task that is repeated over and over again, a macro may be in order. 
Excel provides a great way to create and run macros. I want to caution you, however. It is my belief that 
macros can be over-used. Anytime you find yourself creating a lot of macros in a spreadsheet, you should 
step back and consider whether Excel is the right tool for the project. If you are continuously updating 
a report, you may want to think about putting that report in Access or on the Internet in a web-based 
application where it can be more easily automated, and data can be more easily refreshed. One of my best 
Excel students was very interested in doing EVERYTHING with Excel, but his projects had progressed to 
a point where they really needed to be in a database. He can write macros and VBA code “until the cows 
come home”, but that misses the point when it comes to report functionality.  

Macro Security  
Before we open a file that contains macros, let’s discuss Macro Security. Excel 2016 has a number of file 
types that determine whether or not a macro can be run on the file. The following table illustrates the 
different types of files. 

File Extension Description
.xlsx Macro-disabled Excel workbook
.xlsm Macro-enabled Excel workbook
.xltx Macro-disabled template
.xltxm Macro-enabled Excel template
.xlsb Macro-enabled Excel binary workbook

 
Macros can be run only on Excel files that are saved as macro-enabled workbooks. In the exercises in this 
chapter, we will concentrate on the .xlsm file type of Excel workbook. From here on out, when I refer to 
a macro enabled workbook, I mean macro-enabled workbook or template. When you first open an Excel 
enabled workbook, you may get a message telling you that the macros have been disabled. 
 

1. Open the file at C:\ExcelCEO\Excel 2016\Chapter16\Macro.xlsm.  

Figure 16.1
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This security warning means that your security settings have been set to disable some or all macros in 
the workbook. When you click on the Enable Content button, you will enable the macros for that specific 
workbook. 
 

2. Click on the Enable Content button, if it appears.  

Figure 16.2

The Security Warning goes away, and the macros are enabled for this workbook only. To permanently 
change the settings for all workbooks you open, you need to go to the Macro Security Settings. To work 
with macros, you will need to have access to the Developer tab in your Office Ribbon. If you do not see 
the Developer tab, open the Options dialog box (under the File tab), click on Customize Ribbon, and 
check the “Developer” box. Let’s do that now. 
 

3. If you don’t see the Developer tab in the Office Ribbon, click on the File tab, click on Options, 
click on Customize Ribbon, then check the Developer box in the right section of the Excel 
Options dialog box. 
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Figure 16.3

4. Click OK. 
 
The Developer tab now appears at the top of the Office Ribbon. Let’s now view your macro settings.  

5. Open the Excel Options dialog box, click on Trust Center, click on Trust Center Settings…, 
and click on Macro Settings. 
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Figure 16.4

I like to keep this setting on Disable all macros with notification. Believe it or not, there are some 
unethical people out there who like to write macros that will harm your computer. Microsoft can’t catch 
all of the harmful macros which can be easily written. Macros can be written to execute whenever the 
file is opened, so to be safe, I like to disable all macros until I can review the file to determine if it is safe. 
Before you enable the macros, you should know who the file is being sent from, and you should be certain 
that person wouldn’t send you a file with potentially harmful macros in it. For this reason, you should 
NEVER set the Macro Security Setting to Enable All Macros. 
 

6. Make sure the security level is set to Disable all macros with notification and click OK in 
both dialog boxes. 

7. Close the Macro.xlsm file without saving it. 
 



Excel Tips, Tricks and Training for You to Become the Chief Excel Officer of Your Company

ExcelCEO 

            Chief Excel Officer 422

With that introduction, let’s explore some simple macros. 
 

1. Open the file C:\ExcelCEO\Excel 2016\Chapter16\Sales_2016.xlsm. 
2. Click the Enable Content button. 
3. Save As C:\ExcelCEO\Excel 2016\Chapter16\mySales_2016.xlsm (make sure you save it as 

a Macro-enabled workbook in the Save As dialog box)
 

Figure 16.5

This file calculates Store Manager bonuses for all stores. The Assumptions tab allows you to change the 
assumptions and see what the bonus calculates to. It is essentially the same file you used in Chapter 15. 

VBA  
Macros in Excel are written in a language called Visual Basic for Applications (VBA). The macro that 
is already created on this file does some formatting changes, like bold and italicize some of the cells in 
the spreadsheet. Although you generally don’t need to know how to program with VBA to write macros, 
it does help to be exposed to it. Before we get too deep into macros, let’s open up the code to see how it 
looks. 
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4. In the Macros group on the View tab, click on the drop-down arrow below Macros and choose 
View Macros . 

Figure 16.6

In the Macro dialog box, you can choose to run the macro, run it in steps (Step Into), edit it, delete it, 
and/or assign it a shortcut key (the Options... button). Since this is an existing macro, the Create button is 
diabled. Let’s look at the VBA code behind the macro. 
 

5. In the Macro dialog box, make sure the FormatCells macro is selected, and click the Edit 
button. 

Figure 16.7
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When creating and dealing with macros, you don’t have to know how to write VBA code, but it does help 
to become somewhat familiar with the code screen as you’ll see in an exercise later. You can probably 
read the code and figure out what the macro is supposed to do. VBA is written with mostly English words 
and you can learn how to write the code with little training. This macro selects a few cells, bolds and 
italicizes them, then selects the range E11 – F11 and bolds that range. 
 

6. Close the Microsoft Visual Basic screen. 

Running a Macro  
You now return to the spreadsheet. To see how the macro works, let’s run it. 
 

7. Click the Macros  button and choose Run  in the Macro dialog box.

Figure 16.8

And just like that, the macro selected certain cells and formatted them with bold and/or italics. After 
you run the macro, notice that the Undo button is not available, so if you run the macro, you have to 
manually undo the changes or close out of the file and reopen it. We want to start over on our macro 
lesson, so let’s close the file without saving it and reopen it. 

8. Close the mySales_2016.xlsm file without saving it, then reopen it. 
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9. Enable the macros. 

Shortcut Keys  
I hate to admit it, but it really is kind of a pain to run the macro, isn’t it? You have to go into the View tab, 
click on Macros, then run it. Inexperienced users would have a hard time remembering how to do that. 
Therefore, Microsoft made it easier to run a macro by using shortcut keys. A shortcut key is the keyboard 
shortcut to run the macro. Let’s create a shortcut key to run this macro. 

1. Click on the Macros drop-down menu, choose View Macros, make sure FormatCells is 
selected, and click the Options… button.  

Figure 16.9

The Macro Options dialog box appears. In this screen, you can assign almost any key as the shortcut 
key. The macro runs when you press [Ctrl] and the shortcut key. The only thing you need to remember is 
that you shouldn’t assign a standard shortcut key, like [Ctrl]+c to copy or [Ctrl]+f to find. Let’s assign a 
shortcut key of ‘a’ to this macro. 
 

2. In the Macro Options dialog box, type the letter a (lower-case) in the Shortcut key box, and 
click OK. 

3. Close out of the Macro dialog box. 
4. Press [Ctrl]+a to run the macro.  

Step Into  
If you blinked, you may not have seen it, but the macro ran. You can tell it ran because some of the cells 
changed their formatting and the range E11 through F11 is now selected. Sometimes when you run a 
macro, Excel returns an ugly error message. Unfortunately, it doesn’t tell you exactly what the problem is. 
In these cases, you will want to run each step of the macro until you figure out where the problem is. The 
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Macro dialog box allows you to run the macro in steps by using the Step Into option. Let’s try it. 

5. Manually Undo all of the bolding and italics. 
6. Press [Alt]+[F8] (or [Alt]+[Fn]+[F8], depending on your keyboard) - the shortcut key to open 

the Macro dialog box. 
7. Make sure FormatCells is selected and click the Step Into button. 
8. Rearrange the windows to make it look like the image below: 

Figure 16.10

Notice that the text Sub FormatCells() is highlighted in yellow with a right arrow to the left of the text. 
The current step the macro is on is always highlighted in yellow. This means that this is the step that will 
execute next. All this step tells you is that we’re about to run the macro. To go to the next step, press the 
[F8] key. 
 

9. Press the [F8] key (or Fn+[F8] - use whichever applies to your keyboard throughout). 
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Figure 16.11

The first few lines that begin with an apostrophe are comments. VBA skips over these lines. This is how 
you can type any comment to document what the code is doing. It is a good idea to document as much of 
your code as you can with comments like these. 
 
The first step in the macro is to select the range. This is reflected in the VBA code as highlighted in 
yellow. Once a line is executed by clicking [F8], then the action shows on the spreadsheet.
 

10. Press the [F8] key over and over to step through each of the steps while watching the results in 
the Excel mySales_2016.xlsm spreadsheet in the background. 

 
Once you get to the last step, close the Microsoft Visual Basic screen. 
 

11. Once the steps have completed, and there are no more yellow highlighted lines, close the 
Microsoft Visual Basic screen. 

12. Click OK when prompted that the command will stop the debugger.
 

Review Questions: It is now time to complete the hands-on Review Questions. 
Log on to www.ExcelCEO.com with your Email address and Password, click 
on the Excel 2016 Review Questions, Chapter 16, Section 1 of 2 option in 
your Main Menu, and complete the Review Questions. 
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Create a Macro  
For me, the easiest way in Excel to create a macro is to use the macro recorder. The recorder is just that —
functionality you use to record your actions and save them. In the next exercise, you will create a macro 
that adjusts the column widths after the formatting changes you did in the FormatCells macro. The 
command is very simple to do – just select all columns and double-click on the column lines. 
 

1. With the  tab selected, click on the Macros drop-down menu in the View 
tab, and make sure the Use Relative References icon button is not selected (it will be 
highlighted if it is selected). If it is highlighted, click on it to deselect it. 

2. Click on Record Macro… 

The Record Macro dialog box opens.  

Figure 16.12

Note that when you click on the Macros drop-down menu, you will see an option called Use Relative 
References that can be turned off and on. When the Use Relative References button is not selected (i.e., 
not highlighted), the macro actions are recorded at the cell’s actual address (like Cell A4). When it is 
selected, it records the macro in reference to the position of the cursor. For example, let’s suppose you 
had recorded a macro that began at Cell A1 and moved the cursor down two cells to Cell A3 with the Use 
Relative References not selected. Before running the macro, you moved your cursor to Cell B1. When you 
run the macro, Excel would go directly to Cell A3. If the Relative Reference button was selected, it would 
go down two cells from Cell B1 to Cell B3.  
 

3. In the Record Macro dialog box, replace Macro1 in the Macro name: box with AdjColumns 
4. In the Shortcut key: box, type a lower-case letter “s”. 
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Figure 16.13

5. Leave all other boxes with the default values, and click OK.  

Figure 16.14

On the bottom-left corner of your screen next to the Ready text, you should see a small box. Hold your 
cursor over the box and you will see a screentip that reads, “A macro is currently recording. Click to stop 
recording.” Every keystroke and action made with the mouse is now being recorded. Excel is recording 
and converting all of the keystrokes and clicks in VBA code, which is saved in the macro. Let’s record 
our first macro then stop it. All we want this macro to do is to select the entire spreadsheet and adjust the 
column widths. 
 

6. Select the entire spreadsheet by clicking on the box with the gray triangle in the upper-left 
corner of the spreadsheet where the columns meet the rows. 
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7. Double-click on any column line to auto adjust the width of all columns. 
8. Click on Cell F11 of the  tab and click the Stop Recording button. 

The Stop Recording button disappears, but in the background you have a recorded macro. Let’s try out 
the macro by using the shortcut key you defined. 
 

9. Adjust the width of Column E to be much larger, like 20.00 (145 pixels) and click on Cell A4. 
10. Press [Ctrl]+s. 

 
In a split second, you can see the screen blip and the width of Column E is adjusted, and your cursor 
moves to Cell F11. This indicates the macro is working.  

Editing a Macro  
To format our spreadsheet, the user has to run two macros, the FormatCells and AdjColumns macros. 
Do you think we could combine them into one macro? Sure we can. There are two ways to do it. First, 
you could create a third macro that runs the first two macros. Even though it’s easy to do, I don’t like 
to do that, as you end up with three macros when you should have just one. I prefer the second method, 
which is to copy the VBA code from one macro, and paste it into the other. Let’s do that now. In this next 
exercise, you will copy the AdjColumns macro code into the FormatCells macro. 
 

1. Open the Macro dialog box. 
2. Select the AdjColumns macro, and click the Edit button.  
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Figure 16.15

The VBA Editor opens up with the FormatCells Macro and AdjColumns Macro boxes visible. 

3. In the AdjColumns Macro window, select the three lines in black that make up the text of the 
macro (Cells.Select through Range(“F11”).Select) and copy the text into memory. 

4. Click the VBA Editor screen with the Sub FormatCells() macro in it. 

Note: The number of VBA module code windows displayed depends on 
how many Excel files you have open. Each is searchable in the Project - 
VBAProject menu. Each is labeled according to the workbook and module it 
relates to. You can click the module window directly or use the Project pane 
to select a specific one to work with.
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5. Go to the last line of the macro, just before the End Sub statement, and paste the text from the 
AdjColumns macro.  

Figure 16.16

6. Close the VBA Editor screen. 
7. Make sure the “a” shortcut is still valid in the Macro Options dialog box for the Format Cells 

macro. (Sometimes VBA resets the shortcut to nothing when changes are made to the macro.) 
8. Adjust the column width of Column E to be something much larger than it currently is, un-

bold the bolded cells, and press [Ctrl]+a to run the FormatCells macro. 
 
As you will see, the width of Column E is now shorter and all of the cells in the FormatCells macro 
have changed their formatting. This is the evidence you needed to confirm that both macros are now 
combined into one. Now that they are combined, you don’t need the AdjColumns macro. 

9. Open up the Macro dialog box, click on the AdjColumns macro, and click the Delete button. 
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Figure 16.17

10. Click Yes to confirm the deletion of the macro.  
11. Save the mySales_2016.xlsm file. 

 
One problem with the way we currently have our spreadsheet set up is that the user has to remember to 
use [Ctrl]+a to run the macro. We could type the instructions somewhere on the Assumptions page, but 
that could take up a lot of space. One way to make it “bone stupid simple” is to use a Command Button. I 
really like Command Buttons, and since this is my course, we’ll do some now.  

Command Buttons  
You are probably already familiar with a Command Button. A Command Button is a button that does 
something when you click on it. There are many examples of Command Buttons on almost every Internet 
page. You can create Command Buttons in Excel, Access, HTML, and many other programs. When you 
open a macro-enabled workbook, you see the Enable Content button, which is an example of a Command 
Button. In our example, we’ll create a command button that executes the FormatCells macro. Command 
Buttons, as well as other tools we’ll use later in this chapter, are contained in the Developer tab. 
 

1. While on the  tab, click on the Developer tab. 
2. In the Controls group, click on the Insert icon. 
3. Click on the Button (Form Control)  icon . 
4. With your mouse, draw a rectangle at about Cell E13 below the Total Bonus row, and release. 

When you release the mouse, the Assign Macro dialog box appears.  
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Figure 16.18

5. Select FormatCells in the Macro name: box and click OK. 

Excel creates a button that looks like this:   

Figure 16.19

6. While the Command Button is selected (i.e., handles appear around it), select the text Button 
1 inside the button, and replace it with Format Cells.

7. Resize the Command Button to where all of the text is visible, if necessary. 
8. Click the [Esc] key to exit out of the button Design Mode. 

 
To edit the button, move it around, reassign the macro or resize it, simply right-click on the button and 
either choose an option from the list or click [Esc]. If you left-click on the button, it will execute the 
macro that you assigned to it. 
 

9. Right-click on the Format Cells command button, press [Esc], and position your cursor over 
the button’s shaded area where the cursor turns to a four arrow symbol. 
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10. Drag the button just to the right of the Nitey-Nite Mattresses graphic, and release. 
11. Click anywhere outside of the button (to exit Design Mode).  

Figure 16.20

12. Adjust the width of Column E to be much larger, and click on the Format Cells command 
button to test the macro. 

Tip: To keep the command Button from moving with column adjustments, click 
the Don’t move or size with cells radio button in the Properties tab of the 
Format Control dialog box.

13. Save the mySales_2016.xlsm file. 

Macros in the Quick Access Toolbar  
Another way to store a macro in your spreadsheet is to put it in the Quick Access Toolbar. This comes 
in particularly handy when you have lots of macros and you want to organize them in an easy-to-use 
fashion. In this next example, we’ll put the FormatCells macro in the Quick Access Toolbar. 
 

1. Click on the Customize Quick Access Toolbar drop-down arrow and choose More 
Commands… 

The Excel Options dialog box appears, and the Customize section of the dialog box is activated. 
 

2. Make sure the Choose commands from: box is set to Popular Commands. 
3. Scroll to the bottom of the list and click on View Macros. 
4. Click Add >> 

﻿
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The View Macros object is moved over to the section that displays all of the icons currently available in 
the Quick Access Toolbar. 

5. Click on the Choose commands from: drop-down menu and choose Macros. 

Figure 16.21

6. Click on the FormatCells macro and click Add >> 
7. Click on the FormatCells macro in the right section, and click the Modify... button at the 

bottom of the section. 
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Figure 16.22

The Modify Button dialog box appears.  

8. Click on the button in the ninth row that looks like a paintbrush, and click OK to close the 
Modify Button dialog box, then click OK again to close the Excel Options dialog box. 

 
You have now assigned that image to the FormatCells macro. Whenever you want to use that macro, 
simply click on that image. 

Figure 16.23

9. Click on the brush icon to run the FormatCells macro, and make sure it works.  

Spin Buttons  
Another object from the Developer tab that I use a lot is the Spin Button, sometimes called a Spin Box or 
Spinner Button. Users, particularly upper management, like to see what happens with the bottom line 
with each unit change in a variable. At Nitey-Nite Mattresses, there is an on-going argument over the 
entry point at which management wants to pay bonuses. Some management people say that each store 
must reach 100% before making a bonus. Others say you can make more sales if the entry point is more 
lenient, like at 90%, and yet other hard-core individuals believe 100% is the minimum acceptable to keep 
your job and that the bonus entry point should be at about 110%. With a Spin Button, you can create the 
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functionality to show the end result (Total Bonus Payable) with every percentage point change in the 
entry point without having to type in each assumption. It’s so simple to use that even upper management 
people who have little experience with Excel can use it and they LOVE it! Let’s create a Spin Button. 

1. Make sure you are on the  tab of the mySales_2016.xlsm file, and click on 
the Insert button of the Controls group of the Developer tab. 

2. In the Form Controls box, click on the Spin Button (Form Control). 
3. Draw a vertically shaped rectangle box on the left inside of Cells F14 and F15, and release. 
4. Right-click on the Spin Button and choose Format Control… 

 
The Format Control dialog box appears.  

5. Click on the Control tab. 

Figure 16.24
 

6. Click inside the Cell link: box then click on Cell F14 (you may have to move the dialog box out 
of the way to click on Cell F14) and click OK. 

7. Click outside the Spin Button to take it out of design mode. 
8. Click on the up and down arrows of the Spin Button, and you will see the value in Cell F14 go 

up and down accordingly. 
 
With the spin button set up, all we have to do is write a formula using the number in Cell F14 to calculate 
the change in the entry point. If you look at the values in Cells B15 and B24, you will see that all of the 
percentages are based on the value in Cell B6, which is currently set to 100%. We want to write a formula 
that will take the number in Cell B6 up and down by one percentage point. Notice that the Spin Button’s 
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value in Cell F14 can go up a lot but stops at 0 when clicking the down arrow. It would seem that we can’t 
go below zero, but we can change around some assumptions in the dialog box that will solve that issue.

9. Right-click on the Spin Button and choose Format Control… 
10. Change the Current Value to 100, leave the Minimum Value at 0, change the Maximum 

Value to 200, leave the Incremental change at 1 (you can’t go below 0 on the Incremental 
value – that’s why we have to write a formula), click OK and exit out of the Spin Button’s 
design mode. 

 
The value in Cell F14 changes to 100. Click on the up and down arrows of the Spin Button and you will 
see that you can go up to 200 and down to 0. 
 

11. Replace the value in Cell B6 with this formula: =F14/100. 
12. Hide the contents of Cell F14 (use a Custom format of ;;; in the Format Cells dialog box). 
13. Type Entry Point in Cell E14. 
14. In Cell E15, type =F14/100  and format it as Percent, zero decimal places. 
15. Take the Entry Point down to 95% using the Spin Button.  

Figure 16.25

The Total Bonus becomes $317,496. Notice that the % of Budget numbers are all based on the Entry Point 
in Cell B6. With every click on the Spin Button, there is instantaneously a new Total Bonus value. If you 
can create Spin Buttons on your spreadsheets that are given to upper management or clients, they will 
think you are the Excel master of all masters!
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Check Boxes  
The next object in the Developer tab I think is very useful is the check box. If you’ve spent any time in 
computer programs or on the Internet, you’re probably already familiar with check boxes. A check box 
is used when you want the user to simply check and uncheck an assumption, or in other words, turn 
an assumption off and on. In our example, let’s assume there are discussions with upper management 
as to whether or not Paper stores should be eligible for a bonus, as they are smaller stores that don’t 
contribute much to the bottom line of the company. We will create a check box to include them as eligible 
for a bonus when checked, or uncheck the box, if they are not eligible and see the difference in the Total 
Bonus. Let’s do it. 

1. In Cell E17, type: Include Paper 
2. Click on the Check Box icon  in Form Controls. 
3. With your cursor, draw a small box in the middle of Cell F17. 

You should get something similar to the following:  

Figure 16.26

4. Delete the text to the immediate right of the check box within the object. 
5. Right-click on the check box and choose Format Control… 
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6. On the Control tab, click inside the Cell link: box. 
7. Click on Cell F17 on the spreadsheet or type F17.  

Figure 16.27

8. Leave all default values, and click OK. 
9. Exit out of the check box design mode. 

Check and uncheck the check box. You will see that Cell F17 returns TRUE when it is checked and 
FALSE when it is unchecked. 

10. Make sure the check box is unchecked. 
11. Format Cell F17 (the cell, not the check box) as hidden. 
12. Resize Column E, if necessary. 
13. Go to the  page. 
14. Insert a column between the Store_Type and Bonus fields. The new column should be 

Column K. Name it Include. 
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15. In Cell K5, write a formula that says if the Store_Type is not Paper, return a Y, else, if Cell 
F17 on the  tab is TRUE, then return a Y, else, return N. 

16. Copy the formula down to all cells below.  

Figure 16.28

Notice that in my outline of the formula, I did not hard-code in the word “Paper”. I referred to Cell 
F5 on the Assumptions tab. This way, if Nitey-Nite every decided to change the names Paper, Scissors, 
Rock to Bronze, Silver, Gold (or something similar), all they would have to do is make the change on the 
Assumptions page and all of the formulas would continue to work. 
 

17. Edit the formula in Cell L5 to return 0 if the Include column is N. 
18. Copy the new formula down to all cells below. 
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The new formula in Cell L5 should be as follows: 

=IF(K5=“N”,0,IF(J5=Assumptions!$F$5,VLOOKUP(MATCH(I5,Assumptions!
$B$5:$B$10,1),Assumptions!$A$5:$C$10,3,FALSE)*G5,IF(J5=Assumptions!$F$6,
VLOOKUP(MATCH(I5,Assumptions!$B$14:$B$19,1),Assumptions!$A$14:$C$19,3,
FALSE)*G5,VLOOKUP(MATCH(I5,Assumptions!$B$23:$B$28,1),Assumptions!
$A$23:$C$28,3,FALSE)*G5))) 

 
The only real change to the formula is “IF(K5=0,“N”,0,”, and adding an ending parenthesis at the end. 

19. Go to the  tab. 

20. Check and uncheck the check box. 
 
You should see that the Total Bonus is $317,496 when it is checked and $198,556 when it is unchecked. 
You now have a fully functional application that will allow management to change almost any 
assumption in the Sales program. Trust me, management and clients LOVE this kind of analysis. It gives 
them the opportunity to make any change they want and immediately see the results. 
 

21. Save and close the mySales_2016.xlsm file. 

Review Questions: It is now time to complete the hands-on Review Questions. 
Log on to www.ExcelCEO.com with your Email address and Password, click 
on the Excel 2016 Review Questions, Chapter 16, Section 2 of 2 option in 
your Main Menu, and complete the Review Questions.  

Conclusion  
In this chapter, you learned about macro security and why you should be cautious about receiving files 
containing macros from others. We reviewed the VBA (Visual Basic for Applications) programming 
language, which is the language behind macros. You learned how to create, edit, run, step into and 
delete a macro, as well as how to work with relative references as it applies to macros. You learned about 
shortcut keys and created a shortcut key within a macro. You added a macro to the Quick Access Toolbar 
and finally you created a Command Button, a Spin Button and a Check Box using Form Controls.  

Chapter Exam  
To take the examination for this chapter, you must have successfully completed the examination for the 
previous chapter. You can now go to www.ExcelCEO.com, click on Sign In, log in and take the exam. 
Make sure that you take the exam on the same computer on which you completed the practice files, 
as some of the questions on the exam may refer to some of the completed projects. Chapter exams are 
intended to be hands-on. 
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CHAPTER SEVENTEEN — THE WEB AND MORE COOL EXCEL STUFF 
 
 

Chapter Objectives: 
 

•    Recognize how to create a simple HTML page using NotePad
•    Identify how to save an Excel file as an HTML file and view the workbook using a web browser
•    Determine how to extract data from the internet using a Web Query
•    Recognize how to delete records in a table but not in the worksheet
•    Identify the components of advanced Date filtering
•    Determine the steps to insert a Background into a spreadsheet

Projects You Will Complete During This Chapter:

•	 hello.html
•	 myNew2016.xlsx
•	 myWebQuery.xlsx
•	 Q1_Sales.mht

CPE Credits possible for this chapter: 2
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Working with the Web 
One enhancement that was made in more recent versions of Excel is its capability of saving documents 
to the World Wide Web (Web). When a document is saved on the Web, it can be viewable to everyone or 
just to people that you allow access to it. One of the great points about saving documents to the web is 
the distribution of the document or report. Once it is on the Web, all you have to do is tell people where 
it is, usually by sending them a link in an email, and they can click on the link to access it. Even though 
you can make an Excel file itself available via the Web, that is sometimes not a good idea, particularly 
if that person is accessing the Web using a slower connection. Sometimes large files can take a lot of 
time to open. One change that was made is that users no longer are required to have their own copy 
of Microsoft Excel for simply viewing an Excel document, thanks to Excel Web Access. Office 365 
provides subscription-based access as well for those who prefer always up-to-date applications for a price. 
Microsoft SharePoint as well as cloud-based storage such as OneDrive has made collaboration, even 
simultaneous collaboration, easier than ever for teams who share access to specific files, but do not want 
those files made made open to the public. For now, let’s focus on saving an Excel file to the Internet. 
 
To make an Excel file viewable on a browser (like Microsoft Internet Explorer), it is necessary to save 
the file in some type of browser-viewable format. The basic format for viewing documents on the web 
is in an HTML format. HTML stands for Hypertext Markup Language. An HTML file is a page that is 
programmed to make it readable for a browser. Although programming HTML is beyond the scope of 
this course, it would be helpful to know at least some basics.  

Create a Simple HTML Page  
An HTML file is programmed with tags which tell the browser how to display its contents. HTML is not 
a programming language per se, but a markup language, and is very easy to learn how to code. You don’t 
even need any special software to program it – just open Notepad or Word and start programming. Let’s 
create a simple HTML file using NotePad. 
 

1. Open a blank NotePad file (Cortana, type NotePad, and select NotePad Desktop app using 
Windows 10, or Start Menu, and type NotePad using Windows 8/8.1). 

2. In the NotePad file, type the text as shown in the image below. 
3. Save As C:\ExcelCEO\Excel 2016\Chapter17\hello.html. (Make sure to save the file name as 

hello.html, and the Save as type box set to All Files. You may have to manually type the file 
tag as .html)  

Figure 17.1
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In this file, there are five lines of code. The text surrounded by the “<” and “>” signs are called tags. Tags 
are the basics behind HTML files. There is only one required tag in an HTML file. That tag is the <html> 
tag, which tells the browser that this is an HTML page. All other tags are optional. The last tag, </html>, 
tells the browser it is the end of the HTML page. The <body> tag begins what is contained in the body 
of the page, and the </body> tag ends the <body> tag, or ends the body of the page. You must save an 
HTML file with the extension .htm or .html. 
 

4. Open your Excel 2016 Chapter 17 folder. 
5. Right-click on hello.html, Open with click on your preferred Browser (Edge, Chrome, Opera, 

Internet Explorer, etc.) icon from the menu of options shown. 

 Tip: If you use Internet Explorer, you can either right-click on the browser tab 
area under File, Open..., and navigate to the .html file. If File is not visible, 
click [Alt] to open the Menu Bar temporarily, or activate it by right-clicking 
on the browser header bar and selecting Menu Bar. If you are using Edge, 
Chrome, Opera, etc., you can open the file by navigating to the Chapter 17 
folder, right-clicking the file, selecting Open with..., and then selecting your 
preferred browser.

Figure 17.2

Again, this is a very simple HTML page that is viewable currently only by you since it is on your 
computer’s hard drive. If you want the whole world to see it, you would have to copy the file on to a web 
server, which is simply a computer that is connected to the web.  
 
At this point, you can start changing some of the text and tags to make it more useful, meaningful, or to 
just pretty it up. 
 

6. In the NotePad file, add the <b> and </b> tags around the word Hello. 
7. Save the NotePad file.  
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Figure 17.3

The <b> and </b> tags tell the browser to display a bold format starting with the letter H in Hello and 
end the bold after the letter o. To see how it looks on your browser, just click the Refresh icon after you 
save the NotePad file. You can also use the <strong> tag to bold text, which is also recognized by most 
browsers. 
 

8. Click the Refresh icon on your browser.   

Figure 17.4

Now you see that the word Hello is in a bold format. It is beyond the scope of this course to give a 
complete lesson on creating HTML files, but learning to write HTML is essential if you want to learn web 
development, and it is relatively easy to learn, and now you have some basics. 
 

9. Close your Internet browser and NotePad.  

Save as Single File Web Page  
There are many types of web page languages that can be used to create web pages. Other languages 
include ASP, ASPX (or ASP.Net), PHP, JSP, and CFM, just to name a few. In this next exercise, you will 
open an Excel file and save the file as a web page. When you save an Excel file as a single web page using 
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Excel’s publishing tools, it is created with an mht (MHTML, or Microsoft HTML) extension. Creating 
this kind of file is not much more than clicking File, Save As… and choose a Save as format. Let’s do it. 
 

1. In Excel, open the Q1_Sales.xlsx file located at C:/ExcelCEO/Excel 2016/Chapter17.

Figure 17.5

This is a simple file we’ve worked with before. It contains three tabs: January, February, and March. Each 
tab contains sales data by store and merchandise type. 
 

2. Click on the File tab, then click on the Chapter 17 folder on the Save As screen. 
3. In the Save As dialog box, click on the Save as type drop-down menu, and choose Single File 

Web Page. 
4. Make sure the Entire Workbook radio button is selected. 
5. Click Save. 
6. Click Yes in the Warning dialog box (as all we’re trying to do is create a static web page). 

 
It may not look like anything happened, but you just saved the file as a web page viewable via your 
browser. 
 

7. Open Internet Explorer. 
8. Click File, Open…, navigate to C:\ExcelCEO\Excel 2016\Chapter17\Q1_Sales.mht, and 

open the file. 
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Figure 17.6

9. Close the ActiveX Security message in yellow, if necessary. 
 
You should see something like the figure above. Depending on your browser, you may see a warning 
message telling you that the browser restricted access to the file. Since it is on your computer and no one 
else sees it, it is OK to allow access to it.  
 

10. Click on the  tab at the bottom-left of your screen to see the numbers change to 
February data. 

A note on Web reporting: Microsoft is changing the way users share their Excel files and the way we 
interact with them, meaning allowing users to update the data via the Web. Creating a web page from an 
Excel file like we just did is simply putting the data in a read-only format. If you are interested in sharing 
data over the web and allowing users to interact with the data in reports that sort, filter, and update data, 
I suggest you explore other web tools such as Microsoft SharePoint Services or ASP.Net. There are also 
some good non-Microsoft tools that have that functionality, like PHP, JSP, and ColdFusion. If you want to 
simply report numbers in a formatted report that is printable (i.e., the headers and footer appear on each 
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page and you can control the margins) but cannot update, add or delete records in a database, I suggest 
using tools like MacroMedia’s Business Objects (Crystal Reports) or my favorite, Microsoft SQL Server 
Reporting Services (SSRS). A discussion of these tools is beyond the scope of this course. However, if you 
complete the Excel course AND the subsequent Access and SQL course, you will be adequately prepared 
to start learning to use any one of these tools. 
 

11. Close your browser, and close the Q1_Sales.mht file. 

Review Questions: It is now time to complete the hands-on Review Questions. 
Log on to www.ExcelCEO.com with your Email address and Password, click 
on the Excel 2016 Review Questions, Chapter 17, Section 1 of 2 option in 
your Main Menu, and complete the Review Questions. 

Create a Web Query  
While there is an enormous amount of data on the Web, it doesn’t do you any good unless you can access 
it and manipulate it in a way that is meaningful to you. Excel has the capability of creating a web query 
by letting you copy the data on a web page and pasting it into an Excel spreadsheet. Once you paste it into 
the spreadsheet, a Paste Options button will appear that allows you to create and save the query so you 
can run it over and over again (assuming the data changes). Let’s create a web query on a simple web page 
I built. 
 

1. Open a Blank workbook in Excel, then open your preferred Internet browser. 
2. Type this address into the address bar of your browser: www.ExcelCEO.com/dates.asp.  

Figure 17.7

3. In the Blank workbook, click New Query in the Get & Transform group of the Data tab, 
select From Other Sources, then From Web.  
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Figure 17.8

The From Web dialog box appears to allow you to select the URL from which your query will be return 
data. You will be querying the page you opened on the ExcelCEO website.
 

4. Type ExcelCEO.com/dates.asp in the URL box of the From Web dialog box then click OK. 

 Figure 17.9

The Navigator dialog box appears with a folder identifying content from the URL and a preview window.

5. Click on the Table 0 in the Navigator dialog box and review the table data. 
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Figure 17.10

Now you can choose where to import the table data within the Blank workbook.  
 

6. Click on the Load drop-down arrow and click Load To...
7. In the Load To dialog box, click the Existing worksheet: radio button and click Load. 

The web query is created. To refresh the data in the spreadsheet, just right-click anywhere on the table in 
Excel, and choose Refresh. You can also click Refresh in the Office Ribbon for linked query updates. 
 

7. Right-click anywhere in the table, and choose Refresh. 

Figure 17.11

The data will change according to the time on the webpage’s server (it is in United States Pacific time). 
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The great thing about this kind of query is that you can set it up to pull data from any site you have 
permission to on the Web, and you don’t have to continually go to the web site to copy the data. Just 
refresh the Excel file and your data is updated in real time. You can even set the query to refresh on a 
time interval basis. How about using this for some stock quotes? 

8. Save As C:\ExcelCEO\Excel 2016\Chapter17\myWebQuery.xlsx, and close it.  

More Cool Stuff in Excel  
 To conclude this chapter, let’s look at some of the miscellaneous new things that have been built into 
Excel 2016. I chose to include some of the new things incorporated into Excel 2010 — 2013 as well 
because I realize some people may be upgrading from Excel 2003 or 2007 straight to Excel 2016. Most of 
these enhancements came out with the release of Excel 2013, and I will note those things that are specific 
to 2016. There is already a list of new items for Excel 2016 in the Introduction section of this course, and 
I encourage you to review that list again now that you are coming to the end of the course. Let’s start off 
this discussion reviewing Excel 2016 Tables.  

Excel 2016 Tables  
1. Open the file at C:\ExcelCEO\Excel 2016\Chapter17\New2016.xlsx. 
2. Save As C:\ExcelCEO\Excel 2016\Chapter17\myNew2016.xlsx. 
3. Click Enable Content, if necessary.  

Figure 17.12

The Tickets tab of this file is an import from an Access database of records (sales) for each store. It also 
contains another table of data off to the right that we’ll use in a few minutes. When records are imported 
from an Access database, Excel sets up the record set and formats it as a table. This is important to 
understand because a table in Excel 2016 has additional features as compared with a simple record set of 
data. You can also define a table by using the Format as Table functionality in the Home tab. Let’s do that 
now. 
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4. Click on Cell A1 (or any cell in the table). 
5. On the Home tab in the Styles group, click on the Format as Table button. 
6. Choose Table Style Medium 2.  

﻿

Figure 17.13

The data table is now formatted with a new, lighter style. Let’s write a VLOOKUP() function that looks 
up the Store Number based on the Store ID. 
 

7. In Cell J1, type Store_Name. 
 
As Column J is a column adjacent to the data table, Excel automatically recognizes the column as part of 
the data table and applies the Medium 2 formatting to it. 
 

8. In Cell J2, write a VLOOKUP() formula that looks up the Store_No on Store_ID based on 
the lookup table to the right of the data table. When writing the formula, choose the Cell A2 
with your mouse or with the arrow keys (do not type A2 in the formula).  
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Figure 17.14

Notice how the formula reflects the name of the data table (Excel automatically named the table when 
we formatted it) and a reference to the Store_ID field instead of the A2 reference. Additionally, Excel 
assumes you will apply that formula to all cells beneath it, so it populated all cells in the data table for 
you. Let’s assume that the boss told us to delete Rows 7 and 8 in the data table. We could encounter a 
problem doing that because of the lookup table to the right of the data table. If you delete Rows 7 and 8 
in the data table, it will delete Store_IDs 6 and 7 in the lookup table. Versions of Excel since 2007 have 
a feature that allows you delete rows and columns in the data table without affecting any other tables 
beside or beneath it. 
 

9. With your mouse, select Cells A7 and A8. 
10. On the Home tab in the Cells group, click on the drop-down arrow on the Delete button  

Figure 17.15

11. Click on Delete Table Rows . 
 
 When you clicked on Delete Table Rows, Excel deleted the rows in the table, but not in the lookup table to 
the right. You can delete rows and columns from tables using this new functionality.  
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Zoom In and Zoom Out  
 Another nifty feature is the Zoom functionality. Zoom In and Zoom Out buttons are located at 
the bottom-right of your screen. You can click these buttons to see larger and smaller views of the 
spreadsheet.  

Figure 17.16

1. Click on the Zoom Out button until you can see all columns in both the data and lookup 
tables, but can no longer read the text. 

2. Click on the Zoom In button until the data table columns take up your entire screen. 
3. Return the view of the data table to 100%. 
4. Click on the 100% image.  

Figure 17.17

The Zoom dialog box appears. Using this dialog box, you can customize the size of the data to any size 
you want. The Zoom features are MUCH easier than playing around with the display in Control Panel to 
adjust the size of your screen. 
 

5. Cancel out of the Zoom dialog box.  

Filtering on Dates  
From Excel 2007 on, a feature was added that makes it easier to filter on dates. This functionality is 
available whenever the data in a column is formatted as a date, and Filter is turned on. 

1. If the Filter is not turned on in the data table, turn it on. 
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2. Click on the drop-down arrow next to Sale_Date.  

Figure 17.18

Notice the  boxes next to each year. You can click on the boxes to filter for specific years, months and/
or days. 
 

3. Uncheck the 2014, 2015, and 2017 check boxes. 
4. Click on the  box next to 2016, and deselect all boxes except for January, February, and 

March, and click OK.  
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Figure 17.19

The data table is now filtered for data in the first quarter (January, February, and March) of 2016. This is 
similar in effect to a Slicer for a PivotTable.  

Background Images  
Have you ever seen a Word document that has a “watermark” on it? These are documents that usually 
have something like “Draft” or “Tentative” pasted as a background so the user of the report knows that 
it is not a final document. You can include such a background in an Excel 2016 spreadsheet as well. I 
created a simple “Draft” .jpg file with WordArt and included it in the Chapter17 folder. Let’s use that as a 
background. 
 

1. Click on the  tab of the myNew2016.xlsx file. 
2. Click on the Page Layout tab. 
3. In the Sheet Options group, deselect the View box under Gridlines. 
4. Click on the Background  button in the Page Setup group. 
5. In the Insert Pictures dialog box, click on Browse from the From a file row, and navigate to 

the C:\ExcelCEO\Excel2016\Chapter17 folder, and double-click on the draft.jpg file. 
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Figure 17.20

Notice that the background repeats in all columns and rows of the spreadsheet. 
 

6. Save and close the myNew2016.xlsx file. 
 
Microsoft has gone to great lengths to try to improve Excel. As you continue to use Excel 2016, take some 
time to play around with features that pop up on the right-click menu, or button in the Ribbon that you 
haven’t used before.  
 

Review Questions: It is now time to complete the hands-on Review Questions. 
Log on to www.ExcelCEO.com with your Email address and Password, click 
on the Excel 2016 Review Questions, Chapter 17, Section 2 of 2 option in 
your Main Menu, and complete the Review Questions. 
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Conclusion  
In this chapter, you created a simple HTML page by using NotePad. You learned how to save an Excel 
file as a web file to make it readable on a browser. You saved an Excel file as an MHTML file and created 
a web query. You also explored some of the new features of Excel 2016, like working with tables and 
filtering on dates. You deleted rows in a data table without deleting the data in another table on the same 
spreadsheet. You finished the chapter by including a background in your file so that users of the file 
would know it is still in Draft mode. 

Chapter Exam  
To take the examination for this chapter, you must have successfully completed the examination for the 
previous chapter. You can now go to www.ExcelCEO.com, click on Sign In, log in and take the exam. 
Make sure that you take the exam on the same computer on which you completed the practice files, 
as some of the questions on the exam may refer to some of the completed projects. Chapter exams are 
intended to be hands-on.  
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SECTION IV: THE EXCEL 2016 MASTER 
 
It is this section of the course that goes beyond the traditional Excel learning. This last chapter of the 
course is hard. In fact, it is by far the hardest chapter in the entire course. But the knowledge that you 
will gain by completing this chapter is unparalleled in the market today. If you can complete this chapter, 
then you are truly an Excel Master, and upon completion, I will send you an Excel Master Certification to 
prove to the world how good you really are. Additionally, your name will be registered as an Excel Master 
in the Graduate Verification section of the ExcelCEO Home page. I made this available so you can prove 
to your current or prospective employer that you have successfully completed the ExcelCEO coursework, 
and that you are certified as an Excel Master.
 
If you have completed ALL of the exercises in the previous chapters, you are now ready to start the 
ExcelCEO Excel 2016 Comprehensive Project. At the beginning of this course, I asked you to complete 
all of the exercises herein because the tasks I will ask you to do in the Comprehensive Project contain 
Beginning, Intermediate, and Advanced skills you should have learned throughout the course. Many 
students complete through Chapter 17 by just getting by and barely passing the tests. These students pick 
up a number of tricks, but they don’t master Excel enough to be able to complete the Comprehensive 
Project and the Chapter 18 exam. Some of them just give up. Others go back and work the exercises they 
skipped over to be able to complete this project. I hope you have completed all of the exercises up to this 
point, and I encourage you to continue on. 
 
The Comprehensive Project is a project where I will give you basic instructions on how to complete it, but 
I will not give you the instructions on how to complete the tasks like I have before. Actually, I don’t care 
how you get the right answer, as long as you get it. In that sense, the project is much more like an actual 
project you will get on the job. All of the questions on the Chapter 18 exam are based on the completed 
project, so it is imperative that you complete it exactly as I explain it. To further assist you, I will give you 
some check figures along the way just to make sure you are on the right path.  

Note: There are no Review Questions checkpoints in Chapter 18, and this 
chapter does not count for CPE credits. All 40 CPE credits possible have been 
available to award by the end of Chapter 17. All chapter exam questions will 
refer to your Comprehensive Project. Completing the Comprehensive Project 
and passing Chapter 18 is to achieve the ExcelCEO Excel Master status, 
earn a printed certificate, and become listed in the ExcelCEO Graduate 
Verification at ExcelCEO.com.

 
As I have stated many times in this course, I believe the three most important things an Excel user should 
know are 1) how to write a nested IF() statement; 2) how to create and use PivotTables and 3) how to write 
a VLOOKUP() function. With those three pieces of knowledge, you can do almost unlimited analyses in 
Excel. The Comprehensive Project will test your ability to follow simple and complex logic using all three 
of these tools, as well as using other functions and formula-writing skills learned in this course. With 
that said, let’s get started, and GOOD LUCK! 
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THE COMPREHENSIVE PROJECT 
 
 

Chapter Objectives: 
 

•    Use VLOOKUP(), nested IF() logic, PivotTables, the many other skills you have acquired in the 
preceding chapters to complete the Comprehensive Project

Projects You Will Complete During This Chapter:

•	 myComp_Project.xlsx
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The Comprehensive Project 
The data for the Comprehensive Project will come from the file located at C:\ExcelCEO\Excel 2016\
Chapter18\Comp_Project.xlsx. 
 

1. Open the Comp_Project.xlsx file located at C:\ExcelCEO\Excel 2016\Chapter18 
2. Save As myComp_Project.xlsx in the same folder. 

 
This file contains three tabs of data. The format of this data is probably very similar to databases you 
will find at your own company. The first tab is called Stores. It contains information about each store. 
We’ve used this data in other exercises, so you should be familiar with the data and the format. As you 
will learn if and when you take the ExcelCEO Access course, each table in a database should contain a 
Primary Key. A Primary Key is a field of data in a table that serves as a unique identifier for each record. 
For programming purposes, it is typically better for the primary key to be a number field instead of a text 
field. Using a number field as a primary key generally improves the speed when querying the tables. In 
the Stores tab, the Store_ID is the Primary Key field. 
 
Let me take some time to explain how the Stores table is set up. All of the fields in the table are probably 
self-explanatory, except for the Parent_ID field. The Parent_ID field records the rollup structure of 
all stores in the organization. In relational databases, you will become familiar with a parent/child 
relationship, and this is a good example of how that relationship works. Take for example Store_ID 12, 
which is Store_No 1019, Nitey-Nite Alameda. This store is located in Baltimore, Maryland. You can also 
see the store’s address, city, state, ZIP Code, phone number, and area in square feet. It would be easy to 
query or filter for Store No 1019, or even for all stores in the city of Baltimore, or the state of Maryland, or 
any other city or state. However, Nitey-Nite’s stores are also organized in regions, namely, the Northern 
and Southern Regions. The organization of stores in regions is maintained in the Parent_ID field. For 
Store No 1019, you see that the Parent_ID is 21. The Parent_ID of 21 is the “parent”, or one level higher, 
than Store_ID 12. If you look down the Store_ID field, you will see that Store_ID 21 is Store No R02, 
which is the Southern Region. Store_ID 21’s “parent” is Store_ID 1, which is the Home Office.  
 
Using the Store_ID in this manner, a database programmer can maintain several levels of structures 
with just two fields called the parent and child fields. This could also be accomplished by maintaining 
a separate field for each level, and that usually works best when working with a flat file like Excel. Most 
relational databases are set up using a parent/child structure, also referred to as a hierarchical structure. 
It is important for you to understand a parent/child relationship or hierarchical structure for database 
programming, and in the Comprehensive Project you will turn parent/child fields into a flat file to make 
it easier to work with in Excel. 
 
The second tab is called Accounts. It represents a simple chart of accounts, and includes the Account_
ID, Level, Rollup_ID, Account and Acct_Desc fields. The Account_ID field is the primary key for this 
table. This table is another example of a parent/child relationship. For example, Account 190-3: Employee 
Discounts has an Account_ID of 1043 and a Rollup_ID (or parent ID) of 1007. The programmer included 
a field called Level simply to make the table easier to read and understand the rollup levels. Account ID 
1007 is Discounts, which rolls up to Rollup_ID 1002, Revenue, which rolls up to Net Income. Level 4, 
therefore, is at the lowest level of the account structure, and level 1 is the highest level, Net Income. In 
actuality, companies usually have more than four rollup levels, but I created this simple table to show you 
theoretically how hierarchical files work. 
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The third tab, Finl_Data, is the meat of the file. The data in this tab is kind of scary when you first look 
at it, but it becomes easier to understand when you grasp the concept of parent/child relationships and 
Primary Keys. The first field in the Finl_Data tab is Month. That one is easy to understand. The Month is 
simply the month in which the transaction occurred. As you can see, the first record occurred in Month 
08, or August.  
 
The second field, Store_ID, gets more complicated, but not to worry -- we can work through it. This 
field refers to the Store_ID field in the Stores tab. When creating a database, it is usually a good idea to 
name parent/child fields with the same names in the tables they relate to. Sometimes that is feasible and 
sometimes not. It is good practice to try to do so whenever possible. The first record in the Finl_Data 
tab has a Store_ID of 30. Store_ID 30 in the Stores tab is Store No 1060: Nitey-Nite Elamin in Baltimore, 
MD. All you have to do is to write a VLOOKUP() formula to pull in the store number and name. 
 
The third field, Acct_ID, refers to the Account_ID field in the Accounts tab. The first record in the Finl_
Data tab has an Acct_ID of 1021, which is Account 103-4: Double Fair in the Accounts tab. 
 
The next three columns in the Finl_Data tab, Amt_2016, Amt_2015, and Amt_2014 are the dollar 
amounts of each month, store and account activity. Based on the references that we’ve discussed, that first 
record in the Finl_Data tab tells us that Store No 1060 (Store ID 30) had amounts $7,850, $12,673, and 
$3,557 in August of 2016, 2015, and 2014, respectively. The tables also tell us that Store No 1060 rolls up 
to the Southern Region which rolls up to the Home Office, and that Account 103-4 rolls up to Mattress 
Revenue, which rolls up to Revenue which rolls up to Net Income. That’s a lot of information contained 
in very few fields of data. 
 
The last column in the table is Bgt_2016. You will populate that field with budget numbers toward the 
end of the Comprehensive Project. 
 
I hope you are beginning to grasp the concept of relational databases and parent/child or hierarchical 
structures. You have become an expert in writing formulas, including VLOOKUP() and many other 
useful functions. In the following steps, I will ask you to create a budget for each store at Nitey-Nite 
Mattresses, record that budget in a table, and analyze the company’s performance based on that budget. 
If you have not completed all of the exercises in this course accurately, this will not be an easy project 
to do, and most likely it will be impossible. Again, I will not give you step-by-step instructions on how 
to complete the project, as in previous chapters, but I will give you general guidance, hints, and tips, and 
leave it up to you to decide on how this project is to be accomplished.  
 
In the following exercises, you will be creating a lot of formulas and PivotTables. Try not to hard-code 
anything, as the exam questions require you to change some of the data and assumptions that are 
dependent on those formulas. With that said, let’s get started! 
 

3. Copy the  tab, and rename the new tab myFinl_Data. 

4. Insert a column in the  tab to the right of Store_ID, and call that column 
Store. 

5. Populate the Store field with a concatenated VLOOKUP() formula that looks up the Store No 
followed by a space, a dash, a space, then the name of the store, based on the Store_ID 
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field and the data in the  tab. Adjust cell alignment, and remove text wrap.
6. Insert a column between Month and Store_ID, and call it City. 
7. Write a VLOOKUP() formula that brings in the name of the city. 
8. Insert a column between Month and City, and call it Region. 
9. Populate that field with the name of the Region for each record.

Tip: The Northern and Southern Region offices roll up to the Home Office, 
NOT into their own regions.

10. Insert a column between Acct_ID and Amt_2016, and call it Account. 
11. Write a formula that shows the Account, followed by a colon and a space, then the Acct_

Desc based on the Acct_ID and the Accounts tab (example: 101-1: King Best). 
12. Insert two columns between the Acct_ID and Account columns. Call the new fields Lvl3_ID 

and Lvl3_Acct. (This is the first rollup level of accounts.) 
13. Write formulas that lookup the Level 3 Acct_ID and Acct_Desc in the  tab 

(such as Mattress Revenue or Variable Expenses).  

Format and spot-check your file with the image below. Your myFinl_Data tab should have 15,863 rows of 
data. 

Figure 18.1

14. Insert two columns between Acct_ID and Lvl3_ID. Call the new fields Lvl2_ID and Lvl2_
Acct. 
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15. Write a formula that looks up the Lvl2_ ID and Lvl2_Acct in the  tab

Hint: It will be either Expense or Revenue as those are the only level 2 accounts. 

Figure 18.2

16. Create tabs that contain the Budget numbers as per the following instructions.  

Budget Rules  

Revenue  
Revenue Budgets at Nitey-Nite are simple. They are calculated by first taking the average of the previous 
two years (in this case, the two previous years are 2014 and 2015). You then calculate the percent 
achievement of the previous year and apply that growth rate (with a cap and a floor) to the average 
revenue. Discount budgets are a little more complex, but doable.  

Mattress Revenue Budget 
a) Create a PivotTable based on the  tab. Name the new tab Bgt_Mattress. 
 

In the following steps, you will create a number of calculated fields. Do all of the calculated fields within 
the PivotTable, except where indicated to do them outside the PivotTable. 

b) Use Lvl3_Acct as a Filter, and set it to Mattress Revenue. 
c) Bring in the Store field in the Rows section. 
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d) In a calculated field, calculate the average of 2015 and 2014 revenue by store. Call the formula 
Avg_Amt. Name that field Avg Mattress Rev in the PivotTable. 

e) In another calculated field, calculate the percent of 2015 Revenue (Amt_2015) divided by 2014 
Revenue (Amt_2014) by store. Call the calculated field Pct_2014. In the PivotTable, name 
the field Pct of 2014. 

f) Create another field called Bgt_Pct. For stores with a Pct of 2014 more than 120%, return 
120%; for stores less than 100%, return 100%; and for all other stores, return the actual 
percent. In this formula, use a nested IF() statement. In the PivotTable, call that field Budget 
Percent. 

g) In another calculated field, multiply the Bgt_Pct by the Avg_Amt column, rounded to the 
nearest thousand. Name the calculation Annual_Bgt. In the PivotTable, call it Annual 
Budget. 

h) Create another calculated field called Mo_Bgt. The Monthly Budget number is Annual_Bgt 
divided by 12. 

i) Format all columns appropriately, and sort by Store.  

Check your Mattress Budget numbers with the following image:   

Figure 18.3

Pillow and Other Revenue 
Calculating the Pillow and Other Revenue budgets uses the same theory as the Mattress Revenue Bgt, 
except use the Pillow and Other Revenue numbers. Therefore, you can copy the Bgt_Mattress tab twice, 
and rename the new tabs Bgt_Pillow and Bgt_Other. Change the Lvl3_Acct Page Header and column 
names appropriately.  
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Figure 18.4

Figure 18.5

Discounts 
a) Copy the Bgt_Mattress tab, and rename the copy Bgt_Discounts. 
b) In the Bgt_Discounts PivotTable, take out all existing amount and calculated fields from the 

Values section, and bring in the Avg_Amt field as the only data item. 
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c) Pivot the Lvl3_Acct Report Filter to be in Columns, containing only Mattress Revenue, 
Pillow Revenue, Other Revenue, and Discounts fields, in that order. Remove Grand Totals

Hint: To change the order of a field, right-click on the field and point to Move. 
You can also click the column header border, and drag it to its new location). 
Steps d-g will be outside the PivotTable.

d) Rename the Sum of Avg_Amt field to be Avg Rev, and format it appropriately. 
e) Create the Discount % field as (Discounts / Sum of (Mattress Revenue + Pillow Revenue + 

Other Revenue)) less 0.5%. Calculate this and the following outside the PivotTable. 
f) Each store’s Annual Discount Bgt is calculated by using the sum of (Annual Mattress Bgt plus 

Annual Pillow Bgt plus Annual Other Bgt) each multiplied by the Discount %, rounded 
to the nearest thousand. 

Hint: Use the budget (Bgt_) table numbers, not Revenue figures.

g) Create the Monthly Discount Bgt field and format all fields appropriately. 

Figure 18.6

Note: When you create calculations on a PivotTable outside of the PivotTable, 
be careful! If you use the arrow keys to scroll over to a data item, or use the 
cursor to click on a data item, you will get a =GETPIVOTDATA() function 
that does not copy down properly. To overcome this, you have to manually 
type the cell reference in the formula instead of scrolling over to the cell. 

 
Tip: Actual and budgeted expense numbers will typically carry a minus “-” 

sign. 
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Fixed Expenses 
The Fixed Expenses budget for all stores is calculated by taking the average of the 2014 and 2015 Fixed 
Expenses increased by 3%, rounded to the nearest thousand. 
 

a) Copy the  tab, and name the new tab Bgt_FixedExp. 
b) Change the Report Filter to Fixed Expenses, and take out all data fields, except for the Avg 

Mattress Rev field, and rename it Avg Fixed Expenses in the PivotTable. 
c) Calculate the Fixed Expenses budget in a calculated field according to the instructions above.

Figure 18.7

Note: There will be a fixed expense budget for the Home Office, as well as for 
the Northern and Southern Region offices.  

Variable Expenses
a) Create a new PivotTable based on the  tab. Call the new tab Bgt_VarExp. 
b) Calculate the Variable Expense ratio for each store (Variable Expenses / sum of Total 

Revenue (including Discounts) ) for 2014 and 2015 separately. Name the column Ratios 
w/ Weighting.

c) Management tells us that the budget for variable expenses is more representative in 2015 than 
they were in 2014, so assign a 75% weight to the 2015 ratio and a 25% weight to the 2014 
ratio, less one percentage point. Name this column Sum Ratios -1%.

d) The Variable Expense budget for each store is the sum of the category annual budgets (except 
fixed expenses), rounded to the nearest thousand. Name this column Rev Budgets.

Tip: Remember all those Bgt_ category tabs you just finished creating. This 
would be a good time to use them.

e) Annual Var Exp budget is the sum ratios multiplied by the Rev Budgets rounded to the 
nearest thousand. Monthly Bgt is a monthly division of the Annual Var Exp budgets.
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Note: Many of these calculations can be done outside of the PivotTable. 

 f) Make sure your PivotTable matches with the following figure.  
 

Figure 18.8

For budgeting purposes, management wants to assign the monthly budget amounts for each category 
(mattress, pillow, other, discounts, fixed and variable expenses) to ONE account within each category, 
as illustrated in the table in Step 17 (Remember that the budgets are based on total category revenues). 
 

17. In the myFinl_Data tab, populate the monthly calculated budget numbers for each store in 
each month to the following accounts under the Bgt_2016 column, as follows: 

Budget Category Account
Mattress Revenue 101-1
Pillow Revenue 111-1
Other Revenue 120-1
Discounts 190-4
Fixed Expenses 308-0
Variable Expenses 201-1

Hint: You will most likely have to use a nested IF() statement to make this work 
correctly. If done correctly, most accounts will show a zero. Only the accounts 
above will be populated with budget numbers. 



ExcelCEO 

            Chief Excel Officer

SECTION 4: Master Level   —   Comprehensive Project

475

Chapter 18

Figure 18.9

Make sure to keep the VLOOKUP() formulas intact, as you will be changing some of the assumptions in 
the Budget Rules when you are taking the exam. You will need to refresh the various PivotTables to get 
the correct answers flowing through. 
 

18. Create a PivotTable based on the myFinl_Data tab that summarizes the Lvl2_Acct column 
and the Amt_2016 and Bgt_2016 columns. Make the Revenue numbers appear first in the 
PivotTable. Create a calculated field formula in the PivotTable that calculates the percent 
of budget and call it act_pct_bgt. Format the numbers appropriately. Your numbers should 
match the figure below.

Figure 18.10

19. Name the new tab Actual_Budget.  

Tip: If your Bgt_2016 formula returns an error the first time, or comes back 
blank, make sure Column O from Figure 18.9 is formatted as Number, and 
not General. Then Refresh the PivotTable. This check on formatting could 
save you significant headaches on this project, and in the future. Numbers 
formatted as text will not calculate in a PivotTable.
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I anticipate you will spend quite a bit of time getting the project to this point. Let’s play around with this 
PivotTable a bit more.  

20. Remove the Lvl2_Acct field from the PivotTable (this essentially brings in Net Income), and 
bring in City and Store as Rows. Collapse the entire field to hide the detail for the Store 
field. 

Figure 18.11

Why does Jersey City have negative net numbers? 
 

21. Expand Jersey City to see all locations under it. 
 

Figure 18.12

It looked strange because the Home Office and Northern and Southern Regional office numbers were 
included in Jersey City. When you analyze the performance of the entire company, it is probably 
necessary to include those “overhead” type numbers, but in this analysis we want to look at only the 
operating stores, so let’s take out the overhead numbers. 



ExcelCEO 

            Chief Excel Officer

SECTION 4: Master Level   —   Comprehensive Project

477

Chapter 18

22. Deselect the Home Office, Northern Region, and Southern Region from the Stores field, as 
in the following figure. 

Figure 18.13

23. Modify the PivotTable to remove the City, 2016 Budget, and Pct of Budget fields. 
24. Bring in Month as a Columns label. 
25. Check to make sure your numbers match as illustrated below:  

Figure 18.14

26. Save and close myComp_Project.xlsx. 
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Make absolutely sure that the numbers in your file match with the numbers throughout the 
Comprehensive Project - the screenshots are provided as checks to make sure your formulas are 
populating data correctly. You will be using this Comprehensive Project file to answer all the questions 
in the final exam, so it’s essential you start off with the right file. Again, if the numbers are not matching 
and you don’t know why, rework it following each instruction exactly. 
 

My last piece of advice: When you are taking the last exam, note that the 
questions are not cumulative, meaning you will have to reset the file to its 
original state each time you answer a question.  

Conclusion  
In this chapter, you completed the Comprehensive Project. The primary objective of the Comprehensive 
Project was to test your ability and understanding of PivotTables, using VLOOKUP() functions, and 
writing formulas using nested functions. 
 
In this course, I have taught you the Excel tools that are most helpful in business situations. All of the 
tools require you to use a certain degree of logic, and I’ve attempted to teach you those thought patterns 
as well. However, I cannot anticipate all of the situations that you may encounter. You will have to depend 
on your own creativity and ingenuity to solve those issues. As you use the tools taught in this course 
for your own projects, the concepts should solidify and further improve your understanding and Excel 
mastery.

Remember that your education does not stop here. There are many different areas of Excel you can 
explore, like VBA (Visual Basic for Applications - the programming language behind Excel), and 
discovering other functions. Continue to learn. Buy other books, search the Internet, do everything you 
can to expand your Excel knowledge (especially buying the new releases of the ExcelCEO courses) and 
you will quickly be regarded as the Excel expert of your office.  
 
By going through this course, you’ve learned the basics and advanced basics. From here on out, you can 
use a reference book to research most of your questions. Another good source for researching Excel issues 
is the Internet. I have found answers to many of my questions by going to the Internet and researching 
what others have done. Whenever I think that someone must have had my same problem, usually they 
have.  

Chapter Exam  
To take the examination for this chapter, you must have successfully completed the examination for the 
previous chapter. You can now go to www.ExcelCEO.com, click on Sign In, log in and take the exam. 
Make sure that you take the exam on the same computer on which you completed the Comprehensive 
Project, as all of the questions in this exam refer to the completed project. 
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Term Definition
#DIV/0! Error An error message returned when a numeric calculation is setup to 

divide by zero - a mathematical impossibility.
#N/A Error An error message returned when the search value is not available 

as formatted, or not available at all.
3-D Reference A three-part reference to a workbook file path when referencing a 

different workbook. Parts of the reference include the [workbook_
name]Spreadsheet_Name! and the cell range (Ex: $A$1:$D$5).

Absolute Reference A cell reference in a formula that does not change when copied to 
other cells. This is identified by having a $ before AND after the 
column letter, which acts as an anchor for both column and row. 
The $ anchors whichever cell reference part (column or row) before 
which it is placed.

Active Field The selected area of a spreadsheet when content is in a state to be 
modified.

Align Left Text formatting that locates cell contents toward the left-hand side 
of the cell.

Align Right Text formatting that locates cell contents toward the right-hand 
side of the cell.

Amortization Schedule A table representing a payment plan from a set time until a future 
payoff period. Tracked are interest rate, payment amount, interest 
and principle payments, and remaining balances per period.

AutoFill A text fill function, available through an icon that pops up after 
a tool like DataFill has been used, that allows the Excel user to 
define how data will be copied, with or without originating cell 
formatting, or using Flash Fill.

AutoFilter An Excel filtering feature that allows you to select filtering options 
using a dialog box accessed from column filter drop-down arrows 
that allow you to select specific values using checkboxes and 
menus.

AutoSum A function on the Home tab used for quickly creating a sum for a 
contiguous group of numerically formatted cells. Average, Count,  
and other functions are also available in the AutoSum drop-down 
menu.

AVERAGE() A statistical function for taking the combined middle of a defined 
group of numbers in numeric formats.

AVERAGEIFS() A multiple option criteria-based function for finding the mean of 
given arguments.

Blank workbook An Excel workbook not containing any user-inputted data. This is 
also an option icon when opening Excel for users who want to start 
a new project, or a quick calculation.
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Bold Text formatting that adds visual weight to the characters for the 
intent of standing out.

Borders Formatting that applies line characteristics to the exterior of the 
cell. 

Bottom Align A cell location format that causes cell content to be situated toward 
the bottom of that cell.

Calculated Field A PivotTable function that allows elements of the PivotTable 
to be manipulated using formulas to develop new solutions not 
contained in the source data.

Cell The intersection of a column and a row is called a cell. A cell is a 
rectangular space - named first by column, then by row position 
in the spreadsheet - where calculations or data can be inputted and 
analyzed.

Cell Style A formatting option that allows the Excel user to create a named 
format for quick access. Options include background color and 
font attributes.

CELL() Function A function that returns details about a given cell, based on 
an Info_type, including “address”, or location of the cell, 
“contents”,”Filename”, and more.

Center A cell location format that causes cell content to be situated toward 
the vertical middle of a defined cell.

Chapter Examination An exam that is administered at the end of each chapter to test 
whether or not the participant has learned the material well 
enough from the given chapter. Each Review Questions checkpoint 
in the chapter must be completed prior to taking the exam. A 
passing grade of 70% or above must be obtained before continuing 
to the next chapter, and a maximum of two retakes are possible 
for claiming CPE credit for the specific chapter. Projects outlined 
and completed within the chapter will be referenced in the chapter 
exams, so having the projects accurate, completed, and available 
during the exam is vital to passing each exam.

Chart Elements This is a new-for-Excel 2013 feature that replaces the Layout 
contextual tab from Chart Tools. Chart Elements is a highly 
interactive and visual chart-building group of tools.

Columns Vertical groups of spreadsheet cells named with alphabetical letters 
above the spreadsheet.

Command Button An interactive overlay feature that can have functions connected to 
carry out a defined action when clicked.

Compact View Part of PivotTables, and recognizable from + and - boxes for 
showing more or less data, Compact View allows the Excel user to 
expand the view of lower levels of detail, or hide them for higher-
level information.

Conditional Formatting Cell formatting applied based on pre-defined criteria, ranging from 
text formats to cell background colors.
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Contextual Tab A tab related to a specific function, and represented above the 
Office Ribbon in Microsoft programs.

Copy To record defined cell or worksheet content for placement in 
another location while leaving that same content in the original 
location.

COUNT() Function A data function designed to return the number of cells containing 
a specified value.

COUNTIF() A count function that allows the Excel user to select a range, and a 
specific criteria total based on a cell reference.

CPE Continuing Professional Education. A course by which people 
maintain their knowledge and skills for a particular profession.

Custom Format A user-defined cell appearance that is returned when certain 
criteria is recognized

Custom Sort Functionality in Excel that allows the user to organize data  based 
on column, criteria, and order. Multiple levels are also available for 
more detailed sorting.

Cut To record defined cell or worksheet content for placement in 
another location, removing the content from the original location.

Data Consolidation The process of combining worksheets from separate workbooks 
into a common workbook or file.

Data Labels Descriptive or otherwise identifying information, usually for use 
in charts, to customize appearance of, or draw attention to key 
details.

Data Source A name given to the connection set up to a database from a server. 
The name is commonly used when creating a query to the database.

Data Validation A method for requiring a user to select from pre-defined options in  
a drop-down menu, or from a chosen range. This is preferred when 
the choice affects formula performance.

DataFill Related to AutoFill. A cell content feature  shown as a bold black 
box on the bottom-right corner of an active cell, or group of cells, 
that allows for dragging formulas to adjacent cells, or through 
double-click on the AutoFill/DataFill box, copying the cell content 
formula or pattern to all adjacent cells in a specific column below.

Dates A numeric text format that applies a calendar day format to a 
specified number from a base of one representing January 1, 1900.

DAY() One of three arguments in the DATE() function, or a function for 
extracting the day number from a date formatted cell.

DCOUNT() A database function similar to the regular COUNT() used for 
counting data that meets specified criteria.

Decrease Decimal An icon on the Home tab Number group used for reducing the 
visible amount of numbers following the decimal.

Descriptive Statistics An Excel add-in returns common statistical details about the data 
range chosen.
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Dialog Box A pop-up window on a computer screen that communicates 
information to the user and prompts them for a response.

Dialog Expander A small, downward facing arrow in a box letting the Excel user 
know more options are available in the tool group.

Direct Capitalization Method One method for estimating the value of a business, an investment, 
or income-producing property that divides net income from the 
investment by the capitalization rate.

Discounted Cash Flow (DCF) 
Method

A method for assessing the value of an investment or income by 
discounting each year’s projected income back to the present value.

DSUM() A database function used for summing data that meets specific 
criteria

Expenses A term representing outgoing payments, particularly in an income 
statement

External Data Sources Data contained in a location outside of Excel which can be accessed 
for analysis

Filter A tool for narrowing and defining the search for data within a 
given range or criteria

Find and Replace A tool that locates user-defined content within a selected range, 
and replaces that matching content with content of the user’s 
choosing.

FIND() The function that allows the user to quickly search for specific 
content in a selected range. To work effectively, formatting must 
also match.

Fixed Expenses A financial outgo of capital that does not change based on product 
or service output, material costs, etc. These expenses remain 
constant, or sunk, regardless of ability to generate income.

Flowcharting A SmartArt tool for visually organizing processes, positions, 
or decision-making criteria. Flowcharting is characterized by 
connecting lines between defined and labeled shapes.

Format Cells A dialog box where you can apply number, text, and color formats 
to a cell, or group of cells within a workbook.

Format Painter A formatting tool with a paintbrush icon that allows the Excel user 
to copy the format of a cell within a workbook, and apply it to a 
single cell (on single-click), or multiple cells (double-click) with 
point-and-click ease. Pressing [Esc] will cancel the double-click 
option.

Formula A logic-based equation that performs which evaluates specified 
arguments on values, dates, or text strings from referenced cells in 
an Excel worksheet, or an Access database.

Freeze Panes A view in Excel that allows the user to scroll without losing 
visibility to column headers or row labels. Options include: Freeze 
top row, freeze panes, and freeze first column.
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Function Keys Keys on a keyboard that allow the user to perform certain 
functions that allow the user to use the keyboard instead of a 
mouse to increase speed and maneuverability.  Function keys are 
typically keys that begin with the letter “F” and are located along 
the top of the keyboard.  Also called Action keys.

FV() Function An accounting function in Excel for calculating the future value 
of an investment based on periodic, constant payments with a 
constant interest rate.

Goal Seek Sometimes called a “What-if” analysis, Goal Seek is setup as a 
group of criteria for finding an unknown answer through allowed 
changes in known data.

Graphics Images that can be Inserted or created in a spreadsheet to 
customize the appearance of the work.

Handles Small, opaque squares surrounding an active object that allow 
for adjustment in vertical or horizontal size, or a combination of 
the two. A circular handle can also be available for rotating some 
objects.

Hard-coded Data inputted directly into a cell without formula. Hard-coded 
data does not update without manual adjustment.

Hide Detail A box with a “-” sign inside used for covering low-level details, 
often leaving summary levels.

Hierarchical Structure A parent/child structure in a database that establishes relationships 
between data.

HLOOKUP() A lookup function for searching a table by column, and returning a 
value based on the row number specified in the formula.

HTML Stands for Hyper Text Markup Language. HTML is a language, 
not particularly programming, that identifies how text or images 
should be displayed by a web, or other HTML-compatible browser.

Hyperlinks An interactive connection, through text or image, that allows a 
user to move from one virtual location to another through mouse 
click. Hyperlinks can be used to move between spreadsheets or 
cells within an Excel workbook, to internet pages, or to email client 
windows.

Icon A pictorial representation of an object.  When clicked, the icon 
performs a predesigned task.

IFERROR() A function that has been fixed for Excel that allows the user to pre-
emptively handle formula errors with pre-defined response text or 
numbers. Prior to Excel 2013, ISERROR() handled this function.

Images Another term for graphics, images are visible representations of 
data, scenery, etc., and can be inputted into Excel workbooks to 
enhance interaction, display, or presentation.

Increase Decimal A number icon that expands the total count of numbers visible to 
the right of a decimal, up to the total amount available in the cell, 
or group of cells.
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Insert Function A button to the left of the formula bar identified with “ fx”, which 
can open a dialog box for explaining functions step-by-step, and 
inserting the selected formula into the selected cell.

INT() Function A math function for rounding the numeric contents of a cell down 
to the nearest whole integer.

IRR() Function Short for Internal Rate of Return, this function analyzes 
investment, or potential investment. The first number in the range 
should be negative, representing the initial investment amount, 
and the final percentage displayed represents the interest rate at 
which the net present value of the investment equals zero. The 
higher the percentage, the more desirable the investment would be 
considered, contingent on accuracy.

ISERROR() Similar to IFERROR(), ISERROR() is an error-handling formula 
that allows an Excel user to specify a formula result in the event 
of an error, or to calculate the formula when no error would be 
returned.

Keyboard shortcut Defined keystroke combinations in a program that allow a user 
quick access to specific formulas, functions, menus, or macros 
associated with the combination. (Ex: [Ctrl]+c is the equivalent 
keyboard shortcut for clicking the Copy icon from the Clipboard 
group in the Excel Home tab, and selecting the cell contents to 
copy to the clipboard memory for pasting in another location.)

LEFT() A text function designed to return a specified number of characters 
beginning from the left-most side of a designated cell.

LEN() A text function that returns the length in total characters in a 
defined cell, including spaces before, after, and between character 
groups (words, numbers, etc.)

LOOKUP() A search function with two arguments: the value to be found, and 
the range for return value. The range will always be two columns, 
and the return value will always be the value in the second column 
to the right of the lookup value, or the next lowest value available.

LOWER() A text function that returns an all lower-case equivalent of the text 
in a specified cell.

Macro A mini-program that executes a programmed task, which can 
be linked to buttons or keystrokes. Caution should be exercised 
in knowing the source and intended function of a macro before 
enabling it for use, as macros can perform functions extending 
beyond the program written in.

Macro Recorder A small box icon (also available through a dialog box) that can 
be used to define a macro’s function by executing it visually on 
the screen. Once recording has begun, a Stop box is available on 
the lower-left of the Excel window for ending step recording to be 
associated with the macro.

MATCH() Function A text function that returns the relative row position in a table or 
array for a defined criteria.
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MAX() A statistical function that returns the greatest numeric value in a 
given range.

MEDIAN() A statistical function that returns the value in the middle of a given 
range where half the values are more, and half are less. Not to be 
confused with the AVERAGE() function.

MID() A text function that returns characters from a cell based on user-
defined beginning point, and maximum count.

Middle Align A text alignment tool that vertically locates cell contents in the 
middle of a given cell.

MIN() A statistical function that returns the numerically least value in a 
specified range or array.

Mixed Reference A formula tool for anchoring a cell reference either by column, or 
by row, by placing a “$” sign in front of the column letter, or the 
row number. Cell references can also be toggled using the [F4] key.

MODE() A statistical function that returns the most commonly occurring 
numeric data point in a selected range.

MONTH() A text function that returns the month number from a specified 
cell with the number content formatted as a any type of number, 
based on a beginning point of one being 01 JAN 1900.

Named Range A table or database option for identifying a workbook range by a 
user-specified label in addition to column/row names for quick 
reference in formula-writing or locating. Names for ranges can 
be viewed and written in the Name Box to the left of the Insert 
Function icon and the Formula Bar.

Nesting Functions Text functions that operate based on logical arguments when 
evaluating data for best solution to return.

Non-contiguous Ranges Data ranges with column or row breaks between non-blank cells. 
When intentional, these provide useful barriers for separating non-
related data. If breaks between related data are present, DataFill 
formula copying will not populate beyond the data breaks without 
manual intervention.

NOW() A time function that returns the computer-provided time in the 
given cell. This function updates upon refresh.

NPV() Function A financial function that returns the present value of projected 
future income values for an initial investment.

Operator Sometimes referred to as a Comparison Operator.  Characters or a 
set of characters used in conditional statements to test arguments.  
The six operators are Equals (=), Less than (<), Greater than (>), 
Less than or equal to (<=), Greater than or equal to (>=), Not equal 
to (<>).

Orientation A Page Layout tool divided between Portrait and Landscape used 
for displaying information as it would print on paper, etc.
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Page Break A Page Layout detail that defines where the end of a page would 
be when printed, based on margin values compared to cell 
dimensions. As a selected option, a spreadsheet will display Page 
Breaks with virtual perforations.

Paint A Windows-based program outside of Excel where graphics/images 
can be view, modified, created, and/or saved.

Parent/child relationship A relational database term for identifying how data is connected to 
other data between ranges.

Password A case-sensitive login credential for accessing the student training 
portal at ExcelCEO.com. A temporary password is initially 
assigned for first-time access, which can be changed once logged 
into the specific profile using the access boxes to the upper-right 
of ExcelCEO.com. After periods of inactivity, or for other reasons, 
a registered ExcelCEO student can have their password sent to the 
email address associated with the profile using the [Forgot Your 
Password?] link below the login area.

Paste A text function that takes cut or copied data from the Clipboard, 
and locates it in a specified cell, or group of cells.

PivotChart An advanced Excel feature that displays PivotTable Data in a 
graphical format. New in Excel 2013, PivotChart data can be built 
without first creating a PivotTable, and the chart can update when/
if linked data changes. A PivotTable is still built in the background.

PivotTable An advanced Excel feature for in-depth analysis and organization 
of data that does not alter the original data. Data can be displayed 
using filters, slicers, and modified column and row information 
identified in the original source data, or through user-created 
Calculated Fields.

PivotTable Field List A listing of available column headers in the original source data 
and any Calculated Fields, as well as a four-part grid that allows 
the user to adapt filters, column and row data, and value formats to 
display.

PivotTable Fields Column headers from the source data, or Calculated Fields, that 
can be inputted in the PivotTable organization grid through 
checking boxes, or drag-and-drop ability. Additional data ranges 
can be utilized through the Excel Data Model.

PMT() Function A financial function for determining the amount a payment would 
be based on an initial value, number of periods payments would 
be due, and the interest rate for the initial value. This is a required 
component for an amortization schedule.

Precedent Cell Used in Data Validation to identify cell references affected by 
formula errors

Primary Key A relational database unique identifier for how data in one range 
relates to another range when analyzing specific data contained in 
one range that is not available in another related range.
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Print Preview A visual representation of the way data in a specified range would 
display on a printed page.

Progress Report An emailed reported at a user-specified interval that tracks online 
progress through the course(s) for which the ExcelCEO student is 
registered.

PROPER() A text function that takes text from a defined cell, returning the 
text with the first letter capitalized, and the remaining letters in 
lower-case format.

Protect An option within Excel for locking certain aspects of a cell or 
range against changes to formulas or data without inputting the 
assigned password.

PV() Function A financial function for establishing the value of an investment 
based on the total of future investment payments in present-day 
dollars, based on a specified discount rate — often the expected 
inflation rate reversed.

Quick Access Toolbar A customizable group of icons that enables the Excel user to 
quickly access commonly used features. Default icons include Save, 
Undo, and Redo

Quick Analysis A new feature since Excel 2013, available through an icon that 
appears after a range is selected, for seeing visual representations of 
the data from a group of tool options.

RAND() A number function that returns a random numeric value without 
regard to integer constraints. In other words, the value returned 
would be fully random.

RANDBETWEEN() A function similar to RAND() that provides the ability for the 
Excel user to define minimum and maximum random values.

RANK() Function An analysis function that allows the Excel user to learn the relative 
location of a specified value in a user-defined range, with the 
option to sort in Ascending or Descending order.

Recommended Charts A new chart element since Excel 2013 that provides visual previews 
of how selected data would appear in a variety of chart formats.

Redo A right-facing arrow icon with a curved shaft that is designed to 
reapply the last step that was removed.

Relative reference A column/row name in a formula without any anchors to specific 
cells, columns, or rows (anchors being identified as “$” before the 
column letter, or row number).

Revenue A measurement of received payments that do not take into account 
any related fixed or variable expenses applied to the unit sold.
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Review Questions A hands-on learning component of the ExcelCEO student 
experience in the online profile at ExcelCEO.com (for students 
registered for a complete course) where the student is given 
questions that test their knowledge of the Excel program taught 
directly up to that point, or peripheral knowledge that can be 
gained at the time the question is given, in order to further 
enhance learning opportunities. Each section of Review Questions 
is delivered sequentially, not graded, but must be completed in 
order to move forward in the online portion of ExcelCEO training, 
and each section of Review Questions must be completed prior to 
the Main Menu text link updating to display that chapter’s exam 
link. Each option selection provides an answer and explanation.

RIGHT() A text function that returns/extracts a specified number of 
characters from a defined cell, counting from the right-most 
character in that cell.

ROUND() Function A number function that takes numeric values in cells, and provides 
the closest whole number to the specified space, filling in the 
rest with zeroes. The rounding space number is defined from the 
decimal placement, with positive numbers being to the right of the 
decimal, and negative numbers applying to number slots to the left 
of the decimal.

Rows Horizontal groups of spreadsheet cells named numerically in 
Ascending order.

Screen tip A temporary window seen when hovering over an object in the 
workbook. Screen tips include shortcut key stroke combinations, 
and brief descriptions of object capabilities.

SEARCH() A text function that returns the numeric starting place in a 
defined cell where the user-defined text is located, from the given 
beginning point.

Show Detail A box with a “+” sign inside used for showing (or expanding) low-
level details, allowing the Excel user to see more than summary 
levels for the Data.

Slicers An Excel feature new since Excel 2010 that provides data 
manipulation capability where the user can filter specific ranges 
of data, and see a visual representation of which data is being 
displayed.

Solver A “What-if Analysis” mini-program that can take multiple user-
defined constraints, and find an answer to a problem that satisfies 
those requirements.

Sparklines A chart feature new since Excel 2010 that allows the user to apply 
miniature charts to rows to identify Data trends applicable to that 
specific data. Options include: line, bar, and win/loss charts.

Spin Button A Developer tab add-in that allows data to be modified graphically 
at user-defined intervals through use of up/down buttons tied to a 
specific cell rather than through manually typing the change.
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Spreadsheet A grid of columns and rows that can be used for organizing, 
calculating, sorting, summarizing, etc. In Microsoft Excel, 
Columns are identified alphabetically, and rows are identified 
numerically.

Status Bar A customizable feature to the bottom of the Excel window that 
shows details such as the AutoSum of selected cells, average, and 
count. To access the Status Bar options list, right-click the colored 
bar on the Excel window.

Subtotal A database function that can apply summary data labels and values 
for specific groups of data.

SUM() A number function that provides the mathematical total for the 
cell range provided using addition or subtraction.

SUMIF() A conditional number function that returns a mathematical total 
for cells in a range that meet a defined criteria.

SUMIFS() A conditional number function that returns a mathematical total 
for cells in a range that meet a defined criteria or condition.

Tags HTML markers identified by web browsers to display the enclosed 
text or object(s) in a pre-defined way

Text Functions A group of Excel tools designed to interact with specified data 
using logical arguments and conditions to return the first true 
value available.

Text to Columns An external database tool for inputting data from other sources 
and formats based on user-identifed separators, or delimiters, 
that determine column, row, and cell breaks. This method is not 
formula-based.

Title Bar The area at the top-center of the workbook that identifies the file 
name and program. Unsaved file names will begin with “Book”, 
such as Book1.

TODAY() A text function that identifies the calendar date when written, 
or updated, and is absent of a defined time, as provided with the 
NOW() function.

Top Align A cell text feature that aligns text vertically at the top of the 
selected cell.

Trendline A chart feature new since Excel 2010 that allows the user to apply 
present and forecasted lines that represent they way data now 
displays, and how it would look if the data remained constant 
through the future periods chosen.

TRIM() A text function designed to remove seen and unseen spaces 
surrounding cell data, which can otherwise affect formula 
performance and/or displayed appearance.

Underline A text feature that places a solid line below a specified cell’s data, 
and is used for separation, isolation, or attention purposes.
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Underscore A single-character displayed as a line at the bottom of the text 
field, often as the visual representation of a space, or to improve 
functionality for programs that do not easily recognize unmarked 
spaces.

Undo A left-facing arrow icon with a curved shaft that is designed to 
remove the most recent function or input application.

UPPER() A text function that returns the contents of a chosen cell in all 
capital format.

User ID An identifying credential for logging into a website. ExcelCEO 
students provide email addresses for User IDs, which can be 
changed in the student profile Main Menu, as needed. [Forgot 
Your Password?] requests are setup to send the information to that 
address as well.

Variable Expense A financial outgo of capital that changes based on product or 
service output, material or labor costs, etc.

VBA Visual Basic for Applications. A programming language used for 
executing macros and executable tasks.

Validation Rules User-defined criteria for inputting data in a cell that requires 
specific values for dependent Formulas to perform properly.

VALUE() A text function that returns the static, displayed characters from a 
specified cell without formula dynamics applied.

VLOOKUP() A vertical lookup function that searches for a defined number, 
text string, value, or formula result in a specified data range, and 
returns a related value from a specified column number within that 
range. The value returned can be user-defined as exact or relative.

WEEKDAY() A number function that returns the numeric position of the 
calendar day of the week for a date-formatted number, or number 
identified as a date is located. Several weekday options are available.

WordArt A graphical text function used to format text in a variety of display 
options in a Text Box.

YEAR() A date function that returns the year number from a numerically-
formatted target cell, based on the number 1 representing 01 JAN 
1900.
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